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What's New in Version 2019.1
Developed with a focus on optimizing performance for both administrators and end-users, Exago v2019.1 is packed with enhancements
that improve backend and frontend performance and features that improve the reporting experience. Please also see the Performance
Enhancements in Version 2019.1 article for in-depth information regarding these features.

Configuration Optimizations
The web server can now store a portion of the configuration data, which will not be modified at runtime through the API, in static memory.
This will allow for quicker session initialization, a smaller memory footprint, and improvements to frontend performance with large
configurations.

Formula Sorts in the Database
If enabled, Exago will attempt push all formula sorts to the database instead of running them locally, increasing report execution
performance.

Report Execution Performance Enhancements
Report execution logic has been optimized resulting in an overall improved performance of all report types.

Building Metadata in Bulk
With the optimizations made to the configuration architecture, the use of metadata for every data object is now strongly encouraged for its
added performance enhancements. This feature allows administrators to quickly generate metadata for multiple data objects at once.

Time Zone Calculation Enhancements
Enjoy an extra hour of sleep at the end of daylight saving time with Exago's time zone calculation enhancements! With the implementation
of the Noda Time library, the Scheduler module and Scheduler Queue now accurately consider the implications of DST and other nonlinear scheduling issues related to geopolitical time zones.

Show SQL
Preview the full SQL statement that will be sent to the database during execution directly from the Advanced Report designer. This
feature will also warn the user if the report will not run successfully (e.g., in the case of a circular cell reference).

Dashboard Reflow Added by Default
Dashboards can now be set to Automatically Reposition Tiles, which dynamically derives an optimal new layout for the Dashboard
tiles each time the screen is resized.

Setting Filters and Parameters via the JavaScript API
Add filters, modify prompting filters, and create report-level parameters at runtime via the JavaScript API.

Boolean Parameters
Boolean data types are now supported for parameters. Users may select True or False from a dropdown menu when prompted with a
parameter of this type. The dropdown option language is also customizable!

Defaulting Parameters to Null
Parameters of any type may now be defaulted to Null using {null} as its default value. In previous versions, only String parameters could be
defaulted to Null.

Font Dropdown Enhancements
Now searchable, navigable via the arrow keys, and opens to the currently selected font!

Technical Specifications
Windows
Windows Server 2012+ / Windows 7 / 8 / 10
Internet Information Services (IIS) 7+
.NET Framework 4.6.1+, version 4.7.2 recommended

Linux
Supported Distributions
Red Hat Enterprise Linux 7
SUSE Linux Enterprise Server 12
CentOS 7
Fedora 21-25
Debian 8-9
Ubuntu 14+
Warning
Exago is incompatible with SELinux.

Requirements
Exago is not compatible with mono versions installed from system repositories. It is highly recommended that only official mono-project
repositories are used or that the Exago installer install mono.

Mono
Warning
These are the only versions of Mono that are compatible with Exago. In addition, the Exago installer will install a patched version of
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System.Web.dll. This patch can also be installed manually.
mono 4.2.2.30, 5.10.1.20
Optional: mono-basic, which provides support for VB.NET

Apache 2.4+
mod-mono

NGINX
mono-fastcgi-server4
The Exago installer can automatically download and install supported versions of mono, mod-mono or mono-fastcgi-server4.

Data Sources
Database servers:
Microsoft SQL Server 2000+
PostgreSQL 7.1+
Oracle Version 9i+
MySQL 5.0+
Amazon Aurora
IBM DB2
IBM Informix
ElasticSearch
MongoDB
Redshift
Snowflake
SAP Sybase (ODBC)
Apache Cassandra (ODBC)
OLAP*

Database APIs:
ODBC
.NET Assembly Methods

Files:
XML
Excel

Supported Browsers
Exago BI targets the most current stable versions of the following web browsers.

Desktop
Desktop browsers support the full user interface and admin console.
Mozilla Firefox
Internet Explorer 11
Microsoft Edge
Google Chrome
Apple Safari (MacOS)

Mobile
Mobile browsers support viewing report output in the embedded report viewer.
Google Chrome
Apple Safari

Types of Objects
Database Tables
Database Views
Stored Procedures
Database Functions
Parameterized SQL Statements
Web Service Methods
.NET Assembly Methods

AJAX Enabled
.NET API and REST Web Service API for communication between Exago and host application

System Requirements
The content of this article has been moved to Considerations When Sizing an Exago System.

Configuring IIS for Exago
This guide covers the IIS configuration details necessary in order to install Exago. First-time users are highly encouraged to use this guide
during their installation process. Following these steps in order will reduce the amount of troubleshooting necessary to get Exago running.
1.
2.
3.
4.
5.
6.

Install Prerequisites
Install Exago
Set the Application Pool
Set Folder Paths and Permissions
Check that the Web Site is Running
Open the Admin Console
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Install Prerequisites
Exago requires the following Windows Features to be installed:
Internet Information Services
Web Management Tools
IIS Management Console
World Wide Web Services
Application Development Features
.NET Extensibility
ASP.NET
ISAPI Extensions
ISAPI Filters
Common HTTP Features
Optional: WebDAV Publishing
Before installing Exago, please ensure that these features are present on your system. To verify, access the Windows Features panel via
Control Panel > Programs > Programs and Features, and click Turn Windows features on or off.

In the Windows Features dialog, expand Internet Information Services and ensure that the prerequisite features are selected. If any are
not installed, check the relevant boxes, press OK, then restart the server.

These features are necessary in order for the proper Application Pools to be available.

Install Exago
At this point, Exago can be installed.
For a detailed walkthrough, see Installing Exago on Windows.

Set the Application Pool
Next, verify that Exago is using a valid application pool.
Open IIS via Control Panel > Administrative Tools > Internet Information Services (IIS) Manager.
In the left-most Connections pane, select the Exago application.

In the right-most Actions pane, click on Advanced Settings...
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In this menu, click on the [...] button to the right of the Application Pool.

In the Select Application Pool menu, determine which of the app pools has the properties:
.Net Framework Version: 4.5
Pipeline mode: Integrated

Select this app pool, then press OK to close the App Pool menu, and then OK to close the Settings menu.
Next, ensure that the app pool is running. In the left-most Connections pane, select Application Pools.

Check the Status column for your selected app pool.

If it does not say Started, select the app pool and in the right-most Actions pane, press Start.

Set Folder Paths and Permissions
Exago uses a Temp and Report folders to store working data and the reports file system, respectively. Create folders in locations suitable
for your environment.
The Reports folder should not be within the Exago application directory. This could cause timeout errors while using the application.
The Temp folder may contain sensitive report and database information. It should be in a secure location, inaccessible to web users.
Several Exago folders require you to set additional permissions for the application pool user. First, determine the user: Open IIS to
the Application Pools pane, and look at the app pool which is running Exago. The Identity property indicates the application user:

By default, this is set to ApplicationPoolIdentity. This corresponds with the built-in user IIS_IUSRS. If this is a different user, then set
permissions for that user account instead.
The following folders require the app pool user to have read/write permissions:
Config
Temp
MapCache
Reports
Note
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This process may differ slightly depending on the version of Windows.
First, right-click on the folder and select Properties.

Open the Security tab. Then click the Edit... button.

If the application pool user is not available to select, you need to add it. Press the Add... button.

Then enter the username in the dialog box, and press OK (the default app pool user is IIS_IUSRS).

With the user selected, check the box for Allow Full control. Then press OK.
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Repeat this process for every folder listed above.

Check that the Web Site is Running
Before starting Exago, ensure that the Web Site is running. Open IIS, and in the left-most Connections pane, locate and select the web
server under which Exago was installed

Verify in the right-most Actions pane that the Start button is greyed out, and the Restart and Stop buttons are available. If the Start
button is not greyed out, press it to start the web server.

Next, in the left-most Connections pane, locate and select the web site under which Exago was installed.

Verify in the right-most Actions pane that the Start button is greyed out, and the Restart and Stop buttons are available. If the Start
button is not greyed out, press it to start the web site.

Open the Admin Console
You're almost done! To verify that Exago was installed correctly, open a web browser and navigate to
http://[YourServerAddress]/[YourExagoVirtualPath]/Admin.aspx. If you see the Exago Administration Console, then
your installation was successful.
In the Admin Console > General Settings, set your Temp and Reports paths to the folders you previously created. Then click Okay.
Finally, navigate to http://[YourServerAddress]/[YourExagoVirtualPath]/ExagoHome.aspx. If you can see the Exago
Web Application user interface, depending on version the Report Tree should be:
empty for versions pre-v2020.1
Congratulations! You've completed your first Exago installation.

Additional Notes
We highly recommend Setting up a State Server to handle Exago sessions.
If you are experiencing problems that aren't detailed in this guide, please file a support ticket, and a representative will be happy to help
you get set up.

Installing Exago on Windows
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Exago runs on the web server application Microsoft Internet Information Services (IIS). The following sections walk through the installation
process for Windows based systems.

Prerequisites
See Considerations When Sizing an Exago System to ensure that you have sufficient hardware to run Exago.
See Technical Specifications to ensure you have the minimum software requirements to run Exago.
See Configuring IIS for Exago to ensure that IIS is installed and configured correctly.

Installation
Important
If you are upgrading an existing Exago installation, please ensure that the file eWebReportsManifest.txt is present in the install directory.
Otherwise, the installer will overwrite any custom config or styling you've applied.
Download the Exago installer from our Downloads page.
Run the installer as an administrator. The installation menu will appear with three downloadable applications. Click the top icon to install
the Exago Web Application, as pictured below.
Note
If Windows Defender prevents this installation, it may be bypassed by clicking "More Info" and then selecting "Run Anyway."

Follow the steps in the wizard to install Exago. You may optionally choose to install the Scheduler and the Web Service from this wizard.
Even though the installer has finished, Exago will most likely not function at this point. You must continue with some additional
configuration.

Create the Directory Structure
After the installation is complete, configure Exago using the following steps. (See Configuring IIS for Exago for a more detailed
walkthrough.)
1. Set permissions for the Config folder:
1. Right click on the folder named "Config" and click Properties.

2. In the Security tab click "Edit" then "Add." Enter the IIS application pool user (default IIS_IUSRS).

3. In the "Permissions for Config" window select the user that was just created and select "Full Control" permissions.

2. Repeat this process for the MapCache and Drivers folders if Mongo DB is being utilized.
Caution
If these permissions are not set, an access denied message will appear when trying to add a MongoDB connection string.
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3. For pre-v2020.1, create a folder for storing reports. This folder needs to be accessible from the web server, but is not required to be
on the web server. It can reside on any server accessible by Exago via direct UNC or virtual path created in IIS.
Important
Do not create this folder within the Exago application structure. Doing so will cause ASP.NET sessions to crash when report
folders are created or deleted within the Exago application.
Give the Report Folder full control privileges for the IIS application pool user. Below are three examples of report paths to the
folder \Reports:
C:\Reports – Folder is on a file system.
\\Server Name\Reports – Physical folder is on a separate server.
/Reports – Assumes an IIS virtual directory called 'Reports' has been created to point to the folder.
4. Create a folder for storing temporary data. By default this is a sub-folder of Exago called 'Temp'. However it is recommended to not
use the install path's temp folder in production environments. Give the Temp folder full control privileges for the IIS application pool
user.
5. Point your browser to the Administration Console. By default this is http://<YourServer>/Exago/Admin.aspx.
For pre-v2020.1, in the General > Main Settings section, specify the location of the Report Folder in the 'Report Path'
setting. Verify the connection is successful by clicking the icon.
For all versions, in the General > Main Settings section, specify the location of the Temp Folder in the
'Temp Path' setting.

What's Next
Point your browser to the Admin Console to verify that your installation was successful. By default this
is http://<YourServer>/Exago/admin.aspx
If you encounter problems at any point, please see Installation Troubleshooting for some potential solutions. If you cannot resolve your
problem, please file a Support Ticket.
At this point you will need to set up your data sources in order to use Exago. See Administration Console Setup to get started.
If you would like to set up Google Maps, GeoCharts, and/or any downloadable Application Themes, please see Installing Optional Features
for more information.

Resources
System Requirements — Baseline hardware requirements.
Configuring IIS for Exago — Necessary configuration details for IIS.
Installing the Scheduler Service — Scheduler config info.
Install and Configure the Web Service — Web service config info.
Installation Troubleshooting — Common install problems & their solutions.
Administration Console Setup — Initial data sources setup guide.
Installing Optional Features — How to set up Google Maps, GeoCharts, and Application Themes.

Installing Exago on Linux
The following article walks through the installation process for Linux systems. Before beginning installation, refer to the Technical
Specifications article for a list of supported distributions and a list of minimum requirements.
The Linux Installer was updated in v2019.2.1 of the application. Select the applicable version of Exago from the Application Version
dropdown on the right-side of this article to show only the information pertaining to that version.
Important
Any previous headless install scripts will start prompting for missing formation and will require editing to account for the new parameters.
This article is divided into two sections: Apache and NGINX. Only follow the instructions in the section that corresponds with the web
server in your environment.
Apache • NGINX

Installation with Apache
Apache must be installed prior to installing Exago.
The Exago Linux Installer can be used to install the Exago Web Application, Web Service API, and Scheduler Service. It can also install
mono and mod-mono. Use the following steps to install Exago on Linux with Apache.
Note
Apache or NGINX must be installed prior to installing Exago. If changing from one or the other, verify the dependencies (mod-mono or
mono-fastcgi-server4) are installed.
1. Navigate to the Downloads page, select a build, and then use the Linux Download option.
2. Decompress the download:
tar zxvf ExagoInstaller_vX.X.X.X.tgz

3. Change to the newly created Installer directory.
4. Run installExago.sh as root:
sudo ./installExago.sh

5. The installer can be run in guided or silent mode. The Linux distribution and Apache version will be detected automatically.

Silent Installation with Parameters
Usage:
[-d <install path>] [-m <TRUE|FALSE>] [-i <WEBAPP|WEBAPI|SCHEDULER>] [-y] [-h]

Parameter

Description

-d <Install Path>

Directory to install Exago in
Default is /opt/Exago

-m <TRUE|FALSE>

Whether or not to install Mono framework with Exago
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Which component(s) to install

-i <WEBAPP|WEBAPI|SCHEDULER>

WEBAPP — Web Application
WEBAPI — REST Web Service API
SCHEDULER — Scheduler Service

-a <Web App URL Alias>

Default is /Exago

-s <Web Service URL Alias>

Default is /ExagoWebApi

-r <Scheduler Service Name>

Name to use for the Scheduler Service's systemd service. Default is exagoscheduler.

-w <APACHE|NGINX>

Available in v2019.1.15+
Select the web server to configure, if both are available.

-y

Do not prompt for final verification before installing

-h

Show this help screen

Examples:
1. Install the Exago Web Application and Web Service API into /opt/Exago
./installExago.sh -d /opt/Exago -m TRUE -i WEBAPP -i WEBAPI

Guided Installation pre-v2019.2.1
Specify an install path when prompted. Default is /opt/Exago.
If the proper versions of mono (and mod-mono) are not present in your distribution's package repository then the Exago installer can be
used to download and install the correct versions. If so, the mono repositories will be added to the package manager's repository list so
that they can be updated in the future.
Select which components to install:
1. Web Application
2. Web Service API
3. Scheduler Service
Note
It is possible to install any components at a later time by running installExago.sh again.
The installer will additionally do the following:
Download and install mod-mono, if it is not already present.
Generate an Apache configuration file exago.conf in the Apache site path.
Set read/write permissions for the current Apache user on the install paths.
Config — Permissions and path set automatically
Temp — Requires read and write permissions
Reports — Requires read and write permissions
MapCache — Requires read and write permissions

Start and Test Install
Restart Apache.
Point your browser to the Admin Console to verify that your installation was successful and to create a default configuration file. By
default this is http://<YourServer>/Exago/Admin.aspx
If you encounter problems at any point, please file a Support Ticket.
Continue to Folder Configuration below to continue with the installation.

Folder Configuration
Configure storage locations for the configuration, report storage (either Storage Management for v2020.1.0+ or a Report Path prev2020.1.0) and temporary file storage.

Config
The Config sub-folder of the Exago installation has read and write permissions set by default.

Report Storage
Create a folder for storing reports. This folder needs to be accessible from the web server, but is not required to be on the web server. The
report folder can reside on any server accessible by Exago, provided a mount point is accessible on the Exago server.
Important
Do not create the reports folder within the Exago application structure. This can cause sessions to crash when report folders are created
or deleted within Exago.
1. Set the Report folder's read and write permissions to 770.
sudo chmod 770 Reports

2. Set the default ownership to the specific <apache user>:<apache group>
3. In the Admin Console, specify the location of the report folder in General > Main Settings > Report Path
Note
The group ownership on the reports directory is not mandatory, and can be changed to have other group ownership as needed for access
outside of Exago.
Default UMASK for files written by Exago is 027 and can be changed by updating the MonoUnixUmask option in the generated
exago.conf Apache configuration file.

Temporary File Storage
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The recommended path for the Temp folder is /opt/Exago/Temp.
1. Set the Temp folder’s read and write permissions to 775.
sudo chmod 775 /opt/Exago/Temp

2. Set the default ownership to <apache user>:root
3. In the Admin Console, specify the location of the temp Folder in General > Main Settings > Temp Path
4. Set the MonitoringService folder's read and write permissions for the Apache user, (of if not using the default Apache user the
user ID specified with -u) to 775, and set the default ownership to <apache user>:root.
Installation is now completed. If the Scheduler Service or Monitoring Service is required, continue to the Scheduler and Monitoring Services
section at the end of this article.
If all components are installed, the Installer directory may be deleted.

Installation with NGINX
NGINX must be installed prior to installing Exago. NGINX proxies incoming and outgoing requests to a running instance of Exago using a
fastcgi module that is installed during the installation process. mono-fastcgi-server4 is a prerequisite for Exago to run on NGINX.
The Exago Linux Installer can be used to install the Exago Web Application, Web Service API, and Scheduler Service. It can also install
mono and mono-fastcgi-server4. Use the following steps to install Exago on Linux with NGINX.
Note
Apache or NGINX must be installed prior to installing Exago. If changing from one or the other, verify the dependencies (mod-mono or
mono-fastcgi-server4) are installed.
1. Navigate to the Downloads page, select a build, and then use the Linux Download option.
2. Decompress the download:
tar zxvf ExagoInstaller_vX.X.X.X.tgz

3. Change to the newly created Installer directory.
4. Run installExago.sh as root:
sudo ./installExago.sh

5. The installer can be run in guided or silent mode. The Linux distribution will be detected automatically.

Silent Installation with Parameters
Usage:
[-d <install path>] [-m <TRUE|FALSE>] [-i <WEBAPP|WEBAPI|SCHEDULER>] [-y] [-h]

Parameter

Description

-d <Install Path>

Directory to install Exago in
Default is /opt/Exago

-m <TRUE|FALSE>

Whether or not to install Mono framework in Exago
Which component(s) to install

-i <WEBAPP|WEBAPI|SCHEDULER>

WEBAPP — Web Application
WEBAPI — REST Web Service API
SCHEDULER — Scheduler Service

-a <Web App URL Alias>

Default is /Exago

-s <Web Service URL Alias>

Default is /ExagoWebApi

-r <Scheduler Service Name>

Name to use for the Scheduler Service's systemd service. Default is exagoscheduler.

-w <APACHE|NGINX>

Available in v2019.1.15+
Select the web server to configure, if both are available.

-y

Do not prompt for final verification before installing

-h

Show this help screen

Examples:
1. Install the Exago Web Application and Web Service API into /opt/Exago
./installExago.sh -d /opt/Exago -m TRUE -i WEBAPP -i WEBAPI

Guided Installation pre-v2019.2.1
Specify an install path when prompted. Default is /opt/Exago.
If the proper versions of mono (and mono-fastcgi-server4) are not present in your distribution's package repository then the Exago installer
can be used to download and install the correct versions. If so, the mono repositories will be added to the package manager's repository
list so that they can be updated in the future.
Select which components to install:
1. Web Application
2. Web Service API
3. Scheduler Service
Note
It is possible to install any components at a later time by running installExago.sh again.

Start and Test Install
Configure NGINX
The required configuration is created in a separate site file located in the NGINX configuration directory.
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For Ubuntu systems this is typically /etc/nginx/sites-available/exago. For other systems this may be
/etc/nginx/conf.d/exago. The exact location of the file will depend on your system and NGINX installation. Consult with your
operating system and NGINX official product documentation for more information.
The site file is not enabled by default.

Example
#Exago conf file for fastcgi-mono-server4
server {
listen 80;
listen [::]:80;
server_name _;
root /var/www;
location /Exago/ {
include /etc/nginx/fastcgi_params;
root /opt/Exago;
access_log /var/log/nginx/exago.log;
fastcgi_param SERVER_NAME $host;
fastcgi_param SCRIPT_FILENAME $document_root$fastcgi_script_name;
fastcgi_param PATH_INFO "";
fastcgi_pass 127.0.0.1:9000;
}
location /ExagoWebApi/ {
include /etc/nginx/fastcgi_params;
root /opt/Exago/WebServiceApi;
access_log /var/log/nginx/exago_ws.log;
fastcgi_param SERVER_NAME $host;
fastcgi_param SCRIPT_FILENAME $document_root$fastcgi_script_name;
fastcgi_param PATH_INFO "";
fastcgi_pass 127.0.0.1:9001;
}
}

For example on Ubuntu, to enable the site file, link it to /etc/nginx/sites-enabled:
sudo ln /etc/nginx/sites-available/exago /etc/nginx/sites-enabled/exago

Or include the configuration in another running site configuration file. This step will depend on your specific environment. Consult your
operating system and NGINX official documentation.
Note
Make sure that the default port does not conflict with another running site. If it does, you will see a warning when reloading Nginx:
nginx: [warn] conflicting server name "Exago" on 0.0.0.0:80
Then reload NGINX to refresh the configuration:
sudo nginx -s reload

Note
This article references <WebApp>/, <WebSvc>/ as a placeholder for the application's install location and the Web Service API's install
location, respectively. The default install locations are /opt/Exago/ and /opt/Exago/WebServiceApi; however, these directories
may be changed during installation.

Start Listeners
This script created during installation needs to be started manually or configured to run at startup:
<WebApp>/bin/startExago.sh

If the Web Service API was installed, this script created during installation needs to be started manually or configured to run at startup:
<WebSvc>/bin/startWebService.sh

Point your browser to the Admin Console to verify that your installation was successful and to generate a default configuration file. By
default this is http://<YourServer>/Exago/Admin.aspx
If you encounter problems at any point, please file a Support Ticket.
Continue to Content Storage Configuration below to continue with the installation.

Content Storage Configuration
The Config sub-folder of the Exago installation has read and write permissions set by default.
Create a folder for storing reports. This folder needs to be accessible from the web server, but is not required to be on the web server. The
report folder can reside on any server accessible by Exago, provided a mount point is accessible on the Exago server.
Important
Do not create the reports folder within the Exago application structure. This can cause sessions to crash when report folders are created
or deleted within Exago.
1. Set the Report folder's read and write permissions to 770.
sudo chmod 770 Reports

2. In the Admin Console, specify the location of the report folder in General > Main Settings > Report Path
Note
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The group ownership on the reports directory is not mandatory, and can be changed to have other group ownership as needed for access
outside of Exago.
Default UMASK for files written by Exago is 027.
The recommended path for the Temp folder is /opt/Exago/Temp.
1. Set the Temp folder’s read and write permissions to 775.
sudo chmod 775 /opt/Exago/Temp

2. In the Admin Console, specify the location of the temp Folder in General > Main Settings > Temp Path
Installation of Exago is now completed. If the Scheduler Service or Monitoring Service is required, continue to the Scheduler and Monitoring
Services section at the end of this article.
If all components are installed, the Installer directory may be deleted.

Scheduler and Monitoring Services
Scheduler Service
A script named exago-scheduler.sh by default is used to manage the Scheduler Service. The name is customizable with the
installer's -r parameter.
The new service should start automatically when the system boots, and can be managed with the service command in the following ways:
service exago-scheduler start
service exago-scheduler stop
service exago-scheduler status
When the Scheduler Service is not installed as a systemd service (without the -R parameter), it is not possible to know if another service
with the same name exists on the same server. When a service with the same name is installed, only one can be used at a time. This is
due to the fact that lock files used by the service are based on the service's name, and will prevent the second process from starting. In
this scenario, the -r flag should be used and additional schedulers should given different names.
When a second scheduler is installed on the same server, the default service name will increment: exago-scheduler2, exagoscheduler3, and so on.
See Scheduler Configuration and Setting Up Monitoring to configure the respective services correctly. If necessary, configure the
Scheduler and Monitoring services to run at startup.

Start Monitoring Service
Note
This article references <WebApp>/ as a placeholder for the application's install location. The default install location is /opt/Exago/;
however, this directory may be changed during installation.
If the Web Application was installed, the Monitoring Service is also installed, but is disabled by default. This script created during
installation needs to be started manually or configured to run at startup:
<WebApp>/MonitoringService/startService.sh

Installing Exago on Azure
Microsoft Azure is a cloud infrastructure for hosting files, databases, virtual machines, and web applications. Exago supports various forms
of integration with Azure.
Virtual Machine: Exago BI can be installed on a Windows virtual machine on Azure.
App Service: The Exago BI web app, web service API, and .NET API host apps can be installed as Azure app services. An Azure Virtual
Machine is also required for remote report execution when utilizing an Azure App Service.
File Storage: Exago BI data can be stored and accessed from Azure storage containers.
These methods can be implemented independent of each other. However, Web App integration and VM integration are usually redundant
with each other, and most Web App solutions should also implement Azure file storage. This guide will walk through how to set up each of
these solutions.

Which solution should I use?
Azure virtual machines are the preferred implementation method for production environments.

App Service
Exago can run as a Azure App Service. This is necessary in order to run a .NET API based host application in Azure.
The following Azure resources are required:
App Service plan
App Service
Note
You may require a Storage Account to run Exago as a scalable app. See File Storage for details.
This section is divided into three parts: Hosting Exago BI in an App Service, Using Exago Web Service API in an App Service, and
Using the .NET API with Azure.

Hosting Exago BI in an App Service
Note
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This walk-through requires a local Exago installation. See the Exago Installation Guide for details.

1. In your Azure Dashboard, create a new App Service container or navigate to an existing one.

2. In the App Service, navigate to Deployment Credentials. Add a username and password. This will allow you to FTP into your app
service to transfer files.
3. Next, you'll need an FTP application. Open a connection using the deployment credentials created in step 2. Copy your local Exago
BI web app installation directory to the app service container.

4. In the App Service, navigate to Application Settings. Set the following:
.NET Framework version: v4.0 or Later
Managed Pipeline Version: Integrated
5. Under Virtual applications and directories create a virtual directory path to the installation directory and check
the Application check box.

6. Click Save to save your settings.
7. Configure the Remote Report Execution Host as a Virtual Machine.
8. Test your installation and by navigating to the WebAppUrl\virtual path to Exago App Service\Admin.aspx page (Admin Console).
If you will use Azure Blob Storage to store the config file, follow the File Storage instructions before setting the base config. We also
recommend setting up a state server either with SQL Server or another database when running Exago in an Azure App Service. Consult
with Exago Support for assistance.

Using Exago Web Service API in an App Service

Note
This walkthrough requires either a local Exago Web Service API installation, or a downloadable ZIP file containing the WebServiceApi
directory. See the Installing and Configuring the Web Service article for details.
1. Copy the contents of the local Exago installation's WebServiceApi folder to the app service container.
2. Under Virtual applications and directories create a virtual directory path to the WebServiceApi directory and check
the Application check box.
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3. Click Save to save your settings.
4. In Azure, edit the WebServiceApi\Config\WebReportsApi.xml file as follows:
<apppath>virtual path to Exago App Service</apppath>
<webreportsbaseurl>virtual path to Exago App Service</webreportsbaseurl>

Note
Include a trailing slash for both the apppath and webreportsbaseurl elements.
5. In the WebServiceApi\appSettings.config file, add a new key to enable the REST service.
<appSettings><add key="ExagoREST" value="TRUE" /></appSettings>

The result should be the following:
<?xml version="1.0"?>
<appSettings>
<add key="ExagoREST" value="True" />
</appSettings>

6. To prevent front end access without authentication outside of the API, in the Admin Console, navigate to General > Main
Settings > set Allow direct access to Exago (bypassing API) to False. Click OK. Test your installation by navigating to the
WebAppUrl\Exago\Api.aspx page. An 'Unauthorized access. Please contact your administrator' error message should appear.
7. To test that the path was set correctly, navigate to WebAppUrl\virtual_path_to_Exago_App_Service\Api.aspx. A test file listing
avaiable supported operations in the API should appear.
8. To prevent unauthorizedAdmin Console access to prevent users from inadvertently reaching it, delete
WebAppUrl\Exago\Admin.aspx and WebAppUrl\Exago\Bin\admin.aspx.cdcab7d2.compiled.
Tip
Make a backup of the files before deletion in case Admin Console may be needed later.
9. Test that Admin Console is no longer accessible by navigating to WebAppUrl\Exago\Admin.aspx. A 404 error page should appear.
10. Test that REST is enabled by utilizing an advanced REST client such as Advanced REST Client. Make a POST request to
WebAppUrl\virtual_path_to_Exago_App_Service\rest\rest\sessions.
Header Name
Header Value
Accept
application/json
Content-Type application/json
Authorization The REST authorization key. Review the Introduction to REST article for more information.
Copy the AppUrl received in the response and append it to the end of the browser's URL WebAppUrl\virtual path to Exago App
Service\ The Exago front end should load, proving that the application can only be reached through the API.
11. Configure the Remote Report Execution Host as a Virtual Machine.

Using the .NET API with Azure

Exago .NET API based host applications must be compiled locally before being uploaded to the Azure app container. References to the
WebReports.dll libraries should be updated manually, and the program recompiled, when upgrading to a new Exago version.
Set your API constructor to use the previously set Exago virtual path:
Api api = new Api(@"/exago/virtual/path");

Note
.NET host apps can only access virtual paths (and not URL paths). Therefore they must be located in the same App Service container as
the Exago web app.
Exago utilizes the virtual directory passed in the first argument of this constructor to locate the required .dll libraries to load Exago. In
cases where the virtual directory is not specified within the API constructor (e.g., if Exago is installed on the root of the .NET host
application), then a reference to the Microsoft.WindowsAzure.Storage.dll library will need to be added manually to the host application.

File Storage
Exago can be integrated with Azure cloud storage for storage and live access to reports, templates, config, and other data files.
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The following Azure resources are required:
Storage account
Blob storage
The following Azure resource is optional:
Files storage
Blob storage is a "flat" file system, which stores every file at the root level. To make use of this system, Exago emulates a directory
structure using file names.
File storage is a directory-based system. Files are placed into directories, which can have sub-directories.
Reports can be stored in File storage or Blob storage. Config files, templates, themes, and temp files must be stored in blob storage.
In your Azure Dashboard, begin by creating a new Storage account or navigating to an existing one.

This section is divided into three parts: Config file storage, Reports storage, and Temporary files storage (which includes themes and
templates). If you are implementing Exago as a scalable app, you must set all three to static locations.

Config File
An Exago installation contains a configuration file, usually called WebReports.xml, which tells the application where to store Reports and
Temp files.
First, in the Storage account, navigate to Access Keys. Record of the two connection strings.

Azure Connection String
An Azure Connection String is a formatted string which contains your Azure account name and a unique alphanumeric key. It is used to
give applications access to your storage account. The string uses the following format:
DefaultEndpointsProtocol=https;AccountName=acctName;AccountKey=encryptedalphanumerickey;

Next, there are two places which you need to specify the location of the configuration file:
1. The appSettings.config file in the web app install directory.
2. If you're using the .NET API, a parameter in the API constructor method.

appSettings.config
Exago BI contains a file called appSettings.config in the root folder of the install directory. This file is used for custom app settings which
are automatically imported into Web.config during runtime.
Note
Do not edit Web.config file. It is automatically generated by Exago, and any changes will be overridden.
To set the config file location, add the following key to the appSettings.config file:
<add key="ExagoConfigPath" value="pathtype=azure;credentials='Azure Connection String';storagekey=config"/>

credentials: Your Azure Credentials Connection String.
storagekey: The prefix of a blob container used to store the config file.
Caution
When both the REST API and cloud config storage are being used, the ExagoConfigPath entry must be placed in both the
WebServiceAPI and web application copies of appSettings.config.

API
.NET API host apps cannot access the appSettings.config file. Instead, you must use one of the following two methods to specify a config
file location:
1. Place the config key within the host application's web.config or app.config.
2. Or pass the connection string in the API constructor method:
Api api = new Api("/exago/virtual/path", "configFn.xml", "pathtype=azure;credentials='Azure Connection String';storagekey=config");
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storagekey: The prefix of the blob container used to store the config file.
configFn: The name of the config file.
Caution
When both the REST API and cloud config storage are being used, the ExagoConfigPath entry must be placed in both the
WebServiceAPI and web application copies of appSettings.config.

Reports Storage
To use an Azure storage resource for report and folder management, enter a formatted connection string in the Report Path field in your
config file.

Note
This is different from (but contains) an Azure Connection String.
The connection string uses the following format:
pathtype=azure;credentials='Azure Connection String';storagekey='reports';usefilestorage=false

credentials: Your Azure Connection String.
storagekey: The prefix of the container used to store report files. Reports are stored in "storagekey-reports", templates in
"storagekey-templates", and themes in "storagekey-themes". This key is optional and defaults to "wrreports".
usefilestorage: If true, Reports are stored in File storage. If false, Blob storage is used. Templates and themes always use blob
storage. This key is optional and defaults to false.
Note
Templates are automatically stored in blobs when the template upload button is used in Exago. Themes need to be manually uploaded
to blob storage.

Migrating from local storage to Azure blob storage
Exago emulates a directory structure within a "flat" file system like Azure blob storage by placing a "placeholder.dir" block blob in each
directory. This directory file serves as a reference to a folder within the blob container and is automatically added to new folders when the
Report Path is set to an Azure blob storage container. If this file is not present, Exago will not be able to recognize that the virtual directory
exists within a blob.
When migrating from local storage to Azure blob storage, this file will need to be manually added to pre-existing report folders as it will not
exist in folders that were created when the report path was set to a local directory. In order to manually add this file to these folders,
please follow these steps after the Report Path is set to an Azure blob storage container:
1. Add a new folder to the Exago report tree.
2. Navigate to this folder via the Azure Storage Explorer.
3. Copy the "placeholder.dir" blob within this folder and paste it into folders where it does not already exist.

Temporary Files Storage
Azure allows an App Service to be scaled up to multiple instances on separate servers. If you are implementing this configuration, you
must take the following safeguards in order to prevent loss of user data.
Each instance of Exago BI has its own local temp directory, whose path you can (optionally) specify in the Temp Path setting in the config
file (defaults to %INSTALLDIR%\Temp).

This is Exago's working directory — setup data for most user activity is stored and queried from here.
In a scalable configuration, initial user calls will reach one instance, storing temp files on that server, but subsequent calls may reach a
separate instance, which will not have those temp files in its local directory. There are two solutions to resolve this issue: Temp Cloud
Service and Azure Affinity Cookie.

Temp Cloud Service
This is Exago's built-in solution for handling multiple instances. Specifying a Temp Cloud Service causes each instance to push its temp
files a shared Blob container whenever necessary. Then if a subsequent user call reaches a separate instance, that instance will pull the
relevant files from the blob to its local temp directory.
To set up an Azure storage resource for temporary files, input a formatted connection string in the Temp Cloud Service field in your config
file.

Note
This is different from a Report Path string. This is different from (but contains) an Azure Connection String.
The connection string uses the following format:
type=azure;credentials='Azure Connection String'

The Temp files container name defaults to "wrtemp". Currently this cannot be changed. Temp files can only be stored in blob storage.

Azure Affinity Cookie
Azure supports setting Affinity Cookies, which track which server instance each user is connected to and cause all calls within the
session to reach the same instance.
In your app service, navigate to Application Settings. Set ARR Affinity to On.

Virtual Machine
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Exago can be hosted on a Windows-based Azure Virtual Machine. Installing Exago on a VM differs only marginally from installing it on a
local machine. Therefore, this guide will not go into depth on this method. For a full installation and setup guide, see the Exago
Installation Guide.
You can interact with a VM using either a remote desktop application or a command shell application.

Remote Desktop
1.
2.
3.
4.

Using Remote Desktop Connection or another remote desktop application, view your VM as a desktop environment.
Use a Web Browser to download the Exago Installer from our support site.
Run the installer as Administrator and install Exago.
Configure Exago (see Install and Configure).

Command Shell
1.
2.
3.
4.

On a local machine, use the above steps 2-4 to create a temporary Exago installation.
Remote into your VM using Windows PowerShell or another command shell application.
Copy the Exago directory to a directory on your VM.
Configure Windows and IIS (see Manual Application Installation).

After configuring IIS, open up the Exago port using a Windows Firewall inbound exception rule. You can then access Exago through the
VM's IP address. Set up DNS and data security as desired.

Configuring Remote Report Execution Host for Azure App Service
Deployments
When Exago is deployed as an Azure App Service, some additional configuration is necessary. At a high level, these configuration steps
are:
1. The Exago Scheduler Service must be installed and properly configured on an Azure Virtual Machine. Exago v2019.1.5+ must be
installed for both the Azure App Service and the Virtual Machine, and the version numbers must be the same.
2. On the Azure App Service installation, enable the Scheduler and Remote Execution.
3. Enable Exago's Puppeteer image rendering libraries on the Azure Virtual Machine (for versions pre-v2020.1).
Detailed information about each of these requirements follows.

1. Azure Virtual Machine
Exago's Puppeteer image rendering libraries were introduced in v2019.1.5 of the application. At a minimum, v2019.1.5 must be installed
on the Azure Virtual Machine. The version number of the Scheduler Service must match the version number of the Web Application.
Refer to the articles in the Recommended References section below for complete details on the installation and configuration of the
Scheduler Service and how to install Exago on a Virtual Machine in Azure.

Recommended References
Installing Exago on Azure
Updating to the Latest Version
Installing the Scheduler Service
Configuring the Scheduler Service

2. Settings
The Scheduler Service should already be properly installed and configured on the Azure Virtual Machine.
On the Exago installation running as an Azure App Service, there are four parameters in the Admin Console which direct it to schedule
and execute reports on the Virtual Machine instead of in the App Service:
General > Scheduler Settings > Enable Report Scheduling must be set to True. By default, the value is False.
General > Scheduler Settings > Enable Remote Report Execution must be set to True. By default, the value is False.
General > Scheduler Settings > Schedule Remoting Host must be set to the virtual machine Scheduler Service's protocol, host
name/IP address and port. (e.g. http://a.b.c.d:2000)
General > Scheduler Settings > Remote Execution Remoting Host must be set the same as Schedule Remoting Host
above.

Recommended References
Admin Console Scheduler Settings

3. Enable Puppeteer pre-2020.1
By default, Exago will use the older WkHtmlToImage libraries for visualization rendering. Therefore, Puppeteer must be manually
enabled by adding or changing a key in the virtual machine Scheduler Service's eWebReportsScheduler.exe.config file, as shown below:
<appSettings>
<add key="useWkHtmlToImage" value="false" />
</appSettings>

This file is located in the Scheduler Service's installation directory. For example,
D:\Exago\ExagoScheduler\eWebReportsScheduler.exe.config. The closing / in the new key is required.

Recommended References
Scheduler Apps Application Settings

Installing Optional Features
Several features require additional configuration before they can be used.

Legacy Maps (GeoCharts)
The GeoCharts feature present since v2013.2 has an additional requirement for use if you are enabling it for the first time, or if you are
implementing your application under a new domain name.
Our mapping features use the Google Maps API. Historically, this was a free solution. However, in June 2016, Google began to require
paid licenses for commercial usage.
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If you had GeoCharts enabled prior to June 2016, and you have not since changed the domain name of your application, this section does
not affect you because you have been grandfathered in.
If you are a new user in need of mapping, we strongly suggest implementing the new Google Maps feature instead of legacy GeoCharts.
If you intend to implement GeoCharts under a new domain name, then you must acquire a Google Maps API License in order to use this
feature. See Google's Pricing & Plans page for details. Your license must include the Google Maps Javascript API.
Note
For help with API keys, see Google's API Console Help.
To install a legacy GeoCharts license file, place the license key in the General > Feature/UI Settings > Advanced Report Designer
Settings > GeoChart Map Key (optional) setting of the Admin Console.

Google Maps
Important
Exago's Google Maps wizard uses the Google Maps API, which requires a paid license for commercial use. You must acquire a Google
Maps API license in order to enable this feature.
There are additional steps needed in order to enable the new Google Maps wizard introduced in v2016.3.
1. Download and install the Google Maps Polygon Database for free from our support site. Create a new directory inside Exago's
installation path named MapCache and uncompress the polygon database into it.
2. If using Windows, give the IIS instance user full control permissions for this folder.
1. Right click on the folder and click Properties.
2. In the security tab click Edit then Add.
3. Enter iis_iusrs then click OK.
4. In the Permissions for Config window, select the IIS_IUSRS that was just created and check Allow Full Control. Click
OK.
3. If using Linux, give the Apache instance user read and write permissions for this folder.
chown $apacheUserID MapCache
chmod -R u+wr MapCache

Exago's Google Maps wizard uses the Google Maps API, which requires a paid license for commercial use. You must acquire a Google
Maps API license in order to enable this feature. Please see the the Maps and Places > Geocoding sections of the Google Maps
Pricing Table for details. You must obtain a Google Maps Javascript API key and a Google Maps Geocoding API key, either as part
of the same license, or separate.
Note
Licensing fees are subject to change by Google.
Note
For help with API keys, see Google API Console Help.
To install the license file:
1. Toggle General > Feature/UI Settings > Advanced Report Designer Settings > Show Google Maps Wizard in the Admin
Console to True.
2. Place your unlimited license key or Google Maps JavaScript API key in the Admin Console: General > Feature/UI Settings >
Advanced Report Designer Settings > Google Map Key (unlimited or JS API restricted).
3. If you used a Google Maps JavaScript API limited key in the previous setting, place your Google Maps Geocoding API key in
General > Feature/UI Settings > Advanced Report Designer Settings > Google Map Key (optional Geocode API
restricted).

Installing and Configuring the Web Service API
Install
Use the following steps to install the Web Service API:
1. Download the latest Windows or Linux installers here.
2. Make sure your antivirus software is disabled and run the installation wizard as an Administrator. Continue from here with the steps
for your respective operating system: either Windows or Linux
Note
The Web Service API must be installed on the same server and web site as the Exago Web Application.

For Windows
3.
4.
5.
6.
7.

Click the Web Service button.
Click Next to bring up the ‘Select Installation Location’ menu.
In this menu specify the web site, virtual directory and physical directory where you want Exago installed. Click Next.
Confirm your location selections by clicking Next.
Monitor the installation and click Finish when it is complete.

For Linux
3. Run ./installExago.sh as root.
4. Follow the prompts in the installer, or use the command line parameters outlined in the in Installing Exago on Linux article to select
the Web Service API for installation. For example:
sudo ./installExago.sh -i WEBAPI -D -y

Note
The installer will create the sub directory WebServiceApi in your previously specified install path.
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Configure and Enable
1. Edit the file WebReportsApi.xml which is located in the Config subdirectory where the Web Service API is installed. By default
this is C:\Program Files\Exago\ExagoWebAPI on Windows or /opt/Exago/WebServiceApi on Linux.
Set the following items:
apppath – Add the file path to the Exago Web Application installation (e.g., "C:\Exago" or "/opt/Exago"):
<apppath>C:\Exago</apppath>
<apppath>/opt/Exago</apppath>

throwexceptiononerror – Set to true if you want to catch exceptions in your application thrown by Exago:
<throwexceptiononerror>true</throwexceptiononerror>

writelog – To turn on logging for the web service, set this to true. Then configure log4net by adding a log4net.config file
to the \Config folder, as described in this article. Set web service logging to the INFO level unless directed otherwise.
<writelog>true</writelog>

webreportsbaseurl – Add the <webreportsbaseurl> tags, if they do not already exist, and set its property to the virtual
directory where Exago BI is installed ("http://server/Exago/"):
<webreportsbaseurl>http://server/Exago/</webreportsbaseurl>

Note
Grant write permissions to the ASP.NET app pool user for the log file directory.
2. Enable the REST Web Service API. Follow the steps in the Enable REST section of the Getting Started with REST article to do so.
3. Optionally enable authorization. Follow the steps in the Authentication section of the Introduction to REST article to do so.

Installing the Scheduler Service
Important
The version and build number of the Scheduler Service must match that of the Web Application.
You may have different installations of Exago with different versions/builds on separate servers. The Scheduler Service installation wizard
allows you to install multiple Schedulers to maintain corresponding version/builds with the Web Application.
Use the following steps to install the Scheduler Service:
1. Download the latest Windows or Linux installers.
2. Make sure your antivirus is software disabled and run the installation wizard as an Administrator.

For Windows
1.
2.
3.
4.
5.
6.
7.

Click the Scheduler button.
Click Next to bring up the ‘Select Installation Location’ menu.
Specify if you want to create a new service or if you want to update an existing one.
To create a new service set a name and location.
Select to who the Exago Scheduler Windows Service will be installed. By default, “Everyone” is selected. Click Next.
Confirm your location selections by clicking Next
Monitor the installation and click Finish when it is complete.

Note
As of v2016.2.12, schedulers take system resources into account when assigning remote execution jobs. This requires that the services
have read access to the system registry. This can be done by adding the services to the Performance Monitor Users group. See How
to Read Performance Counters Without Administrator Privileges (MSDN) for details.

For Linux
If you elect to install the Scheduler Service, the installer will create the sub directory "Scheduler" in your previously specified install path.
Follow the instructions in the Installing Exago on Linux article to install the Service. To configure the Service, continue to the Scheduler
Configuration article.

Saving Scheduled Reports to a Repository
The contents of this article have been moved to Scheduler Service Configuration.

Installation Troubleshooting
These are some common issues or error messages that may arise during an installation of Exago and some solutions for resolving them. If
you are encountering problems that are not listed below, please file a support ticket.
An error has occurred. Please contact your administrator.
HTTP Error 500.19 - Internal Server Error
HTTP Error 403.14 - Forbidden
ERR_CONNECTION_REFUSED
Error: Access to the path 'C:\[Exago]\Config\WebReports.xml' is denied.
Object reference not set to an instance of an object.
Exception occured configuring log4net: Access to the path 'C:\[Exago]\Temp' is denied.
Folder or Virtual Directory not found: path=[path], mappedPath=[path]
Error saving report. Please contact your administrator.
Session has timed out; browser page will need to be reloaded or browser restarted

An error has occurred. Please contact your administrator.
Append ?ShowErrorDetail=true to the end of the URL, and try to replicate the behavior which caused the error. This will allow you to
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identify the error in more detail and search for a solution.

HTTP Error 500.19 - Internal Server Error
The configuration section standardEndpoints cannot be read because it is missing a section declaration.
Potential Cause Incorrect or missing Application Pool.
Solution

Select the correct Application Pool.

HTTP Error 403.14 - Forbidden
The Web server is configured to not list the contents of this directory.
Potential Cause

You're connecting to "http://[Exago]/" without specifying the home page or admin console.
Connect to "http://[Exago]/Admin.aspx" or "http://[Exago]/ExagoHome.aspx". OR set the IIS Default
Document to "ExagoHome.aspx".

Solution

ERR_CONNECTION_REFUSED
Unable to connect.
Potential Cause The Exago server or website is not running or the port is not open.
1. Restart the server and website.
2. Add a firewall rule for the inbound HTTP port.

Solution

Error: Access to the path 'C:\[Exago]\Config\WebReports.xml' is denied.
Potential Cause Permissions are not set on the config folder.
Solution

Set the IIS user permissions to Full Control on the config folder.

Object reference not set to an instance of an object.
Potential Cause

Config file is missing or corrupt, or permissions are not set on the config folder.
1. Load the Admin Console to generate a blank config file.
2. If you continue to encounter the error, set the IIS user permissions to Full Control on the config folder.

Solution

Exception occurred configuring log4net: Access to the path 'C:\[Exago]\Temp' is denied.
Potential Cause Permissions are not set on the temp folder.
Solution

Set the IIS user permissions to Full Control on the temp folder.

Folder or Virtual Directory not found: path=[path], mappedPath=[path]
Report folder path is wrong or permissions are not set on the report
folder.

Potential Cause

1. Verify the report path is set correctly in the Admin Console.
2. Set the IIS user permissions to Full Control on the report folder.

Solution

Error saving report. Please contact your administrator.
Potential Cause Permissions are not set on the report folder.
Solution

Set the IIS user permissions to Full Control on the report folder.

Session has timed out; browser page will need to be reloaded or browser restarted
Potential Cause
Solution
Potential Cause
Solution

Exago is dropping sessions or web server is restarting unexpectedly.
1. Make sure the reports folder is located outside the Exago filesystem. You may need toconfigure a
state service
2. Check for any disruptions in your web server's uptime.
Exago is accessed from a different origin as the host application over HTTP
1. Embed Exago over HTTPS if possible.
2. Otherwise, turn on cookieless sessions.

System.UriFormatException
Potential Cause Incorrect version of Mono
Solution

Exago only supports Mono versions 4.2.2.30 and 5.10.1.20

Potential Cause Unpatched System.Web.dll when using cookieless sessions
Solution

Replace System.Web.dll with our patched version

My error is not listed above...
Please file a support ticket with our Support Department.

Administration Console Setup
Configuring the database metadata can be done within the Exago Administration Console. These bullets detail the terms used in Exago
that are consistently referred to in both the guides and the application.
Data Source refers to a database or similar programmable file which provides data to the application.
Tables, views, functions, and procedures are stored as Data Objects (also called Entities and sometimes Categories) within
Exago which can then be connected using Joins.
Exago can automatically discover metadata from most traditional data sources

Data Sources
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Add a data source by entering the Admin Console
http://<YourServer>/Exago/Admin.aspx

See the Data Sources article for instructions on how to add a data source to your installation.

Building Metadata
Multiple Data Objects and joins can be created at once via Exago’s Automatic Database Discovery tool.
See the Data Objects article for instructions on how to create Data Objects from a Data Source and how to use the Automatic Database
Discovery tool.

Verifying the Report Path pre-v2020.1
1. In the Main Menu open the General drop-down and double click Main Settings. The first parameter in Main Settings is the Report
Path.
2. Make sure that the Report Path is pointing to the folder where read/write permissions were set earlier.
3. Check this connection by clicking the Test Connection icon.

Admin Console Password Encryption
Beginning with v2017.3, the Admin Console password is now encrypted by default when entered into the Admin Console or when set
through an API call. This is done to increase the security of credential storage by preventing plain text passwords from being saved to disk
in the unencrypted version of the configuration file.
Caution
If updating from an older version, existing passwords will not be encrypted automatically.
There are two ways to set an encrypted Admin Console password: Using the Admin Console or the API.

Using the Admin Console
1. Browse to the Admin Console
2. Navigate to General > Other Settings.
3. Enter the desired password into the Password and Confirm Password fields

4. Click Apply or Okay
To verify that the configuration contains the encrypted password, open the XML config file in a text or XML editor and locate the
<password> node.

The value should be an encrypted string surrounded by brackets [ ].

Using the API
To add an encrypted password to a programmatically generated config file:
api.General.Password = api.General.EncryptPassword("mypassword");
api.SaveData(); // Save the configuration file to disk

To verify whether two passwords match:
bool IsMatch = api.General.CheckPassword("mypassword", api.General.Password);

To verify if an existing password is encrypted:
bool IsEncrypted = api.General.IsHashedPassword(api.General.Password);

Additional information
Password encryption is one-way. An encrypted password cannot be decrypted into plain text.
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The encryption algorithm used is SHA-256. Passwords are salted.
Important
We still recommend that the plain text config file (e.g. WebReports.xml) is removed in favor of the encrypted config file (e.g.
WebReports.xml.enc) in a production environment. See Security Checklist for more information.

Scheduler Service Configuration
To configure the Scheduler Service, edit the file eWebReportsScheduler.xml. This file can be found in the Scheduler Service's
installation directory. By default, this is C:\Program Files\Exago\ExagoScheduler on Windows and /opt/Exago/Scheduler
on Linux.
The following settings are available:
Important
Settings that can be true or false are case sensitive and must use lower case.
<smtp_server> — The SMTP server used by the Scheduler Service to email reports.
<smtp_enable_ssl> — Set to true to enable SSL.
<smtp_user_id> — The user id that is used to login into the SMTP server.
Note
If the user id is set to a null or empty value or DefaultCredentials, the value automatically defaults to the user's current credentials. For
anonymous emailing see the Credential-less SMTP section below.
<smtp_password> — The password that is used to login into the SMTP server. This value is only considered when using the user id as
an SSL credential.
Note
If the password is set to a null or empty value, the value automatically defaults to the user's current credentials.
<smtp_from> — The 'From' email address used in the report emails.
<smtp_from_name> — The 'From' name used in the report emails.
<error_report_to> — The email address to send error reports to.
<channel_type> — tcp or http — must match the setting of the Remote Host in the Admin Console Scheduler Settings.
<port> — The port number of the .NET remoting object used to communicate with Exago; this should also be entered in the Admin
Console Scheduler Settings.
<working_directory> — The directory where scheduled documents and temporary files are written. The default setting
[INSTALLDIR]working creates a working folder in the Scheduler Service's installation location.
<default_job_timeout> — The maximum number of seconds any report execution is allowed. If an execution reaches a maximum
number of seconds, the job is marked Abended and an email will be sent to the address specified under <error_report_to>. Email
jobs use default_job_timeout exclusively for timing out the connection to the SMTP server.
Important
<default_job_timeout> and <max_job_execution_minutes> work in conjunction. They should both be set to the same time
period. Note that <default_job_timeout> is set in seconds and <max_job_execution_minutes>is set in minutes.
<report_path> — A path to specify where to save reports when 'Email Scheduled Reports' is set to false in the Admin Console. For
more details see Saving Scheduled Reports to External Repository below.
<sleep_time> — The time interval (in seconds) used for polling for scheduled reports to execute.
<simultaneous_job_max> — The maximum number of report executions that can occur simultaneously. This setting is based on the
resources available of the server where the Scheduler Service is installed.
<logging> — Logging is on by default. To turn logging off, set to OFF (in all-caps). To configure logging, edit the Logging Settings in
the eWebReportsScheduler.exe.config file.
<flush_time> — The number of hours that a completed, deleted, or aborted job will be saved for viewing in the
Manager. Set to 0 to flush jobs immediately upon completion. Set to -1 to disable automatic flushing.

Schedule

<sync_flush_time> — The number of hours that a completed, deleted, or aborted synchronous job will be saved in the Scheduler
Service's job list. Reports for remote execution are considered synchronous jobs. Set to 0 to flush jobs immediately upon completion
(default). Set to -1 to disable automatic flushing.
Note
Synchronous jobs are never displayed in the

Schedule Manager, even if this value is greater than 0.

<email_addendum> — Text that will be added at the end of email body. Use \n to insert lines.
<external_interface> — This is optional and overrides the value set in the admin config. The advantage of setting the value here is
that the existing scheduled reports that have a previous external interface value will take the new value. For more details see External
Interface.
<abend_upon_report_error> — This controls how the scheduling service should proceed if an error occurs while loading or executing
a report. The default true will stop the running the schedule and set the status to Abended. Set to false to continue running the
schedule and maintain the status as 'Ready'.
<ip_address> — Binding IP address for the Scheduler Service. Most commonly used when the server has multiple Network Interface
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Cards (NICs).
<encrypt_schedule_files> — Set to true to encrypt the files created by the Scheduler Service. All existing schedules will be
encrypted the next time the service is started.
<max_temp_file_age> — The number of minutes between each flush of the temp files created by the scheduling service. The default is
1440 minutes (24 hours).
Note
Setting <max_temp_file_age> too low may result in errors as temp files are used during report execution and for interactive HTML
capabilities when using remote execution. It is not recommended setting this value any lower than 60 minutes. Execution cache files will
not be flushed.
<email_retry_time> — In the case an email fails to send, the number of minutes to wait before retrying to send the email. After five
failed attempts the schedule will set itself to 'Aborted'. The default is 10 minutes.
<max_job_execution_minutes> (v2016.2.12+) — Maximum amount of time (in minutes) to run an execution job before timing out. If
the job times out, the schedule will be marked as Aborted.
Note
<default_job_timeout> and <max_job_execution_minutes> work in conjunction. They should both be set to the same time
period. Note that <default_job_timeout> is set in seconds and <max_job_execution_minutes>is set in minutes.
<secure_channel> (v2016.3+) — Set to true to allow receipt of encrypted data from hosts. The setting Use Secure Scheduler
Remoting Channel must be true in the Admin Console/XML configuration file.
<security_protocol> (v2016.3.4+) — Specify which security protocol(s) the scheduler should use. Possible values: Ssl3, Tls,
Tls11, Tls12, Tls13 (.NET v4.6+). Separate multiple values with commas (,).
<service_name_tag>— For manual installation of Scheduler Services using Visual Studio installutil.exe, this field is appended to the
end of the service name. Useful for installing multiple services on the same server. installutil.exe must be in the same folder as the
scheduler configuration file.
<webappbaseurl> — Set to the virtual directory URL where the Exago BI Web Application is installed. In Cross-Origin Resource
Sharing (CORS) environments, setting this flag ensures that images are correctly loaded.

Example XML File
<?xml version="1.0" encoding="utf-8" ?>
<eWebReportScheduler>
<smtp_server>smtp.office365.com:587</smtp_server>
<smtp_enable_ssl>true</smtp_enable_ssl>
<smtp_user_id>me@mycompany.com</smtp_user_id>
<smtp_password>notmypassword#1234</smtp_password>
<smtp_from>me@mycompany.com</smtp_from>
<smtp_from_name>Exago Scheduler</smtp_from_name>
<error_report_to>admin@mycompany.com</error_report_to>
<channel_type>tcp</channel_type>
<port>2011</port>
<working_directory>[INSTALLDIR]working</working_directory>
<default_job_timeout>3600</default_job_timeout>
<sleep_time>15</sleep_time>
<simultaneous_job_max>10</simultaneous_job_max>
<logging>on</logging>
<flush_time>-1</flush_time>
<sync_flush_time>0</sync_flush_time>
<email_addendum></email_addendum>
<external_interface></external_interface>
<report_path>[INSTALLDIR]</report_path>
<abend_upon_report_error>true</abend_upon_report_error>
<ip_address></ip_address>
<security_protocol></security_protocol>
<encrypt_schedule_files></encrypt_schedule_files>
<max_temp_file_age>1440</max_temp_file_age>
<email_retry_time>10</email_retry_time>
<queue_service></queue_service>
<load_assembly_in_external_domain>false</load_assembly_in_external_domain>
</eWebReportScheduler>

Starting and Changing Scheduler Services
The Windows Service will have to be manually started for new installations of the Scheduler. Starting the service will create the working
directory as set in <working_directory> described above.
To start the scheduler open Windows Services. Double click on 'ExagoScheduler' and the Properties menu will appear. Click Start.
If any changes are made to the configuration (detailed above) the service must be stopped and restarted for the changes to take effect.

Credential-less SMTP v2018.1+
Within Scheduler Configuration, the values for <smtp_user_id>, <smtp_password>, <smtp_from>, and <smtp_from_name>,
which constitute the required SMTP credentials for non-anonymous emailing, cannot be removed or left blank. Otherwise, these values will
be reset to their default or throw an error when attempting to send an email.
However, credential-less SMTP servers can now be used to send anonymous emails by making the following changes within the
eWebReportsScheduler.xml file. This file is located in the Scheduler Service's installation directory.
To set up anonymous report emailing:
Set <smtp_user_id> to NoSmtpCredentials
Set <smtp_password> to any non-null value
Any scheduled report using these credentials will be sent anonymously when connected to an SMTP server that does not require
credential authorization.
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Saving Scheduled Reports to a Repository
Instead of sending report output as an e-mail, the output file can be saved to a file repository instead. To enable this:
1. Provide a Report Path in the Scheduler Service's configuration file. This is the location where the Scheduler Service will save the
report output files. Add the <report_path> element if it does not yet exist and set the location of the repository.
Note for pre-v2020.1:
This report path is the location of the scheduled report output archive, and should be different than Exago's Report Path
configuration setting.
2. In the Admin Console set

General >

Scheduler Settings > Email Scheduled Reports to False.

After applying these settings, generic scheduled reports (i.e. the schedule does not run as a batch) will be saved directly to the specified
repository rather than being sent via email.
If the General > Scheduler Settings > Show Schedule Delivery Type Options setting is True, users can select whether to save
a scheduled report to the specified repository or to send it via email.
Output files will be saved to the <report_path> directory with the filename based on the Scheduler Service's working file GUID with
_Download appended. For example, 855b5857-38ee-473f-8f2c-f3ce36393ef2_Download.pdf.
Refer to the Managing Scheduled Executions with Server Events and External Interface article for more information.

Scheduler Queue
As of v2016.1, Exago introduced a new powerful feature to scheduling: the Scheduler Queue. The Scheduler Queue is a custom-built
application library that sits between the Exago core application and any number of Scheduler Service instances and handles how
schedule traffic is managed. The Scheduler Queue is completely optional, but configurations with multiple scheduler instances for which
load balancing is a priority are ideally suited to making use of this feature.

Background
The way in which Exago has historically handled report scheduling and the default behavior without using a queue, is the following.
For this discussion, it's important to define some terms:
A Schedule represents all of the information that a Scheduler Service needs to execute a report. A Schedule contains information
such as report name, time and frequency of execution, and how to handle the result. This information is usually stored as an XML
file in a repository. Schedules can be accessed from the .NET API using the ReportScheduler class.
Each Schedule contains some interpreted data that tells a Scheduler Service when to run it. This information is called a Job. Jobs
can also be stored separately from Schedules. Jobs can be accessed from the .NET API using the QueueApiJob class.
The process whereby a Scheduler Service runs a report at a specified time and emails or saves the information is called an
Execution.
Within the host application, all Scheduler Service instances are listed in the configuration XML file:

When a Schedule is created in the Web Application, the host application sends the job to Scheduler Services starting with the first and
moving through the list ("round-robin" style). The queried Scheduler Service stores the Schedule XML in a local working directory. This acts
as a repository for the Scheduler Service's unique set of jobs.
From this point, each Scheduler Service works independently. The host application has no idea what happens to schedules after they are
sent out successfully. Likewise, the Scheduler Services have no more communication with the host application with regard to report
execution.
Note
Schedules can be viewed and edited from the Web Application using the
Schedule Manager, but this is essentially a combined
front-end for the Scheduler Service's existing files. If a Scheduler Service is offline, its schedules do not appear in the list (there will be a
warning message). The Schedule Manager has no impact on the host application.
Scheduler Services periodically scan their repository for job execute times. If a job is ready and the current time is equal to or past the
execute time, the Scheduler Service knows to run the job. The Scheduler Service will perform its duty and then alter the schedule XML file
to indicate success or failure and the next execute time.
This default behavior may be adequate for most cases, but there can be issues. In particular, the Scheduler Queue sets out to solve the
following two issues that can arise in default configurations: Load Balancing and Unexpected Outages.

Load Balancing
Ideally, unoccupied Scheduler Services would receive new jobs. This way, stacks of unexecuted data do not build up on individual
Scheduler Services, leading to unbalanced load and potential time loss. But the host application has no idea which schedulers will be busy
when, and no idea how long jobs will take to run. The randomness of round-robin job assignment could cause jobs to build up inordinately
on one Scheduler Service.

Outages
Once the host application sends out a schedule, as far as it's concerned, it's finished. If a Scheduler Service goes offline unexpectedly the
host has no recovery function. The job will simply be delayed until the Scheduler Service is restarted. There is also no function to move
schedules from one Scheduler Service to another.

How the Queue Works
The Scheduler Queue is a custom .NET or Web Service library which aims to handle scheduling in a more robust manner. It's important
to note that the queue is entirely customizable. You are only required to implement the applicable methods; how you do so is up to you.
The following section will describe a typical setup which can improve load balancing and help resolve some common issues with multiple
Scheduler Services.
The queue sits in between the Exago host application and any number of Scheduler Services and handles logic for all scheduler requests
and maintenance.
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Architecture Diagram pre-v2020.1
The host applications and Scheduler Services all make calls to the queue at certain points during their runtime. In particular, Scheduler
Services will call the queue on three occasions: upon service startup, periodically while running, and when a job's status is changed.
The host application calls the queue for various maintenance tasks related to schedule creation and populating the
Schedule
Manager. For now, we'll focus on the relationship of Scheduler Services to the Scheduler Queue and how it can aid a typical multischeduler configuration.
When Scheduler Services are configured to use the queue, their behavior changes somewhat.
Note
In the default configuration, Scheduler Services store their unique schedules in a local working directory, from which jobs are queried for
execution.
Scheduler Services now periodically query the queue, which has instructions (GetNextExecuteJob) for assigning jobs. (The query time
defaults to 15 seconds, but is configurable). In a typical setup, the queue pulls from a central repository of stored schedules. In order to
prevent duplication, Scheduler Services lock the queue so that only one may access it at a time. Additionally the Scheduler Queue sets a
job's status to "running" while it's active, so that other Scheduler Services know to ignore it.
Note
Scheduler Services still use a local working directory for temporary files.
This has several advantages. First, Scheduler Services are no longer responsible for a unique set of schedules. This prevents outages from
causing excessive missed executes. Only one job will ever be hung per Scheduler Service as it will be responsible for only one job at a
time. If a Scheduler Service goes offline in the middle of a job, the Scheduler Queue can be used to gracefully handle incomplete jobs.
Next, jobs are now distributed much more evenly between the Scheduler Services. Jobs will only be assigned to available Scheduler
Services. Finally, since this allows us to control what data is being sent and received to the Scheduler Services and the file system, any
custom load balancing solution can be implemented.

Set Up
Setting up the Scheduler Queue is a multi-part process which depends on the desired configuration. We'll discuss some constants and
some potential variations.

Write the Scheduler Queue
First we need to write the Scheduler Queue. This can be a .NET Assembly or a Web Service, and it can be part of another library.
All the following methods must be implemented in the Scheduler Queue interface:
public static string[] GetJobList(string viewLevel, string companyId, string userId)

Called from the Exago Web Application to populate the jobs in the

Schedule Manager.

public static string GetJobData(string jobId)

Called from the Exago Web Application

Schedule Manager to get the full job XML data.

public static void DeleteReport(string reportId)

Called from the Exago Web Application when a report is deleted.
public static void RenameReport(string reportId, string reportName)

Called from the Exago Web Application when a report is renamed.
public static void UpdateReport(string reportId, string reportXml)

Called from the Exago Web Application when a report is updated.
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public static void Flush(string viewLevel, string companyId, string userId)

Called from the Exago Web Application

Schedule Manager in response to a click on the

Flush icon.

public static void Start(string serviceName)

Called from Scheduler Services to indicate when a specific service starts.
public static string GetNextExecuteJob(string serviceName)

Called from the Scheduler Services to return the next job to execute.
public static void SaveJob(string jobXml)

Called from both the Scheduler Service and the Exago Web Application to save the job. This method is called when a schedule is added,
updated, completed, killed, etc.
The QueueApi and QueueApiJob helper classes have been added to the API to facilitate writing the Scheduler Queue. You'll need to
reference the WebReports.Api.Scheduler namespace. QueueApiJob wraps a Job object and a variety of useful methods for managing
jobs. The QueueApiJob class will be used extensively in the following example.

Configuration
The host application config and each Scheduler Service config must contain the path to the Scheduler Queue assembly or Web Service
class in the following format:
Assembly=Path\To\Assembly.dll;class=Namespace.Class

The path may be set by one of these methods:
Using the Admin Console by setting the General > Scheduler Settings > Custom Queue Service field.
Setting the Custom Queue Service field in the Admin Console
By setting the field <schedulerqueueservice> in the config file,
By setting the field Api.SetupData.General.SchedulerQueueService via the .NET API at runtime.
In each Scheduler Service, set the field <queue_service> in the config file.
Next, determine how schedules are accessed. A common solution uses a database to optimize lookup speed. The queue only needs to
know the Job ID (filename), Next Execute Time, and the Running status to determine which schedules to run.
Job ID Next Execute Time Running?
String DateTime

Boolean

If you're using folder management, you can implement the those methods in the queue assembly (see Report and Folder
Storage/Management for more information).

User Identification
Exago does not have native user authentication. User logins must be handled by a security layer in the embedding host application. After a
user logs in, the host application should pass identification parameters to the Exago API, which can be used to set permissions on
content and data objects within Exago.

System Parameters
Exago has two built-in parameters which are used to store identifying information: userId and companyId. These parameters are used in
conjunction with the Scheduler Service and User Preferences, and they are automatically passed to any extensions which may need to
access authentication. Folder Management, External Interface, Scheduler Queue, and any extension which can access sessionInfo
(such as Assembly Data Sources or Server Events) can retrieve these parameters in relevant methods.
Note
These are required parameters. They cannot be deleted through the Admin Console, and if they are not present in the Config, then they
are automatically added at load time.
Often userId corresponds with a unique user or log-in, and companyId represents a group of users with shared characteristics. Either
parameter can be used without the other.

userEmail v2018.2+
The userEmail parameter is a third built-in parameter that can specify an email to be set as the "Reply To" email for any scheduled
reports. If using the userId or companyId parameters to identify the user, it is possible to change the default value of userEmail to be
specific to the users identified by userId or companyId. See below for an example of this in the .NET API and REST API. For more
information about this parameter see Scheduler Reply To Address.

Setting the current user
(v2017.2+)
The Id parameters are added by default in the base config file with blank values.

Admin Console
As created in the Admin Console:
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Config File
As created in the config file:
<parameter>
<id>userId</id>
<data_type>string</data_type>
<value />
<hidden>True</hidden>
<prompt_text />
</parameter>
<parameter>
<id>companyId</id>
<data_type>string</data_type>
<value />
<hidden>True</hidden>
<prompt_text />
</parameter>

The userEmail parameter (v2018.2+):
<parameter>
<id>userEmail</id>
<data_type>string</data_type>
<value />
<hidden>True</hidden>
<prompt_text />
</parameter>

.NET API
As created in the .NET API:
Note
"DataType" defaults to DataType.String, so the call is omitted.

api.Parameters.GetItem("userId").Value = "ApiUser";
api.Parameters.GetItem("companyId").Value = "ApiCompany";

For setting the userEmail parameter (v2018.2+):
Parameter userId = api.Parameters.GetParameterById("userEmail");
userId.Value = "user_224@company_17.com";

REST API
As created in the REST API:
Note
"DataType" defaults to "String", so the call is omitted.
POST /parameters
{
"Id": "userId",
"Value": "user_224"
...
}

POST /parameters
{
"Id": "companyId",
"Value": "company_17"
...
}

For setting the userEmail parameter (v2018.2+):
POST /parameters
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{
"Id": "userEmail",
"Value": "user_224@company_17.com"
...
}

Basic sandboxing
Setting the userId and companyId parameters has several effects in the Exago interface.

Schedule Manager
By default, the
Schedule Manager will show only schedules belonging to the current userId. This can be changed by modifying the
following Admin Console setting:
Scheduler Manager User View Level (Scheduler Settings)
Current User ('User'): Filters schedules by current userId parameter.
All Users in Current Company ('Company'): Filters schedules by current companyId parameter.
All Users in All Companies ('All'): No filtering.
This setting can also be overridden by a Role.

Execution Cache
The userId and companyId parameters are used to set permissions for which users can view cached report data. Users can choose
whether a report cache is visible just for their userId, for everyone with the same companyId, or for all users. The options that are
available to a user depends on the following setting:
User Cache Visibility Level (Scheduler Settings)

User Preferences
User preferences, including which reports should run on startup and User Reports (live report customization), are set by userId, and will
only apply to that user.

Advanced permissions
userId and companyId can be used in many other application areas in order to handle security permissions.

Roles
Additional permissions are typically handled by Roles. A check can be made in the API which maps the current userId and/or
companyId to the role which it belongs. This must be handled manually via a lookup table or a similar data structure. Then activate the
role for the session.
.NET: api.Roles.GetRole("admin").Activate();
REST: PATCH /REST/Roles/admin?sid={sid} { "IsActive": true }
For more information, see Roles.

Tenanting
userId and companyId can be used as tenant parameters in your data objects.
If your data is set up such that each table, view and stored procedure has columns that indicate which user has access to each row, then
you can use userId and/or companyId to match these columns and act as data row filters. (For this purpose, the parameters cannot be
set to 'hidden').
For more information, see Multi-Tenant Environment Integration.

Accessing Ids in extensions
userId and companyId are passed to any custom extensions where relevant. For example, in an external interface assembly, you may
wish to access the userId in order to log user executions. You could do so by implementing the ReportExecuteStart method, which
passes the userId parameter.
public static void ReportExecuteStart(string companyId, string userId, string reportName)
{
string logText = string.Format("{0}: Report '{1}' executed by user '{2}'.", DateTime.Now, reportName, userId);
File.AppendAllText(logFile, logText + Environment.NewLine);
}

This would return the following text upon a report execution by userId "Alex":
2017-03-07 14:50:49: Report 'Test\Product Sales Report' executed by user 'Alex'.
Most extensions have methods which can access userId and companyId. In addition, the parameters are accessible through
sessionInfo. So any extensions which can access sessionInfo can also access userId and companyId, even if methods do not explicitly
implement them.
The following server event automatically adds the userId to the description text whenever a report is saved.
Global Event Type: OnReportSaveStart, References: WebReports.Api.Reports
Report report = sessionInfo.Report;
string userId = sessionInfo.UserId;
if (!report.Description.EndsWith(userId)) { report.Description += ("\n" + userId); }
return null;

Scheduler Reply To Address
As of v2018.2, users can specify a "Reply To" address in the Schedule Wizard when scheduling a report.
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The new setting, "Show 'Reply To' Field in the Scheduler 'Recipients' Tab", has been added to the Admin Console under Scheduler
Settings. This setting enables or disables the 'Reply To' field in the Recipients tab when creating or editing a scheduled report.

The "Reply To" Field shown in the Scheduler Wizard.

userEmail parameter
Along with this setting, there is a new parameter named userEmail. Currently, this parameter is used exclusively for the Scheduler Reply
To field. If there is a value placed in this parameter, that value will appear as the default value for the Reply To field when creating a new
scheduled report. If the field is desired to be blank for any new scheduled reports, this parameter must be left blank.
To set the userEmail as a Reply To address, please refer to this article.
Note
The userEmail parameter cannot be deleted.
The "Reply To" field can be modified when creating a new schedule if the user does not want to use the default value of userEmail.
Changing the "Reply To" address here does not affect the value of userEmail.
When using the parameters userId and companyId to identify the user, it is recommended to modify the userEmail parameter based on
the userId and companyId. See User Identification for additional information.

Time Zone Calculation Enhancements in v2019.1
Geopolitical time zones present an inherent problem for scheduling and date calculations. Their UTC offset values may vary throughout the
year based on if and when a user's or server's location observes daylight saving time (DST). For example, a user in California and server in
England would enter and exit DST on different dates, necessitating different UTC offset values throughout the year. This displacement of
the UTC offset may cause schedules to run ahead or behind their intended times or even be ignored entirely.
With the release of v2019.1, Exago BI now offers an easy way to accurately handle different users and server spread across different
geopolitical time zones.

What Changed
In previous versions of Exago BI, the client and server time offset would be compensated for based on the a static setting called Server
Time Zone Offset, a specified number of +/- hours to calculate the difference in time between client and server. This setting, however, is
incapable of considering the fluctuation in server time offset caused by the non-uniform observations of DST in different geopolitical regions.
To better handle this is issue Exago now has a new setting called Client Time Zone Name which works in conjunction with Noda Time,
an advanced .NET library, to accurately consider geopolitical time zones through the year as schedules and calculations are done.

Client Time Zone Name
To accurately handle time zones there is a new Culture Settings field called Client Time Zone Name where the user's geopolitical time
zone may be specified.
Note
Using Client Time Zone Name is highly recommended as a best practice. However, if Client Time Zone Name is not given a value
then Exago BI will fall back on its pre-v2019.1 behavior and use the Server Time Zone Offset setting. In general the Server Time Zone
Offset setting should only be provided if a Client Time Zone Name cannot be determined.

Adjusting the Client Time Zone Name
The Client Time Zone Name setting may be set in the following ways:
Within the Admin Console
Modifying the configuration file XML
Via the .NET and REST APIs

Admin Console
Within Culture Settings in the Admin Console, the default Client Time Zone Name can be specified. Setting a default value is
recommended if all or a majority of clients and users are located within the same geopolitical region. If clients and users are located in
many different regions, then a default is not required as this information should be set dynamically through the use of Roles or via the API.
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The dropdown contains a complete list of official IANA time zones. Expressed as locations rather than as deltas from UTC, each time
zone in this list correlates to a specific geopolitical region and contains information on that region's observations of DST.

Configuration XML
The Client Time Zone Name can be manually edited within the configuration file XML using the following tag:
<clienttimezonename>America/New_York</clienttimezonename>

.NET and REST APIs
To modify this setting via the .NET API, the following property may be used:
PageInfo.SetupData.General.ClientTimeZoneName

This setting may also be modified via the REST API:
curl http://{webservice}/rest/settings?sid={sid} -X PATCH ^
-d "{
'General':
{
'ClientTimeZoneName': 'America/New_York'
}
}"

Noda Time Library
The standard .NET date and time library lacks important date/time concepts (e.g., "a date and time in a specific geopolitical time zone").
Due to the inherent issues that arise for scheduling processes because of DST and other non-linear time zone conflicts, Exago has
replaced this library with a more powerful date and time library: Noda Time, a .NET library specifically designed to resolve date and time
issues associated with geopolitical time zones and DST.
The Schedule module now utilizes the Instant and LocalDateTime classes of the Noda Time library. The Instant class represents a
global, linear time in seconds. It does not map onto any calendar system and does not consider DST. The LocalDateTime class
represents a point in time of a particular IANA time zone. These values can be mapped onto a calendar system and can take DST into
consideration. The system operates using Instants while users operate in the LocalDateTime of their legislative time zone of residence.
The Noda Time library is also available for use by developers via the .NET API. For in-depth information on the Noda Time library, please
see the Noda Time documentation.

Updates to the Scheduler Queue
Note
If you have not implemented the Scheduler Queue, then the following information will not affect your v2019.1 upgrading process.
Certain DateTime values may have been assigned different meanings in the Scheduler Job XML following the implementation of Noda Time.
Depending on the modifications made to your implementation of the Scheduler Queue, changes may have to be made to its code:
If your implementation of the Scheduler Queue utilizes the QueueAPI object from WebReports.Api.Scheduler, then there should
be no required for the Scheduler Queue to function properly after upgrading to v2019.1.
If your implementation of the Scheduler Queue has been modified to directly parse the Job XML, then some DateTime values may
have been assigned a different meaning and will need to be adjusted for. It is recommended that you contact our Services team
at services@exagoinc.com for help in determining which values will need to be adjusted.

Remote Execution
Report execution can be balanced across servers to improve performance. As one execution is being processed subsequent report
execution calls will be sent to different servers. For each new job, Exago will prioritize the server with the lowest load (according to CPU
and memory load) and ratio of running jobs to max jobs allowed. The number of jobs on a server will not exceed the value specified by the
simultaneous_jobs_max setting.
Note
In versions pre-v2016.2.12, machine load is not taken into account, and jobs are sent to different servers in the order that they are
received ("round-robin").
The following instructions provide an overview for setting up report execution on remote servers:
On each remote execution server:
Install the Scheduler Service. For detailed instructions see: Scheduler Service Installation.
The following conditions must be met:
The Scheduler Service version must match the Web Application version.
The Scheduler’s language files and the Exago Application’s language files must match.
Any custom assemblies must be present in the Scheduler directory.
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Configure the Scheduler Service For detailed instructions see: Configuring Scheduler Services.
By default the execution host will pass the reports back to the Exago Application. In order to save reports to an external
repository, see: Saving Scheduled Reports to External Repository.
Note
Multiple Scheduler Services can point to the same repository.
In the Exago Web Application:
1. Using the Admin Console, open the Scheduler Settings
Set Enable Remote Report Execution to True in the Report Scheduling Settings.
In Remote Execution Remoting Host, provide a comma or semicolon delimited list of servers. Servers must include the
procotol, server name or IP address and port number. (e.g. http://MyHttpServer1:2001, tcp://MyTcpServer:2121). The servers
will be prioritized based on the listed order.
Note
When multiple remote execution hosts are enabled, the Exago application will prioritize the one with the lowest number of queued jobs.
Note
When an execution host is used for both scheduling and remote execution, the Exago application will place immediate priority on
Remote Execution tasks.

Set Up Exago in a Web Farm
One method for running Exago in a distributed environment is using a Web Farm to run multiple instances of the Web Application. This
may be desirable for load balancing purposes.
There are several guidelines for setup. Each will be discussed in detail in separate sections.
Load Balancer: A load balancer server is required as the point of entry for client requests.
State Preservation: Since Exago is a stateful application, either a State Server or sticky sessions (affinity cookie) must be
enabled to prevent data loss.
Shared Folders: Instances must have common temp & reports folders, either on a network share or on a cloud drive. Config files
must be mirrored or shared.
Note
A single Exago server with multiple worker processes could also be considered a "web farm." In this guide we'll consider the general term
"web farm" to be synonymous with "server farm," but refer to that specific setup as a "single-server web farm."
A typical setup will look like the following diagram:

Load Balancer
The load balancer server is the point of entry for most web farms. This server receives and directs client traffic to available application
instances. Here, you'll set the list of web farm servers, and set any custom options for load balancing.
Please refer to your software's documentation for the specifics on configuration.
It is good practice to have identical Exago installations, i.e. physical path, virtual path, port number, permissions, on each web farm server.
Note
If you're using a single-server web farm, then a load balancer is not necessary, as the server's CPU will handle the load balancing.

State Preservation
Exago is a stateful application that preserves user information in a session, a temporary storage space for client-server communication.
When a user enters the application, a session is created which persists while the application is in use. A maximum timeout length can be
set in the config file to unload sessions after a period of disuse (default is 15 minutes).
In a web farm, it is important to manage sessions in order to prevent data loss. This can be done in two ways:
Using a State Server (highly recommended)
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Sticky Sessions

State Server
A state server is a server that stores session data. This server should be highly reliable, and we recommended setting up a dedicated
server for this task. However, the load balancer server can act as a state server if necessary.
Note
See the Setting up a State Server article for more information.
When a user opens a session, the load balancer routes the user to one of the web farm servers. That server then creates and stores the
session data on the state server and sets a browser cookie on the user's machine. On subsequent calls, if a user is routed to a different
web farm server, that server will look for the cookie, and load the relevant session from the state server.
State server applications are typically services which listen on a port. Each web farm server needs to be configured to point to the state
server address.
IIS comes with a state server called ASP.net State Service. Please refer to your software's documentation for the specifics on
configuration.
Note
If you're using a single-server web farm, then the state service can run on the same server.

Sticky Sessions
Using sticky sessions preserves user state in a different way. When a user opens a session, the load balancer routes the user to one of
the web farm servers, which creates a local session. The load balancer then sets a cookie on the user's machine that ensures that all
further calls within that session will go to the same server.
To set up sticky sessions, it's usually as simple as enabling the option on the load balancer application settings. Please refer to your
software's documentation for the specifics. It may also be called "affinity cookie."
We generally consider sticky sessions to be a less robust solution than using a state server. Performance can be reduced, and there is no
recovery mechanism if a server goes offline.

Shared Folders
A shared location for storing Report and Temp data is required for a web farm. This can be within the network, or at an external location,
such as a cloud server. In addition, it is recommended to use a shared location for the WebReports.xml configuration file. Otherwise,
any changes to the config would have to be manually pushed to every single instance.

Report & Temp Folders
For each installation, either using the Admin Console or by editing the configuration file, use the following keys to set a shared storage
location:

Network Share
Main Settings > Report Path: <reportpath>
\\Path\to\reports

Main Settings > Temp Path: <temppath>
\\Path\to\temp

Cloud Drive
See the Cloud Setup article for more information.
Main Settings > Report Path: <reportpath>
pathtype=azure;credentials='connection_string'

Main Settings > Temp Path: <temppath>
Local\temp\path

Main Settings > Temp Cloud Service: <tempcloudservice>
type=azure;credentials='connection_string'

Config File
The hidden config setting <webfarmsupport> must be added to the general node of the config file and set to True.
The config file xml needs to be mirrored across installations, either manually by copying the file when you change it, or by setting a config
cloud path.
Each installation contains a file called appSettings.config in the install directory. To set a cloud path, use the following key in the
appSettings.config file for each instance:

Cloud drive
See the Cloud Setup article for more information.
<add key="ExagoConfigPath" value="pathtype=azure;credentials='connection_string';storagekey=config"/>

Additional Notes
Enabling Admin Console > General > Other Settings > Enable Report XML Caching may cause unexpected behavior as the caches
in the different Exago installations will not be synchronized. This setting defaults to True when Exago is installed.
Keep in mind that the information in this guide may not apply to every single configuration.
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For assistance in getting set up, please consider filing a support ticket on our support site. Our staff will be happy to give additional tips or
help walkthrough some of the steps.

Deploying to Production
This guide describes the considerations you should take when deploying an Exago BI installation to a production environment. Suggested
steps are listed in the order they should be taken. Best practices are recommended for each step. However, every environment is different,
so recommendations should be considered in the context of your desired setup.
For personalized support, please file a support ticket.

Contents
1.
2.
3.
4.
5.
6.
7.
8.

Installation: Decide where the Exago BI application and schedulers live
Data: Determine how to expose your data to your users
API: Use the API to control user permissions
Folders: Implement a Folder Management solution
Integration: Visually integrate Exago BI into your host app
Reports: Make "canned" reports as examples for your users
Deployment: Important steps to follow before deploying your application
Security: Follow our Security Checklist of best practices

Installation
Since Exago BI is an embedded application, it is up to you to decide which of your servers Exago is installed on. Exago BI supports nearly
any type of deployment, including cloud, private servers or onsite at your clients.
Exago does not need to be installed on the same server as the host application. One or more scheduling services can be further installed
separate servers to handle Remote Execution of reports. Additional scaling can be accomplished with a Web Farm. To use the .NET
API, Exago BI must be accessible from the host application via a file system path. See API for more information.
The scheduling services are capable of acting as standalone report execution applications. The best way to scale Exago BI for
performance is to deploy additional scheduling servers, and offload report executions to them. This method, called Remote Execution,
also implements an automatic load balancing solution. The servers with the most available resources are given execution priority in order to
keep an even load distribution.
A QA/Staging environment is highly recommended as well. This allows developers to test API changes, config changes, and Exago BI
version updates, before moving to production.
Also consider the following:
Where do you want temp files and report definitions to reside for each server?
Where does the data source reside, relative to where Exago BI will be deployed?
Should Exago BI reside in the same domain as your host application?

Data
It is critical to make the right choices in how to present your data to your users. Consider the technical level and reporting experience of
your users. You may need to service different classes of users, from technical users like developers and database administrators, to nontechnical business analysts and project managers.
Exago BI can manage data object permissions to many levels of precision. Permissions can be set per-user and per-group, for data
objects, fields, rows, and even within field values. Data objects are easily restricted for classes of users using Roles. Within a data object,
fields can be hidden, and row access can be limited by matching a linked user ID with the logged-in user. Roles can also provide filters for
data values, in case some fields should be partially, but not fully hidden from view.
It is also recommended to use aliasing, descriptions, categories, and metadata to control how your data objects appear in the
application. Categories are a way to separate data objects into folders, so you can group together associated data. Aliasing allows you to
show more user-friendly names for data objects, instead of how they are named in the database. Descriptions provide additional
information, and metadata can improve report performance.
Also consider the following:
How normalized or de-normalized should the visible data be?
Should any data objects be available for some users and not for others?
Within a data object are there row-level permissions or multi-tenant permissions per user?
Will the underlying data objects change in the future? If so, add IDs to objects to prevent naming conflicts.

API
It is critical that Exago BI is only exposed to users through the API. The API allows you to set security and permissions settings, and
tailor the reporting experience by user.
.NET environments can use the .NET API, which is the most flexible and extensible API. Non-.NET environments can access a subset of
API calls through the REST Web Service API.
The most basic API implementation begins by initializing a session, then sets the "userId" and "companyId" parameters to identify the
logged-in user, sets a user-specific Role to control permissions, and then launches Exago BI using the getUrlParamString() method.
Developers should write the API code robustly with checks for null return values and exception handling.
Consider where you want Exago BI to appear within your application, and how users should use it to access reporting. For example,
should it be placed in an iFrame container, a redirected page, or a popup window?
Also consider the following:
Do you want to provide a list of reports and dashboards to users and directly run them via the API?
Are there other settings in Exago BI you want to enable or disable based on the user?

Folders
Important
Exago v2020.1 with a planned release in Q2 2020 will replace all existing Storage Management methods. For more information, contact
your Customer Success Manager.
In versions pre-2020.1, Exago can handle the storage and retrieval of reports on a local or cloud-based file system. However, it is strongly
recommend to use the Folder Management extensibility feature to customize where report definitions reside. Using folder management
can allow you to store reports in a database instead of on a file server. This can make it easier to control user access permissions, helps
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to scale your deployment, and provides additional benefits such as soft deletes and report usage tracking.
Your custom folder management definitions are accessed from a custom assembly, so this does require some additional development.
This sample code can be downloaded and used as a guide or a starting point.
Also consider the following:
How do you want the folder tree to appear for new users?
Will you create common reports that are available for all users?
Are there multiple levels of report permissions beyond individual users and published reports?

Integration
Exago BI gives you full control over the CSS, icons, and language strings in the UI. You can have several different application themes if
necessary, and select different ones for different classes of users. You can also build custom themes for reports and visualizations. And
you can make a custom start page that users will see when they first enter the UI.
For integration, we recommend the following best practices:

Home page
Copy the ExagoHome.aspx home page to a new page, and use that as the entry point for users going into the full UI. This copy can be
styled at will.

Application Theme
Make a new application theme by extracting a copy of our theme template into a new folder in the ApplicationThemes directory.
Enable the theme in the Admin Console, and add any custom styling if desired.

Getting Started
Remove the content from the default Getting Started page, since this is only intended to be a styling example. It is recommended to add
custom content, since users with access to the full UI will see this page often. Clients have used the Getting Started page to provide
announcements, quick tips, helpful formulas, and links to other parts of the application.
Also consider the following:
Does your application support multiple languages?
Are there any text strings or tooltips you want to customize?
Do you want to customize the CSS or swap out any of the icons in Exago BI?
Do you want to customize the context-sensitive help to match your documentation?

Reports
By providing a folder of "canned" reports, you can show users Exago BI's capabilities, and some useful examples of the data that is
available to them. This folder should be at the top level so it is easy to locate, and read-only so that users cannot edit the reports. If they
want to make changes or see how the reports are made, they can duplicate a report and edit the copy.
Making these reports can be a good opportunity for your support, sales, and services staff to become familiar with Exago BI. The Exago BI
services team can also assist your staff, either by basing your training on these reports, or by building them for you.
Also consider the following:
What questions can be answered by reporting?
What data objects do you want to highlight?
Are there any specific Exago BI features that you want to showcase?

Deployment
Once the other steps are in place, lay out a plan for moving to production. We recommend keeping detailed notes of the process so it can
be replicated for future updates.
After installing in production, move the following files from your staging environment to production:
1. The encrypted configuration file: /Config/config.xml.enc
2. Any custom application themes folders: /ApplicationThemes/themeFolder
3. Any custom language files: /Config/Languages/language.xml. These also need to be added to the /Languages
directories for each scheduler installation.
4. Your custom Getting Started page: /Config/Languages/getting-started.xml
5. Any other configuration files: /Config/Other/file.json, and /appSettings.config
6. Your custom context-sensitive help, if you have one: /NetHelp
7. Your custom home page: /home.aspx
8. If you are not using folder management, any custom theme files: /Themes/theme
9. If you are using Google Maps, make sure the MapPolygonDataBase.sqlite file is present in the /MapCache folder.
We also recommend adding the non-encrypted config file (/Config/config.xml) to your version control after removing any sensitive
passwords or connection strings.
Disable the Admin Console. It should not be accessible in a production environment.
Also consider the following:
Make sure all Exago BI instances and Scheduler Services are on the same version and build number.
If you are using the .NET API make sure the version of WebReportsApi.dll matches the version and build number of Exago BI.
Do the same with any custom assemblies, such as Folder Management, Scheduler Queue, or Server and Action Events.

Security
IMPORTANT: Follow our Security Checklist before turning on access to your application. It is highly recommended to follow these steps
to reduce the possibility of unauthorized access.

Security Checklist
There are a number of precautions that should be taken before running Exago in a production environment.
Set an external temp path
Disable direct access
Set a config password
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Remove the plain-text config
Remove the admin console
Encrypt scheduler data (if applicable)
Disable SOAP (if applicable)

Set an external temp path
The Temp directory contains working data, and may contain sensitive information. If the Temp Path config parameter is left blank, Exago
will default to a Temp folder at the root of the install directory. This is not recommended because it could expose your temporary data to
web access.
The Temp Path should be set to a location outside of the Exago installation (and behind the server's firewall).
( Main Settings Temp Path ) <temppath>

Disable direct access
Access to Exago should be curated through the API so that user permissions can be set via Roles. Users should not be able to access
the home page directly, which would bypass role restrictions. To disable direct access to Exago, set the following config setting to False:
( Main Settings Allow direct access to Exago (bypassing API) ) <allowhomedirect>

Set a config password
A User ID, Password, and REST Key should be set in the config file. This safeguards access to the Admin Console and REST API. See
REST API for information on accessing a password-protected web service.
( Other Settings User ID ) <userid>
( Other Settings Password ) <password>
( Other Settings Confirm Password )
( Other Settings REST Key ) <restkey>

Remove the plain-text config
The Admin console generates two copies of the configuration whenever the OK or Apply button is pressed: a plain-text xml document,
WebReports.xml by default, and an encrypted version, WebReports.xml.enc. Plain-text config files may contain sensitive information, such
as database connection strings, schemas, usernames, and passwords.
When your config settings have been finalized, the plain-text config file should be removed from the Config folder and saved in a secure
location.

Remove the Admin Console
The Admin Console should not be accessible in a production environment. To permanently remove the Admin Console from your
installation, remove the following file from the web application directory (in a web farm, do so for every application instance):
Bin\admin.aspx.cdcab7d2.compiled

Note: You can delete the Admin.aspx page as well, or edit it to show a static error message.

Encrypt scheduler data (if applicable)
Each scheduler stores working data in a local temporary folder. If you're using scheduler services for report scheduling or remote
execution, you should set them to encrypt their data. For each scheduler, edit the WebReportsScheduler.xml configuration file and set
the following setting to True:
<encrypt_schedule_files>True</encrypt_schedule_files>

Then restart the service.

Disable SOAP (if applicable)
If you are using the REST web service API, then you should disable the SOAP API to prevent any unauthorized web service requests. To
do so, remove the following file from the web service directory (in a web farm, do so for every application instance):
Bin\api.asmx.cdcab7d2.compiled

Note: If you are using the .NET API then you do not need the web service, and you can remove it from your environment.
Note: You can delete the Api.asmx page as well, or edit it to show a static error message.

About the Administration Console
The Exago Administration Console serves as a user interface to set up and save administrative preferences. Use the Administration
Console to create and modify:
Config File Options — Implement a static/dynamic configuration
Storage Management — Configure report, theme, folder and template file storage
Data — Establish how to connect to data sources and determine what data should be exposed to users. Configure system-wide
variables called Parameters.
General — Modify global settings of Exago to enable/disable features.
Roles — Create and modify security Roles for individuals or groups of users.
Extensions
Functions — Create and modify custom functions to make calculations on reports.
Filter Functions: Create and modify custom filter functions
Server Events — Create and modify custom code that is run when reports execute.
Action Events — Create and modify custom code that activates when a certain condition in the application is met.
Custom Options — Create and modify custom options that can be set on reports.
The Administration Console creates two configuration files: an XML file named WebReports.xml and an encrypted XML file named
WebReports.xml.enc. These files are created and saved in the /Config sub-directory of Exago's installation location. The encrypted
file cannot be edited with the Admin Console. It is recommended to use this as the live version of the config in a production environment.
Copy WebReports.xml to a secure backup, and then delete WebReports.xml from the Config directory.

Accessing the Administration Console
Once Exago is installed, navigate with a web browser to http://<Your Server>/Exago/Admin.aspx.
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It is recommended to protect access to the Admin Console by setting values for the General > Other Settings > User ID, Password
and Confirm Password parameters.

Navigation
The Administration Console consists of two sections. On the left is the Main Menu and on the right are Tabs that can contain menus to
create and modify Data Sources, Data Objects, Parameters, Roles, and other settings.

Main Menu
Through the main menu you can:
Create Data Sources, Data Objects, Joins, Parameters, Roles, and Custom Functions.
Edit settings for: Data, Roles, Functions, and General features.
Delete Data Sources, Data Objects, Joins, Parameters, Roles, and Functions.
Automatically discover data source objects and metadata.
Click the Collapse

icon to hide (or restore) the main menu.

Tabs
The right section of the Admin Console is made up of tabs containing menus to create and modify administrative settings.
To save the changes made in a tab click Apply or Okay.
Tabs can be closed with or without saving by clicking the Close

icon to the right of the tab name.

Tabs may be arranged by clicking and dragging them as desired.

Creating Additional Configuration Files
As part of the integration of Exago you may want to create alternative configuration files in addition to WebReports.xml. Additional
configuration files can be utilized in two ways:
If entering Exago directly, the configuration file to be used is specified in the Custom Styling.
When entering through the API the configuration file to be used is specified in the API Constructor Methods.
To create additional configuration files:
1. Navigate to the Administration Console in a web browser.
2. Append "?configFn=NewConfigFile.xml" to the URL replacing NewConfigFile with the desired configuration file name.
3. Click in the URL bar and press enter.

About This Section
This section of the documentation describes in detail each of the Admin Console settings and their effect on the application.. The system
configuration can also be changed by editing the configuration XML files directly, or through one of the APIs.
The settings work the same way regardless of modification method. Use this section of the documentation as a reference when locating a
particular function or setting in the application, then refer back to the appropriate articles for the method you are using.

Main Settings
This article applies to the Admin Console >

General >

Main Settings.

Select your version of Exago from the Application Version dropdown on the right-side of this article to show only the settings available in
your version.
The main settings are the basic options for Exago. The following settings are available:
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Report Path pre-v2020.1
The parent folder for all reports. The Report Path may be:
Virtual Path
Absolute Path — used to provide increased security (ex. C:\Reports)
Web Service URL or .NET Assembly — using a Web Service or .NET Assembly allows reports and folders to be managed in a
database. For more information see Report Folder Storage & Management

Temp Path
The location where temp files are stored. The Temp Path may be:
(no value) — All temp files and images will be saved to ./Temp.
Virtual Path
Absolute Path — Temp files will be saved to the absolute path and image files will be saved to ./Temp
Important
Before deploying into a production environment be sure to set a Temp Path that resides behind your server’s firewall/security system.

Temp Cloud Service
Web Service, .NET Assembly, or Azure Authentication string used to integrate into a cloud environment. For more information see Cloud
Environment Integration.

Language File
List of the XML files that specify language strings. See Modifying Select Language Elements for more details.

Temp URL
Overrides the portion of the temporary URL used to store images from HTML exports. Temp URL can override just the scheme (i.e. https)
or the full URL.

Allow Direct Access to Exago
A boolean setting:
True: allows users direct access to Exago with no security.
False: users must be authenticated by the host application to enter Exago. Users that try to directly access Exago will receive a
message saying ‘Access Denied.’
Important
We highly recommend setting this to False before deploying Exago in a production environment.

Allow Execution in Viewer
Enables or disables running reports in the Report Viewer.

Allowed Export Types
The available formats for exporting all reports. Check the box of the formats that should be available.

Default Output Type
The export format that appears when a new report is selected unless a specific export format is set in the Options Menu of the Report
Designer.
Note
The Default Output Type must be one of the available Allowed Output Types.

Report Tree Shortcut
Whether the report execute button in the report tree defaults to Run the report in the Report Viewer, or Export the report to the default
format.

Active Role
Retains the Id of the Role to be made active upon session start. The active Role may be changed manually using the dropdown. For more
information please see the Roles article.

Culture Settings
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Introduction
The Culture Settings give administrators control over formats and symbols that vary amongst geographic location. These settings can be
overwritten for a specific user or group of users by modifying the Role. For more information see Roles.

Settings
The following settings are available:

Date Format
The format of date values. May be any .NET standard (e.g., MM/dd/yyyy).

Time Format
The format of time values. May be any .NET standard (e.g., h:mm:ss tt).

DateTime Format
The format of date-time values. May be any .NET standard (e.g. M/d/yy h:mm tt).
Note
For more information on .NET Date, Time, and DateTime format strings please visit this MSDN article.

Date Time Values Treated As
Choose to format DateTime as Date or DateTime values. To change this setting for specific columns see Column Metadata.
Note
Column metadata will override culture settings.

Numeric Separator Symbol
Symbol used to separate 3 digit groups (ex. thousandths) in numeric values. The default is a comma (,).

Numeric Currency Symbol
Symbol prepended to numeric values to represent currency. The default is the US currency symbol ($).

Numeric Decimal Symbol
Symbol used for numeric decimal values. The default is a period (.).

Numeric Decimal Places
The default number of decimal places to show when a cell format is set to display a Number or when column metadata or the data source
identifies the value is a number data type. This value is also the default value presented to users in the Report Designer Cell Formatting
dialog. Default is -1 which will show two decimal places. Values between -1 and 8 are accepted.

Currency Decimal Places
The default number of decimal places to show when a when column metadata or the data source identifies the value is a currency data
type. Default is -1 which will show two decimal places. Values between -1 and 8 are accepted.

Apply Numeric Decimal Places to General Cell Formatting
Set to true to apply the Numeric Decimal Places to any cell that has Cell Formatting set to General but contains a number. Default value
is false.

Apply General Currency Right Alignment
Set to true to cause currency values to appear right-aligned by default in report cells.

Server Time Zone Offset
A null-able decimal value that is used to convert server to client time (the negation is used to convert client to server time). This offset is
not applied to data coming from Data Sources. It is utilized by Exago features like the Scheduler Service. Leave blank to use server time or
if using an External Interface to calculate value.
Note
A Server Time Zone Offset is only required if a Client Time Zone Name cannot be provided. Otherwise, all scheduling calculations
will be performed using the provided time zone information.

Time Zone Name
Default geopolitical location of the client as determined by the IANA time zone database (e.g., America/New_York). Utilized by Exago to
properly resolve scheduling issues centering around DST and other non-linear time zone conflicts. An External Interface may also be
used to calculate time zone values. The setting is also used for other time and date related features in the application such as Date/Time
functions like Now().
Note
For information regarding the time zone enhancements made in v2019.1+, please see this article. For a full list of official IANA time
zones and their relative UTC offsets, please reference this Wikipedia article.
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62 of 215

Feature/UI Settings
This article applies to the Admin Console >

Technical Guide
General >

Feature/UI Settings.

Introduction
The Feature/UI settings allow administrators to hide various features in the user interface. As each heading indicates, settings may apply
to specific report types or the entire application.

Settings
Available Report Types
These settings enable/disable report types.

Allow Creation/Editing of Express Reports pre-v2019.2
Enables/Disables the Express Report wizard.

Allow Creation/Editing of Advanced Reports
Enables/Disables the Advanced Report wizard and report designer.

Allow Creation/Editing of CrossTabs
Enables/Disables the CrossTab Report wizard and Insert CrossTab button in the report designer.

Allow Creation/Editing of Dashboards
Enables/Disables the Dashboard designer.

Allow Creation/Editing of Chained Reports
Enables/Disables the Chained Report wizard.

Allow Creation/Editing of ExpressViews
Enables/Disables the ExpressView designer.

ExpressView Settings
These settings only apply to the ExpressView designer.

Allow Editing ExpressView with Live Data
Allows users to make changes to ExpressViews while in Live Mode.
Note
We recommend setting this to False. Editing live ExpressViews will cause a large increase in database calls, and may reduce
performance.

Fields Enabled in Data Fields Tree v2017.1.2+
This setting controls whether users are allowed to add fields to an ExpressView that are not directly joinable to another field on the report.
All joinable fields (default): Users can add any fields with a join path to existing report fields.
Direct joins only: Users can only add fields with a direct join to an existing report field.
Note
As of v2018.1.23+, the join algorithm has been modified for ExpressViews with Direct joins only enabled. The Disable Non-Joined
Data Objects database setting is now taken into consideration when generating a join path, allowing these ExpressViews to properly
analyze join weight and encompass constructed SQL.

Join Path Algorithm
Select the join path algorithm to use when running ExpressViews with multiple entities.
Standard (default): More performant in most cases.
Legacy: Select if you are experiencing issues with ExpressViews created in an older version.

ExpressView Tutorial
Enables an instructive tutorial guide using ExpressViews to guide new users through the process of building an ExpressView report. The
user can opt out during the course of the tutorial.

ExpressView Hints
Enable context-sensitive hints when using different features in ExpressViews.

Express Report Designer Settings pre-v2019.2
These settings only apply to the Express Report wizard.

Show Styling Toolbar
Enables/Disables the styling tools in the Layout tab of the Express Report wizard.

Show Themes
Enables/Disables the Theme dropdown in the Layout tab of the Express Report wizard.

Show Grouping
Enables/Disables the grouping tools in the Layout tab of the Express Report wizard.

Show Formula Button
Enables/Disables the formula editor button in the Layout tab of the Express Report wizard.
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Advanced Report Designer Settings
These settings only apply to the Advanced Report designer.

Show Chart Wizard
Enables/Disables the Chart Wizard

icon in the toolbar. Set to False to disable users from creating or editing charts.

Chart Colors
Lists the values used for default chart colors, except for heatmap charts. Hexadecimal values should be separated by commas or
semicolons.

Maximum Number of Chart Data Points
Upper limit on the number of data points visible on a chart. If the limit is exceeded, a warning will be displayed to the user. Charts with
large numbers of data points could cause browser performance issues.

Default Chart Font
Specifies a default font for charts created in the Advanced Report designer. This setting can be overridden on a per-Report basis. Does not
apply to Data Visualizations.

Show Geochart Map Wizard
Enables/Disables the Geochart Maps button in the Advanced Report designer. Set to False to disable users from creating or editing
Geochart maps.
Note
Geocharts refers to the legacy maps feature, which was available in v2013.2+.
Note
The first time Show Map wizard is set to true a dialog appears prompting you to accept the terms of using the Google Charts Api. Type "I
accept" in the first box and your full name in the second to accept the terms and enable mapping.

Geochart Map Key
Optional Google Maps license key for geochart permissions. License must contain the Google Maps Javascript API service. See
Legacy Maps (Geocharts) for more information.
Note
Due to a change in Google's Maps API Terms of Service, if geocharting was enabled after June 2016, or if you had geocharting enabled
before, but changed your host domain name after June 2016, you need a license key to use this feature.

Geochart Map Colors
List the values used for default Geochart map colors. Hexadecimal values or CSS color names should be separated by commas (or
semicolons).

Show Google Map Wizard
Enables/Disables the Google Maps button in the Advanced Report designer. Set to False to disable users from creating or editing Google
Maps.
Note
In order to use Google Maps, a license key must be obtained from Google, and a polygon file must be downloaded from our support
site. See Google Maps for more information.

Google Map Key (unlimited or JS API restricted)
License key for Google Maps permissions. Must contain either:
Google Maps JavaScript API and Geocoding API services, unlimited key.
Google Maps JavaScript API service, limited key with referrer URLs. If this is the case, supply a limited Geocoding API service
key in the following field.
Note
When upgrading from a version prior to v2018.1, the value previously supplied for the Google Map Key will appear here.

Google Map Key (optional Geocode API restricted)
License key for Google Maps permissions. If the previous field contains a key limited to the JavaScript API service, supply a limited
Geocoding API service key in this field, given server IP addresses. Otherwise leave this blank.

Google Map Colors
List the values used for default Google map colors. Hexadecimal values or CSS color names should be separated by commas or
semicolons.

Show Gauge Wizard
Enables/Disables the Insert Gauge button in the Advanced Report designer. Set to False to disable users from creating or editing gauges.

Gauge Colors
List the values used for default gauge colors. Hexadecimal values or CSS color names should be separated by commas (or semicolons).

Show Document Template
Enables/Disables the Document Template menu. Set to False to disable users from using the Document Template menu.
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Show Document Template Upload Button
Set to True to allow users to upload Document Templates. Set to False to prevent users from uploading Document Templates.

Show Linked Report
Enables/Disables the Linked Report

icon in the toolbar. Set to False to disable users from linking reports.

Show Linked Report Fields
Enables/Disables the Fields selector tab in the Linked Report dialog.

Show Linked Report Formula
Enables/Disables the Formula editor tab in the Linked Report dialog.

Show Linked Action
Enables/Disables the Linked Action button. When True, users will be able to add Action Events to reports.

Show Insert Image
Enables/Disables the Insert Image button in the Advanced Report designer. Set to False to disable users from inserting images.

Show Joins Window
Enables/Disables the Joins menu under Advanced Options. Set to False to disable users from modifying joins.

Show Advanced Joins
Enables/Disables additional options in the Joins menu. Set to True to enable advanced users to create, delete, and modify joins.

Advanced Joins Display v2017.3.1+
Select whether to show complex join options in the report Joins menu.
Complex — allow users to modify join operators and expressions, and allow conjoining clauses.
Standard — only permit joining data columns on equality.

Allow Category Aliasing v2017.3.1+
Category aliasing allows users to add categories multiple times on the same report. This may be necessary for some advanced join
operations.

Show Events Window
Enables/Disables the Events menu under Advanced Options. Set to True to allow advanced users to apply Event Handlers for the report.
See Server Events for more information.

Show Report-Level Parameters Window v2019.1.3+
Enables/Disables the Parameters menu under Advanced Options. Set to True to allow advanced users to view system-parameters and
define their own report-level parameters for use within reports. See Advanced Options for more information.

Show SQL Window
Enables/Disables the Show Generated SQL menu under Advanced Options. Set to True to allow advanced users to generate and view
the SQL that will be sent to relevant databases upon report execution. See Advanced Options for more information.

Linked Report Display v2017.3+
Specify where to display drilldowns for linked reports.
Cursor: Window at the cursor
New Tab: New Exago tab
Center of screen: Window centered in the screen

Allow Grouping on Non-Sorts
Enables/Disables the group formula button in the Group Header/Footer menu. Enabling this will allow users to group on non-sort formulas.
Note
Grouping on non-sort formulas is deprecated and unsupported.

Allow Creation of Custom SQL Objects v2018.1+
Allow end-users to write custom SQL objects at the report level.
Warning
Carefully review the Report Level SQL article before enabling.

Data Sources to Exclude from Custom SQL Creation v2018.1+
When Allow Creation of Custom SQL Objects is enabled, enter the data sources to exclude from Report-Level SQL. Write each data
source in double quotation marks ("), and separate sources by a comma (,). Example: "Northwind","AdventureWorks".

Dashboard Report Designer Settings
These settings only apply to the Dashboard designer. If Show Dashboard Reports is false these settings will be ignored.

Prompt user for Parameters/Filters on Execution
Default setting indicating whether to prompt the user for filter and/or parameter values when executing a dashboard. The option can be
overridden on an individual dashboard in the Options menu.

Show URL Item Button
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Display/Hide the New URL item in the Toolbox of the Dashboard designer.

Allow Creation/Editing of Dashboard Visualizations
Display/Hide the New Data Visualization item in the Toolbox and the Data Fields of the Dashboard designer.

Use Sample Data for Dashboard Visualization Design
Set to True to use sample data while creating and editing Dashboard Visualizations. This will reduce the number of calls to the database.
Set to False to query the Data Source for each change made while editing Dashboard Visualizations.

Refresh Reports/Visualizations on Dashboards Silently
Set to True to disable the refresh hourglass animation for timed automatic dashboard reloads.

Minimum Tile Width for Dashboard Reflow v2019.1+
Specifies the minimum width a tile will be drawn when Dashboard Reflow is enabled. Please see the Screen Fit and Scaling section of
the Dashboard Designer article for more information.

Minimum Window Width for Dashboard Reflow v2019.1+
Specifies the minimum window size where Dashboard Reflow will begin to take effect. Please see the Screen Fit and Scaling section of
the Dashboard Designer article for more information.

Common Settings
Default Designer Font
Specifies a default font for reports created in the Advanced Report wizard, Express Report wizard, Advanced Report designer, and
Dashboard designer. This setting can be overridden on a per-Report basis.
End-users must have the selected font installed locally in order to display. Otherwise, Exago will default to Sans Serif. We suggest using a
font-face CSS tag in your custom home page to tell the browser to download the font automatically:
@font-face {
font-family: 'Open Sans';
src: url('myFonts/OpenSans.ttf');
}

Default Designer Font Size
Specifies a default font size for reports created in the Advanced Report wizard, Express Report wizard, Advanced Report designer, and
Dashboard designer. This setting can be overridden on a per-Report basis. Does not apply to CrossTabs.

Show Help Button
Enables/Disables the Help button in the top right corner of Exago. Set to False to disable users from accessing Context Sensitive help.

Custom Help Source
Specifies the URL that contains custom Context Sensitive Help content. See Custom Context Sensitive Help for more details.

Show Exports in Tab
Set to True to open PDF reports in a tab in Exago. Set to False to prompt the user to download the PDF.

Show IE Download Button
Set to True if Internet Explorer is not automatically prompting users to download PDF, XLS, RTF or CSV reports.

Show Join Fields
Enables/Disables any Data Fields that are used as Unique Keys or Joins. Set to False to hide all unique key and join Data Fields from
users. To hide specific Data Fields see Column Metadata.

Show Grid Lines in Report Viewer
Sets the default output to show grid lines. This can be modified in the Options menu of the report designer.

Show Enhanced Tooltips
Sets the style of tooltips to display. If True, enhanced tooltips which support HTML will be displayed. If False, standard browser tooltips
will be shown.

Save on Report Execution
Set to False to disable automatic saving of reports when executing from the report designer.

Save on Finish Press
Set to False to disable automatic saving of reports when finish button is pressed in a wizard.

Enable Right-Click Menus
Set to False to disable right click menus.

Enable Reports Tree Drag and Drop
Set to False to disable the dragging of reports and folders in the Main menu.

Show Report Upload/Download Options
Set to True to enable users to upload and download report files by right clicking on folders and reports. Default value is False.

Allow interactivity in Report Viewer
Set to False to disable Interactive Report Viewer capabilities, including: changing column width, styling output, and interactive filters.

Show Toolbar in Report Viewer
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Specify if Report Viewer should display paging, search, and export options.
Auto — Exago will detect if the report only displays a single page of content from the Report Footer Section. If so the HTML Toolbar
will be hidden, otherwise it will show.
Show —the toolbar will always show.
Hide — the toolbar will never show.

Default interactive report viewer dock is open
Set to False to have the Interactive report Viewer Dock minimized by default.

Interactive report viewer default dock placement
Specify if the Interactive Report Viewer Dock should appear on the right or left of the default output.

Allow save to report design for report viewer
Set to False to prevent users from saving Interactive Report Viewer changes onto the report.

Maximum number of fields in a CrossTab header or tabulation source
Specify the maximum allowed fields in a CrossTab header or tabulation source. Note that adding a large number of data fields to a
CrossTab will significantly increase the execution time of the report.

Use SVG for Application Icons v2016.3+
Set to True to enable Exago to use SVG (scalable vector graphics) icons instead of the default PNG icons for the UI elements. SVG icons
look nicer on high-pixel density screens, but they may not be compatible with some web browsers.

Application Theme Selection v2016.3+
Choose from a selection of available user interface themes . See Application Themes for more information.
After choosing a theme, users should clear their browser cache and refresh the user interface in order for the theme change to take effect.

Show Data Fields Search Box v2017.2+
Enables/Disables the data field search tools in the sidebar of the ExpressView and Dashboard designers.
Note
We highly recommend setting Column Metadata, and setting Schema Access Type to Metadata for all available objects, before
enabling this feature.

Programmable Object Settings
This article applies to the Admin Console >

General >

Programmable Object Settings.

The Programmable Object Settings enable you to specify names for parameters that will be passed from Exago to stored procedures,
web services, or .NET Assemblies. Using these parameters will allow filtering to be done before the data is sent to Exago. This can
increase performance and reduce server resources when using Programmable Objects. For more information on these types of Data
Objects see Web Services & .NET Assemblies.
Note
If performance is a concern, especially for large data sets, database-joinable objects, such as tables, views, and table-valued
functions, are preferable to programmable objects.
Names for the following Parameters can be set:

Call Type Parameter Name
Integer that specifies what Exago needs at time of the call. There are three possible values.
0 : Schema — return a data set with no rows (only the schema information).
1 : Data — return a full data set.
2 : Filter Dropdown Values — return data for the filter dropdown list. The Data Field requested is passed in the Column
parameter and the filter value is passed in the Filter parameter (see below). The direction the user is scrolling the dropdown is
passed in the Sort parameter as either ASC (scrolling down) or DESC (scrolling up).

Column Parameter Name
Call Type = 1: List of columns required to execute the report, separated by commas.
When Call Type = 2: Column being requested by the filter dropdown.

Filter Parameter Name
When Call Type = 1: The filter string specific to the Data Object being called passed as standard SQL.
When Call Type = 2: The current value of the filter whose dropdown is being requested.

Full Filter Parameter Name
When Call Type = 1: The filter string for the entire report passed as standard SQL.
When Call Type = 2: The Tenant and Row Level filters passed as standard SQL.

Sort Parameter Name
The sort string for the report.
If using call type 2, it can indicate which direction the user is scrolling a filter dropdown. ASC indicates scrolling down or DESC indicates
scrolling up.

Data Category Parameter Name
The Data Object’s Category. Can be used in conjunction with the Data Object ID Parameter.

Data Object ID Parameter Name
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Id of Data Object being called. For more information see Calling a Single Web Service/.Net Assembly/Stored Procedure.

Filter Settings
This article applies to the Admin Console >

General >

Filter Settings.

Introduction
The Filter Settings provide control over what filter options are exposed to users and how the dropdowns within filters behave.

The Filter Settings menu

Settings
Select your version of Exago from the Application Version dropdown on the right-side of this article to show only the settings available in
your version.
The following Filters Settings are available:

Show Group (Min/Max) Filters
Enables/Disables the Min/Max Filter menu. Set to False to disable users from using Min/Max filters.

Show Top N Filters v2017.1+
Enables/Disables the Top/Bottom Filters menu in the ExpressView and Advanced Report designer. Top N filters allow users to see the
highest or lowest values for a data set. Set to False to disable users from using Top N filters.

Allow New Filters at Execution
Controls the creation of new filters when a user is prompted for a filter value at the time of report execution. Set to False to disable new
filters from being created at execution.

Read Database for Filter Values
Enables/Disables filter drop downs to contain values from the database. Set to False only if retrieving the values for the dropdown will take
more than a couple of seconds.

Allow Filter Dependencies
Causes filter drop downs to retrieve values dependent on the filters above them in the menu. Set to True to enable. Default value is False.
For a full description of how this feature works, review the Filter Dependency section of the Filters article.
Note
This setting only works for Data Objects from databases and will not change drop downs from Web Services, .NET Assemblies and
stored procedures.

Show Filter Description
Enables/Disables reports to have description text for the filters menu. The filter description is set in the Description tab of the New Report
Wizard or from the Description item on the Report Designer's Settings menu.
A Help

icon will appear in the Filters dialog and display the filter description when clicked.

Default Filter Execution Window
Determines the type of window that appears when prompting users for filter execution input:
Standard — New reports display the standard filter execution window, allowing filters to be modified and new filters to be created.
Simple with Operator — New reports display a simplified filter execution window that only allows the operator and value to be
changed.
Simple without Operator — New reports display a simplified filter window that only allows the value to be changed.

Allow User to Change Filter Window
Enables/Disables reports to change the type of filter execution window that is displayed.

Include Null Values for 'NOT' Filters
Indicates to include NULL values for filters with using the operators ‘not equal’ or ‘not one of’.

Custom Filter Execution Window
Specifies a control or URL that contains Custom Filter Execution Window. See Custom Filter Execution Window for more details.
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Restore All Default Date Filter Functions v2016.3+
Restores the default Filter Functions to the Extensions menu.

Restore All Default Formula Functions v2017.2+
Restores the default Custom Functions to the Extensions menu.

Database Settings
This article applies to the Admin Console >

General >

Database Settings.

The Database Settings allow administrators to adjust how Exago interfaces with the data sources. Additional type-specific settings allow
you to specify which driver to utilize when connecting to each data source.

Settings
Select your version of Exago from the Application Version dropdown on the right-side of this article to show only the settings available in
your version.
The following Database Settings are available:

Database Settings
Database Timeout
A value that is passed to the data provider's CommandTimeout property as Exago queries the business intelligence data source. It is up
to the data provider what to do with this value. This timeout has no effect on connections to Folder Management or databases, if
applicable.
Caution
This value is passed on to the data source provider when the report is executed. Each data source driver, data source or individual
database may interpret this setting slightly differently. Consult the official product documentation associated with your data source
implementation for complete details how this setting will impact your environment.
Note
This setting will also control the maximum number of seconds that a Web Service API method can run. If set to 0 the Web Service API
time out will be infinite.

Database Row Limit
Maximum number of rows returned on an execution. This only applies to Tables, Views and Functions. Set to 0 to return all rows.

Row Limit Step Size
Maximum number of rows returned on a query. Set to 0 to return all rows. Set greater than 0 to enable Incremental Loading for
Advanced Reports and ExpressView. The value determines how many rows are returned for each user-initiated data query.

Disable Non-Joined Data Objects
If True users are not able to add Data Objects to a report that do not have a join path with at least one other Data Object on the report. Set
to False to disable this restriction.
This setting does not have an affect for ExpressView unless Feature/UI Settings > ExpressView Settings > Fields Enabled in Data
Fields Tree is set to Direct Joins Only.

Enable Special Cartesian Processing
If True any one-to-many Joins will cause special processing to avoid data repeating on the report. Set to False to disable this behavior.

Aggregate and Group in Database
If True, aggregate and grouping calculations will be done in the database when possible. This will provide a performance boost for reports
with group sections.
Important
Before enabling this, you must ensure that all One-To-Many Joins in your environment are correctly identified and set as One-To-Many in
the Join options menu. If these joins are not properly identified, reports which utilize them will return incorrect aggregate data. See
Database Aggregation for more information.

Convert Formula Filters and Sorts to SQL
If True, formula filters and sorts will be converted to SQL when possible. The converted SQL statements will be placed in the WHERE (for
formula filters) and ORDER BY (for formula sorts) clauses when querying data for the report. If set to False, all formula filtering and sorting
will occur in-memory.
For more information, please see the Converting Formula Sorts to SQL section below.
Important
Due to innate difference between Exago's formula engine and SQL database engines, there may be discrepancies in data returned
between two methods. Additionally, because the converted SQL formulas may contain arbitrary input, the connection string must be
read-only access. For more information please see the Database Formulas article.

Type-Specific Database Settings
Each type of Data Source has the following settings available.
Click the AutoFill icon to automatically fill the Data Provider, Table Schema Properties, View Schema Properties, Function
Schema Properties and Procedure Schema Properties fields for each database type. Fields will be filled with data from the drivers
provided with the application.
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Data Provider
Specify the name that can be used programmatically to refer to the data provider.
This matches the InvariantName found as a property of DbProviderFactories in the server's machine.config file.
Note
The machine.config file is located in the %SystemRoot%\Microsoft.NET\Framework\%VersionNumber%\CONFIG\
directory.

Table Schema Properties
Specifies how to retrieve the schema of tables.

View Schema Properties
Specifies how to retrieve the schema of views.

Function Schema Properties
Specifies how to retrieve the schema of functions.

Procedure Schema Properties
Specifies how to retrieve the schema of procedures.
Note
For any of the Schema Property settings you can dynamically refer to properties from the Data Source’s connection string by
surrounding the property name in @ symbols. For example, "@database@" will be replaces with the database name from the connection
string of the Data Source being queried.

Converting Formula Sorts to SQL
When Convert Formula Filters and Sorts to SQL is True, Exago will attempt to push all formula sorts to the database instead of running
them in memory. This feature converts formula sorts on a report to SQL syntax so that they can be appended to the ORDER BY clause of
the query. When applicable, formula sorting will then be pushed to the database level of report execution, improving execution
performance.
For example, a report may be sorted by the following formula, which organizes the data based upon whether or not an Order has a
Revenue of greater than or equal to $1000.
=(OrderDetails.Revenue)>=1000

This formula sort would be converted to the following SQL statement and appended to the ORDER BY clause of the query during report
execution.
ORDER BY
(CASE WHEN dbo.[OrderDetails].[Quantity] * dbo.[OrderDetails].[UnitPrice] >=
1000 THEN '1' ELSE '0' END) asc

Formula Dictionary
All defined Exago formula to SQL statement translations can be found in the dbconfigs.json file. The translations are located under the
Formula Dictionary property of each database type listed in this file. See Managing the dbconfigs.json File for more information.
For example, the following contains part of the Formula Dictionary for the MySQL database:
"FormulaDictionary":
{
"and": ["({0} AND {1})"],
"false":["(1=0)"],
"if": ["(CASE WHEN {0} THEN {1} ELSE {2} END)"],
"or": ["({0} OR {1})"],
"len": ["CHAR_LENGTH({0})"],
"true":["(1=1)"],
"date": ["STR_TO_DATE('{0}/{1}/{2}', '%Y/%m/%d')"],
...
},

SQL syntax translations may be added in this file for any custom functions that are defined. Functions may also be overloaded, meaning
that a client can define multiple versions of a function that can take a variable amount of arguments and Exago will choose the correct
function based on the number of arguments that are passed to it. Functions with an unbounded number of arguments, however, cannot be
defined.

Notes on Behavior
Please take the following information into consideration when utilizing this feature:
Non-SQL databases (e.g., Mongo, ElasticSearch, Excel) do not support this feature. All sorting for reports using non-SQL
databases will occur in-memory.
DB2 is supported by this feature; however, there are limitations regarding what formulas can be translated to SQL when using this
database type.
If a sort contains reference to an object from a different data source than the one that is being queried for report execution, then all
sorting will occur in-memory.
If a sort contains reference to an object from an Excel data source, then all sorting will occur in-memory.
If no sorts exist on a report then no SQL will be appended to the query.
Boolean expressions will prioritize False values when set to ascending and True values when set to descending.
If sorts that cannot be properly translated to SQL exist on a report, then SQL statements will be generated and appended to the
database query up to the sort that cannot be translated. For example, if the third sort on a report is untranslatable, then only the
first two sorts will be translated and appended.
Calculations that are pushed to the database may differ in comparison to those run in-memory by Exago. For example, pi (π) is
rounded to the 15th digit in Exago but is only rounded to the 6th digit in MySQL by default. These differences in calculations vary
depending on the database type and should be taken into consideration when enabling this feature.

70 of 215

Scheduler Settings

Technical Guide

Scheduler Settings
This article applies to the Admin Console >

General >

Scheduler Settings.

Reports can be emailed or scheduled for recurring automated delivery to an email address. The Scheduler Settings are used to configure
these services. Before adjusting the settings, ensure that the Scheduler Service ExagoScheduler is installed, running, and set to
automatically start. For more information see Installing Exago Scheduler.
The Remote Execution service can be used to move processing to a different server or to provide load balancing across multiple servers.
For more information see Load Balancing.

Settings
Enable Report Scheduling
Enables/Disables scheduling and remote execution functionality in the application.
If False, will override Show Report Scheduling Option, Show Email Report Options, & Show Schedule Manager also to False.

Show Report Scheduling Option
Enables/Disables the
scheduling reports.

Schedule Report option when right-clicking on a report in the Report Tree. Set to False to disable users from

Show Email Report Options
Enables/Disables the

Email Report option when right-clicking on a report in the Report Tree.

Show Schedule Reports Manager
Enables/Disables the Schedule Manager

icon on the Main Menu.

Show Schedule No End Date Option
Enables/Disables users ability to create a schedule that never ends. Set to False to force users to set an end date limit to the schedule.

Show Schedule Intraday Recurrence Option
Enables/Disables options in the Recurrence tab of the Schedule Wizard to allow a schedule to repeat throughout the day.

Scheduler Manager User View Level
Controls what information each user can see in the Schedule Manager. These levels utilize the Parameters companyId and userId. There
are three possible values:
Current User: Can only view and delete report jobs that have been created by that user. This setting will hide the Host and
Company Id columns of the Schedule Manager.
All Users in Current Company: User can only view and delete report schedules for their company. This setting will hide the Host
column of the Schedule Manager.
All Users in All Companies: User can view and delete report schedules for all companies (administrator).
For more information, see User Identification.

Email Scheduled Reports
Set to False to have the Scheduling Service save reports to a file repository instead of attaching them to emails. For more details see
Saving Scheduled Reports to a Repository.

Enable Batch Reports
Set to True to allow users to schedule reports which are filtered separately for each recipient user. Batch reporting requires a table or other
data structure containing email addresses for the intended recipients associated with a key used to filter the reports. For more information
see Scheduling Reports.

Show Schedule Delivery Type Options
Enables/disables user option to choose the output type (i.e. email or save report to repository) with each schedule. When True, the default
value will reflect whatever is set in the Email Scheduled Reports setting.

Use Secure Scheduler Remoting Channel
Enables/disables encrypting of data Set to true to cause data sent to remote schedulers to be encrypted. Each scheduler config file must
also have <secure_channel> set to true.

Schedule Remoting Host
Sets the protocol, server and port to the Scheduler Service. Separate multiple remoting hosts with a comma or semicolon. Click the
Test Connection icon to test the connection between the Web Application and the Scheduler Services.
The protocol and port must match the Scheduler Service's channel_type and port configuration settings, respectively.

Examples
http://localhost:2001
http://SchedulerOne:2001,tcp://SchedulerTwo:2001

Enable Remote Report Execution
Permits report execution to be done on a different server via one or more Scheduler Services. Set to True to enable this behavior.

Enable Execution Cache
Enables/disables users to use an execution cache for specified reports. An execution cache refreshes report data on a schedule, and
report execution calls use the cached data instead of querying the data source each time the report is executed.
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User Cache Visibility Level
Controls what visibility permissions users can assign to Execution Caches. Available levels utilize the parameters companyId and
userId. There are three possible values:
User: Users can only view cached report data for caches that they have created.
Company: Users can permit cached data to be visible to all other users in the user's company. Users can also select the User
option.
Global: Users can permit cached data to be visible to all other users for all other companies. Users can also select the Company
or User options.

Enable Access to Data Sources Remotely
Permits all non-execution data base calls to be done on a different server via the scheduler service. Set to True to enable this behavior.
Example calls include Filter value drop downs, Data Object Schema retrieval, and Data Source schemata retrieval in the Administration
Console.

Remote Execution Remoting Host
Specifies the Scheduler Services to use for remote execution. Separate multiple servers with commas or semicolons. Click the Test
Connection icon to test the connection between the Web Application and the Scheduler Services.
The protocol and port must match the Scheduler Service's channel_type and port configuration settings, respectively.

Example
http://MyHttpServer1:2001,tcp://MyTcpServer:2001

Custom Queue Service
Specifies the web or assembly queue service for custom scheduler management and load balancing. See Scheduler Queue for details.
Click the Test Connection icon to test the connection between the Web Application and the Queue Service.

Delete Schedules upon Report Deletion
When a report is deleted corresponding schedules can be deleted automatically by Exago. Set to True to enable this behavior.

Default Email Subject
Set a default subject that will be displayed in the schedule report wizard.
Internal Parameters such as @reportName@ may be utilized in this area.

Default Email Body
Sets a default body that will be displayed in the schedule report wizard.
Internal Parameters such as @reportName@ may be utilized in this area.

Password Requirement (for pdf and excel documents)
Requires a password for PDF or Excel file export. This parameter can be made up of the following values:
A: requires an upper case letter for each ‘A’
a: requires a lower case letter for each ‘a’.
n: requires a numeric character for each ‘n’
4: password must have at least 4 characters
For example, ‘AAnna6’ would require a password of at least six characters with 2 capitals, 1 lower case and 2 numeric characters.

Custom Scheduler Recipient Window
Provides URL, height and width for custom Scheduler Recipient window. See Custom Scheduler Recipient Window for more
information.

Show "Reply To" Field in the Scheduler "Recipients" Tab
Displays the email specified in the userEmail parameter in the Recipients tab when scheduling a report. Any replies to the scheduled
report will be sent to this email address instead.

Other Settings
This article applies to the Admin Console >

General >

Other Settings.

Select your version of Exago from the Application Version dropdown on the right-side of this article to show only the settings available in
your version.

Excel Export Target
Choose the type of Excel export you would like. Choosing 2003 will automatically split the workbook into multiple worksheets when
Excel’s row limit is reached.
Note
Linux does not support setting the Excel export target to 2003.

External Interface
Provide a Web Service URL or .NET Assembly to interface with the external module. For more information see the article on External
Interface.

Enable Paging In the Report Viewer
Controls when data for Report Viewer output is sent to the client. Set to True to send data as each page is requested. If this is set to
False, it restricts the interactive HTML hide/show column option in the Report Viewer.
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Note
When enabled, it will cause multiple requests from the server.
Set to False to send all the data to the client browser at once.

Renew Session Automatically
This setting is used to bypass the session timeout property set in web.config. Set to True to send a server side AJAX callback every
two minutes to keep the session from expiring.
Note
This will only work if the timeout period set in web.config is greater than two minutes.

Write Log File
Set the level of detail logged in the Exago log file. See Application Logging for information about the different log levels. This setting will
be overridden by a log4net.config file.

Enable Debugging
Set to True to enable debugging. For more information see Submitting a Debug Package.

Max Report Execution Time (minutes)
Specify how long, in minutes, reports should run before timing out. Default is 240 minutes (4 hours).

Maximum Age for Temp Files
Determines the maximum number of minutes a temp file can exist before Exago’s automatic cleanup removes it.
Important
Understand that setting the maximum age too low may cause an error, as users might spend some time viewing a report executed in
HTML, which uses AJAX to read temp paging files.
The default value is 1440 minutes (1 day). The minimum this value can be set to is 30 minutes.

Enable Web Service/Assembly Data Mapping
Allows Web Service and .NET Assembly methods to replace Data Field names.

Limit Reports and Visualizations to One Category
Limits reports and visualizations to Data Objects within a single category. Set to true to restrict reports and visualizations to one category,
or false to allow Data Objects from multiple categories.

Run Aggregate Functions at Record Level by Default v2019.1.8+
The recordLevel argument of all aggregate functions will default to this value if no value for recordLevel is passed when the
aggregate function is called. If True, aggregate functions run at the record level (including duplicates). If False, aggregate functions run at
the entity level which is the default behavior.
By default, set to False

Cache External Services
Caches external Web Services and .NET Assemblies. Setting to False may reduce performance due to loading/unloading of services.

Global Schema Access Type
Specifies whether to query the Data Source for an object’s schema or to read it from Column Metadata. See Retrieving Data Object
Schemas for more information.

Allow Multiple Sessions
Allows multiple sessions of Exago per user. Set to True to enable this behavior.

Allow MD5 Hashing on FIPS Server
Allows a FIPS-compliant server to encrypt PDF files by using an alternate MD5 library to the built-in System.Cryptography.

Write BOM to CSV Files v2019.1.1+
Attaches a Byte Order Mark (BOM), an optional abstract character used to declare and recognize Unicode encoding of a text file, to the
beginning of CSV file exports. Set to True to enable.

Enable Report List Caching pre-v2020.1
Note
This setting has moved to the Storage Management section as of v2020.1

If True, the

Report Tree list will be cached rather than being read fresh each time it is needed. Default value is True.

Enable Report XML Caching pre-v2020.1
Note
This setting has moved to the Storage Management section as of v2020.1
If True, the XML report definition files will be cached rather than being read fresh each time they are needed. Enabling this setting will
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reduce the number of calls to the report storage mechanism and may help with performance. Default value is True.

Report XML Caching Timeout pre-v2020.1
Note
This setting has moved to the Storage Management section as of v2020.1
If Enable Report XML Caching is True, set the timeout in seconds that the Report XML cache should expire. Report definition files in the
cache that are this number of seconds old or older will be refreshed from report storage.

'LoadImage' Cell Function Parameter Prefix
A string that is prepended to the LoadImage function when the report is run. This setting allows an administrator to hide the report path of
images on your server. This field is ignored for images loaded from a database.

Ignore Inaccessible Report Folders
If False, Exago throws an error message if a folder has an accessibility issue. Set to True to ignore the error and hide the inaccessible
folder.

User ID
Sets the User ID necessary to gain access to the Administration Console and REST API. Leave blank to permit unverified access to the
Administration Console.

Password
Used in conjunction with User ID to gain access to the Administration Console and REST API.

Confirm Password
Used to confirm the value of Password.

Debug Password
A password that enables clients to send a debug package directly to Exago Inc. Leave blank to disable Debug Extraction. When set to
True, correct permissions must be set on the ./Debug Folder. For details see the Submitting a Debug Package article.

REST Key
Set a key to authenticate REST requests. Review the Authorization section of the Introduction to REST article for more information.

Exago Expiration Date
A date when users will no longer be able to access Exago.

Custom Code Supplied by Exago
Used for custom functionality.

License Key
Used to activate purchased add-on Exago features.

Data Sources
This article applies to the Admin Console >

Data >

Sources settings.

Data Sources establish the connection between Exago and a database or a web service. Although typically only one database is used,
Exago can join data from different sources into a single report.
Note
To utilize some types of data sources you may need to download and install the appropriate driver. Refer to Data Source Drivers below.

Creating, Editing or Deleting Data Sources
To add a new data source click

Sources in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit a source either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete a source either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new objects click the Apply or Okay buttons.

Data Source Properties

Each data source must have the following:
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Name
A name for the data source.

Type
The type of source being used. Valid types include:
Relational databases
SQL Server — Microsoft SQL Server
MySQL
Oracle
Postgres — PostgreSQL
DB2 — IBM db2
Informix — IBM Informix
ODBC — ODBC Driver
Non-relational databases
MongoDB (v2018.2+)
ElasticSearch (v2018.2+) — ElasticSearch/ELK database (For more information see CData Drivers.)
Data warehouses
Redshift (v2019.1.11+)
Snowflake (v2019.1.9+)
Other
File — XML or Excel file (For more information see Excel and XML Files.)
.NET Assembly — .NET Assembly DLL (For more information see .NET Assemblies.)
SOAP Web Service — Web Service (For more information see Web Services.)
MS OLAP — OLAP (For more information OLAP and MDX Queries.)

Schema/Owner Name (blank for default)
Provide a default database schema for the data source.
Note
Only use this if you are using schema to provide Multi-Tenant security. For more details see Multi-Tenant Environment Integration.

Connection String
The method that is used to connect to the data source. Connection strings vary by type:
Type

mssql, oracle, postgres, mysql
and olap

Connection Strings
Refer to connectionstrings.com for database connection strings.
If using Integrated Authentication from an IIS Application Pool to connect to a remote MSSQL server,
review these MSDN and Stack Overflow articles to ensure the correct credentials are sent to the
SQL server.
The database driver specified in Database Settings determines the character set used in the
application. If the data in the data source uses a different character set, it should be explicitly set in
the connection string.
Required parameters:
url – The URL of the web service.
Optional parameters:

dewebsvc

authentication – Set to ‘basic’ to utilize basic authentication through IIS. This will send the user
ID and password as clear text (unless https is used).
uid – User ID is passed to the web service.
pwd – Password is passed to the web service.
Required parameters:

assembly

assembly – The full path of the assembly name.
class – The class name in the assembly where the static methods will be obtained.

file

Requires the physical path to the Excel or XML file and the file type.
Example: File=C:\example.xls;Type=excel;

mongodb

For more information see CData Drivers

elasticsearch

For more information see CData Drivers

snowflake

For more information see CData Drivers

redshift

For more information see CData Drivers

Click the Test Connection icon to verify the connection succeeds.
Click the Make Connection String Visible or Connection String Hide
Data Source tab.

icons to show/hide the connection string in the

Data Source Drivers
Below is a list and the associated links for recommended ADO.NET drivers for each type of data source.
SQL Server
No external ADO.NET driver needed
Oracle
ODAC1120320_x64 or newer
Oracle ODAC Connector
Oracle.ManagedDataAccess.Client
MySQL/MariaDB
dcmysqlfree.exe
Devart Connector
PostgreSQL
dcpostgresqlfree.exe
Devart Connector
DB2/Informix
5.exe or newer
IBM Data Server Driver Package
Elasticsearch, Redshift, Snowflake, MongoDB
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CData ADO.NET drivers

Web Services and .NET Assemblies
Web Services and .NET Assemblies can be used as data sources. This is possible when the Web Service and .NET Assemblies
underlying methods are setup as data objects.
An advantage of doing this is being able to use high-level language to manipulate the data being reported on at run-time. The main
disadvantage is not being able to take advantage of the database to perform joins with other data objects; data from methods can still be
joined, but the work to do this is done within Exago. For more information see Note about Cross Source Joins.

Parameters
Parameters are passed from Exago to Web Services and .NET Assemblies. Three types of parameters can be passed but only Call Type
is required.

Call Type (required)
Integer that specifies what Exago needs at the time of the call. There are three possible values. You may specify the name of this
parameter in the Programmable Object Settings of the General section.
0 : Schema - returns a DataSet with no rows.
1 : Data - returns a full DataSet.
2 : Filter Dropdown Values – returns data for the filter dropdown list. The Data Field being requested is passed in the column
parameter. The filter type is passed in the filter parameter (see below).

Column, Filter and Sort Strings
To optimize performance Exago can pass user-specified sorts and filters to the Web Service or .NET Assembly. This process reduces the
amount of data sent to Exago. If these parameters are not used, all of the data will be sent to Exago to sort and filter. Column, filter and
sort strings are sent as standard SQL. You may specify the name of these parameters in the General > Programmable Object
Settings section.

Custom Parameter Values (optional)
Additional parameters can be specified to be sent to individual methods in the Data Object Menu.
Important
When a Web Service or .NET Assembly is first accessed it is compiled and kept in an internal cache within Exago. This is done in order
to increase performance. Due to this internal cache, Exago will not be aware of any changes within the Web Service or .NET Assembly.
If the service or assembly is subsequently changed, Exago will execute the prior compiled version. Thus, when you modify the Web
Service or .NET Assembly reset the internal cache of Exago by clicking the connection verification icon of the Data Source or by
restarting IIS.
Note
If an Exago .NET API application needs to access reports, which use an assembly data source. It must include a reference to the
assembly WebReportsAsmi.dll.

SessionInfo (optional) v2016.2+
Session state variables. See SessionInfo for more information.

.NET Assemblies
It is important to note that when a connection string for .NET Assembly is set the class name must match the name of the class where
the static methods will be searched. UNC or absolute paths may be used. Make sure that the assembly has read privileges for the IIS user
running Exago. Below is an example of a .NET Assembly connection string:
assembly=\\MyServerName\MyShareName\MyAssembly.dll;class=Main

.NET Assembly methods must be static. Below is an example of a .NET Assembly method.
public class Main
{
public static DataSet dotnet_optionees(int callType, string columnStr, string filterStr, int myCustomParameter)
{
switch (callType)
{
case 0:
// return schema
case 1:
// return data
case 2:
// return filter values for dropdown
}
}
}

Method signature using SessionInfo (v2016.2+):
public class Main
{
public static DataSet dotnet_optionees(WebReports.Api.Common.SessionInfo sessionInfo, int callType, string columnStr, string filterStr, int myCustomParameter)
{
switch (callType)
...
}
}

Web Services
Web Services are accessed via SOAP. Below is an example of a Web Service connection string:
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url=http://MyServer/MyWebService.asmx

Web services methods are similar to .NET Assembly methods with the following exceptions:
Methods do not need to be static
Methods must return a serialized XML string. The returned XML must follow the structure used by the C# method DataSet.GetXML.
An example of XML format can be found in the following section.

Excel and XML Files
Exago can use Microsoft Excel and XML files as data sources. Remember though that Excel and XML files are not databases. Simply put,
these data sources do not offer the speed, performance, or security of a real database. Using Excel and XML files is recommended only if
your dataset is small or if the information is only available in this format.

Connection String
File=C:\example.xls;Type=excel;

Excel
Each worksheet in the Excel file will be read as a separate table. Each worksheet’s name will be read as the table’s title. The top row will
be read as the column header, and the remaining cells will be read as the data. Do not leave any blank rows or columns.

XML
The XML document must begin with the schema. After defining the schema the data must be placed into the appropriate tags. For
reference see the working example below:
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<?xml version="1.0" encoding="UTF-8"?>
<ExagoData>
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema" xmlns:msdata="urn:schemas-microsoft-com:xml-msdata" id="ExagoData">
<xs:element name="ExagoData" msdata:IsDataSet="true" msdata:UseCurrentLocale="true">
<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded">
<xs:element name="Call">
<xs:complexType>
<xs:sequence>
<xs:element name="CallID" type="xs:unsignedInt" minOccurs="0" />
<xs:element name="StaffID" type="xs:string" minOccurs="0" />
<xs:element name="VehicleUsed" type="xs:unsignedInt" minOccurs="0" />
</xs:sequence>
</xs:complexType>
</xs:element>
<xs:element name="Staff">
<xs:complexType>
<xs:sequence>
<xs:element name="StaffID" type="xs:unsignedInt" minOccurs="0" />
<xs:element name="Rank" type="xs:string" minOccurs="0" />
<xs:element name="LastName" type="xs:string" minOccurs="0" />
<xs:element name="FirstName" type="xs:string" minOccurs="0" />
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:choice>
</xs:complexType>
</xs:element>
</xs:schema>
<Call>
<CallID>890</CallID>
<StaffID>134</StaffID>
<VehicleUsed>12</VehicleUsed>
</Call>
<Call>
<CallID>965</CallID>
<StaffID>228</StaffID>
<VehicleUsed>4</VehicleUsed>
</Call>
<Call>
<CallID>740</CallID>
<StaffID>1849</StaffID>
<VehicleUsed>2</VehicleUsed>
</Call>
<Staff>
<StaffID>134</StaffID>
<Rank>Captain</Rank>
<LastName>Renolyds</LastName>
<FirstName>Malcom</FirstName>
</Staff>
<Staff>
<StaffID>228</StaffID>
<Rank>Lieutenant</Rank>
<LastName>Brown</LastName>
<FirstName>Bill</FirstName>
</Staff>
<Staff>
<StaffID>1849</StaffID>
<Rank>Sergeant</Rank>
<LastName>John</LastName>
<FirstName>Pepper</FirstName>
</Staff>
</ExagoData>

OLAP and MDX Queries
Exago can query OLAP Data Sources using MDX Queries. OLAP Data Sources and Objects are identical to a regular data base type
object, with the following exceptions:
Data Objects belonging to OLAP type Data Sources must have their Schema Access Type set to Metadata and must have
Column Metadata set for all fields.
OLAP Data Objects will always be MDX Queries written in the Custom SQL Object dialog.

Using Azure based SSAS
In order to use an Azure based SQL Service Analytic Service Database (SSAS) you need the most up to date ADOMD.NET driver, which
is available from Microsoft. Then, in order to properly configure Data Object entities through joins, the following information must be
provided:
The entity containing the primary key should be specified in the "From" section.
The entity containing the foreign key should be specified in the "To" section.
The IDs used in the join configuration must be included in the metadata fields and should be available in the design model.

ODBC Drivers
Exago can use ODBC drivers to connect to data sources. When connecting to an ODBC data source, an extra option will appear to set
the Column Delimiters. The delimiter character depends on which type of data base you are connecting to.

Examples
MySql
' (grave accent)

MsSql, OLAP
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[] (brackets)

DB2, Informix, Oracle, Postgres, Sqlite
" (quotation marks)

If you don't know which delimiter character to use, contact your database administrator.
Warning
If your data objects have spaces in their names, you must set the correct delimiter in order to access the data. Otherwise, improper SQL
will be generated and you will see errors or erroneous data.

CData Drivers
As of v2018.2+, Exago allows for additional data source types through CData ADO.NET drivers. For more information, see the article on
CData Drivers.

Assembly Data Sources
Exago BI supports the ability to retrieve data from .NET assemblies. Assembly Data Sources (ADS) are custom programmatic .NET
Framework binaries for transforming and exposing arbitrary data in a format that can be read by Exago BI.
ADS can be used as data connectors and drivers for unconventional data sources. They can also be used as ETL (Extract, Transform,
Load) layers for processing, combining, and caching data before it reaches the reporting engine. This article describes how to write custom
.NET ADS for Exago BI.
ADS must be written for and compiled with supported versions of the .NET Framework.The ADS must be compiled as a class library
(.dll).

Interface
ADS must be coded to fit the following interface.
The entry point or points for Exago BI are public static methods, which accept at least an integer Call Type parameter and return an
ADO.NET System.Data.DataSet object. The Call Type parameter name must be defined in the Programmable Object Settings of
the Admin Console.

Parameter names defined in the Admin Console
Note
Although the return type is a DataSet, each ADS method is expected to return only a single data table. This is usually done by merging
in a System.Data.DataTable object which has a schema and has been populated with data. If a DataSet with multiple tables is
returned, only the first one will be recognized.
Entry methods can optionally accept some or all other parameters described in the Programmable Object Settings, in order to have
additional context for the method call. All the parameters in use must have defined names in the Admin Console.
As of v2016.2+, entry methods may also access a WebReports.Api.Common SessionInfo object. This contains the active
session's configuration settings and references to the active API objects. It can be used to identify properties as well as mutate session
state. An assembly reference to bin\WebReportsApi.dll is required for the SessionInfo class definition.

Method Examples
Considering the following parameter names defined in the configuration:
Call Type Parameter Name: CallType
Column Parameter Name: Columns
Filter Parameter Name: Filter
The following are valid entry method signatures:
public static DataSet Method(int CallType)
public static DataSet Method(int CallType, string Columns, string Filter)
public static DataSet Method(int CallType, string Columns = "")
public static DataSet Method(SessionInfo Session, int CallType)
public static object Method(SessionInfo Session, object CallType)

There can be more than one entry method. Each public static method in the class will appear as a virtual table when adding the ADS data
model to the Admin Console.
Alternatively, one method can support multiple tables by incorporating the Object ID parameter, which passes the object ID as defined in
the configuration. See Handling Multiple Data Tables for details.

Additional Notes
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1. Methods cannot be overloaded, as it will be ambiguous which one Exago BI should use.
2. For security reasons, only the entry methods in the class should be marked as public, so that any other utility or misc methods are
not erroneously visible in the Admin Console.

Class Definition
The entry methods must reside within a public class (non-static) within a defined namespace. The class must be at the top level of the
namespace, not within another class. Its default constructor must be public (defining the constructor is optional).

Example
namespace AssemblyDataSource {
public class Tables {
public Tables() { ... } /* optional */
public static DataSet EntryMethod(...) {...}
}
}

Implementation
Each ADS query is a discrete atomic operation. While you may choose to have Exago BI cache the assembly in memory, the application
will not maintain a connection with it between queries. Unless you store application state on disk, queries will have no knowledge of each
other.
ADS method calls are synchronous, meaning that the main application thread will wait until the method returns before continuing.
Exago BI queries ADS for three distinct reasons:
Schema: The column/field names and data types. This is called whenever the schema needs to be retrieved (such as expanding a
category's fields in the ExpressView data pane) and the Schema Access Type is set to Datasource. The frequency of schema
calls can be significantly reduced by specifying a static schema for the ADS in the Column Metadata.
Data: The data values for the table. This is called whenever a report is executed.
Filter values: Data values for a single column, possibly filtered by an input string. This is called when values need to be populated
for a filter dropdown list.
Each type of query requires a different amount of information to be returned. The Programmable Data Object parameters are passed
alongside each query to indicate the information that Exago BI is expecting. With this in mind, you can write ADS with certain
optimizations to improve performance. It is highly recommended to use the Programmable Data Object parameters for this reason.
Note
If performance is a strict concern, consider that databases will almost always be more performant for large data sets than Assembly
Data Sources.
See Optimizing for Query Types for more details.

Data Format
Exago BI expects an ADO.NET DataSet object to be returned from the ADS method. A DataSet is an in-memory representation of a
relational data model.
Important
To return no data, for any reason, construct and return a DataSet with the schema and no rows. Sending null or an empty schema will
cause an exception to be thrown.
Exago BI reads only the first DataTable in a set, at index DataSet.Tables[0], regardless of the number of tables comprising the set.
To return multiple tables from an ADS, return a different DataSet depending on an input parameter or method name. See Handling
Multiple Data Tables for more information.
See DataSets, DataTables, and DataViews for the ADO.NET DataSet documentation.

Optimizing for Query Types
Avoid retrieving the full data set whenever possible. This is usually the most computationally intensive query task. A number of
Programmable Object Parameters are passed to the ADS in order to determine the amount of processing required for each query.

The ADS query types, what data they expect, and how the data is processed by Exago

Using the Call Type Parameter
Call Type is an integer parameter, with value 0 for a schema query, 1 for a data set query, and 2 for a filter values query.
Schema queries are expected to be quick, and do not require the actual data table. Returning a static schema is the most performant way
to handle this. Do not make the application wait to populate the full table.
Warning
It is highly recommended to set the Schema Access Type for the ADS to Metadata in order to eliminate schema queries to the data
source. This will significantly improve the responsiveness of the user interface.
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Filter values query a single data column, with a text filter applied to limit the number of values returned. Therefore this call type works best
with the Column and Filter parameters.

Column, Filter, and Full Filter Parameters
For data queries (Call Type 1), it is not strictly necessary to implement these parameters to filter the data in the ADS, because Exago BI
will filter the data regardless once it is returned to the application.

Supressing Application Filtering & Sorting v2018.1
You have the option to suppress the default application filtering and sorting of data returned for data queries. You can choose to filter and
sort in the ADS code instead, which allows for more control over the manner in which these processes are done.
To suppress application filtering and sorting for selected objects, set the Suppress Sort and Filter (Objects) setting in the Admin
Console to True for each object.
Note
Suppression will only occur for reports where the object is joined exclusively to zero or more programmable objects which also have
suppression enabled. In-memory processing such as advanced joins, special Cartesian processing, and sort and filter formulas will
override this setting and force application processing to occur.
Caution
Exago will not filter the dropdown values for filter values queries (Call Type 2) by default. It is highly recommended to apply filtering for
these queries in the ADS, to avoid inaccurate and potentially insecure behavior for the filter dropdown lists. Therefore, these parameters
should not be seen as optional for all but the most trivial applications.
The following table shows the parameter values for either data or filter values queries.
Call Type
Column
Filter
Full Filter

Sort

1
Data
List of requested column database names
"col1,col2,col3"

2
Filter values
Requested column database name
"col2"

Data object filter SQL
"(col1 = 'value') AND (tenantId = 'id')"

Filter dropdown value
"value"

Report filter SQL
"([obj].[col1] = 'value') AND ([obj].[tenantId] = 'id')"

Tenant and row-level filter SQL
"([obj].[tenantId] = 'id')"

Sort SQL
"col3 asc, col1 desc"

Sort SQL
"col3 asc, col1 desc"

Expected DataSet with requested columns, optionally filtered
Return

DataSet with single column, filtered

The Column parameter will give the list of fields necessary for a report execution (data query) or the field requested by a filter dropdown
(filter values query). It may be more performant to build the DataSet with only the requested columns.
Filtering for data queries is only required if the Suppress Sort and Filter setting (v2018.1+) is True. Otherwise Exago BI automatically
filters the data set in memory for data queries.
Note
In Exago v2018.2+, users will be able to filter by formulas, using the application's internal formula engine. It is impossible to handle
formula filters in an ADS code.
You must apply filtering for filter value queries.
What is a filter values query?
Several activities in the application involve querying a table for a list of values from a single field, possibly filtered by a user input string. This
occurs when users interact with filter dropdowns, so that they can view and select valid field data when creating report filters.

Example of interaction with a filter dropdown
Note
Report viewer and dashboard interactive filters are populated by the data query for the report execution, not by a separate filter values
query.
You can prevent this type of query entirely by setting the Admin Console >
Values setting to False.

General >

Filter Settings > Read Database for Filter

Note
It is not possible to implement Filter Dependencies in an ADS.
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Typing into a filter dropdown field causes it to return values filtered by the input text. This filtering must be done manually in the ADS for
two reasons:
1. Accuracy: Dropdown lists are not filtered by Exago BI, so typing to filter will be ineffective if not implemented manually.
2. Security: Row and column tenancy filters must be applied to the dropdown list so that users cannot view data values without
access rights.
The Column, Filter, Sort and Full Filter parameters must be combined together to generate the proper filtering. With Call Type 2, the
Column parameter contains the name of the requested data field, and the Filter parameter contains the input text. These can be
combined to generate the necessary SQL WHERE clause.
Example:
string SQL = string.Format("(CONVERT({0}, System.String) LIKE '%{1}%')", Columns, Filter);
// Note: DateTime columns should use a different comparison

The Full Filter parameter already contains the necessary tenancy SQL specified in the data object and active role settings, so this can be
easily added to the input filter SQL to create the full clause. Then apply it to the data set and return only the resulting rows.
As of v2019.1.11+ the Sort Parameter can be used to indicate in which direction the user is scrolling a filter dropdown. ASC indicates
scrolling down or DESC indicates scrolling up.
SQL += " AND " + FullFilter + Sort;
DataRow[] DropdownRows = FullTable.Select(SQL);
// Note: In a proper implementation be sure to sanitize the SQL before passing it to the db

Additional Considerations
DateTime comparisons should be handled in a different manner than with a LIKE operator.
Only distinct values are shown in the dropdown, so there is no need to use a DISTINCT clause in the SQL statement.
A maximum of 100 values are shown in the list. You can choose to implement a TOP 100 clause, if it would improve performance.
As of Exago BI v2017.3+, for database sources, end-users have the option of selecting, via a menu, whether their filter dropdown input
should apply a Starts With or Contains filter to the data field. This behavior cannot currently be implemented in an ADS, because the
value of this setting is not passed in a parameter.
As of v2017.3+, values are queried incrementally as the user scrolls the dropdown list, for supported sources. This is also not currently
supported by ADS.

Sort Parameter
It is only required to sort in an ADS if the Suppress Sort and Filter setting (v2018.1+) is set to True. Otherwise Exago BI automatically
sorts the data set in memory for data queries.
Note
Formula sorts use the application's internal formula engine. It is impossible to handle formula sorts in an ADS code.
Note:
The sort parameter is irrelevant for filter values queries. Filter values are always sorted in ascending order.

Handling Multiple Data Tables
There are two ways which an ADS can allow for multiple data tables to be returned as separate objects in the Exago BI data model. The
first involves using multiple entry methods. The second involves specifying table names in the metadata.

Multiple Methods
Separate tables can be implemented as separate entry methods within the ADS. This has several advantages. Each public method from a
source will appear as a "table" in the Admin Console when adding objects to the data model. Method names can describe the tables in a
self-documenting manner.
Example:
/* Public methods seen by Exago BI */
public static DataSet EmployeeTable(int call) { return GetTableData("Employee", call); }
public static DataSet ProductsTable(int call) { return GetTableData("Products", call); }
/* Common data retrieval method */
private static DataSet GetTableData(string tableName, int call) { ... }

However, this does not allow retrieval of previously undefined tables without editing the ADS and adding additional methods in support. So
for a database where objects are likely to be added, programmatic maintenance of the ADS will be required, which is not ideal.

Single Method with Parameters
The Data Category and Data Object ID parameters correspond to the user-input metadata fields Category and ID (respectively) in each
data object's properties in the Admin Console. The ID field, in particular, can accept arbitrary input without affecting the user interface.
So table names or identifiers can be defined in the ID field. Thus, one entry method can support multiple tables based on a conditional
string from the metadata. This allows an ADS to support a more dynamic data structure, since any subsequent tables can be added
simply by editing the metadata.
Example:
public static DataSet GetTableData(string objectId, int call)
{
switch (objectId)
{
case "Employee": { ... }
case "Products": { ... }
default: { throw ... }
}
}

However, adding metadata elements to the config can be error-prone, so ensure that admins always have the up-to-date mapping of IDs to
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tables.

Configuration
Once written, the following steps are taken for Exago BI to access the ADS.
1. Ensure that the assembly is in a location accessible by the IIS application pool user (and the Exago Scheduler service, if in use),
with read and execute permissions.
2. Add the ADS to the Admin Console data sources (with Type=Assembly) using the following connection string format:
assembly=\path\to\assembly.dll;class=Namespace.Class

3. Click the connection verification icon to verify that the assembly and class are accessible.
4. Define the method parameter names in the Programmable Object Settings.
5. Add the entry methods to the Admin Console data objects (the Automatic Data Discovery tool does not support ADS), then add
any relevant joins and metadata aliasing.

Maintenance
There are several notes to keep in mind when updating an ADS and/or updating Exago BI.

System Locks
The web server maintains a lock on the ADS file as long as it is running. Additionally, if using any classes in the
WebReports.Api.Scheduler namespace, or if there are any scheduled or cached reports that use the ADS, the scheduler services
will lock it as well.
When updating the ADS, the web server and schedulers will need to be disabled while the file is replaced. So it is generally not appropriate
to update an ADS in a live environment.

WebReportsApi.dll Version
If you are using SessionInfo or any other Exago .NET API classes, the ADS must be recompiled with the new version of the
WebReportsApi.dll assembly whenever Exago BI is updated.
Note
Utility libraries, such as SQLUtils.dll are updated less frequently than the main web application binaries. Even if only referencing utilities,
verify nevertheless that the ADS works without needing recompilation.

Example
The following example is provided for reference. While trivial, the example is fully working and demonstrates a typical ADS framework. It
can be freely used, extended, and redistributed for any custom implementation.
Download the example.

Data Objects
This article applies to the Admin Console >

Data >

Objects settings.

Data Objects are the tables, views, methods, stored procedures, functions and custom SQL made accessible from the Data Sources for
reports.

Create, Edit, Delete Data Objects
To add a new data object click

Objects in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
or to quickly add data objects, use the Automatic Database Discovery
To clone an object, right-click and select Clone from the context menu
To edit an object either:
double click it

tool

select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete an object either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new objects click the Apply or Okay buttons.

Data Object Properties
A data object has the following properties:

Name
Select the data source from the first dropdown. In the second drop-down select a data object. This field is required.
Note
This will display all the of the source’s tables, views, methods, stored procedures, and functions.

To add custom SQL click the Add Custom SQL
Objects.

icon next to the Data Sources dropdown. For more details see Custom SQL

Important
The name of data objects may not contain the following characters:
{ } [ ] , . %
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Alias
The user friendly name for the data object. The alias will be displayed to end-users. This field is required.
Important
An alias may not contain the following characters:
@ { } [ ] , . %

Unique Key Fields
The columns which uniquely identify a record in this data object. This field is required.

Category pre-2020.1
The folder used to group related data objects. A hierarchy can be created by using backslashes between names.
Northwind

Data objects in a single folder
Northwind\Employees

A hierarchy of data objects

ID
An application-wide unique identifer for the data object. IDs are required when creating multiple data objects with that have the same name
but come from distinct data sources. IDs can also be used to optimize Web Service and .NET Assembly calls. For more information see
Data Object IDs.
Note
By default all objects have an implicit object ID that is set behind-the-scenes. This field allows you to set the IDs explicitly. It is generally
recommended to set explicit IDs for all data objects. As of v2019.1.12, this field will display the implicit ID by default.

Parameters
Parameters that are passed to stored procedures, table functions, Web Services or .NET Assembly methods. Clicking in the drop-down
will bring up a menu. Click the Add button and select the parameter from the drop-down list. For more information see Stored
Procedures and Web Services & .NET Assemblies.
Parameter values are passed in the order in which they are listed in the data object. It is critical to ensure that the order is correct.

Tenant Columns
Specify which columns contain tenant information and link the parameters accordingly.
This setting is used to filter data when multiple users’ information is held within the same table or view, and a column holds information
identifying each user. Exago will only retrieve the rows where the column value matches the corresponding parameter.

Description
Provide an optional user-friendly description of this data object. When this object is hovered over in the
description text will pop up in a tooltip.

Data Fields Pane, the

Both plain-text can be added verbatim or a language file ID can be supplied. See Column Description v2016.3+ below for more information.

Column Metadata
Specify any columns that should not be filterable, visible, or that should be read as a specific data type. See Column Metadata for more
information.
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Schema Access Type
Specify how Exago should retrieve the schema for the data object. There are three possibilities:
Default — Follow the global Schema Access Type setting in Other Settings.
Datasource — Queries the data source for the schema.
Metadata — Reads the schema from the stored metadata.
Note
For more information see Retrieving Data Object Schemas.
As of v2019.1+, the Schema Access Type defaults to Metadata. The optimizations made to the configuration architecture in this version
alleviate the performance issues previously associated with loading large configuration files—metadata playing a primary role in increasing
configuration file size. Exago now strongly encourages the full use of metadata in combination with the new configuration optimizations as
this will reduce the frequency in which the application queries databases.
Note
For more information regarding the performance enhancements of v2019.1+, please see this article.

Filter Dropdown Object
Specify an alternative data object or custom SQL to be queried when a user clicks a filter value dropdown (for example in the Report
Designer's Filters dialog, the Filters pane of the Dashboard or ExpressView Designer)

Filter value dropdown in the Report Designer's Filters dialog
Important
The Filter Dropdown Object must have a column with the same name as each column in the main data objects or an error message
will be displayed to the user when clicking the dropdown.
To set a Filter Dropdown Object, choose a Data Source and then:
select a table or view from the dropdown on the right, or
click the Custom SQL icon to write custom SQL statements to retrieve filter values. Writing custom SQL for Filter Dropdown
Objects is the same as writing Custom SQL Data Objects.
To remove a Filter Dropdown object, click the Delete

icon.

For more information, review the Filter Dropdown Objects section at the bottom of this article.

Suppress Sort and Filter v2018.1+
If this object is a programmable object (Stored Procedure or .NET Assembly Method), select whether to suppress the application sorting
and filtering for report execution queries. Enable this if the programmable object uses Programmable Object parameters to do sorting
and filtering in code, as application processing would be redundant and unnecessary. This can allow for better performance for
programmable objects.
Note
If the application requires sorting/filtering in memory, it will not be suppressed. For instance, a report with this object has a cross-source
join, an advanced join, a Cartesian join, or a formula sort or filter. Multiple tables from the same programmable data object can be joined
with suppressed filtering & sorting if this setting is enabled for all of them.

Cloning Data Objects v2019.1+
As of v2019.1+, data objects may be cloned via the Admin Console. A cloned data object inherits all its base attributes from its parent
except its Alias and ID, which must be entered manually in order to create the clone.
To clone a data object, right-click it and select Clone.

Enter a new Alias and ID for the cloned object.

The cloned object will then appear in the Objects menu:
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Functionality of Cloned Data Objects
A cloned data object is linked to its parent object. Any changes made to a parent data object will be reflected in its clone.
Deleting the parent data object will also delete its linked clone.
Clones do not inherit joins from their parent objects. Joins need to be manually created between clones and other data objects.
Clones cannot be distinguished from other data objects within the report designers. There is no visual or functional difference
between a cloned data object and a normal object outside of the Admin Console.
A cloned data object cannot itself be cloned or duplicated.

Stored Procedures
Stored Procedures offer the ability to use high level code to modify the data set before it is sent to Exago.
For best performance, stored procedures should know what sorts and filters the user has set and whether to return the schema, a single
column, or the entire data set. To accomplish this:
Use the Call Type, Filter, Column and Sort Parameters in the Programmable Object Settings. These parameters will be passed
from Exago to identically named parameters in the Stored Procedure. It is highly recommended to use these parameters as they
can improve performance.
Additional parameters may be passed by setting them in the Data > Object > Parameters tab for the Data Object.
Important
As noted above in the Parameters section, parameter values are passed in the order in which they are listed. It is critical to ensure that
the order listed is correct.

Important Note for Microsoft SQL Server
SQL Server has an attribute called FMTONLY that must be handled by all stored procedures.
FMTONLY has two possible values:
ON: The stored procedure will only return the column schema. However all IF conditional statements are ignored and all of the code
will be executed. This setting will fail if the stored procedure contains any temp tables.
OFF: The stored procedure returns all of the data and the column schema. The stored procedure will correctly execute IF
conditions.
The ON setting will cause problems if there are IF conditions in the procedure; however, only using the OFF setting will hurt performance if
the Call Type Parameter in the Programmable Object Settings is not used.
The following example demonstrates how to use the Call Type, Column, Filter and SortStr Parameters to improve efficiency.
As of v2019.1.11+ the Sort Parameter can be used to indicate in which direction the user is scrolling a filter dropdown. ASC indicates
scrolling down or DESC indicates scrolling up.
Note
For SQL Servers, FMTONLY is set to OFF.

ALTER PROCEDURE [dbo].[sp_webrpt_person]
@callType INT,
@columnStr varchar(1000),
@filterStr varchar(1000),
@fullFilterStr varchar(1000),
@sortStr varchar(1000)
AS
SET NOCOUNT ON /*for performance reasons */
SET FMTONLY OFF /*force procedure to return data and process IF conditions */
declare @sql varchar(2000)
declare @columnInfo varchar(1000)
declare @orderbyClause varchar(1000)
if @callType = 0 /*return schema; no need to return any rows */
begin
set @sql = 'select * from vw_webrpt_person where 0 = 1'
end
else
if @callType = 1 /*return all data for execution */
begin
set @orderbyClause = ''
if @sortStr is not NULL AND @sortStr <> 'null' set @orderbyClause = ' ORDER BY ' + @sortStr
set @sql = 'select' + @columnStr + ' from vw_webrpt_person where ' + @filterStr + @orderbyClause
end
else
if @callType = 2 /*return filter dropdown values; limit # rows to some value; sortStr will indicate which direction user is scrolling the dropdown*/
begin
set @orderByClause = ''
set @operator = ' >= '
if @sortStr is not NULL AND @sortStr <> 'null' AND @sortStr <> '' Begin SET @orderByClause = ' ORDER BY ' + @sortStr END
if (RIGHT(@sortStr, 4) = 'DESC')Begin SET @operator = ' <= 'END
set @columnInfo = '[' + @columnStr + ']'
SET @sql = 'select top 100 ' + @columnInfo + ' from Northwind.dbo.OrderDetails where ' + @columnInfo + @operator + @filterStr + ' AND ' + @fullFilterStr + @orderByClause
end
exec(@sql)ss

Table Value Functions
Table Value Functions can be used as data objects. Any available table value functions of a data source will be displayed in the
Extensions tab under Functions. Exago handles table value functions similar to views and tables except it will pass any parameters
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For more information, see Table-Valued Functions.

Custom SQL Objects
Exago can use custom SQL as data objects. Parameters can be embedded in these SQL statements to enable you to change the
statement at runtime.
To add or edit a Custom SQL Object click the Custom SQL

button and a dialog box will appear.

Data Object Name
The name of the data object to be displayed in the Administration Console.

Data Source
The data source that will be sent the SQL.

Parameter/Insert
Select the parameter you want to embed in the statements. Use the Add button to move the selected parameter into the SQL
statement where your cursor is located. Parameters may also be added manually between @ symbols (ex. @userId@).
Use the Test

button to verify that the SQL statement is correct.

Press Okay to save the SQL statement or Cancel to close the dialog without saving.

Data Object Macros
Macros can be embedded in Custom SQL Objects to make them even more dynamic. Each macro allows for different SQL to be used
according to the circumstances in which the data object is being called. Below are the details and examples of available macros.

IfExecuteMode
(string trueCondition, string falseCondition)
Description

Includes the trueCondition if a user is executing a report. Includes the falseCondition if
otherwise.

Example

SELECT * FROM vw_webrpt_optionee IfExecuteMode("WHERE [State] = 'CT'","")

IfExistReportDataObject
(string dataObjectName, string trueCondition, string falseCondition)
Description

Includes the trueCondition if dataObjectName exists inside the full Exago SQL statement
to the data source. Includes the falseCondition if otherwise.

Example

SELECT * FROM vw_webrpt_optionee IfExistReportDataObject("fn_webrpt_grant", "JOIN
ON fn_webrpt_grant...", "")

Column Metadata
Column metadata refers to the properties of each column in the data objects. Normally Exago gets the metadata for each column directly
from the data source, however, in some cases it may be helpful to override or add additional information to the metadata.
Note
Column metadata will override culture settings.
To modify the metadata of a column, double-click it or select it and click the

Add button.

Click the Read Schema button to quickly create column metadata for each column in the data object. Alternatively, as of v2019.1+,
metadata can be built in bulk across all of the existing data objects in a data source. For more information see the Building Metadata in
Bulk section below.
To remove metadata for a column, select it in the right panel and click the Delete Row

icon.

To save changes to Column Metadata, click the Okay button. To discard the changes, click the Cancel button.
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The following properties of each column can be modified:

Column Alias
The name of the data field that the end-users see.
Important
Column aliases may not contain the following characters:
{ } "

Column Description v2016.3+
Data fields can have description text added. If the data field is hovered over in a selection screen in the Report Designer, the description
text will pop up in a tooltip.

Plain Text
Tooltip text can be added verbatim in the Column Description field. In-line HTML tags like <b> can also be used if desired. Press Okay
when done, then Apply the change.

Language File

You can also add description elements to the language file, and reference them in the Column Description field.
In the language file, add new elements to the <AdminObjects> section using the following format:
<element id="uniqueIdentifier" tooltip="Description Text"></element>

HTML tags must be encoded like so:
Encode < as &lt;
Encode > as &gt;
Encode " as &quot;
For example, the following tooltip string encodes "<b>Description</b> Text", which displays as "Description Text."
<element id="uniqueIdentifier" tooltip="&lt;b&gt;Description&lt;/b&gt; Text"></element>

After adding the element to the language file, add the ID string to the Column Description field. Press Okay when done, then Apply the
change.

Data Type
The type of data Exago should treat the data field as any of the following valid types:
String
Date
Datetime
Time
Int
Decimal
Image
Float
Boolean
Guid
Currency

Filterable
Whether this field can be used to filter reports. The available options are:
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Important
To prevent users from attempting to build a filter in the Report Designer on an unsupported data type, Filterable should be set to None
if the column's data type is not one of the supported types in the Data Type section above.
Field

Used as a Report Filter
Yes, for the:
Advanced Report Designer
Express Report Designer
ExpressView Designer
Dashboard Designer
Scheduler

All (True)

Used as an Interactive Filter
Yes, for the:
Report Viewer

Yes, for the:
Dynamic (False)

No

Report Viewer

Yes, for the:
Static (v2017.1.2+)

Advanced Report Designer
Express Report Designer
ExpressView Designer
Dashboard Designer
Scheduler

None (v2017.1.2+) No

No

No

Note
This setting affects the availavbility of the column in the user interface. Filters may still be programatically added to reports with the API
regardless of the setting here.

Sortable v2016.3+
If set to False, the data field will not be listed in the Sorts menu.
Admins can now indicate whether data fields should appear in the Sorts menu using the Sortable dropdown.
Note
This toggle does not prevent data fields from being sorted by. Users can still enter the data fields manually as a formula, or use the data
fields within a sort formula.

Date Format String v2019.1+
The format of datetime data fields. Allows datetime data fields to be properly pulled out of generic string columns. Implemented in order to
support datetime metadata for vertical tables.

Visible
If set to False, the data field will not be listed for users.

Sort and Group-By Value v2016.3+
Specify a custom formula by which columns should be sorted and grouped by the application.
This field allows admins to specify how columns should be sorted and grouped by the application. By default, Exago will sort (and group)
columns based on the data in the column. You can use this metadata field to specify different data by which the column should be sorted.
Note
As of v2019.1.1+, Sort and Group-By Values are not honored when the data field is being used within a formula sort. This change was
made to prevent unexpected behavior from occurring in these instances.
For example, you may have a custom column Employees.FullName like the following:
{Employees.FirstName} & ' ' & {Employees.LastName}
By default, Exago would sort this field on the full string. You may want to sort on just the LastName, instead. In Sort and Group-By
Value, enter {Employees.LastName}, and the column will sort on LastName.
Another common example is sorting a Month field by the numeric representation of the month instead of the name. Since this value
accepts any valid Exago formula (except aggregates), custom functions can also be used.
Note
The Sort and Group-By Value field must have a one-to-one relationship with the data field. Otherwise, unexpected behavior could
occur.

Custom Columns v2016.3+
Custom Columns are a way to add columns to Exago that don't exist in the Data Source. This is completely transparent for the users;
they can then use them like any other column. New data columns can be created from composite or interpreted data fields. You could
even use a formula to create data from scratch. Admins often use custom columns to make popular formula sorts available on an
application-wide level.

Admin Console
To add a custom column using the Admin Console:
1. Expand the Data > Objects group and double-click on the desired data object, or select it and click the Edit icon.
2. In the Object panel that opens, in the Column Metadata field, click on the Edit Metadata icon at the end of the line to open
the Column Metadata dialog box.
3. Click the Add New button at the bottom left of the Column Metadata dialog box. Enter a name for the new column in the dialog
box.
4. Data Type, Column Alias, and Column Value are required fields, the others are optional.
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5. In the Column Value field, click the Formula Editor
icon to open the Formula Editor and define the data for the new column.
For example, to create a new Revenue column, you might enter the formula {OrderDetails.Quantity} *
{OrderDetails.UnitPrice}.
6. Click Okay when done, then click Apply to save the new column to the configuration.

Config File
To add a Custom Column by editing the config file, open the config file in a text or xml editor. Data Objects are <entity> elements.
Locate the desired entity and add a new <column_metadata> element:
<entity>
...
<column_metadata>
<col_source>ExagoFormula</col_source>
<col_name>FullName</col_name>
<col_type>string</col_type>
<col_alias>FullName</col_alias>
<col_description>First and Last Name</col_description>
<filterable>false</filterable>
<col_value>{Employees_0.FirstName} &amp; ' ' &amp; {Employees_0.LastName}</col_value>
<col_sortandgroupbyvalue>{Employees_0.LastName}</col_sortandgroupbyvalue>
</column_metadata>
</entity>

Note
Fields in bold are required.
<col_source>ExagoFormula</col_source> is static. This is the same for every <column_metadata>.
In <col_value> and <col_sortandgroupbyvalue>, data fields are identified by their ID, not their alias.
Acceptable values for <col_type>: string, date, datetime, time, int, decimal, image, float, boolean, guid, currency.
Save the config file when done, and restart the web server.

Examples:
There are a lot of options for what kinds of data fields you can create:
Transform or interpret an existing data field:
Right({Employees.SocialSecurityNumber},4)
Month({Orders.OrderDate})
Combine multiple data fields together:
{Employees.FirstName} & ' ' & {Employees.LastName}
Create new data from scratch:
Random(0,65536)
Uses a custom function
And much more!
Note
Custom columns cannot be used as filters or within aggregate formulas.

Retrieving Data Object Schema
Many of the dialogs throughout Exago require schema information such as column name, data type, filterable, sortable and vidible status,
sort-and-group-by value etc.... To enhance performance, schema information can be stored in the application as column metadata.
Exago can then read this metadata instead of querying the data source.
Note
While storing the schema as column metadata improves performance, updates to the column metadata will be required whenever
columns are added, removed, or re-titled.

Building Metadata in Bulk
As of v2019.1+, the use of full metadata is strongly encouraged. In combination with the configuration optimizations that may be
implemented in this version, the use of column metadata will reduce the frequency in which the databases are queried for schema
information. Furthermore, to make the process of adding metadata simpler, this information can now be built in bulk through the Admin
Console.
To build metadata in bulk, right-click a data object source under the

Objects menu and click Bulk Metadata.

Building metadata in bulk on the Northwind data source
Exago will then process the information for each data object under that data source and add metadata information for each field within
these objects. The Schema Access Type of each object will automatically be set to Metadata for each object.
A new Bulk Metadata tab will open in the Admin Console displaying the processing information.
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The metadata information that has been processed and added to each data object may then be edited or removed in the Column
Metadata menu.
Please note, however, that if metadata has not been added to or is not enabled for a data object, the following warning will appear next to
the data object in the Admin Console. This warning serves to further encourage the use of metadata and notify the system administrator
that this data object will query the database each time it requires schema information.

Building Metadata Manually
In versions prior to v2019.1, data sources are queried for schema information by default. This process, however, may cause performance
issues if the data sources take a considerable amount of time to return the schema. To avoid these performance issues, metadata may be
added manually via the Column Metadata menu.
For Exago to retrieve schema information from the metadata:
1. In Other Settings, set Schema Access Type to Metadata. This will force Exago to get all schema information from the metadata
for all data objects.
Note
Alternatively this setting can be overwritten for individual data objects by setting the Schema Access Type property.
2. For each data object open the Column Metadata menu.
1. Click the Read Schema button. A message will appear asking you to confirm you want to continue. Click Okay.
2. Click Okay to close the Column Metadata menu.
3. Press Okay or Apply to save the data objects.
Note
Other metadata options such as aliasing can still be utilized.

Data Object IDs
There are three ways in which you can utilize data object IDs.

Adding Multiple Data Objects with the Same Name
IDs are used distinguish data objects that have the same name but come from different data sources. When adding multiple data objects
with the same name, make sure each data object has a unique ID.

Avoiding Issues from Changes to Object Names
Providing IDs for all the data objects will avoid issues if the name of the underlying tables, views, or stored procedures, is changed.

Calling a Single Web Service/.NET Assembly/Stored Procedure
Web Services, .NET Assemblies and Stored Procedures comprise a group called Programmable Objects. These objects can retrieve
parameters from Exago and the host application in order to control what data is exposed to the user.
Generally for Web Services and .NET Assemblies each data object calls a distinct method. Similarly each Stored Procedure is its own
data object. By using data object IDs a single method/stored procedure can be called. This method can then return data or schema based
on the data object ID.
To call a single Web Service/.NET Assembly/Stored Procedure:
Provide a name for Data Object ID Parameter Name in Programmable Object Settings
Create a method/procedure in your Service/Assembly/Procedure that utilizes the object ID parameter to return the appropriate
data/schema.
For each data object:
Select
Object in the Main Menu and click the Add button
Select the single Service/Assembly/Procedure
Provide an Alias and an ID for the object
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Select the key columns
Click Okay or Apply to save the object.
Example: This stored procedure uses the object ID parameter (@objectID@) to return different data/schema information for different
object IDs.
ALTER PROCEDURE "dbo"." Exago_Example" @callType INT, @objectID nvarchar(max) AS
SET
NOCOUNT
ON
SET
FMTONLY OFF
if @objectID = 'Produce' begin
if @callType = 0
begin
ProductID,
ProductName,
SupplierID,
UnitPrice,
UnitsInStock
FROM
Products
WHERE
CategoryID = 1001
end
else if @callType = 1
begin
SELECT
ProductID,
ProductName,
SupplierID,
UnitPrice,
UnitsInStock
FROM
Products
ORDER BY
ProductID
end
else if @callType = 2
begin
SELECT
ProductID,
ProductName,
SupplierID,
UnitPrice,
UnitsInStock
FROM
Products
ORDER BY
ProductID
end
end if @objectID = 'Orders0' begin
if @callType = 0
begin
SELECT
OrderID,
OrderDate,
RequiredDate,
ShippedDate,
CustomerID
FROM
Orders
WHERE
CustomerID = 0
end
else if @callType = 1
begin
SELECT
OrderID,
OrderDate,
RequiredDate,
ShippedDate,
CustomerID
FROM
Orders
ORDER BY
OrderID
end
else if @callType = 2
begin
SELECT
OrderID,
OrderDate,
RequiredDate,
ShippedDate,
CustomerID
FROM
Orders
ORDER BY
OrderID
end
end

SELECT

Reading Images from a Database
Exago can read images from a database and load them directly into a cell of a report. When images are stored in a database as a binary
string there are two ways that Exago can load them into a report.
1. Change Column Metadata
1. Open the Column Metadata menu and for the image column set Data Type to Image.
2. Place the data field containing the images into the desired cell of a report. Upon execution the images will be loaded into the
cell.
2. Without changing Column Metadata
1. Place the data field that contains the images into the LoadImage function. Upon execution Exago will interpret the binary and
load the images into the cell.

Filter Dropdown Objects
The Filter Dropdown Object overrides the source of values that populate a filter value dropdown in the user interface (e.g. in a
prompting filter dialog; in the Filters dialog in the Report, Dashboard or ExpressView Designer; in the Dashboard or Report Viewer).
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A variety of filter value dropdowns as displayed in the Dashboard Viewer; ExpressView Filters pane and the Simple Filter
Window of the Report Viewer
By default, filter value dropdowns populate with data from their corresponding data object. Explicitly defining a Filter Dropdown Object in
the configuration allows those default values to be replaced by another table, view or by custom SQL statements. This substitution
happens transparently to the end user.
Specifying a Filter Dropdown Object may be most useful when the corresponding data object is a Stored Procedure, Web Service, or
.NET Assembly that takes more than a few seconds to return data, as this can adversely affect user experience. Filter Dropdown Objects
may also be useful when explicitly controlling filter values available to end users is desired (see Caution below).
Note
Using a Filter Dropdown Object requires General > Filter Settings > Read Database for Filter Values to be True.
Filter Dropdown Objects may reference Data Sources other than their corresponding data object but there must be an identical column
in the source data object and the Filter Dropdown Object.
For example, consider the Orders and OrderDetails tables of the Northwind sample data set. If the Orders table is used as the Filter
Dropdown Object for the OrderDetails table, and a filter is created on the OrderId field, the Filter Dropdown Object will work since
both tables contain an integer typeOrderId field.

Setting
Filter Dropdown Object for Northwind.OrderDetails table
Although not obvious in the figure, the order ID numbers (e.g. 10248, 10249, 10250) in the ExpressView filter dropdown below are read from
the Orders table since it is the Filter Dropdown Object for OrderDetails.
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On the contrary, there is no Quantity column in the Orders table. When attempting to filter on OrderDetails.Quantity, an error
message will be displayed to the end user.

To prevent users from filtering on fields that are not available in the Filter Dropdown Object, set the Filterable property in the Filter
Dropdown Object's Column Metadata to False. Note that this will prevent all filtering on that field through the user interface. Filters on the
column may still be added via one of the APIs.
Caution
Filter Dropdown Objects will completely replace the available filter dropdown values for their corresponding data object. If the Filter
Dropdown Object has less or more values than its corresponding data object, users may not be able to filter on all possible values or be
able to select values that do not correlate with records in the corresponding object.

The figure below demonstrates a less than ideal Filter Dropdown Object—the object only contains three Order IDs despite there being
many more in the OrderDetails table, as well as an Order ID that does not exist in the OrderDetails table (i.e. 9999999). A user
would only be able to filter by order ID 10248 or 10249.

Additional Resources
Admin Support Lab — Filters, segment on Filter Dropdown objects runs from 14:05–20:15.

Automatic Database Discovery
This article applies to the Admin Console >

Data >

Sources settings.

Automatic Database Discovery enables you to quickly and easily add many Data Objects and Joins from a single Data Source.
Discovery can only be performed on the following database types: mssql, oracle, mysql, postgresql, db2, and Informix.
Note
Automatic Database Discovery is not supported for ODBC data sources.

To start using Automatic Database Discovery, select a Data Source from the list and click the Discover Database Metadata
the top of the main menu. This will open a discovery tab for the Data Source.

icon at

Automatic Database Discovery tab
In the discovery tab you can:
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1. Select the Tables, Views, Functions, and Stored Procedures you would like to add by either:
checking individual item checkboxes
clicking Select All Complete Objects to select only those objects with unique key values already defined
clicking Select All Objects to select all data objects regardless of whether or not unique key values are defined
Table A — Icons
Icon
Description
This object has identified unique key values
This object has associated joins
This object is incomplete
2. Add Unique Key fields by right-clicking on an object and selecting Add/Edit Primary Key Info.
3. Check Preview Only and then Add Objects to preview the selected objects and joins.
4. Uncheck Preview Only and then add the selected Data Objects to the system by clicking Add Objects or Add Objects and
Joins to add the selected objects and any associated joins.
Note
If any selected Objects are missing unique key values they can be completed individually in a new tab which will open entitled
Incomplete Objects.

Customizing Data Discovery SQL v2016.3.6+
The SQL statements used for Automatic Database Discovery can be customized if necessary, in order to accommodate non-standard key
names.
To customize the discovery SQL:
1. Refer to Managing the dbconfigs.json File for the location of the file to edit. Follow the instructions in the Overriding dbconfigs
Information section to correctly override the default behavior depending on your version of Exago.
2. Locate the property for your data source type and edit the SQL for either or both primary and foreign keys.
3. Save the file, then run Database Discovery to see your changes.

Join Configuration
This article applies to the Admin Console >

Data >

Joins settings.

Joins specify to Exago the relationship between Data Objects.
All existing Joins are listed in the Main Menu under Data. All the joins you are adding or editing will be displayed in a tab entitled Joins.

Create, Edit, Delete Joins
To add a new join click

Joins in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
or to quickly add data joins, use the Automatic Database Discovery
To edit a join either:
double click it

tool

select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
Important
Review the Modifying Joins section below when making changes to joins in the Admin Console.
To delete a join either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new joins click the Apply or Okay buttons.

Join Properties
Every join has the following properties:

From Object
The first Data Object you would like to join.

To Object
The other Data Object you would like to join.
The order of the Data Objects is important if you have a one-to-many relation type or a Left/Right Outer Join type. See below for
details.

Join Column(s)
Specify the field(s) of each Data Object that must match to join an entity in the From Object to an entity(s) in the To Object.

Join Type
Specify whether rows from either Data Object that do not have a match should or should not be included.
Inner: only includes rows of the From Object that have a match in the To Object and vice versa.
Left Outer: includes rows of the From Object that do not have a match in the To Object but not vice versa.
Right Outer: includes rows of the To Object that do not have a match in the From Object but not vice versa.
Full Outer: includes rows in either Data Object that do not have a match.
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Relationship Type
Specify if the join type is one-to-one or one-to-many.
One-to-One: Each row in the 'From Object' can join to at most one row from the 'To Object'.
One-to-Many: Each row in the 'From Object' can join to any number of rows from the 'To Object'.

Weight
Give a join weight in order to set its precedence when multiple join paths exist between Data Objects. The path with the higher weight will
be utilized.
A report contains three Data Objects ‘Students’, ‘Professors’ and ‘Comp Sci 101.’ Students is joined to ‘Professors’ and ‘Comp Sci
101.’ Additionally ‘Professors’ is joined to ‘Comp Sci 101.’ There are two available join paths between ‘Students’ and ‘Comp Sci
101.’ Adding weight to a join will clarify which of the two paths Exago should use.

Modifying Joins
Although joins are created in the Administration Console, they are saved within each individual report. For Join changes in the
Administration Console to take effect, edit the report and use the ‘Recreate’ button in the Advanced Options menu. For instructions on how
to access the Advanced Options please see Advanced Report Designer: Advanced Options.
Important
It is important to make sure that all of the joins are set to your desired specifications in the Administration Console before you begin
building numerous reports.

Note About Cross Source Joins
Data Objects from different Data Sources can be joined in Exago. Because the Data Objects come from distinct data sources they must
be joined through code by Exago.
Important
Though Exago strives for efficiency, this process may be memory intensive for large data sets.

Parameters
This article applies to the Admin Console >

Data >

Parameters settings.

Parameters are used throughout the Exago application to store values. Although parameters can be created and given a default value in
the Administration Console, parameters are designed to be set at runtime through the API.
Parameters can be used to:
Pass values to Web Services, .NET Assemblies, or custom SQL Data Objects.
Important
Parameter values are passed in the order in which they are listed in a data object. It is critical to ensure that the order is correct. For
more information please see the Data Objects article.
Set tenant values to assure security in a multi-tenant environment. For more information see Data Objects.
Pass values into cells and formulas of a report. To display a non-hidden parameter in a cell type "=@ParameterName@".
Pass values into custom functions. For more information see Custom Functions.
Create a custom dropdown list of values for user selection on a report prompt.

Create, Edit, Delete Parameters
All existing parameters are listed in the Admin Console Main Menu under Data. All the parameters that are added or edited will be
displayed in a tab entitled Parameters.
To add a new parameter click

Parameters in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit a parameter either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete a parameter either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new parameters click the Apply or Okay buttons.
Note
Currently, the prompt window will not appear when drilling down into a child report that contains prompting parameters. However, this can
be partially bypassed by adding the prompting parameter in a hidden cell on the parent report so that the user will be prompted at
execution for the parameter value.

Parameter Properties
Each Parameter has the following properties:
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Name
A name for the parameter. Prompting parameters are sorted alphabetically by name unless otherwise specified or unless there are
dropdown parameters with dependencies.
The following characters are not allowed: @ , . { } [ ]
The following names are reserved by the application: filter, email, userId, companyId, reportName, reportFullName,
pageNumber, data_label, data_value, series_label, bubble_size, bubble_value, batch_x (where x can be any
string of characters).
Important
Parameter names are case sensitive.

Type
The parameter data type. The following types are available:
string
date
integer
decimal
boolean (v2019.1+)
Note
Select date for DateTimes and string for functions.

Value
The default value of a parameter. This is intended to be overwritten at runtime through the API.
Date values should be entered in yyyy-MM-dd format.
Null values may also be passed to parameters. In order to do so, the default value of the parameter needs to be set to {null}. This will
allow parameters to process any null values that are passed through the API or application at runtime.
Formulas as Default Parameter Values
Formulas that return strings, integers, dates or decimals may also be passed as parameter default values. Just as entering a function into
a cell in the Report Designer, include an equals sign as a prefix (e.g. =QuarterNumber(Today())).
Formulas may include multiple functions. As with other functions, these may also include other parameters.
Caution
The Admin Console will only allow String, Decimal or Integer Type parameters to have a formula as their default Value. If you need the
Date type, select String in the Admin Console, enter the formula into the Value field and then manually edit the XML configuration file to
choose the desired data type.
Examples
1. This parameter as defined in the XML configuration file is date type and by default will return the value of the Today() function, which is
today's date.
<parameter>
<id>DateChoose</id>
<data_type>date</data_type>
<value>=Today()</value>
<hidden>False</hidden>
<prompt_text>Choose a date</prompt_text>
</parameter>

2. This parameter defined in the Admin Console returns a string with an employee's name. The employee's name is decided based on the
year of the current date.

3. This parameter defined in the Admin Console returns a decimal with the future value of an asset multiplied by 2.

Hidden
Set hidden to True to disable this parameter from being used by users in cells and formulas.

Prompt Text
Give non-hidden parameters a prompt text to query the user for a value at the time of report execution. Leave blank to use the default value.
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Parameter Dropdown Object
Optional data object for populating the parameter as a drop-down selection list. Only applicable with prompting parameters. Commonly
used in conjunction with programmable data objects (such as stored procedures).

Stored Procedure Parameters
A list of preexisting Exago parameters to be used as variables for a selected stored procedure.

Value Field
A column from the data object or custom SQL that sets that actual value of the parameter at runtime. This represents a set of values that
are not displayed to the end user but are instead used when parameter values are required in custom SQL or stored procedures, or other
server side processing.

Display Value Field
A column from the data object or custom SQL that sets the display value of the parameter for the dropdown selector. This represents the
set of values that should be presented to the end user when they are executing or scheduling a report.

Display Type
The display value data type.

Report-Level Parameters v2019.1.3+
Report builders can define their own parameters on the report-level. These parameters function identically to parameters existing on the
system-level and may be used within filters, functions, and so on within the report. Parameters defined in this way are only accessible
within the report that they are created on. For more information, please see the Report-Level Parameters section of the Advanced
Options article.
Important
Report-level parameters cannot be used in report-level Custom SQL Objects
This feature is enabled by default and can be disabled by setting Show Report-Level Parameters Window to False. This setting is
located in the Feature/UI Settings section of the Admin Console.

Modifying Report-Level Parameters via the .NET API
To modify existing report-level parameters:
1.
2.
3.
4.

Load the report that the parameter is defined on.
Iterate through the parameters collection to find the parameter.
Finally, adjust the required values of the parameter
Save it back to the API.

Note
Currently, report-level parameters cannot be loaded or modified via the JavaScript API.

Example
ReportObject report = (ReportObject)api.ReportObjectFactory.LoadFromRepository(@"Reports\Sales Reports");
report.Parameters.Find(x => x.Id == "SalesQuota").Value = "1500";
api.ReportObjectFactory.SaveToApi(report);

Parameter Support for Dashboard URL Tiles
A new feature of Exago BI v2017.3 is the ability to use parameters in dashboard URL tiles. Dashboard reports intended for use by
multiple classes of users can implement URL tiles that change based on user variables.

URL tile with parameter values
Parameters are key-value pairs that are reachable from the Exago API, application extensibility, and, optionally, the user interface.
They are intended to be instantiated via the API at session initialization, the value of which are set depending on the user accessing the
session. They can either be created in the API or created in the config file or Admin Console and modified in the API.
Note. Parameters must have the Hidden property set to False in order to be usable in the application user interface. Date type
parameters cannot be used in URL tiles.

Setting a parameter's Hidden property to False in the Admin Console
If the Prompt Text property is set on a URL tile parameter, users will be prompted to set its value when they run the dashboard.
Note. Dashboard URL tiles cannot be modified after the dashboard is run. Prompting URL parameters cannot be made accessible in the
Interactive Parameters pane.
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URL formatting
Parameters may be utilized anywhere within a URL string.

Example
http://@address@.com
http://example.@domain@
http://@subdomain@.example.com
http://example.com/@path@
@protocol@://example.com
http://example.com:@port@
http://example.com?@key@=value
http://example.com?key=@value@
http://example.com#@fragment@

It is recommended that spaces and other special characters are URL-encoded where appropriate. For example, to pass "Hello World" as
part of a URL query string, encode the space between the two words as "%20%". This will not be done automatically.
http://example.com?key=Hello%20World

For more information, see Percent-encoding (Wikipedia)

Roles
This article applies to the Admin Console >

Roles settings.

This article explains how to use the Roles to control access to data and override the General Settings.

Create, Edit, Delete Roles
To add a new role click

Roles in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit a role either:
double click it
select it, expand the sections (Main, General, Folders, Objects or Filters) and click the Edit
menu
To delete a role either:

icon at the top of the main

select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new joins click the Apply or Okay buttons.
The Role that is currently active will be highlighted under the Roles menu of the Admin Console.

User is the currently active role

About Roles
Roles are created to specify how a user or group of users interfaces with Exago. Roles can restrict access to folders or data objects.
Roles can also override the General Settings.
Note
Exago was designed to be an integrated reporting solution for other applications using the application’s own security and authentication
methods. Although you can create Roles through the Admin Console, Roles are typically created through the API to dynamically set a
user's access. For more information see the article regarding Integration and the sections regarding the various APIs.
Roles have five sections to control access: Main, General, Folders, Objects, and Filters.

Main Settings
The Main settings control the broad properties of the Role.

Id
A name for the role.

Include All Folders
If checked, all folders that are not listed in Folder Access will be available. If unchecked, only those listed in Folder Access will be
available.

All Folders Read Only
If checked, all folders that are not specified in Folder Access will be execute-only. If unchecked, only those specified in Folder Access
will be execute-only.

Allow Folder Management
If True, users will be able to create root and sub folders, rename folders and delete folders in the user interface. If False, users cannot take
action on folders and the Add Folder buttons are hidden from the user interface.
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Include All Data Objects
If checked, all Data Objects that are not listed in Objects Access will be available. If unchecked, only those listed in Objects Access will
be available.

General Settings
The General settings of a Role override the global General Settings. Utilize the API in order to overwrite additional settings for a user or
group of users.

The following settings can be overwritten:

Report Path pre-v2020.1
The parent folder for all reports. The Report Path can be:
Virtual Path
Absolute Path: Used to provide increased security (ex. C:\Reports)
Web Service URL or .NET Assembly: Using a Web Service or .NET Assembly allows reports and folders to be managed in a
database. For more information see Report Folder Storage & Management.
A Web Service should be formatted as ‘url=http://WebServiceUrl.asmx’. A .NET Assembly should be formatted as ‘assembly
= AssemblyFullPath.dll;class-Namespace.ClassName’.

Date Format
The format of date values. Can be any .NET standard (ex. MM/dd/yyyy). If left blank, this setting will inherit the environmental settings.

Time Format
The format of time values. Can be any .NET standard (ex. h:mm:ss tt). If left blank, this setting will inherit the environmental settings.

Date Time Format
The format of date-time values. May be any .NET standard (ex. M/d/yy h:mm tt). If left blank, this setting will inherit the environmental
settings.
Note
For more details on .NET Date, Time and DateTime Format Strings please reference the Microsoft document here.

Numeric Separator Symbol
Symbol used to separate 3 digit groups (ex. thousandths) in numeric values. The default is ‘,’.

Numeric Currency Symbol
Symbol prepended to numeric values to represent currency. The default is ‘$’.

Numeric Decimal Symbol
Symbol used for numeric decimal values. The default is a period (.).

Server Time Zone Offset
Value that is used to convert server to client time (the negation is used to convert client to server time). If left blank, this setting will use
server time or an External Interface to calculate value.

Time Zone Name v2019.1+
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Default geopolitical location of the client as determined by the IANA time zone database (e.g., America/New_York). Utilized by Exago to
properly combat scheduling issues centering around DST and other non-linear time zone conflicts. An External Interface may also be
used to calculate time zone values.

Show HTML Export Grid Lines
Sets the default value for the HTML output option Show Grid. This can be modified in the Options Menu of the Report Designer.

Show Crosstab Reports
Displays/Hides the Crosstab Report Wizard and Insert Crosstab button in the Report Designer.

Show Express Reports pre-v2019.2
Displays/Hides the Express Report Wizard.

Show Styling Toolbar pre-v2019.2
Displays/Hides the styling tools in the Layout tab of the Express Report Wizard.

Show Themes pre-v2019.2
Displays/Hides the Theme drop-down in the Layout tab of the Express Report Wizard.

Show Grouping pre-v2019.2
Displays/Hides the grouping tools in the Layout tab of the Express Report Wizard.

Show Formula Button pre-v2019.2
Displays/Hides the Formula Editor button in the Layout tab of the Express Report Wizard.

Show Advanced Reports
Displays/Hides the Advanced Report Wizard and Report Designer.
Note
If Show Advanced Reports is False then attempts to edit Advanced or Crosstab reports will cause an ‘access denied’ message.
Additionally, if False, users will not be able to create CrossTab reports.

Database Timeout
Maximum number of seconds for a single query to run.
Caution
This value is passed on to the data source driver when the report is executed. Each data source driver, data source or individual database
may interpret this setting slightly differently. Consult the official product documentation associated with your data source implementation
for complete details how this setting will impact your environment.
Note
This setting will also control the maximum number of seconds that a Web Service API method can run. If set to 0 the Web Service API
time out will be infinite.

Read Database for Filter Values
Enable/Disables filter drop-downs to contain values from the database. Set to False only if retrieving values for the drop-down will take more
than a couple of seconds.

Show Report Scheduling Option
Displays/Hides the scheduler icon on the Main Menu. Set to False to disable users from creating scheduled reports.

Show Email Report Options
Displays/Hides the email report icon on the Main Menu. Set to False to disable users from emailing reports.

Show Schedule Manager
Displays/Hides the scheduler manager icon on the Main Menu. Set to False to disable users from editing existing schedules.

Scheduler Manager User View Level
Controls what information each user can see in the Schedule Manager. These levels utilize the Parameters companyId and userId. There
are three possible values:
Current User: Can only view and delete report jobs that have been created by that user.
All Users in Current Company: User can only view and delete report schedules for their company.
All Users in All Companies: User can view and delete report schedules for all companies (administrator).

Allow Creation of Custom SQL Objects in Advanced Reports v2018.1+)
Allow this role to create and execute reports with report-level custom SQL objects.

Folder Access
The Folder Access controls which report folders are visible and executable for the Role.

101 of 215

Custom Functions

Technical Guide

Note
If Include All Folders is checked this list will deny access to the folders added. If unchecked, the list will allow access to the folders
added. If All Folders Read Only is checked this list will overwrite the setting when a folder is added without the 'Read Only' option
checked.
To add a folder to the list:
1. Click the Add button.
2. Click in the Folder Name column and select the folder you want to add.
3. To make the folder execute only check the box in the Read Only column.
To delete a folder click the Delete

icon at the end of the row.

Objects Access
The Objects Access controls which data objects are accessible to the Role. A report can only be executed if the Role has access to all
the data Objects on the report.

Note
If Include All Data Objects is checked this list will deny access to the data objects added. If unchecked the list will allow access to the
data objects added.
To add a data object click the

Add button.

Click in the Data Object Name column and select the object you want to add.
To delete an object click the Delete

icon at the end of the row.

Allow User to View Report-Level Custom SQL Objects v2018.1+
If Allow Creation of Custom SQL Objects in Advanced Reports is False, enable this setting to allow this role to run reports with reportlevel custom SQL objects. (Otherwise users will receive an "Access Denied" message when running such reports).

Filters Access
Filter Access provides a means to filter a Data Object by Role. Filters can be added to data objects so that users can only view specific
rows in the data object. To set row-based tenancy in Exago:

1. To add a filter click the Add button.
2. Select the Data Object Name from the dropdown.
Important
A Data Object may only appear in the list once. Adding the same Data Object multiple times is not allowed and will return an error
message, "Please address the following errors before saving: Filters table contains the same object in multiple rows."
3. Enter the Filter String. The filter string should be valid, standard SQL to be added to the 'WHERE' clause sent to the Data Source.
This filter string can include Exago system parameters (e.g. @userId@) or custom SQL including subqueries (e.g. IN (SELECT
EmployeeID FROM Employees WHERE EmployeeID <4)). The Filter String must contain the actual name of objects in the
Data Source (e.g. tables, views, columns, etc...) rather than their Exago aliases.
To delete a filter click the Delete

icon at the end of the row.

Custom Functions
This article applies to the Admin Console >

Extensions >

Functions settings.

Exago comes with a number of functions that can be used to make formulas in the Formula Editor. Administrators may create additional
custom functions using high level coding languages which will be accessible to end-users of the Report Designer. Functions can be
added to a preexisting folder or a function can be put into a new custom folder.
Custom Functions can be written in C#, VB.NET, or JavaScript (Windows only). Functions can take as many input arguments as needed.
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Functions can get and set elements of the current session state of Exago such as Parameter values. See SessionInfo for more
information.

Create, Edit, Delete, Restore Custom Functions
To add a new custom function click

Extensions >

Functions in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit a function either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete an object either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To restore the default custom functions that come with the application either:
right-click Extensions > Functions in the Main Menu and select Restore All Formula Functions from the context
menu
General > Filter Settings > Restore All Default Formula Functions and click on the Restore button.
To save changes and new functions click the Apply or Okay buttons

Custom Function Properties
Each Custom Function has the following properties.

Name
A name for the function that will be displayed to the end users. Required.

Description
A description of the function that will be displayed to the end users.
Note
To support multi-language functionality, you can supply an Id from a language file instead of a static string. For more information, see
Multi-Language Support.
Note
Arguments are passed to the code as an array of generic objects, accessed as args[ ].

Category
A way of grouping similar functions. You can assign custom functions to an existing Exago category or create a new category. To create a
new category, select Other. An input field entitled Specific Category Name will appear. Leaving this field blank will assign your function
to the Other category in the Exago Formula Editor. A non-empty value in this field will be new category with the specified name.
Note
To support multi-language functionality, you can supply an Id from a language file instead of a static string. For more information, see
Multi-Language Support.

Return Type v2018.2.6+
A return type must be specified for each Custom Function. This field can be defined as a String, Integer, Decimal, or Date, and determines
the expected return type of each function.

Prevent In-Database Grouping When Included in Detail Section v2019.1.5+
You may use this flag to specify whether this function has side-effects and should disqualify including reports from aggregating in the
database (thus skipping the function when in a suppressed Detail section). For example, most functions that build or manipulate memory
storage with Get/SetStoredValue should have this flag set to true.

Language
The high-level language of the code for the function. Can be C# or VB.NET, or JavaScript (Windows only).

References
A semicolon-separated list of any DLLs that need to be referenced by the Custom Function. The DLLs must be present in the \bin folder
of the Exago Web Application, Scheduler Services, and the Web Service API if applicable. This folder can be found in the installation
directory of the respective component.
Tip
System.dll does not need to be listed as a reference as it is already available.

Namespaces
A semicolon-separate list of any namespaces that need to be referenced by the Custom Function.

Program Code
The program code for your Custom Function. Press the green check mark to verify the code executes properly. Required.
Note
To use a .NET Assembly for custom functions, first add it to the applicable \bin folders. Then add the assembly as a reference in the
Custom Code window, and invoke the method, e.g., return Extensions.Functions.DayBefore(args);.
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Arguments
Starting with version v2017.2 there are several enhancements to the way function arguments are implemented and used. See Formula
Editor for details on how argument and function information will appear for end-users.
Click Edit Argument Info to show a dialog for managing arguments. Then click Add Argument for each argument the function will have.
Arguments have the following properties:

Name
The name of the argument, which will appear as a placeholder in the function parentheses and in the function's description tooltip.

Description
A description for what the argument is used for. You should mention the expected data type, if it is not obvious. This will appear in a tooltip
when the placeholder name is selected.
Can also be a language file ID.

Optional
Whether this argument is required or optional. Optional arguments are surrounded by brackets [ ] in the function's description tooltip.

Variable Argument Count
If selected, the last argument in the list accepts more than one value. Variable arguments are followed by an ellipsis (...) in the function's
description tooltip.

Exago Session Info
Custom Functions can access the Exago session state through a "sessionInfo" object. Access to sessionInfo allows powerful new
capabilities such as the ability to persist values across function invocations, allowing each invocation to be aware of previous calls and
behave accordingly.
Note
sessionInfo can also be accessed in Server Events, Action Events, and Assembly Data Sources.

Properties
PageInfo
This is the parent of all information in the current session. Included is the active Report and SetupData objects.
Note
Since the Report and SetupData objects are accessed frequently, direct pointers are included for these objects.

Report
An object that contains all of the report’s Data Object, sort, filter, and layout information.

SetupData
An object that contains all of the session’s configuration setting including Filters, Parameters, Data Objects, Joins, Roles, etc.

CompanyId
A direct pointer to the companyId Parameter value.

UserId
A direct poitner to the userId Parameter value.

Methods
GetReportExecuteHtml(string reportName)
A method that executes the specified report and returns its html output. This could be used to embed a report within a cell of another
report.
Note
The reportName is relative to the session’s report path.

GetParameter(string parameterName)
A method that returns the specified Parameter Object. 'GetParameter' first looks in the Report Parameter collection, parameters being
utilized by the report, and then in the Config Parameter collection, as well as other parameters such as hidden parameters or multi-tenant
values.

GetReportParameter(string parameterName)
A method that returns the specified Parameter object that is utilized by the report being executed.
E.g. If a parameter is prompting a user for a value it will be available with the prompted value.

GetConfigParameter(string parameterName)
A method that returns the parameter object stored in the default configuration.
E.g. Any parameter that is not being utilized by the report being executed.

WriteLog(string text)
A method that writes the specified text to the Exago log file.
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Note
The following methods utilize Stored Values which are objects that can be created and set by custom functions during report execution
to pass data between custom function calls. Stored Values only exist for the duration of report execution.

GetStoredValue(string valueName, [object initialValue = null])
A method that retrieves a Stored Value. If a there is no Stored Value with the specified valueName, then one will be created with the
specified initialValue.

SetStoredValue(string valueName, object newValue)
A method that sets the value of a Stored Value. Passing 'null' to newValue will delete the Stored Value.

Calling Exago Functions
Cases may arise where you want to call an existing function within your Custom Function. Using the class CellFormula and returning the
method CellFormula.Evaluate().

Default Custom Functions v2017.2+
Starting with v2017.2, Exago BI ships with several built-in custom functions. These are functions that are common in many reporting
environments, but the manner in which they work may be different depending on locality, time zone, or other factors. For this reason, these
functions have been exposed in the Admin Console so that administrators may change how they work.
Note
If these functions are unavailable, such after an upgrade, in the Admin Console navigate to General > Filter Settings > Restore All
Default Formula Functions and click on the Restore button.
The following custom functions ship with Exago BI:

MonthName
Description

Given a date value, returns the name of the month of that date. The month name is retrieved from the
active language dictionary. For example, given the date "01/01/2017", MonthName() will return
"January" in an English-speaking environment, and "Enero" in a Spanish-speaking environment.

Arguments

inputDateOrNumber: A formatted date string, a Date or DateTime value, or an integer value.
Required.

References

mscorlib.dll
These examples are in an English-speaking environment:
MonthName("02/29/2020")
February

Example

MonthName(3)
March
MonthName(1989-07-06 22:19:21)
July

QuarterName
Description

Arguments

Given a date value, returns the fiscal quarter of the date, as "Q1", "Q2", "Q3", or "Q4". By default, Q1
encompasses January 01 - March 31, Q2 encompasses April 01 - June 30, Q3 encompasses July 01 Sept 30, and Q4 encompasses Oct 01 - Dec 31. But since different countries or financial landscapes
may use different systems of quarters, the behavior of the function is exposed and customizable.
inputDate: A formatted date string, Date value, or DateTime value. Required.
QuarterName("02/29/2020")
Q1

Example
QuarterName(1989-07-06 22:19:21)
Q3

QuarterNumber
Description

Arguments

Given a date value, returns the fiscal quarter of the date, as "1", "2", "3", or "4". By default, Q1
encompasses January 01 - March 31, Q2 encompasses April 01 - June 30, Q3 encompasses July 01 Sept 30, and Q4 encompasses Oct 01 - Dec 31. But since different countries or financial landscapes
may use different systems of quarters, the behavior of the function is exposed and customizable.
inputDate: A formatted date string, Date value, or DateTime value. Required.
QuarterNumber("02/29/2020")
1

Example
QuarterNumber(1989-07-06 22:19:21)
3

Custom Filter Functions
This article applies to the Admin Console >

Extensions > Filter Functions settings.

Custom Filter Functions provide the ability to make functions that will dynamically calculate a value for a filter using high level code.
Filter Functions can be written in C#, JavaScript, or VB.NET. Filter Functions written in C# and VB.NET can get and set elements from the
current session of Exago, such as Parameter values. See Exago Session Info for more information.

Create, Edit, Delete, Restore Custom Filter Functions
To add a new custom filter function click

Extensions >

Filter Functions in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
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To edit a function either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete an object either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To restore the default custom filter functions that come with the application either:
right-click Extensions > Filter Functions in the Main Menu and select Restore All Default Date Filter Functions
from the context menu
navigate to General > Filter Settings > Restore All Default Date Filter Functions and click on the Restore
button.
To save changes and new functions click the Apply or Okay buttons

Custom Filter Function Properties
Each Custom Filter Function has the following properties:

Name
A name for the filter function that will be displayed to the end users. Required.

Description
A description of the function.
Note
To support multi-language functionality, if the filter function’s name or description can be prepended with ‘_wrFunctionId’. If this ID
matches the ID of any element in the language files, then the string of that language element will be displayed to the user instead of the
function name/description in the Admin Console. For more information see Multi-Language Support.

Filter Type
Determines the data type that the filter function should be available for. Either Date, String, Integer or Decimal.

List Order
The order the filter function will appear among other filter functions of the same type. Functions with a lower number will appear higher on
the list. If two functions have the same list value they will display in alphabetic order.
Note
All of the built in filter functions start with list value 100 or greater.

Language
The high-level language of the code for the date function. May be C#, JavaScript, or VB.NET.

References
A semicolon-separated list of any DLLs that need to be referenced by the Custom Filter Function. The DLLs must be present in the \bin
folder of the Exago Web Application, Scheduler Services, and the Web Service API if applicable. This folder can be found in the installation
directory of the respective component.
Note
System.dll does not need to be listed as a reference as it is already available.

Program Code
The program code for your Custom Filter Function. The code must return the data type that was set in the Filter Type setting.
Note
Parameters may be referenced within custom functions by placing their name between @’s. For example, @userId@.

A Custom Filter Function that returns the date value of the last day of the current quarter
Click the Test custom code execution

icon to verify that the code properly compiles.

Custom Options
This article applies to the Admin Console >

Extensions > ;

Custom Options settings.

Custom Options allow for the definition of settings that users can modify on a per-report basis in the Report Designer. Options can be
accessed during report execution by Server Events or Custom Functions.
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The name of each option can be controlled on a per-user basis using the multi-language feature. Custom Options can be Integers,
Decimals, Booleans, Strings or Lists. Each data type provides an appropriate UI element for the user to select a value.

Create, Edit, Delete Custom Options
To add a new custom filter function click

Extensions >

Custom Options in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit an option either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete an option either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new options click the Apply or Okay buttons

Custom Option Properties
Each Custom Option has the following properties:

Id
The unique Id or name of the custom option. The Id is used in accessing the option and may be displayed in the Custom Options Menu as
the user sets its value on a report. Required.
The Id may not contain the following characters:
[ ] { } . , @ and whitespace.

Note
To support multi-language functionality, create an element in the language file(s) with an Id that matches the Option’s Id. The string of
that language element will be displayed to the user in the Custom Options Menu. For more information see Multi-Language Support.

Type
The data type the Custom Option should display. Each data type will display an appropriate input element in the Custom Options Menu.
The following types are available.
Int: Represents a whole number.
Decimal: Represents a decimal number.
Bool: Represents a Boolean value. A checkbox is displayed.
Text: Represents a text string and displays a text box.
List: Represents a single choice from among multiple values. Click the Add

icon to define list choices.

User Interaction with Custom Options
After Custom Options are created, the Custom Options Menu will be available in the Report Designer of Advanced and CrossTab Reports.

Custom Options in Report Designer Settings menu
Note
The Custom Options Menu will only display if Custom Options exist.
In the Custom Options dialog, values can be set using the user interface elements displayed above.

Custom Options dialog with one list and one decimal option

Accessing Custom Option Values
The .NET API, Server Events, and Custom Functions can access Custom Option values through the SessionInfo.Report object by
using the following function:
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string GetCustomOptionValue(string id)
Description

Returns the value of the specified Custom Option as a string.
For Bool options the value returned will be true or false.
For List Options, the chosen Id is returned.

Remarks

Note
List options will return the Id of the selected value and not the displayed language
string.
A Custom Function could use the following C# code to return the value of a Custom
Option. The Id of the Option is entered as an argument of the Custom Function.

Example
return
sessionInfo.Report.GetCustomOptionValue(args[0].ToString());

Config File XML Reference
This reference guide describes the structure of the config file XML elements. Use this guide if you build or edit your config XML directly,
without using the Admin Console.
Note
For the settings nodes within <general></general>, see Config File and API Setting Reference.
The config file's outer nodes are as follows:
<?xml version="1.0" standalone="yes"?>
<webreports></webreports>

All following nodes are within the <webreports> element. They are organized below in alphabetical order, not necessarily the order they
appear in the configuration file.

How to Use This Document
XML objects are represented in tables with the following format:
Node

Description

Type Required

Node is the XML node name. Nodes in bold font are objects, which are represented below the table.
Description is the name of the field as it appears in the Admin Console. If there is no mapped field, or the field is implicit, the description
is in italic font.
Type is the value type. If the type is a constant or enum, the possible values are listed below the table. Constants are case sensitive.
Required indicates whether the node requires a value. (1+) indicates that there can be multiple nodes.

Action Events
The Introduction to Action Events article includes detailed descriptions of each of these settings.
Outer node: <actionevent></actionevent>

name

Node
Name

Description

Type
string

Required
yes

id

Unique Id

int

yes

event_type

Global Event Type

constant

yes

datasource_id

Id of assembly data source int

no

func_name

Assembly function name

string

no

user_action

Event Type

constant

yes

language

Language

constant

no

program_code

Program code

string

no

uiaction

Assigned UI Item(s)

object

no (1+)

reference

References

object

no (1+)

namespace

Namespaces

object

no (1+)

Possible values for event_type: None, or see Global Action Events.
Possible values for user_action: None, Load, Click
Possible values for language: CSharp, JavaScript, VB

uiaction
Node
element_id

Description
Element Id

Type Required
constant yes

Possible values for element_id: See Identifying Actionable UI Elements.

reference
Node
name

Description
Reference name

Type Required
string
yes

Description
Namespace name

Type Required
string
yes

namespace
Node
name

Example
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<actionevent>
<name>DoubleClick</name>
<id>0</id>
<event_type>OnDoubleClickReport</event_type>
<user_action>Click</user_action>
<language>CSharp</language>
<program_code>return Extensions.ActionEvents.DoubleClick(sessionInfo);</program_code>
<uiaction>
<element_id>RunReportBtn</element_id>
</uiaction>
<reference>
<name>Extensions.dll</name>
</reference>
</actionevent>

Custom Options
The Custom Options article includes detailed descriptions of each of these settings.
Outer node: <customoption></customoption>
Node
option_id

Id

Description

Type Required
string
yes

option_type

Type

constant yes

option_list_item

Option list item

object

no (1+)

Possible values for option_type: Int, Decimal, Bool, Text, List

option_list_item
Node
option_list_item_id

Description
List item Id

Type Required
string
yes

Example
<customoption>
<option_id>Hello</option_id>
<option_type>List</option_type>
<option_list_item>
<option_list_item_id>World</option_list_item>
</option_list_item>
</customoption>

Data Sources
The Data Sources article includes detailed descriptions of each of these settings.
Outer node: <datasource></datasource>

id

Node

Description
Unique Id

Type Required
int
yes

name

Name

string

dbtype

Type

constant yes

dataconnstr

Connection String

string

schema

Schema/Owner Name string

no

odbcdelim

Column Delimiter(s)

no

string

yes
yes

Possible values for dbtype: mssql, oracle, msolap, odbc, websvc, assembly, mysql, file, postgres, db2, informix, cdata

Example
<datasource>
<id>0</id>
<name>Northwind</name>
<dbtype>odbc</dbtype>
<schema>dbo</dbtype>
<dataconnstr>DRIVER=SQLite3 ODBC Driver;Database=C:\Northwind.sqlite;</dataconnstr>
<odbcdelim>`</odbcdelim>
</datasource>

Data Objects
The Data Objects article includes detailed descriptions of each of these settings.
Outer node: <entity></entity>
Node

Description

Type

Required

id

Id

string

no

entity_name

Alias

string

no

cloned_from

v2019.1+ <id> of the parent data object that
this one is a clone of.

string

no

db_name

Name

string

yes

sql_stmt

Custom SQL Object

string

no

object_description

Description

string

no

category

Category

string

no

datasource_id

Id of data source

int

yes

object_type

Object type

constant

yes

schema_access_type

Schema Access Type

constant

no

key

Unique Key Fields

object

yes (1+)

param

Parameters

object

no (1+)
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tenant
filter_dropdown

Tenant Columns
Filter Dropdown Object

object
object

no (1+)
no

column_metadata

Column Metadata

object

no (1+)

transform

Vertical table transform

object

no

affinity

v2018.1+ Report or config affinity

constant

no

suppress_sort_filter

v2018.1+Suppress Sort and Filter

boolean

no

Possible values for object_type: table, view, procedure, function, assembly, sqlstmt, websvc, file
Possible values for schema_access_type: Metadata, Datasource
Possible values for affinity: Global, Report

key
Node
col_name

Description
Column name

Type Required
string
yes

Node

Description
Parameter name

Type Required
string
yes

Node
col_name

Description
Column name

Type Required
string
yes

parameter_id

Parameter name

string

Node
db_name

Description
Data object name

Type Required
string
yes

sql_stmt

SQL statement

string

no

datasource_id

Id of data source

int

yes

object_type

Object type

constant yes

param
id

tenant

yes

filter_dropdown

Possible values for object_type: table, view, procedure, function, assembly, sqlstmt, websvc, file

column_metadata
Node
col_source

Description
Specify as custom col

Type Required
constant no

col_name

Column name

string

yes

col_description

Column Description

string

no

col_type

Data Type

constant

no

col_alias

Column Alias

string

no

visible

Visible

bool

no

filterable

Filterable

constant

no

sortable

Sortable

bool

no

col_sortandgroupbyvalue Sort and Group-By Value string

no

col_value

no

Column Value

string

Possible values for col_source: ExagoFormula
Possible values for col_type: string, date, datetime, time, int, decimal, image, float, boolean, guid, currency
Possible values for filterable: All, Dynamic, Static, None

transform
col_name

Node

Description
Data field names column

Type
string

Required
yes

val_name

Data values column

string

yes

datatype_name

Data types column

string

no

non_transform_col

Fields exempt from transform object

no

non_transform_col
Node
col_name

Description
Data field name

Type Required
string
yes

data_type

Data type

enum

no

Possible values for data_type: 0: string, 1: date, 2: datetime, 3: time, 4: integer, 5: decimal, 6: float, 7: bit, 8: guid, 9: image, 10: currency

Example
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<entity>
<id>ODE</id>
<entity_name>OrderDetails</entity_name>
<db_name>OrderDetail</db_name>
<sql_stmt>SELECT *</sql_stmt>
<category>Order Information</category>
<datasource_id>1</datasource_id>
<object_type>table</object_type>
<key>
<col_name>OrderId</col_name>
</key>
<key>
<col_name>ProductId</col_name>
</key>
<param>
<id>count</id>
</param>
<tenant>
<col_name>CategoryName</col_name>
<parameter_id>count</parameter_id>
</tenant>
<filter_dropdown>
<db_name>Category</db_name>
<sql_stmt>SELECT *</sql_stmt>
<datasource_id>-1</datasource_id>
<object_type>table</object_type>
</filter_dropdown>
<column_metadata>
<col_source>ExagoFormula</col_source>
<col_name>Total</col_name>
<col_type>currency</col_type>
<col_alias>Total</col_alias>
<filterable>false</filterable>
<col_value>{ODE.Quantity}*({ODE.UnitPrice}-{ODE.Discount})</col_value>
</column_metadata>
<column_metadata>
<col_name>UnitPrice</col_name>
<col_type>currency</col_type>
</column_metadata>
</entity>

Functions
The following articles include detailed descriptions of each of these settings
Custom Functions
Custom Filter Functions
Outer node: <function></function>
Note
Functions and Filter Functions use the same xml syntax. Filter functions have weight > 0 (which indicates its order in the filter list).
>
Node

Description

Type

Required

name

Name

string

yes

description

Description

string

no

category

Category

constant

no

arguments_json

v2017.2+ Arguments information

json object

yes

variable_arguments

v2017.2+ Variable Argument Count

bool

yes

available_in

Formula, filter or custom aggregate

enum

yes

filter_return_type

Filter Type

constant

no

weight

List Order

int

yes

language

Language

constant

yes

program_code

Program Code

string

yes

disable_database_grouping

v2019.1.5+ Prevent In-Database Grouping
When Included in Detail Section

bool

yes

reference

References

object

no (1+)

namespace

Namespaces

object

no (1+)

Possible values for category: Aggregate, Operators, Logical, Date, Financial, Database, Arithmetic, String, Formatting, Other
Possible values for available_in:
0.
1.
2.
3.

Unavailable
Formula
Filter
Aggregate

Possible values for filter_return_type: date, string, integer, decimal
Possible values for language: CSharp, JavaScript, VB

reference
Node
name

Description
Reference name

Type Required
string
yes

Description
Namespace name

Type Required
string
yes

namespace
Node
name
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arguments_json v2017.2+
A JSON-formatted array of objects with the following format:
Name

Node

Description
Name

Type Required
string
yes

Required

Required

bool

yes

Description

Description

string

yes

Example
<function>
<name>IncrementBy</name>
<description>Count up by value steps.</description>
<category>Other</category>
<arguments_json>[{"Name":"counter","Required":false,"Description":"Number to increment by. Default: 1."}]</arguments_json>
<variable_arguments>false</variable_arguments>
<available_in>1</available_in>
<filter_return_type>String</filter_return_type>
<weight>0</weight>
<language>CSharp</language>
<program_code>return Extensions.CustomFunctions.IncrementBy(sessionInfo, args);</program_code>
<reference>
<name>Extensions.dll</name>
</reference>
</function>

Joins
The Join Configuration article includes detailed descriptions of each of these settings.
Outer node: <join></join>
Note
For entity names, use Id if set, otherwise use db_name.
Node
entity_from_name

Description
From object (left)

Type Required
string
yes

entity_to_name

To object (right)

string

join_type

Join Type

constant yes

relation_type

Relation Type

constant yes

weight

Weight

int

yes

clause

v2017.2+ Join Clause

object

yes (1+)

affinity

v2018.1+ Join affinity

constant yes

yes

Possible values for join_type: inner, leftouter, rightouter, fullouter
Possible values for relation_type: 11: one to one, 1M: one to many
Possible values for affinity: Global, Report

clause v2017.2+
left_entity

Node

Description
Type
From object (left) (v2017.3+) string

Required
no

left_side

From expression (left)

string

yes

right_side

To expression (right)

string

yes

conjunction

Joining conjunction

constant

yes

comparison

Comparison operator

constant

yes

left_side_type

From expression type

constant

yes

right_side_type

To expression type

constant

yes

level

Parenthesis nesting level

int

yes

left_entity overrides the base (implicit) from object entity_from_name for the specific join clause; this is necessary for some uses of the
IN operator
Possible values for conjunction: AND, OR
Possible values for comparison: EQ (=), NE (<>), LT (<), GT (>), LE (<=), GE (>=), IN
Possible values for left_side_type, right_side_type: Column, Constant, SubQuery, Expression

Example
<join>
<entity_from_name>PRO</entity_from_name>
<entity_to_name>CAT</entity_to_name>
<clause>
<left_side>ProductId</left_side>
<right_side>CategoryId</right_side>
<conjunction>AND</conjunction>
<comparison>EQ</comparison>
<right_side_type>Column</right_side_type>
<left_side_type>Column</left_side_type>
<level>0</level>
</clause>
</join>

Parameters
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The Parameters article includes detailed descriptions of each of these settings.
Outer node: <parameter></parameter>

id

Node
Name

Description

Type
string

Required
yes

data_type

Type

constant

yes

value

Value

string

no

hidden

Hidden

bool

yes

prompt_text

Prompt Text

string

no

parameter_dropdown

Parameter Dropdown Object object

no

Possible values for data_type: string, date, integer, decimal, boolean

parameter_dropdown
db_name

Node

Description
Database object name

Type
string

Required
yes

sql_stmt

SQL statement

string

no

datasource_id

Unique Id of data source int

object_type

Object type

constant yes

value_field

Value Field

string

yes

display_value_field

Display Value Field

string

no

display_data_type

Display Type

constant yes

sp_params

Stored proc parameters string

yes

no

Possible values for object_type: table, view, procedure, function, assembly, sqlstmt, websvc, file
Possible values for display_data_type: string, date, integer, decimal

Example
<parameter>
<id>count</id>
<data_type>integer</data_type>
<hidden>False</hidden>
<prompt_text />
<parameter_dropdown>
<db_name>Category</db_name>
<sql_stmt />
<datasource_id>1</datasource_id>
<object_type>view</object_type>
<value_field>Category_View</value_field>
<display_value_field />
<display_data_type>string</display_data_type>
<sp_params />
</parameter_dropdown>
</parameter>

Roles
The Roles article includes detailed descriptions of each of these settings.
Outer node: <role></role>

id

Node
ID

Description

Type Required
string
yes

active

Active

bool

yes

rolegeneral

General settings

object

yes

security

Security settings

object

yes

rolegeneral
Node

Description

Type

Required

reportpath

Report Path

string

no

dateformat

Date Format

string

no

timeformat

Time Format

string

no

datetimeformat

DateTime Format

string

no

separatorsymbol

Numeric Separator Symbol

string

no

currencysymbol

Numeric Currency Symbol

string

no

readfiltervalues

Read Database for Filter Values

bool

no

dbtimeout

Database Timeout

int

yes

showgrid

Show Grid Lines in Report Viewer

bool

no

showcrosstabreports

Allow Creation/Editing of Crosstab Reports bool

no

showdashboardreports

Allow Creation/Editing of Dashboard
Reports

bool

no

showchainedreports

Allow Creation/Editing of Chained Reports

bool

no

showexpressviews

Allow Creation/Editing of ExpressViews

bool

no

allowexpressviewliveedit

Allow Editing ExpressView with Live Data

bool

no

showexpressreports

Allow Creation/Editing of Express Reports bool

no

showexpressreportsgrouping

Show Grouping

bool

no

showexpressreportsformulabutton

Show Formula Button

bool

no

showexpressreportsstylingtoolbar

Show Styling Toolbar

bool

no

showexpressreportsthemes

Show Themes

bool

no

showadvancedreports

Allow Creation/Editing of Advanced Reports bool

no

113 of 215

Config File XML Reference

Technical Guide

showschedulereports

Show Report Scheduling Option

bool

no

showschedulereportsmanager

Show Schedule Reports Manager

bool

no

schedulemanagerviewlevel

Scheduler Manager User View Level

constant

no

showschedulereportsemail

Show Email Report Options

bool

no

decimalsymbol

Numeric Decimal Symbol

string

no

languagefile

Language File

string

no

servertimezoneoffset

Server Time Zone Offset

int

no

showdashboardnewvisualizationbutton

Allow Creation/Editing of Dashboard
Visualizations

bool

no

allowreportcustomsqlobjects

Allow Creation of Custom SQL Objects in
Advanced Reports (v2018.1+)

bool

no

Possible values for schedulemanagerviewlevel: user, company, all

security
Node

Description

Type

Required

folders

Folder Security

object

yes

dataobjects

Data Object Security

object

yes

dataobjectrows

Data Row Security

object

no

includereportcustomsqlobjects

v2018.1+ Allow User to View Report-Level
Custom SQL Objects

bool

no

folders
Node
include_all

Description
Include All Folders

Type
bool

Required
yes

read_only

All Folders Read Only

bool

yes

allow_management

Allow Folder Management bool

yes

folder

Folders

no (1+)

object

folder
name

Node

Description
Folder Name

Type
string

Required
yes

read_only

Read Only

bool

yes

propagate

Propagate status to sub-folders bool

yes

dataobjects
Node
include_all

Description
Type
Include All Data Objects bool

Required
yes

dataobject

Objects

no (1+)

object

dataobject
Note
For name, use Id if set, otherwise use db_name.
Node
name

Description
Data Object Name

Type Required
string
yes

Description
Filters

Type Required
object
no (1+)

dataobjectrows
Node
dataobjectrow

dataobjectrow
Note
For name, use Id if set, otherwise use db_name.

name

Node

Description
Data Object Name

Type Required
string
yes

filter

Filter String

string

yes

Example
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<role>
<id>Test</id>
<active>False</active>
<rolegeneral>
<reportpath>asraaweweweasd</reportpath>
<dateformat />
<timeformat />
<datetimeformat />
<separatorsymbol>,</separatorsymbol>
<currencysymbol>$</currencysymbol>
<readfiltervalues />
<dbtimeout>0</dbtimeout>
<showgrid />
<showcrosstabreports />
<showdashboardreports />
<showchainedreports />
<showexpressviews />
<allowexpressviewliveedit />
<showexpressreports />
<showexpressreportsgrouping />
<showexpressreportsformulabutton />
<showexpressreportsstylingtoolbar />
<showexpressreportsthemes />
<showadvancedreports />
<showschedulereports />
<showschedulereportsmanager />
<schedulemanagerviewlevel />
<showschedulereportsemail />
<decimalsymbol>.</decimalsymbol>
<languagefile />
<servertimezoneoffset>1</servertimezoneoffset>
<showdashboardnewvisualizationbutton />
</rolegeneral>
<security>
<folders>
<include_all>True</include_all>
<read_only>False</read_only>
<allow_management>True</allow_management>
<folder>
<name>Examples</name>
<read_only>False</read_only>
<propagate>True</propagate>
</folder>
</folders>
<dataobjects>
<include_all>False</include_all>
<dataobject>
<name>CAT</name>
</dataobject>
</dataobjects>
<dataobjectrows>
<dataobjectrow>
<name>CAT</name>
<filter>heyho</filter>
</dataobjectrow>
</dataobjectrows>
</security>
</role>

Server Events
The Introduction to Server Events article includes detailed descriptions of each of these settings.
Outer node: <serverevent></serverevent>

name

Node
Name

Description

Type
string

Required
yes

id

Unique Id

int

yes

event_type

Global Event

constant

yes

datasource_id

Id of assembly data source int

no

func_name

Assembly function name

string

no

language

Language

constant

no

program_code

Program code

string

no

reference

References

object

no (1+)

namespace

Namespaces

object

no (1+)

Possible values for event_type: None, or refer to the List of Server Events.
Possible values for language: CSharp, JavaScript, VB

reference
Node
name

Description
Reference name

Type Required
string
yes

Description
Namespace name

Type Required
string
yes

namespace
Node
name

Example
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<serverevent>
<name>ExpandAllFolders</name>
<id>0</id>
<event_type>OnAfterLoadReportsList</event_type>
<language>CSharp</language>
<program_code>Extensions.ServerEvents.ExpandAllFolders(sessionInfo, (TreeNodeCollection)args[0]);
return null;</program_code>
<reference>
<name>Extensions.dll</name>
</reference>
<reference>
<name>WebReports.dll</name>
</reference>
<namespace>
<name>WebReports.UI.Controls</name>
</namespace>
</serverevent>

Config File and API Setting Reference
If you build your config files directly, without using the Admin Console, or if you change settings in the API, use this reference to map
Admin Console settings to the relevant config file node or API key.
Note
For config file elements not in the <general> node, see Config File XML Reference.

How to Use This Document

Setting Name : type
<config_file_node> (within the <general> element)
Api_Key (within the Api.SetupData.General namespace)
Tip
This document is presented in the order that settings appear in the Admin Console. Use your browser's Find function (Ctrl+F) to find a
specific setting in this document.

Main Settings
The Main Settings article includes detailed descriptions of each of these settings.

Report Path : string pre-v2020.1
<reportpath>
ReportPath

Temp Path : string
<temppath>
TempPath

Temp Cloud Service : string
<tempcloudservice>
TempCloudService

Language File : string
<languagefile>
LanguageFile

Temp URL : string
<tempurl>
TempUrl

Allow direct access to Exago (bypassing API) : bool
<allowhomedirect>
AllowHomeDirect

Allow Execution in Viewer : bool
<allowhtmloutput>
AllowHtmlOutput

Allowed Export Types - Excel : bool
<allowexceloutput>
AllowExcelOutput

Allowed Export Types - PDF : bool
<allowpdfoutput>
AllowPdfOutput

Allowed Export Types - RTF : bool
<allowrtfoutput>
AllowRtfOutput
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Allowed Export Types - CSV : bool
<allowcsvoutput>
AllowCsvOutput

Default Output Type : constant
Possible values: excel, pdf, rtf, csv
<defaultoutputtype>
DefaultOutputType

Report Tree Shortcut : constant
Possible values: Run, Export
<reporttreeshortcut>
ReportTreeShortcutRun : bool

Active Role : string v2019.1+
<activeroleid>
ActiveRoleId

Culture Settings
The Culture Settings article includes detailed descriptions of each of these settings.

Date Format : string
<dateformat>
DateFormat

Time Format : string
<timeformat>
TimeFormat

DateTime Format : string
<datetimeformat>
DateTimeFormat

DateTime Values Treated As : constant
Possible values: date, datetime
<datetimetreatedas>
DateTimeTreatedAs

Numeric Separator Symbol : string
<separatorsymbol>
SeparatorSymbol

Numeric Currency Symbol : string
<currencysymbol>
CurrencySymbol

Numeric Decimal Symbol : string
<decimalsymbol>
DecimalSymbol

Numeric Decimal Places : int
<decimalplaces>
DecimalPlaces

Currency Decimal Places : int
<currencydecimalplaces>
CurrencyDecimalPlaces

Apply Numeric Decimal Places to General Cell Formatting : bool
<applygeneralformatdecimalplaces>
ApplyGeneralFormatDecimalPlaces

Apply General Currency Right Alignment : bool
<applygeneralcurrencyrightalignment>
ApplyGeneralCurrencyRightAlignment

Server Time Zone Offset : int
<servertimezoneoffset>
ServerTimeZoneOffset

Time Zone Name : string
<clienttimezonename>
ClientTimeZoneName

Feature/UI Settings
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The Feature/UI Settings article includes detailed descriptions of each of these settings.

Allow Creation/Editing of Express Reports : bool
<showexpressreports>
IsShowExpressReports

Allow Creation/Editing of Advanced Reports : bool
<showadvancedreports>
IsShowAdvancedReports

Allow Creation of Crosstab Reports : bool
<showcrosstabreports>
IsShowCrosstabReports

Allow Creation/Editing of Dashboards : bool
<showdashboardreports>
IsShowDashboardReports

Allow Creation/Editing of Chained Reports : bool
<showchainedreports>
IsShowChainedReports

Allow Creation/Editing of ExpressViews : bool
<showexpressviews>
IsShowExpressViews

Allow Editing ExpressView with Live Data : bool
<allowexpressviewliveedit>
IsAllowExpressViewLiveEdit

Show Data Fields Search Box : bool pre-v2017.2
<showexpressviewdatafieldssearch>
IsShowExpressViewDataFieldsSearch

Fields Enabled in Data Fields Tree : bool v2017.2+
<showdatafieldssearch>
IsShowDataFieldsSearch

Show Styling Toolbar : bool
<showexpressreportsstylingtoolbar>
IsShowExpressReportsStylingToolbar

Show Themes : bool
<showexpressreportsthemes>
IsShowExpressReportsThemes

Show Grouping : bool
<showexpressreportsgrouping>
IsShowExpressReportsGrouping

Show Formula Button : bool
<showexpressreportsformulabutton>
IsShowExpressReportsFormulaButton

Show CrossTab Wizard : bool
<showcrosstabwizard>
IsShowCrosstabWizard

Show Chart Wizard : bool
<showchartwizard>
IsShowChartWizard

Chart Colors : string
<chartcolors>
ChartColors

Maximum Number of Chart Data Points : int
<maxnumberofchartpoints>
MaxNumberOfChartPoints

Default Chart Font : string
<defaultchartfont>
DefaultChartFont

Show Geochart Map Wizard : bool
<showmapwizard>
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IsShowMapWizard

Geochart Map Key (optional) : string
<geochartmapkey>
GeochartMapKey

Geochart Map Colors : string
<mapcolors>
MapColors

Show Google Map Wizard : bool
<showgooglemapwizard>
IsShowGoogleMapWizard

Google Map Key (unlimited or JS API restricted) : string v2018.1+
<googlemapjsapikey>
GoogleMapJSAPIKey

Google Map Key (optional Geocode API restricted) : string v2018.1+
<googlemapgeocodeapikey>
GoogleMapGeocodeAPIKey

Google Map Colors : string
<googlemapcolors>
GoogleMapColors

Show Gauge Wizard : bool
<showgaugewizard>
IsShowGaugeWizard

Gauge Colors : bool
<gaugecolors>
GaugeColors

Show Document Template : bool
<showpdftemplate>
IsShowPdfTemplate

Show Document Template Upload Button : bool
<showtemplateuploadbutton>
IsShowTemplateUploadButton

Show Linked Report : bool
<showlinkreport>
IsShowLinkReport

Show Linked Report Fields : bool
<showlinkreportfields>
IsShowLinkReportFields

Show Linked Report Formula : bool
<showlinkreportformula>
IsShowLinkReportFormula

Show Linked Action : bool
<showlinkaction>
IsShowLinkAction

Show Insert Image : bool
<showinsertimage>
IsShowInsertImage

Show Joins Window : bool
<showjoinswindow>
IsShowJoinsWindow

Show Advanced Joins : bool
<showadvancedjoins>
IsShowAdvancedJoins

Advanced Joins Display : bool v2017.3.1+
<showcomplexjoins>
IsShowComplexJoins

Allow Category Aliasing : bool v2017.3.1+
<showcategoryalias>
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IsShowCategoryAlias

Show Events Window : bool
<showeventswindow>
IsShowEventsWindow

Show Report-Level Parameters Window : bool
<showreportparameterswindow>
IsShowReportParametersWindow

Show SQL Window : bool
<showsqlwindow>
IsShowSQLWindow

Linked Report Display : constant v2017.3+
Possible values: Cursor, NewTab, ScreenCenter
<linkedreportdisplay>
LinkedReportDisplay

Allow Grouping on non-Sorts : bool
<showgroupheadersformulabutton>
IsShowGroupHeadersFormulaButton

Prompt user for Parameters/Filters on Execution : bool
<dashboardpromptatexecution>
IsDashboardPromptAtExecution

Show URL Item Button : bool
<dashboardshowurlitembutton>
IsDashboardShowUrlItemButton

Allow Creation/Editing of Dashboard Visualizations : bool
<showdashboardnewvisualizationbutton>
IsShowDashboardNewVisualizationButton

Show Data Fields Search Box : bool
<showdashboarddatafieldssearch>
IsShowDashboardDataFieldsSearch

Visualization Database Row Limit : int
<visualizationdbrowlimit>
VisualizationDbRowLimit

Refresh Reports/Visualizations on Dashboards Silently : bool
<silentdashboardrefresh>
IsSilentDashboardRefresh

Minimum Tile Width for Dashboard Reflow : int v2019.1+
<mintilewidth>
MinTileWidth

Minimum Window Width for Dashboard Reflow : int v2019.1+
<mindesktopwidth>
MinDesktopWidth

Default Designer Font : string
<defaultfont>
DefaultFont

Default Designer Font Size : int
<defaultfontsize>
DefaultFontSize

Show Help Button : bool
<showhelp>
IsShowHelp

Custom Help Source : string
<customhelpsource>
CustomHelpSource

Show Exports in Tab : bool
<showexportsintab>
IsShowExportsInTab

Show IE Download Button : bool
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<showiedownloadbutton>
IsShowIeDownloadButton

Show Join Fields : bool
<showjoinfields>
IsShowJoinFields

Show Grid Lines in Report Viewer : bool
<showgrid>
IsShowGrid

Show Enhanced Tooltips : bool
<enhancedtooltips>
IsShowEnhancedTooltips

Save on Report Execution : bool
<saveonexecute>
IsSaveOnExecute

Save on Finish Press : bool
<saveonfinish>
IsSaveOnFinish

Enable Right-Click Menus : bool
<enablerightclickmenus>
IsEnableRightClickMenus

Enable Reports Tree Drag And Drop : bool
<enablereportstreedraganddrop>
IsEnableReportsTreeDragAndDrop

Show Report Upload/Download Options : bool
<showreportuploaddownloadoptions>
IsShowReportUploadDownloadOptions

Allow interactivity in report viewer : bool
<interactivehtml>
AllowInteractiveHtml

Show Toolbar in Report Viewer : constant
Possible values: Auto, Show, Hide
<showhtmltoolbar>
IsShowHtmlToolbar

Default interactive report viewer dock is open : bool
<defaultisdockopen>
DefaultIsDockOpen

Interactive report viewer default dock placement : constant
Possible values: Left, Right
<dockplacement>
IsEnableScheduling

Allow save to report design from the report viewer : bool
<executesavetodesign>
AllowExecuteSaveToDesign

Maximum number of fields in a crosstab header or tabulation source : int
<crosstabmaximumfields>
CrossTabMaximumFields

Use SVG for Application Icons : bool
<usesvgforappicons>
UseSVGForAppIcons

Application Theme Selection : string
<csstheme>
CssTheme

Join Path Algorithm : const v2018.1+
<expressviewjoinalgorithm>
ExpressviewJoinAlgorithm

Allow Creation of Custom SQL Objects : bool v2018.1+
<allowreportcustomsqlobjects>
IsAllowReportCustomSQLObjects
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Data Sources to Exclude from Custom SQL Object Creation : string v2018.1+
<excludedatasourcesreportcustomsql>
ExcludeDataSourcesReportCustomSQL

Programmable Object Settings
The Programmable Object Settings article includes detailed descriptions of each of these settings.

Call Type Parameter Name : string
<calltypeparamname>
CallTypeParamName

Column Parameter Name : string
<columnparamname>
ColumnParamName

Filter Parameter Name : string
<filterparamname>
FilterParamName

Full Filter Parameter Name : string
<fullfilterparamname>
FullFilterParamName

Sort Parameter Name : string
<sortparamname>
SortParamName

Data Category Parameter Name : string
<datacategoryparamname>
DataCategoryParamName

Data Object ID Parameter Name : string
<objectidparamname>
ObjectIdParamName

DB Row Limit Parameter Name : string v2018.1+
<dbrowlimitparamname>
DbRowLimitParamName

DB Row Start Index Parameter Name : string v2018.1+
<dbrowrangestartparamname>
DbRowRangeStartParamName

DB Row End Index Parameter Name : string v2018.1+
<dbrowrangeendparamname>
DbRowRangeEndParamName

Filter Settings
The Filter Settings article includes detailed descriptions of each of these settings.

Show Group (Min/Max) Filters : bool
<showgroupfilters>
IsShowGroupFilters

Show Top N Filters : bool
<showtopn>
IsShowTopN

Allow New Filters at Execution : bool
<allowexecutenewfilters>
AllowExecuteNewFilters

Read Database for Filter Values : bool
<readfiltervalues>
IsReadFilterValues

Allow Filter Dependencies : bool
<allowdependantfilters>
AllowDependantFilters

Show Filter Description : bool
<showfilterdescription>
IsShowFilterDescription

Default Filter Execution Window : constant
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Possible values: Standard, SimpleWithOperator, Simple, Custom
<defaultFilterExecutionWindow>
DefaultFilterExecutionWindow

Allow User to Change Filter Window : bool
<changeableFilterExecutionWindow>
IsChangeableFilterExecutionWindow

Include Null Values for 'NOT' Filters : bool
<includenotfilternullvalues>
IsIncludeNotFilterNullValues

Custom Filter Execution Window : string
<filterexecutionwindow>
FilterExecutionWindow

Database Settings
See Database Settings for more information.

Database Timeout : int
<dbtimeout>
DbTimeout

Database Row Limit : int
<dbrowlimit>
DbRowLimit

Row Limit Step Size : int v2017.2+
<dbrowlimitstepsize>
DbRowLimitStepSize

Disable Non-Joined Data Objects : bool
<detectjoinedobjects>
IsDetectJoinedObjects

Enable Special Cartesian Processing : bool
<enablespecialcartesianprocessing>
IsEnableSpecialCartesianProcessing

Aggregate and Group in Database : bool
<aggregateandgroupindatabase>
IsAggregateAndGroupInDatabase

Convert Filter and Sort Formulas to SQL : bool
<evaluateformulasindatabase>
EvaluateFormulasInDatabase

Scheduler Settings
The Scheduler Settings article includes detailed descriptions of each of these settings.

Enable Report Scheduling : bool
<enablescheduling>
IsEnableScheduling

Show Report Scheduling Option : bool
<showschedulereports>
IsShowScheduleReports

Show Email Report Options : bool
<showschedulereportsemail>
IsShowScheduleReportsEmail

Show Schedule Reports Manager : bool
<showschedulereportsmanager>
IsShowScheduleReportsManager

Show Schedule No End Date Option : bool
<showschedulenoenddate>
IsShowScheduleNoEndDate

Show Schedule Intraday Recurrence Option : bool
<showscheduleintradayrecurrence>
IsShowScheduleIntradayRecurrence

Scheduler Manager User View Level : constant
Possible values: User, Company, All
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<schedulemanagerviewlevel>
ScheduleManagerViewLevel

Email Scheduled Reports : bool
<emailscheduledreports>
IsEmailScheduledReports

Enable Batch Reports : bool
<enablebatchreports>
IsEnableBatchReports

Show Schedule Delivery Type Options : bool
<showscheduledeliverytypeoptions>
IsShowScheduleDeliveryTypeOptions

Use Secure Scheduler Remoting Channel : bool
<usesecureremotingchannel>
IsUseSecureRemotingChannel

Schedule Remoting Host : string
<scheduleremotinghost>
ScheduleRemotingHost

Enable Remote Report Execution : bool
<executeremotely>
IsExecuteRemotely

Enable Execution Cache : bool
<executioncache>
UseExecutionCache

User Cache Visibility Level : constant v2017.3+
Possible values: Global, Company, User
<cachevisibilitylevel>
CacheVisibilityLevel

Enable Access to Data Sources Remotely : bool
<accessdatasourcesremotely>
IsAccessDataSourcesRemotely

Remote Execution Remoting Host : string
<synchronousremotinghost>
SynchronousRemotingHost

Custom Queue Service : string
<schedulerqueueservice>
SchedulerQueueService

Delete Schedules upon Report Deletion : bool
<deleteschedulesuponreportdeletion>
IsDeleteSchedulesUponReportDeletion

Default Email Subject : string
<reportscheduleemailsubject>
ReportScheduleEmailSubject

Default Email Body : string
<reportscheduleemailbody>
ReportScheduleEmailBody

Password Requirements (for pdf and excel documents) : string
<passwordrequirement>
PasswordRequirement

Custom Scheduler Recipient Window : string
<schedulerrecipientwindow>
SchedulerRecipientWindow

User Settings
The User Settings article includes detailed descriptions of each of these settings.

User Preference Storage Method : constant
Possible values: None, Cookie, ExternalInterface, ServerEvent
<userprefstorage>
UserPreferenceStorage
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Startup Report(s) Replace Getting Started : bool
<userstartupreportoverwritegettingstarted>
UserStartupReportOverwriteGettingStarted

Maximum Number of Startup Reports : int
<userstartupreportmaxnum>
UserStartupReportMaxNum

Allow User Reports : bool
<userallowuserreports>
UserAllowUserReports

Other Settings
The Other Settings article includes detailed descriptions of each of these settings.

Excel Export Target : constant
Possible values: v2003, v2007, v2010, v2013, v2016. v2013 is the default value.
<excelexporttarget>
ExcelExportTarget

External Interface : string
<externalinterface>
ExternalInterface

Enable Paging in Report Viewer : bool
<htmlpaging>
IsHtmlPaging

Renew Session Automatically : bool
<renewsession>
IsRenewSession

Write Log File : constant v2017.2+
Possible values: NONE, ERROR, INFO, DEBUG
<logginglevel>
LoggingLevel

Enable Debugging : bool
<debugging>
IsDebugging

Max Report Execution Time (minutes) : int
<maxjobexecutionminutes>
MaxJobExecutionMinutes

Maximum Age for Temp Files : int
<maxtempfileage>
MaxTempFileAge

Enable Web Service / Assembly Data Mapping : bool
<datamapping>
IsDataMapping

Limit Reports and Visualizations to One Category : bool
<onecategorylimit>
IsOneCategoryLimit

Run Aggregate Functions at Record Level by Default : bool
<isaggregaterecordlevel>
IsAggregateRecordLevel

Cache External Services : bool
<cacheservices>
IsCacheServices

Global Schema Access Type : constant
Possible values: Datasource, Metadata
<schemaaccesstype>
SchemaAccessType

Allow Multiple Sessions : bool
<allowmultiplesessions>
AllowMultipleSessions

Allow MD5 Hashing on FIPS server : bool
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<allowmd5onfips>
AllowMD5OnFIPS

Write BOM to CSV Files v2019.1.1+
<writebomtocsv>
WriteBOMToCSV

Enable Report List Caching : bool pre-v2020.1
<reportlistcacheenabled>
IsReportListCacheEnabled

Enable Report XML Caching : bool pre-v2020.1
<reportxmlcacheenabled>
IsReportXmlCacheEnabled

Report XML Caching Timeout (s) : int pre-v2020.1
<reportxmlcachetimeout>
ReportXmlCacheTimeout

'LoadImage' Cell Function Parameter Prefix : string
<loadimageprefix>
LoadImageFuncParamPrefix

Ignore Inaccessible Report Folders : bool
<ignoreinaccessiblereportfolders>
IgnoreInaccessibleReportFolders

User ID : string
<userid>
UserId

Password : string
<password>
Password

Debug Password : string
<debugextractionpassword>
DebugExtractionPassword

REST Key : string v2017.3+
<restkey>
RestKey

Exago Expiration Date : string
<expirationdate>
ExpirationDate

Custom Code Supplied by Exago : bool
<customcode>
CustomCode

License Key : string
<licensekey>
LicenseKey

Hidden Flags
Some settings are not accessible in the Admin Console and are only available by editing the Config File. These so called hidden flags are
documented in the Hidden Flags article.

Unsupported
These settings are not accessible in the Admin Console. Changing these settings is not supported.

Formula functions loaded : bool v2017.2+
<formulafunctionsloaded>
AreFormulaFunctionsLoaded

Date functions loaded : bool
<datefunctionsloaded>
AreDateFunctionsLoaded

Version Number : string
<versionnumber>
VersionNumber

Data Cloud Service : string
<datacloudservice>
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DataCloudService

Window Height : int
<windowheight>
WindowHeight

Window Width : int
<windowwidth>
WindowWidth

Map Terms Signature : string
<maptermssignature>
MapTermsSignature

Join Transform Objects in Database: bool v2018.1+
<canjointransformobjectsindb>
CanJoinTransformObjectsInDb

Hidden Flags
The following options are inaccessible from the Admin Console, but may be toggled on or off or otherwise modified by editing the field in
the XML configuration file.
<allowhtmlinscheduledemails> — Set to True to allow users to insert html tags within the body of scheduled emails.
<filterdropdownobjecttenancy> — Set to False to disable tenanting on filter and parameter dropdown objects. If this is
disabled and a tenant column limits the dataset for a data object, then a filter or parameter dropdown list within a report will show
the full dataset for the data object rather than its intended limited subset.
Example
A tenant column limits the dataset of an Employees data object so that only data for an employee with the last name "King"
appears. A report that uses this data object will only output data associated with King. If <filterdropdownobjecttenancy> is
True (default), then a filter on Employees.LastName added to this report will only allow King to be selected. However, if it is set to
False, the filter on Employees.LastName will allow all employee last names to be selected even though only data for King will
appear.
<showbrowseroutofdatewarning> (v2016.3.4+) — Set to False to prevent a popup error message from appearing if a user
accesses Exago with an unsupported browser.
<webfarmsupport> — If not using sticky sessions in a web farm environment, should be True. More temp information will be
written to disk when True allowing other nodes in the farm to read it. Should be False if sticky sessions is configured or when
Exago runs in a single node to stop unnecessary costly disk writes and keep information in memory instead.
<expressviewdefaultformattheme> — (v2017.1+) Select a default ExpressView theme.
<aliasallentities> — (v2017.2+) Set to True to always use the Exago data object ID as table aliases in application
generated SQL, rather than auto-generated aliases.
<allowearlypagebreak> — (v2017.3+) Set to True to allow users to insert a page break at the beginning of a report, which
would cause the first page to be empty.
<canjointransformobjectsindb> — (v2018.1+) Set to False to cause vertical table transformations to be processed in the
application instead of in the database. This will prevent the use of advanced joins with vertical tables.
<performancetesting> — (v2018.2+) Set to True to set Ctrl+Alt+A to allow for running a report a specified number of times
simultaneously for performance testing. Must be run from the report designer for the desired report.
<reportlistcache> — (v2018.2–v2020.1.0) Set to False to opt out of caching in the GetReportList method when using a Folder
Management assembly.
<webrequestkeepalive> — (v2018.2+) Set to True to allow the use of a single TCP connection to send and receive multiple
HTTP requests. If set to False, a new TCP connection will be opened for every HTTP request. This flag only applies to Google Maps
widgets.
<webrequestprotocolversion> — (v2018.2+) Defaults to "1.1", allowing the definition of 24 status codes as well as other
advancements made present in HTTP protocol version 1.1. This flag only applies to Google Maps widgets.
Any fields which are not mentioned here are either not intended for external use or not fully implemented and should be ignored.

Monitoring: System Overview
The Monitoring system is structured in the following manner:
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Structure of the monitoring system

Web Application Database
The Web Application database stores data for report and user interface events. The type of data tracked depends on your configuration. At
the Extract interval, the monitoring service moves this data from the local db to the collected db.

Scheduler Application Databases
Each Scheduler Service has a local database which stores report execution data, if enabled in the configuration. At the Extract interval, the
monitoring service moves this data from the local dbs to the collected db.
Scheduler performance data is "persistent," that is, always available, and is therefore not stored in the local scheduler dbs. At the
Statistics interval, the monitoring service polls the schedulers for their performance statistics, and logs this data in the collected db.

File Paths for Config Files & Databases
ExagoWeb\Monitoring\Monitoring.sqlite - WebApp db
ExagoWeb\appSettings.config - Select which web app data to track
MonitoringService\Monitoring.sqlite - Main collected db
MonitoringService\Monitoring.exe.config - Set Extraction & Statistics intervals

ExagoScheduler\Monitoring.sqlite - Scheduler local db
ExagoScheduler\eWebReportsScheduler.exe.config - Select which scheduled report data to track

Monitoring: Setup
Monitoring that allows report management, execution, and performance statistics for the web application and schedulers to be tracked in
v2017.1+. Monitoring data is stored in local SQLite database files and can be reported on using Exago.
Many actions in the application can be monitored:
Report Management
Edit
Execute (begin & end)
Save
Delete
Rename
Duplicate
Report Designer usage
Gauge Wizard
Google Map Wizard
GeoChart Wizard
Map Wizard
Scheduling
Scheduled report
Schedule Manager
Monitoring for these components can be toggled on or off depending on your needs.
Additionally, you can track track CPU and memory load for each scheduler application so you can fine-tune your load balancing setup.
When the Exago Web Application is installed, the monitoring system is automatically installed, but it is disabled by default. It must be
configured and enabled manually. To set up monitoring, you need to configure the monitoring application, set your options for which data to
collect, and then set the monitoring service to run automatically.

Configuring Monitoring
Note
This article references <WebApp>as a placeholder for the application's install location. The default install locations are /opt/Exago/ on
Linux and C:\Program Files\Exago\ExagoWeb\ on Windows; however, these directories may be changed during installation.
The monitoring system is located in a folder MonitoringService, in the same folder as where the Web application is installed. The web
application stores its monitoring data in a Monitoring subfolder of the installation. So you should have the following folders:
<WebApp>
Monitoring
MonitoringService
Windows: Ensure that the IIS user has Full Control permissions for the ExagoWeb\Monitoring and MonitoringService folders.
See Configuring IIS for instructions.
To configure monitoring:
1. In MonitoringService, open the file Monitoring.exe.config in a text or xml editor. For each of the following keys in the
<appSettings> element, set the values as follows:
exagoAppPath, value="path" where path is the file path to the web app
Format: "C:\file\path\" (Windows), "/file/path/" (Linux)
A trailing slash (\) or (/) is required
userConfig, value="config" where config is the application config file
Format: "filename.xml"
Use extension .xml for either the encrypted or unencrypted version
webAppUri, value="uri" where uri is the url virtual path to the web app
Format: "http://local/path/"
A trailing backslash (/) is required
Optional: ExtractionIntervalMinutes, value="i" where i is the number of minutes between updates to the core
database. The default is 3.
Optional: StatisticsIntervalMinutes, value="j" where j is the number of minutes between when each scheduler
is polled for performance statistics. The default is 1.

Example
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<appSettings>
<add key="ExtractionIntervalMinutes" value="3" />
<add key="StatisticsIntervalMinutes" value="1" />
<add key="exagoAppPath" value="C:\ExagoWeb\" />
<add key="userConfig" value="WebReports.xml" />
<add key="webAppUri" value="http://localhost/monitoring/" />
</appSettings>

2. In <WebApp>, open the file appSettings.config in a text or xml editor. In the <appSettings> element, set
the Monitoring.DbPath key to the folder where your web application's monitoring data file is. The default location
is <WebApp>\Monitoring.

Example
<appSettings>
<add key="Monitoring.DbPath" value="C:\Exago\ExagoWeb\Monitoring\" />
...
</appSettings>

3. In the same file, set the options for which types of usage data you want to collect. To turn on monitoring for a specific action, set
the value for the key to "true". Available options are as follows:
Monitoring.CollectDeleteReportUsage
Monitoring.CollectRenameReportUsage
Monitoring.CollectDuplicateReportUsage
Monitoring.CollectExecuteReportUsage
Monitoring.CollectSaveReportUsage
Monitoring.CollectSaveReportXmlUsage
Monitoring.CollectDesignReportUsage
Monitoring.CollectGaugeControlUsage
Monitoring.CollectGoogleMapControlUsage
Monitoring.CollectMapControlUsage
Monitoring.CollectChartControlUsage
Monitoring.CollectScheduleReportControlUsage
Monitoring.CollectScheduleReportManagerControlUsage

Example
<appSettings>
...
<add key="Monitoring.CollectDeleteReportUsage" value="true" />
<add key="Monitoring.CollectRenameReportUsage" value="false" />
<add key="Monitoring.CollectDuplicateReportUsage" value="true" />
<add key="Monitoring.CollectExecuteReportUsage" value="true" />
...
</appSettings>

4. Restart your web server for the changes to be applied.

Configuring Scheduler Monitoring
If you want to track scheduled report execution, do the following for each Scheduler Service installation:
Open the eWebReportsScheduler.exe.config file in a text or XML editor. Add the following key to the <appSettings> element:
<add key="Monitoring.CollectExecuteReportUsage" value="true" />

Enabling the Monitoring Service
The monitoring system uses a Windows or Linux service that updates the core database with data from the Web Application and
Schduler Services at specified intervals. This way you have the data from every component in a single location.
The service is installed automatically, but it is not enabled by default. To enable the service:

Windows
1. As an administrator, open the Windows Services manager:
1. Click Start>Run.
2. Type services.msc.
3. Press Enter.
2. Locate the service Exago Monitoring Service vX.X.X.X, where vX.X.X.X is your Exago version. Right-click the service
and select Properties.
3. In the Properties window:
1. From the Startup Type list, select Automatic.
2. Click Start to start the service.
3. Click OK.

Accessing the Monitoring Data With Exago
To use monitoring data in reports, you need to add the Monitoring Service's core database
file MonitoringService/Monitoring.sqlite as an Exago Data Source.

Recommended Resources
Using SQLite Data Sources
Data Sources

Monitoring Database Schema
The monitoring database has three tables that can be used to build reports. This article describes what data is stored, and how to interpret
what you see.
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Entity-relationship diagram (ERD) for the monitoring database

SystemStatistics
The SystemStatistics table logs the available CPU load and memory for the system on which each scheduler service is installed.
Data is polled at occasional intervals. You can specify the time between polls using the StatisticsIntervalMinutes setting in the
Monitoring.exe.config file. For instructions, see "Configuring monitoring".
The table contains the following data columns:
id
An integer used to uniquely identify each row. This is the primary key for the table.
transactionId
(v2017.2+) An integer used to associate rows with type: cpu available and type: free memory to common transactions, in order
to facilitate a vertical table transformation and report off both CPU and Memory usage in the same report and chart.
hostId
The scheduler which was polled for system data. Every scheduler is polled at the same time. Schedulers are identified by their host
address, as specified in the Administration Console.
Example. tcp://localhost:2010
type
One of:
cpu available, which indicates that the value field in this row shows the CPU load percentage available at this time.
free memory, which indicates that the value field in this row shows the amount of free memory at this time.
value
One of:
A value indicating the CPU load available at this time, as a percentage of 100%. This field indicates CPU available if the type field
for this row shows cpu available. This value is "-1" if the scheduler could not be reached at this time.
A value indicating the amount of free memory at this time, in megabytes (MB). This field indicates free memory if the type field for
this row shows free memory. This value is "-1" if the scheduler could not be reached at this time.
Note. This field should be formatted as a decimal, either in the metadata for this column, or in the report cell formatting.
timestamp
A datetime value indicating when this scheduler was polled.

Transform
The following vertical transformation is recommended for the SystemStatistics table:
<entity>
<!--<entity_name></entity_name>-->
<db_name>SystemStatistics</db_name>
<!--<datasource_id></datasource_id>-->
<object_type>table</object_type>
<key>
<col_name>transactionId</col_name>
</key>
<transform>
<col_name>type</col_name>
<val_name>value</val_name>
<non_transform_col>
<col_name>timestamp</col_name>
<data_type>8</data_type>
</non_transform_col>
<non_transform_col>
<col_name>hostId</col_name>
<data_type>0</data_type>
</non_transform_col>
<non_transform_col>
<col_name>transactionId</col_name>
<data_type>0</data_type>
</non_transform_col>
</transform>
</entity>

Audit
The Audit table records when certain events, which you specify, happen to reports. This table records data for the web application and the
schedulers.
Data is logged at the time of each event, but the data is only collected in the core database at occasional intervals. You can specify
the time between data collections using the ExtractionIntervalMinutes setting in the Monitoring.exe.config file. For instructions,
see "Configuring monitoring".
The table contains the following data columns:
id
An integer used to uniquely identify each row. This is the primary key for the table.
hostId
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The application for which this action took place. The web application and schedulers are identified by their host address.
Example. tcp://localhost:2010
Example. http://localhost
transactionType
A string indicating which type of event has triggered this row to be created. One of:
Execute Report
Rename Report
Duplicate Report
Delete Report
Design Report
Save Report XML
Chart Control
Gauge Control
Map Control
Google Map Control
userId
The userId parameter for this event.
companyId
The companyId parameter for this event.
timestamp
A datetime value indicating when this event happened.
auditId
For rows where the transactionType is Execute Report, this field joins up to two rows in the ExecutionDetail table that indicate
when this execution started and, if successful, when it ended.
This field also joins rows in the ReportDetail table which give some information about the report in which the logged event happened.

ExecutionDetail
This table records data for report execution events.
Up to two rows for each event are created:
The first has transactionType Report Execution Begins, which logs when the report execution started.
The second has transactionType Report Execution Ends, which logs when the report execution ends. If the report execution
was not successful, this row will not be created.
The table contains the following data columns:
auditId
An integer used to join up to two rows in this table with a row in the Audit table.
transactionId
A globally unique identifier (GUID) for this execution. This GUID is used in several places throughout Exago. Notably, it is used as
the file name for scheduled reports which have been saved to disk.
transactionType
One of:
Report Execution Begins, which indicates that the timestamp value for this row shows when this execution started.
Report Execution Ends, which indicates that the timestamp value for this row shows when this execution ended.
timestamp
A datetime value indicating when this execution started or finished, depending on the value of transactionType.
Note. This table uses columns (transactionId and transactionType) as a primary key.

Transform
The following vertical transformation is recommended for the ExecutionDetail table:
<entity>
<!--<entity_name></entity_name>-->
<db_name>ExecutionDetail</db_name>
<!--<datasource_id></datasource_id>-->
<object_type>table</object_type>
<key>
<col_name>transactionId</col_name>
</key>
<transform>
<col_name>transactionType</col_name>
<val_name>timestamp</val_name>
<non_transform_col>
<col_name>auditId</col_name>
<data_type>2</data_type>
</non_transform_col>
</transform>
</entity>

ReportDetail
This table records information about the reports which relate to events in the Audit table.
auditId
An integer used to join a row in this table with a row in the Audit table.
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reportId
The file path and name of the report which the event affected.
reportType
The type of report: advanced, express, expressview, chained, dashboard

Styling the Home Page
Visually modifying and branding the user interface is a simple but effective step toward integrating Exago into a host application. For
styling purposes Exago can be thought of as a control that sits within a div on an .aspx (html) page.
Aesthetic changes can be made for single users or groups of users by directing each user/group to different custom .aspx pages.
However, we suggest using Application Themes instead to encapsulate groups of changes, which can be selected dynamically in the
API.
To visually integrate Exago, make a copy of the ExagoHome.aspx file and modify the elements surrounding the Exago control or override
the CSS of the user interface itself.
Note
Do not make changes directly to ExagoHome.aspx as they will be overwritten during upgrades. Instead use the example below to create
a custom .aspx page.

Exago Control
The example below is the minimum code necessary to embed the Exago control.
<%@ Page Language="C#" EnableViewState="false" EnableEventValidation="false" %>
<%@ Register src="WebReportsCtrl.ascx" tagname="WebReportsCtrl" tagprefix="wr" %>
<!DOCTYPE html>
<html>
<head runat="server">
<title>Exago</title>
</head>
<body>
<form runat="server">
<wr:WebReportsCtrl ID="WebReportsCtrl" runat="server" />
</form>
</body>
</html>

Exago Control Properties
Several properties can be set on the Exago Control to modify various settings and behaviors of Exago. The following properties can be set.
ConfigFile — Loads a configuration file other than that created by the Administration Console (e.g.
ConfigFile="NorthwindConfig.xml").
Note
If entering Exago through the Api this parameter is ignored.
LanguageFile — Specify which language files to use in place of the 'Language File' parameter of Main Settings in the
configuration file. (e.g. LanguageFile="es-mx, getting-started-custom").
ForceIECompatMode — Setting to True will force certain JavaScript functions to working in 'compatibility' mode. This may be
necessary if dragging a Data Field into a cell of the Report Designer does not work properly. (e.g.
ForceIECompatMode="true").
XUaCompat — Controls whether to remove the meta u-ax-compatible tag when running reports to PDF in IE8. The default is false
which removes the tag. If you are experiencing issues downloading PDF reports in IE8 setting this flag to True may resolve the
issue. (e.g. XUaCompat="true").
Note
IE8 is no longer supported by Exago, as of v2016.1.

Changing CSS and Images
All of the CSS and images used by Exago can be modified within the aspx page if desired. However we recommend using an Application
Theme instead.
Any icon in Exago can be changed on a per-company or per-user basis:
1. Create the custom images you would like to display.
2. Identify the Id of the image you want to change. See Finding Image Ids for more details.
3. Create a language file that maps the Ids to the location of the custom images. See Multi-Language Support for more information.

Example
<element id="ExportTypeMenuHtml" image= "Config\Images\Custom\HTMLExecutIconLarge.png"></element>

Hovering Images
For icons that have hover effects there is a special naming convention.
To change custom icons with hover effects:
1. Follow the steps above to create the non-hover icon.
2. Create the custom icon with the hover effect. Save it to have the same name as the non-hover icon and append "_h" to its name.

Finding Image Ids
To find the Ids of icons in Exago:
1. Open Exago in a browser.
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2. Use the browser’s developer tools to inspect the icon you want to change. For most browsers this can be done by pressing F12.
3. Look at the id property of the icon. There will be several words separated by underscores. Use the last element as the image Id (see
example below).

Customizing Getting Started Content
The Getting Started tab is displayed as a user enters the Exago Web Application user interface. This tab can be customized by
customizing HTML in a language definition file. This is done by modifying the language element <GettingStartedContent> in the
<WebApp>\Config\Languages\en-us-getting-started.xml
Note
This article references <WebApp> as a placeholder for the Web Application's install location.
To assist in customizing the Getting Started tab, Exago provides several JavaScript functions and HTML5 attributes to open the New
Report Wizard, execute reports, open other custom tabs and display reports as Dashboards.
The figure below demonstrates a custom Getting Started tab. The two charts are loaded with the data-onloadreportname HTML5
attribute. The links to the New Report Wizard and Dashboard Designer use the void wrStartNewReportWizard([string
reportType]) function.

Note
It is recommended to make custom tabs in a separate language file to make it easy to change tabs by user or groups of users. See
Modifying Select Language Elements.

Creating Additional Custom Tabs
Additional custom tabs can be created by creating a language elements with a unique name containing the HTML content. Custom tabs
can be opened with the JavaScript function wrAddTabbedContent.
This example demonstrates a custom tab that has buttons to launch a report in different formats.
<element id="QuickReportsTab">
<button value="HTML" onclick="wrExecuteReport('My Reports\\Revenue', 'html');" />
<button value="EXCEL" onclick="wrExecuteReport('My Reports\\Revenue', 'excel');" />
<button value="PDF" onclick="wrExecuteReport('My Reports\\Revenue', 'pdf');" />
<button value="RTF" onclick="wrExecuteReport('My Reports\\Revenue', 'rtf');" />
<button value="CSV" onclick="wrExecuteReport('My Reports\\Revenue', 'csv');" />
</element>

JavaScript Functions
To assist with the creation of custom tab content, Exago provides a number of JavaScript functions to allow custom HTML to call features
of Exago.

void wrStartNewReportWizard([string reportType])
Opens the Report Wizard in a new tab. Optionally, specify which wizard to open with the reportType argument.
Available values for reportType:
Description

Example

advanced
express
expressview
dashboard
chained
<p>Click <span style="text-decoration:underline; cursor:pointer;" onclick="wrStartNewReportWizard();">here</span> to create a new report.</p>

void wrStartDuplicateReportDialog(string reportFolder\\reportName)
Description Opens the Duplicate Report dialog.
Remark
Example

If the report name is null or blank Exago will use the report selected in the Main Menu.
<p>Click <span style="text-decoration:underline; cursor:pointer;" onclick=" wrStartDuplicateReportDialog();">here</span> to create a duplicate this report.</p>

void wrExecuteReport(string reportFolder\\reportName, string
format)
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Description Executes the specified report in the specified format.
Example

<input type="button" class="Button" value="HTML" onclick="wrExecuteReport('Sales Reports\\Revenue by Category','html')

string wrGetSelectedReportName()
Description

Returns the name of the report that is selected in the Report Tree.

Remark

The returned string will include the folder structure of the report separated by slashes.

void wrAddTabbedContent(string ContentID, string TabName)
Description

Opens a new tab and loads the HTML stored in the element of the Language file that
corresponds to the ContentID string.
The ContentID should match the element ID of the HTML you want to load.

Remark

The TabName can match the element ID of the name you want the tab to display, or a
custom string with the name of the tab.

JavaScript HTML5 data- Attributes
To assist with the creation of custom tab content, Exago provides a number of HTML5 data- attributes to allow custom HTML to call
features of Exago.

data-onloadreportname="ReportFolder\ReportName"
Description

Executes a report as HTML and loads it into a div or iframe. Dashboards are not compatible with dataonloadreportname.
The report string should be formatted as "Report Folder\\Report Name."

Remark

Note
When using this function make sure the setting Enable Debugging in Other settings is False.

Example

<div class="Report" data-onloadreportname="Employee Reports\Number of Sales by Employee"></div>

data-useviewer="True/False"
Description Specifies to load a report as raw HTML or utilize Exago dynamic report viewer.
Remark
Example

Default value is true. In cases where the dynamic capabilities of the Report Viewer is not needed set to false to load raw HTML. This has a similar
behavior to using either ApiAction vs. GetExecute methods via the APIs.
<div class="Report" data-onloadreportname="Employee Reports\Number of Sales by Employee" data-useviewer= “False”></div>

data-enablescrolling="value"
Description Specifies whether or not to show scroll bars. This can helpful for certain reports that may not fit exactly within the startup content.
Available values for value:
Remark

Example

true — show scrollbars (default)
false — do not show scrollbars
<div class="Report" data-onloadreportname="Employee Reports\Number of Sales by Employee" data-enablescrolling= “False”></div>

data-reloadinterval="value"
Description Reloads a report every value seconds.
Remark
Example

This function is used in conjunction with data-onloadreportname.
<div class="Report" data-onloadreportname="Employee Reports\Number of Sales by Employee" data-reloadinterval="2"></div>

data-allowexport="value"
Description Specifies whether or not to show the export menu for the report.
Available values for value:
Remark

Example

0 — do not show the menu (default)
1 — show the menu
<div class="Report" data-onloadreportname="Employee Reports\Number of Sales by Employee" data-reloadinterval="1"></div>

Custom Context Sensitive Help
Exago is installed with context sensitive help. When a user clicks the Help
icon a tab opens to display the appropriate section of the
Exago User Guide. The content of this tab can be replaced with custom content managed by the host application.
To implement Custom Context Sensitive Help:
1. Create a minimum of one webpage for the custom help content.
2. Set the Admin Console > General Settings > Feature/UI Settings > Custom Help Source setting to the URL of the webpage
from step 1. Prefix the URL with url=.
Example
url=http://www.Customhelp.com/Exago;

Important
Supplying a value for the Custom Help Source will replace the Exago provided help system throughout the entire application.

Now, when a user clicks the Help

icon a tab opens to display the content from the supplied Custom Help Source URL.

The user’s language and a context parameter will be appended as a query string to the URL.
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The language is determined by the value of the Admin Console > General Settings > Main Settings > Language File setting.
The context parameter is determined by where in the application the user clicked the Help
below.

icon, selected from Table A

Example
http://www.customhelp.com/Exago?helpKey=tabChartType&language=en-us

Table A — Custom Context Help Context Parameters
Context Parameter aka "helpKey"
Details
tabexecute
The user is in the Report Viewer.

ExpressView
tabExpressView

The user has the ExpressView Designer or ExpressView visualization
builder active.

Express Report Wizard
tabExpressName

The user has the Name tab of the Express Report Wizard active.

tabExpressCatepgories

The user has the Categories tab of the Express Report Wizard active.

tabExpressSorts

The user has the Sorts tab of the Express Report Wizard active.

tabExpressFilters

The user has the Filters tab of the Express Report Wizard active.

tabExpressLayout

The user has the Layout tab of the Express Report Wizard active.

tabExpressOptions

The user has the Options tab of the Express Report Wizard active.

Chained Report Wizard
tabChainedName

The user has the Names tab of the New Chained Report Wizard active.

tabChainedReports

The user has the Reports tab of the New Chained Report Wizard active.

tabChainedOptions

The user has the Options tab of the New Chained Report Wizard active.

CrossTab Wizard
tabCrosstabName

The user has the Names tab of the New CrossTab Report Wizard active.

tabCrosstabCategories

The user has the Categories tab of the New CrossTab Report Wizard
active.

tabCrosstabFilters

The user has the Filters tab of the New CrossTab Report Wizard active.

tabCrosstabLayout

The user has the Layout tab of the New CrossTab Report Wizard active.

dialogCrosstabOptions

The user has the CrossTab Data Designer dialog open.

New Report Wizard
tabAdvancedName

The user has the Names tab of the New Advanced Report Wizard active.

tabAdvancedCategories

The user has the Categories tab of the New Advanced Report Wizard
active.

tabAdvancedSorts

The user has the Sorts tab of the New Advanced Report Wizard active.

tabStandardFilters

The user has the Filters tab of the New Advanced Report Wizard active.

tabAdvancedLayout

The user has the Layout tab of the New Advanced Report Wizard active.

Report Designer
tabDesign

The user is editing an Advanced or CrossTab report and has the design
grid active.

dialogName

The user has the Rename Menu active.

dialogDescription

The user has the Description Menu active.

dialogCategories

The user has the Categories Menu active.

dialogSorts

The user has the Sorts Menu active.

dialogFilters

The user has the Filters Menu active.

dialogGeneralOptions

The user has the Options Menu active.

dialogHtmlOptions

The user has the Report View Options menu active.

listItemReportHtmlOptionsGeneral

The user has the General section of the HTML Options active.

listItemReportHtmlOptionsFilters

The user has the Filter section of the HTML Options active.

listItemReportHtmlOptionsSorts

The user has the Sorts section of the HTML Options active.

dialogTemplates

The user has the Template Menu active.

dialogJoins

The user has the Advanced Menu active.

dialogJoinEdit

The user has the Report Join Menu active.

dialogFormulaEditor

The user has the Formula Editor active.

dialogLinkedReport

The user has the Linked Report Menu active.

tabCellFormatNumber

The user has the Number tab of the Cell Format Menu active.

tabCellFormatBorder

The user has the Border tab of the Cell Format Menu active.

tabCellFormatConditional

The user has the Conditional tab of the Cell Format Menu active.

dialogCrosstabDesign

The user has the Crosstab Menu active.

dialogGroup

The user has the Group Section Menu active.

dialogSectionShading

The user has the Section Shading Menu active.

dialogShowSQL

The user has the Show Generated SQL Menu active.

dialofReportLevelParameters

The user has the Report Level Paramers Menu active.

tabChartType

The user has the Type tab of the Chart menu active.

dialogChartBenchmarkLine

The user has the Benchmark Line dialog active.

dialogChartDataFormat

The user has the Chart Data Format tab active.

tabChartLabels

The user has the Labels tab of the Chart menu active.
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tabChartData
tabChartAppeance

The user has the Data tab of the Chart menu active.
The user has the Appearance tab of the Chart menu active.

tabChartSizeAndPreview

The user has the Chart Size and Preview tab of the Chart menu active.

tabMapType

The user has the Type tab of the Map menu active.

tabMapLocations

The user has the Locations tab of the Map menu active.

tabMapData

The user has the Data tab of the Map menu active.

tabGaugeType

The user has the Appearance tab of the Gauge menu active.

tabGaugeData

The user has the Data tab of the Gauge menu active.

tabGoogleMapAppearance

The user has the Appearance tab of the Google Maps menu active.

tabGoogleMapLocations

The user has the Locations tab of the Google Maps menu active.

tabGoogleMapData

The user has the Data tab of the Google Maps menu active.

tabGoogleMapSizeAndPreview

The user has the Size and Preview tab of the Google Maps menu active.

listItemReportCacheOptionsGeneral

The user has the Execution Caching menu active.

Dashboards
tabDashboard

The user has the Dashboard Viewer active

tabDashboardDesigner

The user has the Dashboard Designer active.

dialogDashboardUrlOptions

The user has the Insert Url menu active.

dialogDashboardName

The user has the Dashboard Rename menu active.

dialogDashboardDescription

The user has the Dashboard Description menu active.

dialogDashboardOptions

The user has the Dashboard Options menu active.

tabDashboardReportOptions

The user has the Report tab of the Insert Report menu active.

tabDashboardReportOptionsFilterPrompts

The user has the Filters tab of the Insert Report menu active.

tabDashboardReportOptionsParameterPrompts

The user has the Parameters tab of the Insert Report menu active.

tabDashboardReportOptionsOptions

The user has the Options tab of the Insert Report menu active.

tabDashboardFilterOptionsReports

The user has the Reports tab of the Insert Filter menu active.

tabDashboardFilterOptionsFilter

The user has the Filter tab of the Insert Filter menu active.

dialogDashboardVisualizationOptions

The user has the Options menu of a Data Visualization active.

Scheduler
tabScheduleReportManager

The user has the Schedule Report Manager active.

tabScheduleRecurrence

The user has the Recurrence tab of the New Schedule Wizard active.

tabScheduleParameters

The user has the Parameter tab of the New Schedule Wizard active.

tabScheduleFilters

The user has the Filter tab of the New Schedule Wizard active.

tabScheduleRecipients

The user has the Recipients tab of the New Schedule Wizard active.

tabScheduleBatch

The user has the Batch tab of of the New Schedule Wizard active.

Tip
Create a default page to handle any cases where an undocumented or null context parameter is passed. This guarantees that a valid
help page will always be displayed.

Themes
Themes allow a user to quickly stylize reports or elements of reports such as maps and charts. This article covers Chart, ExpressView,
CrossTab, GeoChart and Express Report Themes. For styling the entire user interface, refer to the Application Themes article. Any further
references to Themes throughout this article refers specifically to the aforementioned visualization and report types.
Note
This article references <WebApp>/, as a placeholder for the Web Application install location. The default install location is C:\Program
Files\Exago\ExagoWeb on Windows or /opt/Exago/ on Linux. These directories can be changed during installation.
Exago comes with several themes pre-installed. Pre-installed themes are saved in the <WebApp>\Themes folder of Exago.
By default custom themes are saved in the Admin Console > General > Main Settings > Report Path.
Alternatively the host application can manage theme storage by implementing the GetTemplate, GetTemplateList, and SaveTemplate
functions. See Report and Folder Management for more information.

Chart Themes
A user can quickly select colors for Charts by applying a chart theme.
There are two way to create a chart theme:
Manually
1. In folder specified in the Admin Console > General > Main Settings > Report Path create a text file containing a comma
separated list of the hexadecimal values of the desired colors.
2. Save the file with the theme name.
3. Change the extension to .wrth.
With the Exago Theme Maker
1. Launch the Exago Theme Maker, and follow the instructions in the Exago Theme Maker article.
2. Download the theme created with the Theme Maker.
3. In folder specified in the Admin Console > General > Main Settings > Report Path, save the .wrth file.
Note
The file name will be displayed to the end user. To translate the name of a custom theme, see Multi-Language Support for Theme Names
below.

Example
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The theme file below implements the built-in theme Autumnal Sunset.
#FFAA5C,#DA727E,#AC6C82,#685C79,#455C7B

ExpressView Themes
A user can quickly style ExpressViews by applying a theme. ExpressView themes can specify background color, foreground color, group
colors, section shading, row shading, borders, fonts and text size.
Refer to the Create a Custom ExpressView Theme article for detailed instructions.

CrossTab Themes
A user can quickly style CrossTabs by applying a theme. CrossTab themes can specify background color, foreground color, section
shading, borders, fonts and text size.
To create custom CrossTab themes:
1. Create a CrossTab with several Tabulation Data cells, Row Headers, Column Headers as well as sub-totals and grand totals. We
recommend CrossTab Themes have at least five Row Headers, Column Headers, Tabulation Data, sub-total rows, and sub-total
columns as well as a grand total row and a grand total column.
Note
If a user adds more Tabulation Data, Row Headers or Column Headers than existed on the theme they will appear without styling.
2. In the Report Designer stylize each cell as desired.
3. Hover the mouse over the CrossTab. Notice the CrossTab Design Menu
4. Hold Ctrl + Alt + Shift and click on the CrossTab Design Menu
icon

icon appears in the bottom left corner.

5. Click
Save as Theme.
6. Enter a name for the theme. This name will be displayed to the end-users.

GeoChart Themes
A user can quickly select colors for GeoCharts by applying a theme.
There are two ways to create GeoChart themes:
Manually
1. In folder specified in the Admin Console > General > Main Settings > Report Path create a text file containing a comma
separated list of the hexadecimal values of the desired colors.
2. Save the file with the theme name.
3. Change the extension to .wrtm.
With the Exago Theme Maker
1. Launch the Exago Theme Maker, and follow the instructions in the Exago Theme Maker article.
2. Download the theme created with the Theme Maker.
3. In folder specified in the Admin Console > General > Main Settings > Report Path, save the .wrtm file.
Note
The file name will be displayed to the end user. To translate the name of a custom theme, see Multi-Language Support for Theme Names
below.

Express Report Themes
A user can quickly style Express Reports by applying a theme. Express report themes can specify background color, foreground color,
section shading, borders, fonts and text size.
To create a custom Express Report theme:
1. Create an Express Report with Headers, Footers and a Page Header/Footer and a Grand Total. We recommend Express Report
Themes utilize many Columns, Headers and Footers.
Note
If a user adds more Columns, Headers, or Footers than existed on the theme they will appear without styling.
2. In the Layout tab stylize the report as desired.
3. Hold Ctrl + Alt + Shift and click on the Save
icon.
4. Enter a name for the theme. This name will be displayed to the end-users.
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Multi-Language Support for Theme Names
To support multi-language functionality, if the theme name concatenated with ‘_wrThemeId’ matches the id of any element in the language
files then the string of that language element will be displayed to the user instead of the theme name.
For example, in the Basic theme that is installed with Exago, there exists a language id ‘Basic_wrThemeId’. The string associated with
this id is displayed. For more information see Multi-Language Support.

Multi-Language Support
Note
The language elements discussed in this article do not include those created by users or administrators such as reports, folders,
express report/crosstab themes or Data Field names. To modify Data Field names please see Column Metadata. To modify theme
names please see Express Report and CrossTab Themes.
Any text in the application can be translated or modified. This can be accomplished by creating XML files in the Config\Language
directory under Exago's Web Application installation directory. These files map IDs to strings. Any place within Exago that displays text
has an associated ID. When a text element is required in the application, Exago will read the file(s) specified in the ‘Language File’
parameter of Main Settings and use the string that is mapped to the ID.
Exago comes with both a standard English file en-us.xml and a Spanish translation es-mx.xml. Below is an example of the multilanguage functionality. Notice that the prompt text in the New Report Wizard can be set by changing the string associated with the ID
NewReportLb1.
En-us.xml:
<NewReport>
<element id="NewReportLbl">Complete the steps in the wizard below to create a new report</element>
</NewReport>

Es-mx.xml:
<NewReport>
<element id="NewReportLbl">Complete los pasos en el asistente para crear un nuevo informe</element>
</NewReport>

Caution
Some language strings contain special place holders between curly brackets (ex. {0}). These hold the place of elements that must be
filled in dynamically by Exago. Do not translate anything inside curly brackets. The place holders may be moved within the string but
do not delete them.
The example below demonstrates three place holders that will be replaced by dropdown menus in the Scheduling Wizard.
<element id="ScheduleRecurrenceRelativeMonthlyTxt">The {DayPosition} {DayOfWeek} of every {MonthNumber} month(s)</element>

Translating Exago
To translate the entire interface, make a copy of the file en-us.xml and give it a different name. Make sure this copy is in the folder
<webapp_dir>/Config/Languages, where <webapp_dir> represents the Exago Web Application installation directory. Without
changing the IDs translate the strings as desired (see example above). Then set the Language File setting in Main Settings to point at
your translated copy.
Note
If you are using the Exago Scheduler Service be sure to copy all custom language XML files to the ‘<scheduler_dir>/Languages’ folder of
each Scheduler Service instance.

Modifying Select Language Elements
To change specific language elements without copying the entire mapping you can use a base file and specify changes in separate
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language files. When you set the Language File setting, list the all of the files you want to load separated by commas or semicolons.
Exago will load the files from left to right, meaning the first file listed will be used as a base and can be changed by the files loaded after it.
As an example you can create the file en-custom.xml which only contains the lines:
<?xml version="1.0" encoding="utf-8" ?>
<element id="GettingStartedTab">Home</element>

Set the Language File setting to en-us, en-custom and the Getting Started tab will reflect the change made in the custom file.

Note
Begin all language XML files with the line <?xml version="1.0" encoding="utf-8" ?>

Text of Prompting Filters and Parameters on Dashboards
When adding a Report to a Dashboard a user can specify text for any prompting Filters or Parameters. By default this text will match the
strings associated with the ids CompositeReportOptionsFilterDefaultPromptText and
CompositeReportOptionsParameterDefaultPromptText respectively.
If a user changes the default and enters a different language Id then the associated text for that new Id will display when the dashboard is
executed.
If a user enters text that does not match any language Id the text will be displayed when the dashboard is executed.

Theme Names
Names of custom chart, GeoChart, CrossTab, ExpressView and Express Report themes can also be translated. Review the MultiLanguage Support for Theme Names section of the Themes article for more information.

An Overview of Exago Extensions
Exago extensions allow developers to access, extend and modify the platform's capabilities to suit particular needs that can't be handled
"out-of-the-box".
The interface for most capabilities is via coded elements, done either via Code Editor in the Administration Console or external code
modules provided via .NET Assemblies or Web Services. Other situation-specific options are also available, such as providing custom
parameterized SQL.
The following extension types are supported. More information on each type is provided in the remainder of this document:
Custom SQL
Custom Functions and Filter Functions
Server Events
Action Events
Custom Data Sources
External Interface
Custom Options

Custom SQL
Exago supports a Custom SQL type Data Object. Objects of this type are very similar to pre-defined database views. They consist of a
SQL statement, have an implied field schema and return a relational value.
There are a few differences from traditional database views however.
Exago Custom SQL statements can be parameterized. In other words Exago parameters can be embedded within the SQL
statement. Parameters serve as placeholders for runtime values. Upon execution of a report any parameter values will be replaced
with the value of the parameter at runtime. Any part of the SQL statement can be parameterized in this way.
Exago Custom SQL statements behave like any other entity type. Administrators can attach column metadata. Report designers
can filter, sort and layout fields from the entity, etc.
Since the SQL is stored in the Exago configuration no intervention by database administrators is required.

Adding Custom SQL
Add a new Data Object and select the Data Source from the dropdown. Instead of selecting a table or view from the name field, click the
SQL button on the right of the name field.
You will be presented with the SQL code editor. Specify a name for your Data Object (no whitespace or special characters) then enter
your SQL as shown.
Notice the @StartDate@ and @EndDate@ parameters. They can be manually typed or inserted by selecting from the list of Parameters
and selecting the Add button.
When finished select Ok to save your object's information. You can then specify and Alias and select Unique Key Fields like any other
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object.

The SessionInfo Object
The global SessionInfo object is available to Custom Functions, Server Events, and Action Events. It is similar to the API object in that
it contains the full running state of the Exago system during execution.
Collections of metadata and settings normally set in the Administration Console and/or via the API are accessible through the
sessionInfo.SetupData property. Note that for the most part the accessible properties are settable via SessionInfo.
SessionInfo also contains a key object store accessible via two methods:
void sessionInfo.SetStoredValue(Object key, Object value)
Object sessionInfo.GetStoredValue(Object key)

Custom Functions and Custom Filter Functions
Custom Functions and Custom Filter Functions allow developers to create abstracted high level language routines that are used by
report designers. Standard Custom Functions appear in the Exago Formula Editor as if they were part of the product. Custom Filter
Functions are available to use as values in user formulas.
Both types of functions have access to the SessionInfo object, creating powerful opportunities for context-sensitive processing as well as
storage. In the case of Custom Functions, global storage can be used to maintain counts as the report is processing.

Server Events
Server Events are handlers invoked on the server side during the normal execution lifecycle. They allow developers to inspect and/or
modify running state to achieve situation-specific objectives. Server Event handlers also have access to the global SessionInfo object,
providing the same global storage and state variables as mentioned above.
A commonly used event is the OnReportExecuteStart event, which allows the handler to make modifications to a report just prior to
execution. Another commonly-used event is OnExecuteSqlStatementConstructed which is invoked after Exago generates SQL
but before it is shipped to the data source. This event can be used to simply log the SQL for audit or diagnostics or to modify it to e.g.
substitute actual fields for placeholders.

Action Events
Action Events are handlers invoked on the client side during the normal execution lifecycle and include an abstracted interface for serverside callbacks to gather data as needed and perform similar tasks. They offer a rich interface for modify charts and dashboard reports in
response to user actions. There are also specific interfaces to allow trapping and instrumentation of things like user saves.

Custom Data Sources
In additional to traditional relational data sources Exago can consume data from programmable data sources such as .NET assemblies
and SOAP-based web services. Connection to and marshalling of the data sources is handled at the metadata layer, just like standard
sources. This capability provides two key benefits to end users:
Data from multiple disparate sources can be combined into a single report, visualization or dashboard
The end user view is the same regardless of the type of data source. Users will see no difference between relational and
programmable data sources when building reports and dashboards.
Custom data sources are often used when it is desirable to make use of an existing business logic layer such as a means to pull data
from non-traditional or distributed sources.

External Interface
The External Interface is a set of pre-defined event types that can be trapped and instrumented. External Interface events are similar to
Server Events with two key differences: External Interface can be invoked via web service (whereas Server Events require code developed
using the Administration Console code editor or via .NET assemblies). As a result External Interface methods do not have access to the
global SessionInfo object.

Custom Options
Custom Options allow administrators to alter the Exago UI to capture custom input from report designers. The values chosen by the
designer are available via the sessionInfo object and are thus accessible to Server Event and Action Event handlers.

Introduction to Server Events
This article applies to the Admin Console >

Extensions >

Server Events settings.

Server Event Handlers provide code that Exago can execute when certain events happen during the application runtime. This code can
either come from a .NET Assembly or be written in a high-level programming language.

Create, Edit, Delete Server Event Handlers
To add a new custom function click

Extensions >

Server Events in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit a function either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete an object either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new functions click the Apply or Okay buttons

Server Event Handler Properties
Each Server Event Handler has the following properties:

Name
Provides a unique identifier for each Event Handler
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Function
Choose between Custom Code or the name of a .NET Assembly. If there are no .NET Assembly Data Sources available, Custom Code will
be the only available option.

Custom Code
To save code directly in Exago, select Custom Code from the first function dropdown. Clicking on the second dropdown opens the custom
code dialog.

Custom Code dialog
Custom Code has three additional properties:
Language: Code can be written in C#, JavaScript (in Windows only) or VB.NET.
References: A semicolon-separated list of any DLLs that need to be referenced by the code. The DLLs must be present in the
\bin folder of the Exago Web Application, Scheduler Services, and the Web Service API if applicable. This folder can be found in
the installation directory of the respective component.
Note
System.dll does not need to be listed as a reference as it is already available.
Code: The code that will be executed by Exago when called. See Arguments for information on how to access the arguments for
each Event. When finished, click the Test Custom Code
icon to check if the code compiles.

.NET Assembly
There are two ways to reference a .NET Assembly method.
1. Create a .NET Assembly Data Source. Select the desired assembly from the first Function dropdown. Clicking on the second
dropdown will open a list of available methods.
2. Add the .NET Assembly to the \bin folder of the Exago Web Application, Scheduler Services, and the Web Service API if
applicable. This folder can be found in the installation directory of the respective component. Then in the Custom Code window, add
the assembly as a reference and invoke the method, for example:
return Extensions.Events.CensorEmployeeBirthYear(sessionInfo, args);

Global Event
Determine when this Server Event Handler will be called, either whenever specific event type occurs, or only when that event occurs for
specific reports.
Select a Global Event from the list to indicate that the Event Handler should be called whenever this event occurs in the
application for all report executions.
Leave Global Event set to None to indicate the Event Handler is meant for a specific report. See Setting Event Handlers on
Specific Reports for more information. For example, selecting OnReportExecuteStart from this dropdown will cause the Event
Handler to be called at the start of any Report Execution.

Arguments
Server Event Handlers can access the following information in order to inspect the session state, and utilize built-in methods:
sessionInfo – The sessionInfo object provides access to elements of Exago's current session such as parameters, filters, and the
current report.
args – Events may have access to an array of values called args. For each Event the content of the array will be different. For
details on the arguments that each event provides, see Full Description of Events.

.NET Assemblies
The following are important details for using .NET Assemblies as Server Event Handlers.
The Assembly DLL will be locked by Exago when it is first accessed. To replace the DLL, unlock it by restarting the IIS App Pool
(and Scheduler Services, if applicable).
The first argument of all Event Handlers is the sessionInfo object which can be used to access elements within the Exago session.
To make use of this object the assembly must reference WebReportsApi.dll.
If the code does not need to make use of sessionInfo then the method signature in the assembly can declare sessionInfo as an
object instead of as a sessionInfo data type.
All methods used as Event Handlers must be static.
Note
If WebReportsApi.dll or another Exago DLL is referenced by the assembly, then it must be recompiled to the current version
whenever Exago is updated.
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Adding Server Events to Specific Reports
Event Handlers can either be set to run during the execution of every report or to only be called when executing specific reports.
NOTE. When multiple Event Handlers are set to run for a single Event, all the Event Handlers are run using the same input values and
then the first non-null return value is used by Exago. This means that the return value of Report-specific Event Handlers will take
precedence over global Event Handlers.
Ex. Suppose there is a global Event Handler for OnExecuteSqlStatmentConstructed that logs each reports SQL query and a report
specific Handler that modifies the ‘Where’ clause of the SQL. When the specified report is run, both Handlers will be executed and return
an SQL string. If non-null, the modified SQL from the report specific Event Handler will be utilized by Exago to query the database.
To set an Event Handler to be report specific:
In the Administration Console:
1. Set the Event Handler’s Global Event to None. Click Apply or Ok.
2. In the Feature/UI Settings set Show Events Window to True. Click Apply or Ok.
In the Reporting Application:
1. In the Main Menu select the desired report and double click or click the edit button.
2. Select the Report Options drop-down menu and hover over Advanced. Click Events. This will cause the Events Menu to appear.

3.
4.
5.
6.

In the Event Menu click the Add button.
From the Event dropdown select when the Event Handler should be called.
From the Action dropdown select which the desired Event Handler.
Click Okay and save the report.

Displaying User Messages
Some Server Events are designed to display messages to the user based on a return value. For the other server events a user message
can be displayed by throwing the following exception method.
WrUserMessage(string messageOrId, wrUserMessageType Type)
Description

Displays a message to the user.

Remarks

wrUserMessageType can either be Text or Id.
Text – The user message will display the string message
Id – The user message will display the string associated with the Id in the Language Files.
This requires a reference to WebReports.Api.Common

//OnWebServiceExecuteEnd, inspect the returned value and throw a
//message if it matches any of the error messages.
object webServiceResult = args[0];

Example

switch(webServiceResult.ToString())
{
case "message1" : throw new WrUserMessage("Some Message to User", WrUserMessageType.Text);
}
return webServiceResult;

Note: This cannot be used for the Events OnConfigLoadStart, OnConfigLoadEnd or OnExceptionThrown.

SessionInfo
Custom Functions, Server Events, Action Events, and Assembly Data Sources can access the Exago session state through a
sessionInfo variable. Access to sessionInfo allows powerful new capabilities such as the ability to persist values across function
invocations, allowing each invocation to be aware of previous calls and behave accordingly.

Properties
PageInfo
This is the parent of all information in the current session. Included are the active Report and SetupData objects.
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Note
Since the Report and SetupData objects are accessed frequently, direct pointers are included for these objects.

Report
An object that contains all of the report’s Data Object, sort, filter, and layout information.

SetupData
An object that contains all of the session’s configuration settings including Functions, Parameters, Data Objects, Joins, Roles, etc.

CompanyId
Contains the value specified by the system CompanyId parameter.

UserId
Contains the value specified by the system UserId parameter.

JavascriptAction
This object is set when sessionInfo is called from an Action Event. It is primarily used to load the client-side Javascript:
JavascriptAction.SetJsCode(string sCode): Pass the client side code as a string. The Action Event must return the
JavascriptAction object.

Methods
GetReportExecuteHtml(string reportName)
Executes the specified report and returns its HTML output. This could be used to embed a report within a cell of another report.
Note
The reportName is relative to the session's report path.

GetParameter(string parameterName)
Returns the specified Parameter object. GetParameter first looks in the Report Parameter collection, parameters being utilized by the
report, and then in the Config Parameter collection, as well as other parameters such as hidden parameters or multi-tenant values.

GetReportParameter(string parameterName)
Returns the specified Parameter object that is utilized by the report being executed.
Note
If a parameter is prompting a user for a value it will be available with the prompted value.

GetConfigParameter(string parameterName)
A method that returns the Parameter object stored in the default configuration.

WriteLog(string text)
Writes the specified text to Exago’s log file.
Note
The following methods utilize Stored Values which are objects that can be created and set by Custom Functions during report
execution to pass data between calls. Stored Values only exist for the duration of report execution.

GetStoredValue(string valueName, object initialValue = null)
Retrieves a Stored Value. If a there is no Stored Value with the specified valueName, then one will be created with the specified
initialValue.

SetStoredValue(string valueName, object newValue)
Sets the value of a Stored Value. Setting newValue to null will delete the Stored Value.

Calling Functions
To call an existing function from within your extension, use the class CellFormula and return the method
CellFormula.Evaluate(null).

Example
CellFormula formula = CellFormula.CreateFormula(sessionInfo.PageInfo, formulaText, CellVariableCollectionFilter.DataField);
return formula.Evaluate(null);

CellVariableCollectionFilter types:
DataField
AggFunction
CellReference
LinkedReport
Parameter
WidgetCellReference
All
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Introduction to Action Events
This article applies to the Admin Console >

Extensions >

Actions Events settings.

Action Events can be grouped into two general categories: Local and Global events.
Local events have two sub-categories:
Handlers attached to items in reports and set to fire automatically, or when the item is interacted with in the Report Viewer.
Handlers attached to items in the Web Application User Interface and set to fire when that item is clicked.
Global events are active throughout the application, and fire when specific events occur.
This article explains how to create Local and Global Action Events, describes the ways in which Action Events can interact with the
Exago application, and lays out examples for common usage.

Create, Edit, Delete Action Events
To add a new action event click

Extensions >

Action Events in the Main Menu and either:

click the Add
icon at the top of the main menu
right-click and select Add from the context menu
To edit an action event either:
double click it
select it and click the Edit
icon at the top of the main menu
right-click it and select Edit from the context menu
To delete an action event either:
select it and click the Delete
icon at the top of the main menu
right-click it and select Delete from the context menu
To save changes and new functions click the Apply or Okay buttons
They can also be added or modified on a per-session basis via the .NET API using the Api.SetupData.ActionEvents server call.
This section details how to create Action Events through the Web Application but contains important details about programming them
which will apply to the .NET API as well.

Action Event Properties
Each Action Event has the following properties:

Name
A unique identifier for each Action Event.

Function
Can either be custom code or a .NET Assembly method.

Custom Code
To save code directly in Exago, select Custom Code from the first Function dropdown. Clicking on the second dropdown opens the
Custom Code dialog. See the Writing Action Events section below for information on how to access the arguments for each Event.

Custom Code has four additional properties:
Language: Code can be written in C#, JavaScript (in Windows only) or VB.NET.
References: A semicolon-separated list of any libraries that need to be referenced by the Action Event. The DLLs must be present
in the \bin folder of the Exago Web Application, as well as any Scheduler \bin folders, and the Web Service API, if applicable.
Note
System.dll does not need to be listed as a reference as it is already available.
Namespaces: A semicolon-separated list of namespaces in the referenced DLLs or the Exago API library.
Code: The code that will be executed.
When done writing code, click the Test Execution icon to test the code for errors.

.NET Assembly Method
There are two ways to reference a .NET Assembly method.
Create a .NET Assembly Data Source. Select the desired assembly from the first Function dropdown. Clicking on the second
dropdown will open a list of available methods.
Add the .NET Assembly to the \Bin folder (for the Web Application, Web Service API, and all Scheduler Services, if applicable).
Then in the Custom Code, add the assembly as a reference, then invoke the method, e.g.
return Extensions.Events.CensorEmployeeBirthYear(sessionInfo, args);
Note
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The Assembly’s DLL will be locked by Exago when it is first accessed. To replace the DLL, unlock it by restarting the IIS App pool.
Note
If you want to utilize the sessionInfo object that is passed to all Action Events the Assembly must include a reference to
WebReportsApi.dll. For more information see the article on SessionInfo.
Note
All methods used as Action Events must be static.

Event Type
Select an option in this dropdown to create an local event that will be executed when certain client-side actions are taken.
None: This Action Event is a Global Event. A value must be set for Global Event Type.
Load: The Action Event will execute when a report item is loaded in the Report Designer, Report Viewer, or upon Export. This
type of handler is typically used to interpret and then apply alterations to report data, e.g. conditionally changing the colors on
charts or maps.
As of v2016.2.5+ Load events can affect Export formats (PDF, Excel, RTF, CSV).
Click: The Action Event will execute when a user clicks on an item in a report or in the Exago UI. This type of handler is typically
used to add additional interactive elements to reports or to the Report Designer. Click events will not function on Export formats.
For information on adding action events to specific reports, see Adding Action Events to a Report.

Global Event Type
Select an option in this dropdown to create an event that will be triggered when a condition is met in the Exago application. The Global
Events article contains descriptions of all of the available event handlers.
Note
Selecting a Global Event Type will cause Exago to ignore any selected Local Event Type.

Assigned UI Item(s)
This field designates a semicolon-separated list of UI item IDs for items in the Exago interface. These elements can be intercepted and
modified by entering them in this field.
Important
This selection field only applies when the Event Type is Click. This field will be ignored when any other options are selected.

Writing Action Events
When an Action Event is fired, two primary parameter objects are passed: sessionInfo and clientInfo. These are the main points of
interaction with the Exago application.
sessionInfo: Provides access to all the elements of the current Exago session. This is the server-side information. For more
information see the article on sessionInfo.
Note: To access sessionInfo from a .NET Assembly, a reference to WebReportsApi.dll must be included.
clientInfo: A JavaScript object that is accessed from within the client-side script. Provides access to any specified client-side
parameters and information about the item attached to the Action Event. For a breakdown of the elements in clientInfo, see
ClientInfo.
arguments array – The server-side portion of action events can also access an array of input values called args. These parameters are
passed manually from client code to server code using the function clientInfo.ServerCallback(eventName, args...).

Global Action Events
Global Actions Events are actions that can be attached to one of a specific list of events that will occur within the Exago application.
These events usually trigger in response to user input, but they are not necessarily directly related to the input action, and thus will not
transfer information about the user input. However, global events are more reliable than capturing user clicks, especially in response to
actions that can be taken in a variety of ways, such as saving a report.
A subset of global events, namely the ones which are used to handle report tree interaction, require a boolean return value or a Promise of
a boolean in the client script. True indicates to Exago to stop the normal course of action, which we have replaced with our custom code.
False indicates that we should continue with the normal action. If any action event returns a Promise Exago will await the Promise before
taking action based on the boolean result.
For example, when double-clicking on a third party (non-Exago) report, we may want to launch an external editor instead of the Exago
report designer. We would check the report type, and if it is a third party report, we would insert our callout and then return True. If it is a
regular Exago report, we would continue with the normal course of action by returning False.
For these events to be able to have a return value, they must be enclosed within a JavaScript function. This means that if you want to write
the full client scripts in the admin console (rather than calling out to a separate function) each event will need to be wrapped in an autoexecuting anonymous function, like so:
string jsCode = @"(function()
{
/* javascript stuff; */
return true;
}())";
sessionInfo.JavascriptAction.SetJsCode(jsCode);
return sessionInfo.JavascriptAction;

List of Global Events
Events which require a boolean or Promise of a boolean return value are labeled.

OnSaveReport
Fires when a user attempts to save an open report.
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Warning

Description

This action event replaces the default save handling. If this action event is implemented, reports will
not be saved by the normal means.
Remarks

Passes the report object.

OnDuplicateReport
Description
Remarks

Fires when an open report is duplicated.
Passes the report object.
If the return value resolves to true, then Exago will not launch the report name dialog to allow the user
to select the duplicate report name. If the return value resolves to false, then Exago will launch the
name dialog as usual.

OnEditReport v2016.3+
Description
Remarks

Fires when a report is opened for editing.
Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true, then Exago will not launch the corresponding
Designer. If the return value resolves to false, then Exago will launch the Report Designer as usual.

OnSelectReport v2016.3+
Description
Remarks

Fires when a report item in the folders tree is selected.
Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true, then Exago will not fetch report information
and update the report description box. If the return value resolves to false, then Exago will fetch
information about the report and update the report description box as usual.

OnDeleteReport v2016.3+
Description
Remarks

Fires when a report is deleted from within the folders tree.
Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true, then Exago will not prompt the user to delete
the report. If the return value resolves to false, then Exago will prompt the user to delete the report as
usual.

OnRenameReport v2016.3+
Description
Remarks

Fires when a report is renamed from within the folders tree.
Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true, then Exago will prevent the rename text box
from appearing. If the return value resolves to false, then Exago will show the rename text box as
usual.

OnExecuteReport v2016.3+
Description
Remarks

Fires when a report is executed from within the folders tree.
Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true, then Exago will not execute the selected
report. If the return value resolves to false, then Exago will execute the selected report as usual.

OnDoubleClickReport v2016.3+
Description
Remarks

Fires when a report item in the folders tree is double-clicked.
Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true, then Exago will not launch the report editor. If
the return value resolves to false, then Exago will launch the report editor as usual.

OnRightClickReport v2016.3+
Description
Remarks

Fires when a report item in the folders tree is right-clicked.
Passes the webReportsCtrl object, i.e. the application DOM, including the main UI window, folders
tree, main menu, etc. If the return value resolves to true and the selected node is a “custom” node
created by the client integration, then Exago will hide certain built-in menu items. If the return value
resolves to false, then Exago will show the normal context menu.

OnAfterAddDataObject
Description

Fires after a data object is added to a
report.

OnBeforeRemoveDataObject
Description

Fires before a data object is removed from a
report.

OnChangeParameterValue
Description
Remarks

Fires when the value of a parameter in a prompt is changed
This is commonly used in conjunction with parameter drop-downs in order to selectively enable,
disable, and populate fields.

OnDashboardResize
Description
Remarks

Fires when a running dashboard has its container size changed, by either the web page or the browser
window
This is commonly used to enable dashboards to re-format their contents in response to changing
screen size.

OnBeforeCloseApiWindow
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Fires when the user clicks the cancel button in an iFrame or modal window containing a report wizard.
This can be used to provide a JavaScript callback to close the window automatically, rather than
returning to a blank page.

Remarks

OnSaveReportSuccess v2017.1+
Fires after an existing report is successfully saved from a Wizard, Designer, or Viewer. Works for all
report types. Also fires when an Advanced Report is created from an ExpressView, Express Report or
a Dashboard Visualization.

Description

Does not fire when a report is duplicated, or when a User Report is saved as a new Advanced Report
from the Report Viewer. Use OnDuplicateReport for these cases.
This can be useful for implementing handlers to update the host application after reports are saved.
This does not interfere with the default report saving behavior.
Remarks
Report name (path and filename) is available to the action event handler through the reportName
property of the ClientInfo object.

OnClassifyUserInputURL v2018.2.6+
Fires when a URL is loaded (e.g., when a URL is added to a URL tile in the Dashboard Designer or
when a URL is loaded upon dashboard execution) or clicked (e.g., when an end-user clicks a URL in
an executed report or report description).

Description

Only fires on loading in the Dashboard designer or on an executed Dashboard.
This event is used for determining whether a URL is internal or external to the host domain, and can be
utilized to prompt users for verification when attempting to access external URLs.
Remarks

The urltoclassify property is an available property of the ClientInfo object allowing for the specification
of the URL
Please see Action Event: External URL Confirmation for more information.

Actionable UI Elements
Advanced Reports
The following Report Designer toolbar items can be attached to a Click Action Event.
ID

Icon pre-v2019.2

Icon v2019.2+

Description

ReportOptionsBtn

Report Settings menu

SaveReportBtn

Save Report

DesignNewReportBtn

Design New Report

UndoBtn

Undo

RedoBtn

Redo

FormatCellsBtn

Cell Format window

FormatPaintbrushBtn

Format Paintbrush

BoldBtn

Bold

ItalicBtn

Italic

UnderlineBtn

Underline

UnderlineSelect

Underline type select

AlignTopBtn

not available v2019.2+ Vertical Align - Top

AlignMiddleBtn

not available v2019.2+ Vertical Align - Middle

AlignBottomBtn

not available v2019.2+ Vertical Align - Bottom

MergeCellsBtn

Merge Cells

SplitCellsBtn

Split Cells

AlignLeftBtn

not available v2019.2+ Horizontal Align - Left

AlignCenterBtn

not available v2019.2+ Horizontal Align - Center

AlignRightBtn

not available v2019.2+ Horizontal Align - Right

AlignJustifyBtn

not available v2019.2+ Horizontal Align - Justified

WrapTextBtn

Wrap Text

AutoSumBtn

Auto Sum

EditFormulaBtn

Formula Editor

SuppressDuplicatesBtn

Suppress Duplicates

CrossTabWizardBtn

CrossTab Report Wizard

LinkedReportBtn

Linked Report/Drilldown

LinkedActionBtn

Linked Action

GoogleMapBtn

Google Maps Wizard

MapBtn

GeoCharts Wizard

ExpressView v2019.1.12+
Beginning with v2019.1.12+, the following ExpressView toolbar items can be attached to a Click Action Event.
ID
ExpressViewLiveDataButton

Icon
Live Data

Description
Start/Stop using live data

Live Data

Example
The return value of the embedded JavaScript determines whether the result of clicking the button should take place.
If the Action Event returns True, then toolbar item action is cancelled
If the Action Event returns False, then the toolbar item action is carried out
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ExpressViewLiveData only: If the Action Event implementation returns a Promise, then the toolbar item action continues if and
when that Promise resolves False (for v2019.1.12+).
string JsCode = @"(function() {
return !confirm('Continue?');
}())";
sessionInfo.JavascriptAction.SetJsCode(JsCode);
return sessionInfo.JavascriptAction;

ClientInfo
This article describes the properties and methods in the clientInfo object and what they are commonly used for.
Note
If an element is not listed here, it is likely intended for internal use and should not be accessed.

Properties
showHourglass
Description

Set to False to disable the progress icon that appears when data is being saved or
loaded.

includeReportData
Description

Set to False to prevent the client from passing the sessionInfo object to the server
whenever a server callback is done.

Remarks

It may be useful to disable this to limit overhead if access to sessionInfo is not needed
for a specific callback.

includeReportSaveData
Description

Set to False to prevent the client from passing the report save data to the server
whenever a server callback is done.

Remarks

The SaveData is an additional set of data passed whenever a report is saved. This
information is only passed by an onSaveReport global event. It may be useful to
disable this to limit overhead if the save data is not needed for a specific callback.

refreshDataOnReturn
Description

Set to False to prevent the client Viewer from refreshing the report whenever a server
callback alters report data.

Remarks

If a SaveReport callback does not alter the appearance of the report, it may be useful
to disable this to limit overhead.

Utilities
Description

Access to a large variety of utilities and controls.

Remarks

Likely unnecessary in most cases. A pre-written action event provided to you by a
support analyst may make use of this.

webReportsCtrl
Description

Access to the Exago Web Reports UI.

Remarks

Often used in order to add or remove items from the report tree sidebar. Useful for
allowing Exago to handle third-party report objects.

contextObject
Description

A generic class for the object which the action event call was attached.

Remarks

The more specific context items below provide a superset of this class.

dashboard, dashboardItem, report, chartData, chartSeriesDataPoint, chartItemDataPoint,
reportWidgets, categoriesCtrl, parameterListCtrl
Description

Specific classes which are set depending on the context of the call. Contain
information about the object for which the action event call was attached.

Remarks

These are set contextually depending on the object of the call. For example, chartData
will only be set if the action event was attached to a chart or gauge.

uiElement
Description

Provides information about the UI element called by a "click" local action event. For a
list of supported elements, see UI Elements.

isSandboxMode
Description

True if an action event is running in a non-interactive environment, i.e. any non-html
environment, where javascript interactivity is not permitted. Includes all export types:
PDF, Excel, RTF, CSV.

urlToClassify
Description

String value of a URL. To be classified as "external" or "internal". Requires user
confirmation if classified as external.

Remark

This property corresponds specifically with the OnClassifyUserInputURL Global
Action Event. For an example of a use case, please see Action Event: External
URL Confirmation.
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Methods
ServerCallback(args[])
Description

Call back to the server with any given arguments.

GetLanguageData(id)
Description

Returns the text and tooltip info from the language file for the specified UI item.

ExecuteParentFunction(func, args), GetParentFunction(func),
GetParentByFunctionName(func)
Description

If the Exago UI application is running in an iFrame these are helper functions to call
javascript functions in the parent frame.

Remarks

These functions are for convenience and safety. They are generally the same as
calling Parent.FunctionName.

LoadHtmlDialog(html, options)
Description

Creates and loads an HTML dialog box. Accepts an HTML string or an html element.
Accepts several options.

SetDialogValue(elementId, value)
Description

Populates the given element of a dialog with a given value.

GetDialogElementById(elementID)
Description

Finds and returns the element given by its ID.

Alert(alertText)
Description

Creates and loads an HTML alert dialog with the given text.

UpdateChart(chartWidget, chartData)
Description

Updates the given chart with the given data and re-renders it in the report.

GetDashboardReports(options)
Description

Returns all the reports on the dashboard as report objects.

GetDashboardWidgets()
Description

Returns all the widgets on the dashboard (i.e. all dashboard elements besides
embedded reports).

EditReport(reportName, options)
Description

Opens the Report Designer for the given report with options. See .NET API.

ExecuteReport(reportName, exportType, options)
Description

Executes the given report with options. See .NET API.

StartNewReportWizard(reportType)
Description

Starts the New Report Wizard for the given report type.

GetClientReportObject(reportName)
Description

Returns the given report object by name.

LoadUrlToNewTab(string url)
Description

Opens a new tab with the provided URL as the contents.

Introduction to the .NET API
The Exago interface consists of two elements: The User Interface and the API. The User Interface is built directly onto the .NET API. This
means that .NET applications can interface directly with Exago. Non-.NET applications can interface with the REST Web Service API,
which offer subsets of the .NET API.
This guide will walk through the process of integrating Exago into a .NET-based web application. We will demonstrate how to use the API
to connect with an existing installation of the Exago Application, and showcase how to do some basic report management tasks.
For this example, we will load an existing report, modify its run-time filters, and then execute the report in a browser window.

Referencing the API
First reference the Web Reports API library. This is usually located in the <WebApp>\bin folder, where <WebApp> represents the install
directory of the Exago Web Application. The file is named WebReportsApi.dll .
Include the following namespaces for now:
WebReports.Api: Contains the Api class which is the main interaction class between Exago and your application.
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WebReports.Api.Reports: Contains the Report class, for creating and managing reports.
WebReports.Api.Roles: Contains classes for managing role security settings.

Creating an Api Object
An Api Object is the main class you need to create in order to interact with Exago. It contains the first and last points of entry for each
instance of your application.
Create an Api Object using the following overloaded constructor:
Caution
Do not call the constructor with no arguments.

Api myApi = new Api(AppPath);

AppPath is the physical or virtual location of your Exago installation.
Note
You can use the ConfigFile parameter to load an Exago Config file. If left out, it will default to WebReports.xml.

Loading a Report
Now let's load the report we want to modify.
Report myReport = (Report)myApi.ReportObjectFactory.LoadFromRepository(@"TestReport");

Note
You do not need to specify the file extension. The application will not allow reports of the same name but different types.
The ReportObjectFactory class is the collection class for report management methods. This contains methods for creating, loading,
copying, saving, renaming, and deleting report files. It can be used to work within a repository or a temporary browser session, or both if
necessary. In this case, we're simply loading a pre-existing report into the Api.
Note
Several methods reference an Active report by default. This is usually the last report accessed, but can be specified by the Active
property of the ReportObjectFactory.
Reports called from within the ReportObjectFactory are ReportObject objects, which is a general class representing the various report
types.
We are casting the ReportObject called from the factory to a Report, because we know it is a report. Report inherits several methods from
ReportObject, but greatly expands the management capabilities.
Note
If we loaded a Dashboard or a Chained Report, we would cast it to DashboardReport or ChainedReport respectively.
See Loading Reports in the .NET API for more information.

Retrieving the Role Security
Let's see if the current user has access to the database object we want to filter for.
if (myApi.Roles.ActiveRole.Security.DataObjects.GetDataObject("Customers") != null)
{ Permission Granted!; }
else Permission Denied!;

The Roles object allows for accessing and modifying the elements found within the Admin Console. Changing or adding Role settings will
only persist for the current session, and will not modify the config file.
We can also set some additional security and restrict the user from seeing specific data object rows:
DataObjectRow dataObjectRow = myApi.Roles.ActiveRole.Security.DataObjectRows.NewDataObjectRow();
dataObjectRow.ObjectName = "SSN";
dataObjectRow.FilterString = "false";

Modifying the Report
Now that we have loaded and declared our Report object, we can begin to modify its contents. Let's clear out the pre-existing runtime
filters, and add one of our own:
foreach (Filter oldFilter in myReport.Filters)
{ myReport.Filters.Remove(oldFilter); }
Filter myFilter = myReport.Filters.NewFilter();
myFilter.DbName = "Customers.CompanyName";
myFilter.Operator = wrFilterOperator.NotEqualTo;
myFilter.Value = "Exago Inc.";
myFilter.AndOrWithNext = wrFilterAndOrWithNext.And;

Note that all these modifications will take place within the current session, and will not modify the report definition itself unless you
specifically overwrite it.

Closing the Session and Executing
Let's execute the altered report. First, some administrative action is required.
Set the report execute type to HTML, so it runs in the browser:
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myReport.ExportType = wrExportType.Html;

And hide the application tabs to avoid clutter:
myApi.ShowTabs = false;

Now save the changes we've made to the Api. This will load the report into a temporary space in the Api to prepare for execution.
myApi.ReportObjectFactory.SaveToApi(myReport);

And we're all set! Calling the following method will end the session, perform the specified action, and return the session URL. The session
URL is an alphanumeric single-use identifier for the session. Append it to your Exago application URL.
Since we loaded a report into the Api, the action defaults to Execute.
string url = @"//MyDomainServer/Exago/" + myApi.GetUrlParamString(ExagoHome);

Note
The ExagoHome parameter can be used to specify the Web Application's home page. It will default to ExagoHome.aspx.
Now redirect your browser to the generated URL and see the results!

Load Reports in the .NET API
The ReportObject Class
All Report type objects inherit from ReportObject. The class includes basic functions such as loading and saving the objects. Report
type objects consist of simple report types such as ExpressView and Advanced, and composite types such as Dashboard and Chained.

Accessing Reports via the API
A Report is normally loaded via API in order to launch directly into the execution or editing of the report. In most cases, report loading is
handling by the Exago runtime via the LoadFromRepository call. LoadFromRepository returns an object of type ReportObject.
In order for the load to complete, a corresponding SaveToApi is done. SaveToApi will save the ReportObject, including any
modifications back to the API for loading (for execution or editing). Both LoadFromRepository and SaveToApi can be accessed via
the Api.ReportObjectFactory property.
Both LoadFromRepository and SaveToApi return and store a ReportObject respectively. Most modifications made to a report
loaded at runtime (such as changing filter values) are performed on properties defined within the child types (such as Report or
DashboardReport). Such modifications would require a cast of the ReportObject to the appropriate child type.
If no modifications are required, the sequence is simple:
//Load the report -- Refers to the full folder path
//Followed by the report name
ReportObject ro = api.ReportObjectFactory.LoadFromRepository();
//Save the report back to the API
api.ReportObjectFactory.SaveToApi(ro);

If modifications are desired, it is necessary to cast the value returned by LoadFromRepository to the appropriate base type. Supported
base types include:
WebReports.Api.Reports.Report for Advanced, CrossTab and Express Reports.
WebReports.Api.Composite.Dashboard.DashboardReport for Dashboards.
WebReports.Api.Composite.Chained.ChainedReport for Chained Reports.
For example, you can modify Filters on a report to be executed as follows:
//Load the report -- Refers to the full folder path
//Followed by the report name
Report report = api.ReportObjectFactory.LoadFromRepository() as Report;
report.Filters[0].Value = ;
//Save the report back to the API
api.ReportObjectFactory.SaveToApi(report);

Note
The filter change will only apply to this execution of the report. The report design itself will not be modified.

.NET API General Reference
This article contains a list of examples for using the .NET API's various features. The .NET API can be used for many purposes, and the
most common is to create secured access points for end-users via browser sessions. However, you can also use the API to create and
manage schedules, generate config files and reports programmatically, edit existing reports, and more.
Note
This guide is kept up to date for the most current version available. For a list of changes in the API, see the Updating Guide.

Getting Started
Exago BI .NET applications must include a reference to the file WebReportsApi.dll , found in the bin folder of the application
installation directory. This contains all the classes and method groups necessary for the examples in this article.
Optional: If you are connecting to a .NET Assembly Data Source, you will need to include a reference to WebReportsAsmi.dll. A
reference to WebReports.dll is unnecessary, except in some rare cases that are not discussed in this guide.
The following Exago BI namespaces are used in the examples in this guide:
WebReports.Api
WebReports.Api.Reports
WebReports.Api.Common
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WebReports.Api.Data
WebReports.Api.Roles
WebReports.Api.Programmability
WebReports.Api.Scheduler
WebReports.Api.ReportMgmt
WebReports.Api.Theme
As well as the following system namespaces:
System.Collections.Generic
System.Linq
System.Xml

Contents
API Object
Sorts and Filters
Settings
Role Permissions
Advanced Configuration
Scheduling
Managing Files and Folders

API Object
An API object must be instantiated at the start of an API application since it is the access point for all API activity. API objects also
encompass sessions which are used to encapsulate user-specific changes, such as security and permissions settings.
Note
Variable names, such as "api" and "report", are declared in their respective sections in this guide, then referenced throughout the
remainder.

Constructors
Basic constructor: appPath is the file path or virtual path to Exago base install.
Api api = new Api("appPath");

Specify a config file (other than the default WebReports.xml)
Api api = new Api("appPath", "configFn");

Custom config file and its location in Azure storage (must match web.config)
Api api = new Api("appPath", "configFn", "azurePath");

Let the host application configure log4net
Api api = new Api("appPath", bool isLogCustomConfig, "configFn");

Write to the default log file ([Temp]\WebReportsApiLog.txt)
Logger logger = Log.GetLogger();
logger.Info("message"); // Writes at info level

API Action
The location to direct the Exago interface when first loaded. Edit or Execute actions work on an "active" report.
api.Action = wrApiAction.Home;

Hide tabbed UI
api.ShowTabs = false;

Active Report
Load a report from repository. Makes it the active report. "reportName" is the fully qualified path relative to the base report directory without
the file extension. ReportObject is a generic class encompassing all report types.
ReportObject reportObject = api.ReportObjectFactory.LoadFromRepository("reportName");

Report is validated (checked for errors) unless overridden
ReportObject reportObject = api.ReportObjectFactory.LoadFromRepository("reportName", bool validate);

Manually validate
reportObject.Validate();

Check the errors list. See list of error types.
foreach (ReportValidationError error in report.ValidationErrors)
{
string.Format("Error: {0}\n\t{1}\n\t{2}\n",
error.ReportErrorType.ToString(),
error.Data1,
error.Data2);
}

Get the report type
string reportType = reportObject.ReportType.ToString();

Cast the report object to higher level class
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Report report = (Report)reportObject;

Validate the export type
bool IsReportAllowPdfExport = report.IsExportTypeAllowed(wrExportType.Pdf);
bool IsConfigAllowPdfExport = api.General.AllowPdfOutput;

Set the export type
report.ExportType = wrExportType.Pdf;

Launch Exago and Execute Report
To launch in a browser frame with specified Action, get the App URL to redirect the browser. Redirecting to the App URL closes the API to
further changes. It should be the last thing done.
Get the App URL, with the default home page "ExagoHome.aspx"
string appUrl = api.GetUrlParamString();

Specify a custom Exago home page, "homePage" is the file name without the file extension
string appUrl = api.GetUrlParamString("homePage");

Set ShowErrorDetail to true, for more detailed user error messages
string appUrl = api.GetUrlParamString(null, true);
// This is equivalent to:
string appUrl = api.GetUrlParamString() + "?ShowErrorDetail=true";

Redirect the browser to the App URL (this will close the API to any further changes)
Frame.Src = baseUrl + appUrl;

GetExecute
As an alternative to API Action, reports can be executed and the data returned directly to the application. This will not close the API. Since
this does not launch Exago, report interactivity is not supported, only bare HTML, JSON, and so on. Acts on the specified report, not the
active report.
string reportHtml = report.GetExecuteHtml();
string reportJson = report.GetExecuteJson();
byte[] reportData = report.GetExecuteData();
string[] reportSql = report.GetExecuteSql();

While report interactivity is not supported for the GetExecute functions, they will still trigger the following Server Events:
OnReportExecuteStart
OnReportExecuteEnd
OnAfterReportExportSuccess
This functionality is included in order to ensure that reports are properly executing according to their design, which may be affected by
these Server Events. For example, a report could trigger OnReportExecuteStart in order to modify the SQL generated, which would affect
the data that is returned upon execution.

Sorts and Filters
You can add sorts and filters to reports at runtime. After making changes, save back to the API for execution in the session.
api.ReportObjectFactory.SaveToApi(report);

Changes could be saved back to the report file on disk
api.ReportObjectFactory.SaveToRepository(report);

Save edited report as a new report
api.ReportObjectFactory.Copy(report, "newName", null);

Sorts
See the existing sorts in a report
foreach (Sort sort in report.Sorts)
{
string.Format("{0}, {1}\n", sort.SortText, sort.Direction);
}

Add a new sort to a report
report.Sorts.Add(new Sort(api.PageInfo)
{
// Use object Alias name, as well as the field Alias name if set
SortText = objectName + '.' + fieldName,
Direction = wrSortDirection.Ascending
});

Formula sort
SortText = string.Format("=Formula({{{0}.{1}}})", objectName, fieldName);

Sorts is an ordered list. Reorder the list to change the precedence of the sorts.
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// Move a sort from position 3 to position 1
for (int i = 3; i > 1; i--)
{
Sort temp = report.Sorts[i - 1];
report.Sorts[i - 1] = report.Sorts[i];
report.Sorts[i] = temp;
}

Filters
See the existing filters in a report
string filterString = ""; // Build a filter summary string for display
foreach (Filter f in report.Filters)
{
filterString += string.Format("{0}{1} {2} {3}{4}",
new string('(', f.GroupStartCnt),
f.FilterText,
f.DisplayOperatorText,
f.DisplayValue,
f.GroupEndCnt > 0 ? new string(')', f.GroupEndCnt) : ' ' + f.AndOrValue + ' ');
}

Add a new filter
// Get the data field info (should first check that the report contains the entity)
EntityColumn field = report.Entities.GetEntity("objectName").GetColumn("fieldName");
report.Filters.Add(new Filter(api.PageInfo)
{
FilterText = field.FullName, // Object and field Alias names
DataType = field.DataType,
Operator = wrFilterOperator.OneOf, // This filter type takes multiple values
DataValues = new DataValueCollection()
{
new DataValue(api.PageInfo, field) { Value = "value1" },
new DataValue(api.PageInfo, field) { Value = "value2" }
}
});

Group Min/Max filters
string groupFilterString = ""; // Build a filter summary string for display
int i = 0;
foreach (GroupFilter filter in report.GroupFilters)
{
groupFilterString += string.Format("{0} {1} for each {2} {3}{4}",
filter.DisplayOperatorText,
filter.FilterText,
filter.GroupName,
filter.IgnoreOtherGroups ? "ignoring other groupings" : "",
(i < report.GroupFilters.Count()) ? ", " : "" );
i++;
}

Add a new group filter
// Should check that the entity and sorts exist on the report
EntityColumn field = report.Entities.GetEntity("objectName").GetColumn("fieldName");
Sort sort = report.Sorts.GetSort("sortName");
report.GroupFilters.Add(new GroupFilter(api.PageInfo)
{
FilterText = field.FullName, // Object and field Alias names
Operator = wrGroupFilterOperator.Maximum,
GroupName = sort.SortText // Or sort.Entities[0].Name, or "EntireDataSet"
});

See Top N filter
// Build a filter summary string for display
// Reports limited to one Top N filter, max one foreach group per filter
string topNFilterString = "";
if (report.TopNItems.Count() > 0)
{
if (report.TopNItems[0].UseTopNItem)
{
TopNItem filter = report.TopNItems[0];
topNFilterString = string.Format("{0} {1} {2}{3}",
filter.Action == TopNAction.top ? "Top" : "Bottom",
filter.Number,
report.Cells.GetCellById(filter.CellId).DisplayText,
(filter.ForEachGroup.Count() > 0) ? " for each " + filter.ForEachGroup[0] : "");
}
}

Add Top N filter
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// Check that the cell exists
int cellId = report.Cells.GetCell(int row, int col).Id;
TopNItem topN = new TopNItem(api.PageInfo)
{
Action
= TopNAction.top,
Number
= int N, // the N in "Top N"
CellId
= cellId,
ForEachGroup = new List<string> { },
UseTopNItem = true
};
// Must be at zero-index position
if (report.TopNItems.Count() == 0)
report.TopNItems.Add(topN);
else
report.TopNItems[0] = topN;

Settings
Change the values of config settings and parameters dynamically, which often depend on user access rights. A dynamic config can be
thought of as an extension of a Role, although Roles aren't necessarily required.

Configuration Settings
api.General.anySetting = newValue;

See Config File and API Setting Reference for the full list of config settings.

Parameters
Parameters are "buckets" for values that persist throughout a session, and are reachable by extensions. You can use them to set custom
environment variables. userId and companyId are built-in parameters for storing user information.
Caution
The .NET namespace System.Web.UI.WebControls also contains a class called Parameter. You may wish to alias one or both
classes to resolve name conflicts.

using wrParameter = WebReports.Api.Common.Parameter;

List config parameters
foreach (Parameter parameter in api.Parameters)
{
string.Format("Name: {0}, Value: {1}\n", parameter.Id, parameter.Value);
}

Get a specific parameter by Id
Parameter parameter = api.Parameters.GetParameter("parameterId");

Add a new parameter
api.Parameters.Add(new Parameter(api.PageInfo)
{
Id
= "foo", // No spaces
DataType = (int)DataType.String,
Value
= "bar"
});

Non-hidden parameters are usable on reports
parameter.IsHidden = false;

Prompting parameters will ask the user for a value when running a containing report
parameter.PromptText = "Enter a value";

Prompting parameters can display a selection list based on a data field or custom SQL
Entity entity = api.Entities.GetEntity("entityName");
parameter.DropdownDataSourceId
parameter.DropdownObjectType
parameter.DropdownDbName
parameter.DropdownValueField
parameter.DropdownDisplayValueField

=
=
=
=
=

entity.DataSourceId;
entity.ObjectType;
entity.DbName;
entity.GetColumn("colName").Name;
entity.GetColumn("colName").Name;

Save to Disk
api.SaveData(bool isPermanent)

Creates .xml and encrypted .enc files in the Temp directory. If isPermanent = true, creates the files in the /Config directory, overwriting the
existing config files.

Role Permissions
Roles are a neat way to encapsulate a collection of permissions. Roles also allow for some more fine grained control over data and folder
access than the base config settings. Only one role can be active at a time.

Get a specific role
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Role role = api.Roles.GetRole("roleId");

Create new role
api.Roles.Add(new Role(api.PageInfo) { Id = "roleId", IsActive = true });

Edit role settings
role.General.AnySetting = "value";

Folder/Object/Row Security
role.Security.Folders.IncludeAll = true;
role.Security.Folders.Add(new Folder() { Name = "folderPath", ReadOnly = true });
role.Security.DataObjects.Add(new DataObject() { Name = "objectName" });
role.Security.DataObjectRows.Add(new DataObjectRow()
{
ObjectName = "objectName",
FilterString = "filterString"
});

Activate a role
role.Activate();

Advanced Configuration
You can dynamically change data sources, objects, joins, etc., in the API, or simply use these settings to programmatically generate a
config file.

Data Sources
View data source
api.DataSources.GetDataSource("dataSourceName").DataConnStr;

Create a new data source
api.DataSources.Add(new DataSource(api.PageInfo)
{
Name
= "dataSourceName",
DbType
= Constants.DatabaseType.SqlServer,
DataConnStr = "connectionString"
});

Data Objects
View data objects
foreach (Entity entity in api.Entities)
{
// three ways to identify an entity
string.Format("Alias: {0}, Id: {1}, Database Name: {2}\n",
entity.Name, // Alias
entity.Id,
// Id
entity.DbName // Database Name
);
}

Get a specific data object
Note
This is the recommended way to get an entity by name, but there are other methods provided as well.

Entity entity = api.Entities.GetEntity("entityAlias");
// Returns null if it does not exist
// Best to retrieve entities by Alias name, because Aliases are unique and required
// Ids are unique, but not required; Db names are required, but not unique (across sources)

View object fields
foreach (EntityColumn column in entity.Columns)
{
string.Format("Alias: {0}, Database name: {1}\n",
column.Name,
// Alias (or actual if no alias)
column.ActualName // Database name
);
}

Create new data object
Tip
Set the Id property before the DbName.
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Entity entity = api.Entities.NewEntity(entityName);
entity.DataSourceId = api.DataSources.GetDataSource("dataSourceName").Id;
entity.ObjectType = DataObjectType.Table;
entity.Id
= "idName";
// Unique
entity.DbName
= "databaseName"; // Required
entity.Name
= "aliasName";
// Required, unique
// Add key column
entity.KeyColumns.Add(new KeyColumn(entity.GetColumn("colName").ActualFullName));

SQL Object
entity.SqlStmt = "SELECT * FROM Employees";

Add tenanting to object
entity.Tenants.Add(new EntityTenant(api.PageInfo,
entity.Name,
entity.GetColumn("colName").ActualFullName, // Get col by Alias but supply ActualFullName
"parameterId" // Tenant parameter
));

Filter dropdowns
entity.FilterObjectType = DataObjectType.Table; // Table, View, Function, Procedure, etc.
entity.FilterDbName = "FilterObjectName";
// or custom SQL:
entity.FilterObjectType = DataObjectType.SqlStmt;
entity.FilterSqlStmt = "SELECT etc...";

Joins
See all config joins
// Build the join string for display
string joinString = "";
// All config joins; for report joins, use report.Joins
foreach (Join join in api.Joins.OrderByDescending(x => x.Weight)) // Order by weight
{
foreach (JoinColumn col in join.JoinColumns)
{
joinString += string.Format("{0} {1} {2}{3}\n",
col.FromColumn.FullKeyName,
join.JoinText,
col.ToColumn.FullKeyName,
join.RelationType == 1 ? "(s)" : "" // 1-to-Many
);
}
if (join.Weight > 0) joinString += ("Weight: " + join.Weight + "\n");
}

Get specific join
Join join = api.Joins.GetItem("fromEntity", "toEntity", false);

Create a new join
Note
For creation of Advanced Joins, see Advanced Joins.

Entity fromEntity = api.Entities.GetEntity("fromName");
Entity toEntity = api.Entities.GetEntity("toName");
Join newJoin = new
{
EntityFromName =
EntityToName =
Type
=
RelationType =
Weight
=
};

Join(api.PageInfo)
fromEntity.Name,
toEntity.Name,
(int)JoinType.Inner,
0, // 0: One-to-One, 1: One-to-Many
0

// Add key columns
newJoin.JoinColumns.Add(new JoinColumn(
new KeyColumn(fromEntity.Name, fromEntity.GetColumn("fromColName").ActualFullName),
new KeyColumn(toEntity.Name, toEntity.GetColumn("toColName").ActualFullName)
));
// Add to the config; for reports, use report.Joins.Add()
api.Joins.Add(newJoin);
// If there is an active report, recreate the joins
report.CreateJoins();

Custom Functions
Get a specific function
UdfFunction function = api.CustomFunctions.GetItem("functionName");

Create a new function
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UdfFunction newFunction = new UdfFunction(api.PageInfo)
{
Name
= "functionName",
AvailableIn = UdfFunctionAvailableType.Formula, // Custom or filter function
ArgumentsJson = "[{'Name':'argName','Required':true,'Description':'desc'}]",
Language
= CodeLanguage.CSharp.ToString(),
ProgramCode = "Code();"
};
// Add any references and namespaces
newFunction.Namespaces.Add("Program.Namespace");
newFunction.References.Add("Reference.dll");
// Add to the config
api.CustomFunctions.Add(newFunction);

Server Events
Get a specific server event
ServerEvent serverEvent = api.ServerEvents.GetByName("eventName");

Create a new server event
ServerEvent newEvent = new ServerEvent(api.PageInfo)
{
Name
= "eventName",
EventType = ServerEventType.OnReportExecuteStart, // Global event, or "None"
};
// Custom code
newEvent.ServerCode.CustomCode.Language
= CodeLanguage.CSharp;
newEvent.ServerCode.CustomCode.ProgramCode = "Code();";
//Add a namespace
newEvent.ServerCode.CustomCode.Namespaces.Add("System.IO");
// Code from data source
newEvent.ServerCode.DataSourceId = api.DataSources.GetDataSource("eventsAssembly").Id;
newEvent.ServerCode.FunctionName = "functionName";
// Add to config
api.ServerEvents.Add(newEvent);
// Add to a report (must be in config)
report.ServerEvents.Add(new ReportServerEvent(api.PageInfo)
{
EventType = ServerEventType.OnDataCombined,
EventId = api.ServerEvents.GetByName("eventName").Id
});

Scheduling
Note
Use of the NodaTime library is required beginning with v2019.1. More information is available in the Time Zone Calculation
Enhancements in v2019.1 article.

View schedule list
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List<Exception> exceptions;
// Build the job list string
string jobList = "";
foreach (List<JobInfo> schedule in api.ReportScheduler.GetJobList(out exceptions))
{
foreach (JobInfo job in schedule.OrderBy(x => x.NextExecuteDate).ThenBy(x => x.Name))
{
jobList += string.Format("Job '{0}' for report '{1}' ",
job.Name,
api.ReportScheduler.GetReportScheduleInfoByJobId(job.JobId.ToString()).ReportBaseName
);
switch (job.Status)
{
case JobStatus.Completed:
jobList += string.Format("ran on {0}, at host {1}.\n",
job.LastExecuteDate.ToString("MMM d hh:mm tt"),
api.ReportScheduler.GetHost(api.ReportScheduler.GetHostIdxForJob(job.JobId))
);
break;
case JobStatus.Ready:
jobList += string.Format("ready to run on {0}.\n",
job.NextExecuteDate.ToString("MMM d hh:mm tt")
);
break;
case JobStatus.Deleted:
case JobStatus.Removed:
case JobStatus.Abended:
case JobStatus.UserAbort:
jobList += string.Format("ended. Last run on {0}, at host {1}.\n",
job.LastExecuteDate.ToString("MMM d hh:mm tt"),
api.ReportScheduler.GetHost(api.ReportScheduler.GetHostIdxForJob(job.JobId))
);
break;
default:
jobList += string.Format("status unknown.\n");
break;
}
}
}

Create an immediate schedule (basic options)
using NodaTime;
...
// Run-once, immediately save to disk
string jobId;
// Use to retrieve schedule info later for editing
int hostIdx;
// Assigned execution host id
ReportScheduleInfo newSchedule = new ReportScheduleInfoOnce()
{
ScheduleName
= "Immediate Schedule",
// Schedule name
ReportName
= @"Report\Full\Path",
// Report path
ReportType
= wrReportType.Advanced,
// Report type
RangeStartDate = new LocalDate(DateTime.Now.Year, DateTime.Now.Month, DateTime.Now.Day),
ScheduleTime = new LocalTime(DateTime.Now.Hour, DateTime.Now.Minute), // Start time
SendReportInEmail = false
// Email or save
};

// Start date

// Send to the scheduler; wrap in try/catch to handle exceptions
try {
api.ReportScheduler.AddReport(
new ReportSchedule(api.PageInfo) { ScheduleInfo = newSchedule }, out jobId, out hostIdx);
}
catch (Exception) { }

Recurring schedules (additional options)
Daily
using NodaTime;
...
ReportScheduleInfo newSchedule = new ReportScheduleInfoDaily()
{
... // Include basic options
// Range of recurrence, every N days, or every weekday
DailyPattern = ReportScheduleInfo.DailyPatternType.EveryNDays,
EveryNDays = 2, // N days
// End date (optional):
RangeEndDate
= new LocalDate(2017, 12, 25), // End on a specific date
RangeNOccurences = 10,
// Or end after N occurrences
// intraday recurrence (optional):
RepeatEvery
= true, // Enable intraday recurrence
RepeatEveryHours = 4,
// Repeat every N hours
RepeatEveryMinutes = 0,
// And N minutes
RepeatEveryEndTime = new TimeSpan(DateTime.Parse("12:00 PM").Ticks) // Optional end time
}
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Weekly
ReportScheduleInfo newSchedule = new ReportScheduleInfoWeekly()
{
... // Include basic options
... // Optional end date, optional intraday recurrence
EveryNWeeks = 1, // Every N weeks
// On these days:
Sun
Mon Tues Wed
Thu Fri
Sat
IsDayOfWeek = new bool[] { false, true, false, false, true, false, false }
}

Monthly
ReportScheduleInfo newSchedule = new ReportScheduleInfoMonthly()
{
... // Include basic options
... // Optional end date, optional intraday recurrence
// Specific or relative day pattern
MonthlyPattern = ReportScheduleInfo.MonthlyPatternType.SpecificDayOfMonth,
// Specific: day X of every N months
SpecificDayOfMonth = 7, // Day of the month
SpecificEveryNMonths = 2, // Every N months
// Relative: the Xth
RelativeWeekOfMonth
RelativeDayOfWeek
RelativeEveryNMonths

day-of-week of every N months
= ReportScheduleInfo.WeekOfMonthType.First, // Week of month
= ReportScheduleInfo.DayOfWeekType.Weekday, // Day of week
= 2
// Every N months

}

Yearly
ReportScheduleInfo newSchedule = new ReportScheduleInfoYearly()
{
... // Include basic options
... // Optional end date, optional intraday recurrence
// Specific or relative day pattern
YearlyPattern = ReportScheduleInfo.YearlyPatternType.SpecificDayOfYear,
// Specific: Month/Day of every year
SpecificMonthOfYear = 3, // Month of the year
SpecificDayOfMonth = 15, // Day of the month
// Relative: the Xth day-of-week for month N
RelativeWeekOfMonth = ReportScheduleInfo.WeekOfMonthType.Last, // Week of month
RelativeDayOfWeek = ReportScheduleInfo.DayOfWeekType.Friday, // Day of week
RelativeMonthOfYear = 3
// Month N
}

Email job
newSchedule.SendReportInEmail = true;
newSchedule.EmailSubject
= "Subject Text";
newSchedule.EmailBody
= "Hello World!";
newSchedule.EmailToList.Add("email@company.com");
// newSchedule.EmailCCList.Add();
// newSchedule.EmailBccList.Add();

//
//
//
//
//
//

Enable email
Email subject
Email body
To addresses
CC addresses
BCC addresses

Batch email
// Batch addresses entity (must be in the batch report)
Entity batchAddresses = report.Entities.GetEntity("entityName");
newSchedule.IsBatchReport = true;
newSchedule.BatchEmailToList.Add("supervisor@example.com");
// newSchedule.BatchEmailCcList.Add();
newSchedule.BatchEntity = batchAddresses.Name;
newSchedule.BatchField = batchAddresses.GetColumn("Email").Name;
newSchedule.IncludeReportAttachment = true;

//
//
//
//
//
//

Enable batch
Summary recipients
Summary cc recipients
Email address object
Email address field
Include the report

Access existing schedule by jobId
ReportScheduleInfo schedule = api.ReportScheduler.GetReportScheduleInfoByJobId("jobId");

Update an existing schedule
api.ReportScheduler.UpdateExistingSchedule(newSchedule, "jobIdToUpdate");

Delete an existing schedule
api.ReportScheduler.DeleteSchedulerJob("jobIdToDelete");

Managing Files and Folders
Initialize the manager class for the type of folder mgmt in use
// File System
ReportMgmtFileSystem manager = new ReportMgmtFileSystem(api.PageInfo);
// Database
ReportMgmtMethod manager = new ReportMgmtMethod(api.PageInfo);
// Cloud drive
ReportMgmtCloud manager = new ReportMgmtCloud(api.PageInfo);

View the full reports tree
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XmlDocument tree = new XmlDocument() { InnerXml = manager.GetReportListXml() };

View themes list by type
List<string> evThemes = manager.GetThemeList(ReportTheme.ReportThemeType.ExpressView.ToString());

Get a specific theme (class depends on theme type)
ExpressViewTheme evTheme = (ExpressViewTheme)ReportTheme.GetTheme(
api.PageInfo, ReportTheme.ReportThemeType.ExpressView, "themeName");

View list of templates
List<string> templates = manager.GetTemplateList();

Add a new folder
manager.AddFolder("parentFolder", "newFolderName");

Move or rename a folder
manager.RenameFolder("oldPath", "newPath");

Move or rename a report
manager.RenameReport("oldPath", "newPath");

Duplicate an existing report
api.ReportObjectFactory.Copy("reportName", "newName");

Save a new report to disk
api.ReportObjectFactory.Copy(report, "reportName", null);

.NET Sample Code
To access the API, add a reference to the assembly WebReportsApi.dll to your project. For more information, review the Introduction
to the .NET API.
In all of the examples below the return value should be checked for validity. The examples below have omitted validations for clarity.

Create API Object
// create WebReports API object passing Exago virtual path;
Api api = new Api("ExagoServer/Exago");

Add or Modify a Role
// create a new runtime Role (is automatically made active)
Role role = api.Roles.NewRole();
// -- OR -// accessing a pre-created Role and making it active
Role role = api.Roles.GetRole("Admin");
role.Activate();

Add Folder Security to a Role
// start with privileges to all folders for this user session (this is the default)
role.Security.Folders.IncludeAll = true;
// disallow access to folder 'Stew's Reports' (and any subfolders)
Folder folder = role.Security.Folders.NewFolder();
folder.Name = "Stew's Reports";
// make folder 'Summary Reports' (and any subfolders) read only
Folder folder = role.Security.Folders.NewFolder();
folder.Name = "Summary Reports";
folder.ReadOnly = true;

Add Data Object Column Security to a Role
// start with privileges to all data objects (this is the default)
role.Security.DataObjects.IncludeAll = true;
// disallow access to data object ‘vw_cancellation’
DataObject dataObject = role.Security.DataObjects.NewDataObject();
dataObject.Name = "vw_cancellation";

Add Data Object Row Security to a Role
// don’t allow this user to view rows from the ‘vw_grant’ object with a
// ‘Grant Date’ value of ‘2000-01-01’
DataObjectRow dataObjectRow = role.Security.DataObjectRows.NewDataObjectRow();
dataObjectRow.ObjectName = "vw_grant";
dataObjectRow.FilterString = @"""Grant Date"" <> '2000-01-01'";

Set Configuration Settings for the Session in a Role
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Set up several general user session parameters for a role (overriding individual global general parameters)
// set global date format for this user
role.General.DateFormat = "dd/MM/yyyy";
// set currency symbol for this user
role.General.CurrencySymbol = "kr";

Modify a Data Source's Connection String
// set data connection string for a specific datasource
DataSource dataSource = api.DataSources.GetDataSource("MyDb");
dataSource.DataConnStr = "Server=SVR;Database=db1;uid=userId;pwd=password;";

Modify a Parameter Value
// modify a parameter value
Parameter parameter = api.Parameters.GetParameter("asOfDate");
parameter.Value = "2007-06-01";

Set a Data Object Column Alias
api.Entities.GetEntity("vw_webrpt_optionee").ColumnMetadatas.SetColumnAlias("Hire Date", "Date of Hire");

Clone a Data Object
Note
The ability to specify a description and category/folder or to inherit them from the parent was added in v2019.2.18.

pageInfo.SetupData.Entities.GetEntity("originalEntityId");
Entity clone = orignal.Clone();
clone.Id = "uniqueId";
clone.Alias = "uniqueAlias";
//v2019.2.18+ only
clone.Description = "Clone Description";
clone.HasInheritedDescription = false;
clone.HasInheritedCategory = true;

Set User Identification Parameters
For additional information about user authentication in Exago, review the User Identification article.
api.Parameters.GetItem("userId").Value = "ApiUser";
api.Parameters.GetItem("companyId").Value = "ApiCompany";

Set the End User's Time Zone
For additional information about time zones in Exago v2019.1+, review the Time Zone Calculation Enhancements in v2019.1 article.
PageInfo.SetupData.General.ClientTimeZoneName = 'America/New_York'

Launch the Exago Session
At this point if you want to run the Exago applications, do the following:
// setup URL
string url = "http://MyDomainServer/Exago/" + api.GetUrlParamString();
Response.Redirect(url);
// or you can redirect any control that can be set to a URL
this.ReportIFrame.Attributes["src"] = url;

Execute a Report Directly From the Host Application
You can combine setting user session information as above with report execution. To do that, just omit the redirect above and do the
following:
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// load a specific report and return Report object (make sure to check return value)
Report report = (Report)api.ReportObjectFactory.LoadFromRepository(@"Stew Meyers' Reports\My Report");
// add a sort
Sort sort = report.Sorts.NewSort();
sort.SortText = "vw_optionee.First Name";
sort.Direction = wrSortDirection.Ascending;
report.Sorts.Add(sort);
// add a filter
Filter filter = report.Filters.NewFilter();
filter.DbName = "vw_grant.Grant Date";
filter.Operator = wrFilterOperator.LessThan; // default is EqualTo
filter.Value = "20070501"; // filter dates are entered in YYYYMMDD sequence
filter.AndOrWithNext = wrFilterAndOrWithNext.And; // default is And
filter.GroupWithNext = false; // default is false
filter.Prompt = true; // default is false
// Set the Execute behavior to run in the Report Viewer (default is export to PDF)
report.ExportType = wrExportType.Html; // "Html" refers to the Report Viewer
// should Report Viewer be opened in new browser window
report.OpenNewWindow = false; // default is false
report.ShowStatus = false; // default is true
// saves a temporary version of the report to be used for execution
api.ReportObjectFactory.SaveToApi(report);

Execute a Dashboard Directly from the Host Application
api.Action = wrApiAction.ExecuteReport;
DashboardReport report = (DashboardReport)Api.ReportObjectFactory.LoadFromRepository(@"Reports\My Dashboard") as DashboardReport;
report.ReportItems[0].SetParameterValue("productname", "Parm1");
report.ReportItems[0].SetFilterValue("Employees.EmployeeID", wrFilterOperator.EqualTo, new List<string>() { "3" });
report.ReportItems[0].SetFilterValue("Orders.OrderDate", wrFilterOperator.GreaterThanOrEqualTo, new List<string>() { "1996-07-04 01:00:00" });
report.ReportItems[1].SetParameterValue("productname", "Parm2");
report.ReportItems[1].SetFilterValue("Employees.EmployeeID", wrFilterOperator.EqualTo, new List<string>() { "5" });
report.ReportItems[1].SetFilterValue("Orders.OrderDate", wrFilterOperator.GreaterThanOrEqualTo, new List<string>() { "1996-07-04 01:00:00" });
api.ReportObjectFactory.SaveToApi(report);
string url = @"[Exago Install Path] /" + api.GetUrlParamString("Home");
this.ReportIFrame.Attributes["src"] = url;

Start Report Execution
//setup URL
string url = "http://MyDomainServer/Exago/" + api.GetUrlParamString();
Response.Redirect(url);
// or you can redirect any control that can be set to a URL
this.ReportIFrame.Attributes["src"] = url;

Schedule a Report
Schedule a report with a filter, and e-mail the output.
//load in the report
Report report = (Report)api.ReportObjectFactory.LoadFromRepository(@"Reports\Employee Performance") as Report;
//specify the export type of the scheduled report
report.ExportType = wrExportType.Pdf;
//set email information
List<string> toList = new List<string>();
toList.Add("emailaddress@example.com");
SchedulerEmailInfo info = new SchedulerEmailInfo(toList);
//set a filter on the report
Filter filter = report.Filters.NewFilter();
filter.DbName = "Employees.FirstName";
filter.Operator = wrFilterOperator.EqualTo;
filter.Value = "Janet";
filter.Prompt = true;
//create a schedule
api.ReportScheduler.CreateImmediateSchedule("Schedule Test", info);
//save the report to the API object
api.ReportObjectFactory.SaveToApi(report);

Introduction to REST
The Exago API provides programmatic access to create session configurations based on user credentials. The REST API is an alternative
to the .NET API for applications not built in .NET environments. REST web services provide access to API functions for any client capable
of passing HTTP requests over a network.

Installing REST
To install REST, run the Exago Installer, then select the Exago Web Service API.
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Choose a file path, IIS website, and a virtual path for the web service. The installer should automatically create an application in IIS for the
web service.
Set the application pool in IIS. Then grant it Full Control permissions to the web service Config directory. See Configuring IIS for Exago
for detailed instructions.
In the Web Service directory, edit appSettings.config and add the key ExagoRest with value True, to enable REST:
<add key="ExagoREST" value="True" />

Then, configure the Web Service API following the instructions in the Configuring Web Service article.
Restart your web server and you should be ready to test your installation. See Authentication for options for password-protecting your
web service.
See Starting a REST Session to get started using the REST API.

The API
This is the documentation for the Exago REST API. This information will always reflect the latest available Exago version. Changes are
made periodically to the API. For details, please refer to the REST Updates.
The API is a JSON API. For more information, see Using JSON.
Endpoints are documented with the HTTP request type and a URI sub-path:
POST /rest/sessions

Prepend the URL path to your web service to get the full endpoint URL:
http://{myapp}/{exago web service}/rest/sessions

Curly braces, {}, are values that you must supply:
GET /rest/roles/{Id}

Usually the value to supply is found in JSON given by a request to the base endpoint. For example, to retrieve a particular Role by its "Id",
first run GET /rest/roles to see the roles available to you:
[
{
"Id": "Admin"
},
{
"Id": "User"
}
]

Then to see detailed data on a Role, run GET /rest/roles/{Id} where {Id} is the value of its "Id" property (case sensitive):
GET /rest/roles/Admin

Some methods may accept optional URL parameters. Append any url parameters to the end of the endpoint URL using the following
format:
/rest/{endpoint}?{param1}={value1}&{param2}={value2}&{param3}={value3}

For all endpoints except /rest/sessions, you must append the session Id as a url parameter to the end of the URL:
VERB /rest/{endpoint}?sid={sid}

For more information, see Starting a REST Session.
The examples in this documentation use cURL ("curl"), which is a command-line tool for transferring data using various protocols. Curl is
compatible with Windows or Linux, and can be downloaded from https://curl.haxx.se/. If curl is installed on your machine, you can copyand-paste the examples into a command line, replacing any item in {braces} with your local variables, in order to test them out for yourself.
Long examples may be broken into multiple lines in order to improve readability. The caret symbol (^) tells the command line to ignore the
following linebreak. On Linux, replace the caret with a backslash (\).
curl http://{webservice}/rest/settings?sid={sid} ^
-H "Accept: application/json" ^
-H "Content-Type: application/json" ^
-H "Authorization: Basic Og==" ^
-X PATCH ^
-d "{'ShowExpressReports':false}"

For testing, we recommend a graphical application such as Advanced Rest Client or Postman.

Authentication
The REST API requires authorization to be accessed. To make an authorized request, the authorization header must be supplied. There
are two different authorization methods depending on your needs. Both rely on the username ("User ID") and "REST Key" found within the
Exago configuration file currently being accessed.
Note. In versions prior to v2017.3, the "Password" field was utilized as the REST Key.

Basic Authorization
When using basic authorization, the authorization header is constructed as follows:
1. The User ID and REST Key are combined into a string User ID:REST Key.
2. The resulting string literal is encoded using Base64.
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3. "Basic" and a space are placed before the encoded string.
For example, if the User ID is "Brian" and the REST Key is "open sesame" then the authorization header would be constructed as follows:
1. Combine User ID and REST Key into a string
Brian:open sesame

2. Encode the string using Base 64
QWxhZGRpbjpvcGVuIHN1c2FtZQ==

3. Append "Basic " to the front
Basic QWxhZGRpbjpvcGVuIHN1c2FtZQ==

The auth key is sent in clear text with each request. If this is a concern, the REST API should be deployed in an SSL environment or the
more secure ExagoKey authorization should be used.
A configuration with a blank User ID and REST Key can be accessed using the following authorization header:
Authorization: Basic Og==

ExagoKey Authorization
ExagoKey authorization uses the HMAC-SHA256 algorithm for authorization. When using ExagoKey authorization, the authorization
header is constructed as follows:
1.
2.
3.
4.

The string to sign is UTF-8 encoded, then signed with the UTF-8 encoded REST key using the HMAC-SHA256 algorithm.
The resulting signature is then encoded using Base64.
The User ID and a colon is put before the encoded signature.
"ExagoKey" and a space are placed before the encoded string literal.

For example, if the User ID is "Brian" and the REST Key is "open sesame" then depending on the request the authorization header might
be something like:
Authorization: ExagoKey Brian:6HZE5tCWjsjbJY+VXQg3UzXlK/jeoGhbm25YDXiHWdE=

Using ExagoKey does not send the password with each request, making it more secure than Basic Authorization. To ensure greater
security the REST API should be deployed in an SSL environment.

ExagoKey String
The ExagoKey string that is to be signed is constructed using the following information from the request, in the following order, with "\n"
after each item (including the last one).
1. The HTTP Method, must be in uppercase.
2. The absolute request path, up to but not including the query string if one should exist. For example, if the request is to
"http://myserver.com/exago/rest/sessions?config=myconfig" the absolute request path would be "/exago/rest/sessions".
3. The contents of the Content-Length header.
4. The contents of the Content-Type header, or a string of zero length if no header exists.
5. The contents of the Content-MD5 header, or a string of zero length if no header exists.
6. The session ID, or a string of zero length if no session ID exists.
7. The contents of the X-Exago-Date header, or the contents of the Date header if the X-Exago-Date header does not exist, or a string
of zero length if neither header exists.
Note: If a date is supplied, the REST API will reject any request that is older than 15 minutes from the supplied date. The date supplied
is in GMT (UTC).

Request Format
The REST API uses JSON. It will not accept data in any other format. In the case of an error, it may return plain text, but this is not
session data. You must set the following headers on all requests:
"Content-Type: application/json"
"Accept: application/json"
"Authorization: {type} {authstring}"
Most of the examples in this documentation omit the headers in order to improve readability; however they are required for all requests.

Response Format
Successful requests return HTTP status codes in the 200 range. When you create a resource with POST, the API returns the resource in
the response body:
Status: 201 Created
Location: /{webservice}/rest/Entities/Employees
{
"Id":
"Name":
"Schema":
"CategoryName":
"DataName":
"DataSourceId":
"DataType":
...

"Employees",
"Employees",
"dbo",
"",
"Employees",
"0",
"Table",

}

You may get a plain text response in the case of errors or bad requests. The content will not contain any session data.
Responses have one of the following status codes:
200
The request was completed successfully. The document in the body, if any, is a representation of some resource. This code is usually
returned for a successful GET request.
201
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The request was completed successfully. A new resource has been created at the URL specified in the Location header of the response.
The document in the body, if any, is a representation of the resource created. This code is usually returned for a successful POST request.
204
The request was completed successfully. There is no content in the body. This code is usually returned for successful PATCH, PUT, and
DELETE requests.
400
The request was bad on the client side. The document in the body, if any, is error data describing the problem. This is usually the result of
using an invalid method type.
401
The request wasn’t authorized to access the resource. The document in the body, if any, is error data describing the problem.
404
The requested resource was not found. The document in the body, if any, is error data describing the problem. Often this is the result of a
malformed URL request string.
409
The request caused a conflict between two resources. The document in the body, if any, is error data describing the problem.
500
There was a problem on the server side. The document in the body, if any, is error data describing the problem. Often this is the result of a
malformed JSON request package.

Request Data
The API returns and accepts JSON values, which can be strings, numbers, objects, arrays, true, false, or null. See Using JSON for more
information.
Each endpoint uses a unique JSON object for input and output of variables. The JSON is documented with each resource in a table:
Name

Type

Writeable

Description

Each row represents a property. The Name field is the name of the property. The Type field indicates what type of data it accepts.
The Writeable field indicates whether this property can be written:
no - this property is read-only
yes - this property can be written
yes ("value") - this property can be written; its default value is in parentheses
required - this property must be written; it cannot be null
required-create - this property must be written for all POST calls; it is read-only for all other calls
The Description field is any relevant information about the property.

Id Values
Most resources are identified by an "Id" property, which is an integer or string. The Id must be unique among the set of resources. If you
are permitted write-access to the Id, avoid conflicting names.

Constant or Enum Values
Some properties can only accept one of a set of string or integer values (or sometimes null).
Properties which accept enumerated values are indicated as having an "enum" type. The description field in its JSON representation links
to the list of possible values, which can usually be represented by their string or equivalent integer value. For example:
Name

Type

Writeable

Description

DataType

enum

yes

Parameter Type

Properties which accept constant string values are indicated as having an "const" type. The description field in its JSON representation
links to the list of possible values. For example:
Name

Type

Writeable

Description

JoinType

const

yes

Join Type

This Documentation
This documentation is broken down by section according to the use cases for different API elements. Each section represents a single
endpoint or set of related endpoints and use cases. To find out how to do something using the REST API, first browse to the relevant
section for the element you want to use. Then check the table of contents for what actions you want to take; Or read from top to bottom to
gain a fuller understanding of the resource.
Check out Getting Started with REST to get started!
See List of REST Endpoints for the available endpoints and their usages.

Using JSON
The Exago REST API is JSON-based. ;Data sent to the API methods is formatted in JSON, and the methods return JSON formatted
response objects. In order to use the REST API you need to convert your data to, and from JSON.

What is JSON?
JSON is a data-interchange format that is designed to be text-based, and easy to read and parse. JSON objects are formatted using the
following rules:
1. Objects contain a collection of properties in "key": "value" format. Braces {} enclose objects.
2. Keys are strings, which are enclosed by single- (' ') or double-quotes (" "). Each key has a value, indicated by a colon (:). Properties
are separated by commas (,).
3. Properties can accept sets of values using arrays, enclosed by brackets [ ]. Values are separated by commas (,).
4. Values can be strings, numbers, arrays, other JSON objects, true, false, or null.
5. The order of properties within an object doesn't matter.
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Example
{
"users": [
{
"id": "358",
"username": "alex224",
"admin": true,
...
},
...
]
}

Note
Ellipses ... indicate that one or more properties or objects have been omitted for clarity.

Using JSON with Code
JSON data usually has to be converted into a format that your code can understand. Most modern programming languages have JSON
compatible libraries, if they are not built into the language.
To convert JSON strings into objects:
JavaScript (see JSON.parse() at MDN)
var json_obj = JSON.parse('{"user":{"id":"358"}}');

Python 3 (see json at Pydoc)
json_obj = json.loads('{"user":{"id":"358"}}')

JSON Object Documentation
Although JSON objects can be formatted in a variety of ways, each endpoint requires an object with a specific set of properties. The
required format can be viewed in the documentation for each endpoint. Some properties are mandatory; some are read-only; some are
create-only, which means that they are required for POST calls, but read-only for other call types; and some are optional. Accessing
certain resources in an un-authorized state may only return a subset of data; in general we recommend that all REST calls be authorized.
For example, the documentation for the JSON object above might read like the following:
Name

Type

Writeable

Description

users

array of
User

yes

List of users belonging to the session

Name

Type

Writeable

Description

id

integer

no

This user's unique Id

username

string

required

This user's login key

admin

boolean

yes (false)

Whether this user has admin privileges

User JSON

Note
Read (-only) permissions indicate that the property cannot be edited with PATCH or PUT. This does not indicate whether a DELETE call
can be used on the object.

Using the API with cURL
Throughout the REST documentation there are examples which use cURL, a free command-line tool for using various protocols. Download
cURL at: https://curl.haxx.se/download.html. If you're using Google Chrome, the Advanced REST Client browser extension is an
excellent alternative. We recommend using either program to experiment with the API and test your method calls.
Disclaimer
We cannot provide support for any third-party tools such as cURL or Advanced REST Client.
API calls using cURL require the following at a bare minimum: Three headers, Accept: application/json, Content-Type:
application/json, and your authorization header; The JSON data, which should be empty if the endpoint expects no data; And the
"verb" e.g. POST, GET, etc.
All cURL calls are formatted like the following:
curl http://{webservice}/rest/{endpoint}?sid={sid}&{param1}={value1}&{param2}={value2} ^
-d "{json}" ^
-H "Accept: application/json" ^
-H "Content-Type: application/json" ^
-H "Authorization: {type} {authstring}" ^
-X {verb}

Note
Replace text in {braces} with the applicable data for your environment, method, and JSON. End-of-line carets (^) terminate each line to
improve readability, but are not necessary.
For example, a new session call is formatted like the following:
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curl http://{webservice}/rest/sessions ^
-d "" ^
-H "Accept: application/json" ^
-H "Content-Type: application/json" ^
-H "Authorization: Basic Og==" ^
-X POST

For an un-authenticated installation, you could copy and paste this example into a command line, replacing {webservice path} with the
path to your web service, in order to test whether REST is working.
If it succeeds, it should return data similar to the following:

{"AppUrl":"ExagoHome.aspx?d={appUrl}","Id":"{sid}","Page":"ExagoHome","ApiAction":"Default","ExportType":null,"ShowTabs":true,"ShowErrorDetail":true,"ReportSettings":{"Id":null,"Repo

Note that all the data was returned on a single line. For improved readability, copy and paste this into a "pretty-printer" (there are many free
online solutions).
{
"AppUrl": "ExagoHome.aspx?d={appUrl}",
"Id": "{sid}",
"Page": "ExagoHome",
"ApiAction": "Default",
"ExportType": null,
"ShowTabs": true,
"ShowErrorDetail": true,
"ReportSettings": {
"Id": null,
"ReportPath": null,
"SortsResource": null,
"FilterItems": null
}
}

To pass JSON with cURL, either insert it inline:
curl http://{webservice}/rest/sessions ^
-d "{'ReportSettings':{'ReportPath':'Test\\TestReport'}}" ^
-H "Accept: application/json" ^
-H "Content-Type: application/json" ^
-H "Authorization: Basic Og==" ^
-X POST

Or reference a text file containing the JSON object:
curl http://{webservice}/rest/sessions ^
-d @json.txt ^
-H "Accept: application/json" ^
-H "Content-Type: application/json" ^
-H "Authorization: Basic Og==" ^
-X POST

json.txt
"{'ReportSettings':{'ReportPath':'Test\\TestReport'}}"

List of REST Endpoints
The following REST Web Service API endpoint paths are available. All calls require the following headers:
Content-Type: application/json
Accept: application/json
Authorization: {type} {authstring}

/rest/Batch v2018.1.1+
POST
/rest/Sessions
POST
GET
/rest/Sessions/{sid}
GET
PATCH
DELETE
All of the following calls require the Session ID URL parameter: sid={sid}

Example
GET /rest/Settings?sid={sid}

/rest/DataSources
GET
/rest/DataSources/{Id}
POST
GET
PATCH
/rest/Entities
POST
GET
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/rest/Entities/{Id}
GET
PATCH
DELETE
/rest/Entities/{Id}/Fields
GET
/rest/Entities/{Id}/Fields/{Field Id}
GET
PATCH
POST v2019.1.13+
/rest/Folders/{Name}
POST
DELETE
/rest/Folders/Rename
POST
/rest/Functions
POST
GET
/rest/Functions/{Id}
GET
PATCH
DELETE
/rest/Joins
POST
GET
/rest/Joins/{Id}
GET
PATCH
DELETE
/rest/Parameters
POST
GET
/rest/Parameters/{Id}
GET
PATCH
DELETE
/rest/Reports/List
GET
/rest/Reports/Execute/{Type}
POST
/rest/Roles
POST
GET
/rest/Roles/{Id}
GET
PATCH
/rest/Roles/{Id}/DataObjectRows
GET
PATCH
/rest/Roles/{Id}/Entities
GET
PATCH
/rest/Roles/{Id}/Folders
GET
PATCH
/rest/Roles/{Id}/Settings
GET
PATCH
/rest/ServerEvents
GET
/rest/ServerEvents/{Id}
GET
DELETE
/rest/Settings
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GET
PATCH

REST — Batch
Beginning with v2018.1.1, developers can utilize the new Batch REST endpoint to group together multiple sequential calls into a single
network request. For environments which make a number of programmatic alterations to the session configurations, Batch REST can
significantly reduce the network load and speed up the initial session creation.
The session ID can be passed as a URL parameter just as it is for the other REST endpoints.
When supplied as part of a batch call, the individual requests are evaluated sequentially in the order they are supplied.
Note
The GET|PATCH|DELETE /Sessions/{sid} endpoints are not supported by Batch REST.

Batch JSON
The body of a Batch call is formatted as an array of Batch objects, each of which has the following JSON format:
Name

Type

Url

string

Writable

required

Description
REST endpoint URL (following /rest/)
Note
Case-sensitive. Resource names must begin with a capital letter.

Method

constant

required

Request method, one of: POST, PATCH, GET, DELETE

Payload

Payload

yes

Optional payload for POST and PATCH calls.

Example
[
{
"Url": "Sessions",
"Method": "POST"
},
{
"Url": "Roles/MyRole",
"Method": "PATCH",
"Payload": { ... }
}
]

Payload JSON
The format of the Payload property depends on the Url, and mirrors the payload supplied for the non-batch versions of the specified
endpoint. For example, when the Url is "Parameters", the payload has the following format (as detailed in the REST - Parameters article):
{
"Id":
"DataType":
"Value":
"PromptText":
"IsHidden":

"MyParameter",
"String",
"",
"Input a value",
true

}

Making Batch Calls
POST /rest/batch

All Batch calls are made using the POST method. There is no session ID parameter; however, calls to the Batch endpoint require the
same Headers as all other REST calls. Each request object is supplied in order of evaluation. The response object contains the responses
from each request in the same order that they were sent.
Important
Adding additional Data Source column metadata or performing a GET for the Data Source Fields will result in fixing the current column
metadata list as the only defined columns. The column metadata can be further altered, but will not be reflected in the Entity Columns
collection until the session is launched in a browser. The column metadata can be further altered, but will not be reflected in the Entity
Columns collection until the session is launched in a browser.

Available parameters
Name

Type

Description
Specify which config file to create the session with.
Format: CustomConfigFile

config

string

Caution
All config files must use the same Temp path. Otherwise, you may experience
errors when loading sessions.

Response JSON
Name
ReturnCode

string

Type

ResponseContent

object

Description
Response code indicating whether the call was successful
If the response code is 200 or 201, this is the content of the response. Otherwise
this indicates whether an error occurred and the error type.

ResponseContent JSON
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ReturnCode: 204
Name
StatusCode

Type
int

Description
Status code

StatusDescription string

Status description

ReturnCode: 400-500
Name
reason

Type
string

stacktrace string

Description
Error message
Stack trace, if available

Using curl
curl http://{webservice}/rest/batch -X POST ^
-d "[{'Url':'Sessions','Method':'POST'}, ^
{'Url':'Roles/Example','Method':'PATCH','Payload':{'IsActive':true}}]"

Example response
[
{
"ReturnCode": "201",
"ResponseContent": {
"AppUrl": "ExagoHome.aspx?...",
"ApiKey": "...",
"Id": "...",
"Page": "ExagoHome",
"ApiAction": "Default",
"ExportType": null,
"ShowTabs": true,
"ShowErrorDetail": true,
"ReportSettings": {
"Id": null,
"ReportPath": null,
"SortsResource": null,
"FilterItems": null,
"IsError": false,
"ErrorList": null
}
}
},
{
"ReturnCode": "204",
"ResponseContent": {
"StatusCode": 204,
"StatusDescription": null
}
}
]

REST — Config Settings
The Settings endpoint allows you to access many relevant settings for the current configuration.

Settings JSON
Settings are represented as JSON objects with the following properties. Each corresponds with a setting in the Admin Console and/or
Config file.
Some settings appear both in the Settings JSON (Table A) and in General Settings JSON (Table B). When this happens, the setting
contained in Table B should be used in lieu of the one in Table A.

General

Table A — Settings JSON
Type
General Settings

yes

DateFormat
Deperecated. Use General/DateFormat instead.

string

yes

TimeFormat
Deprecated. Use General/TimeFormat instead.

string

yes

DateTimeFormat
Deprecated. Use General/DateTimeFormat instead.

string

yes

SeparatorSymbol
Deprecated. Use General/SeperatorSumbol instead.

string

yes

CurrencySymbol
Deprecated. Use General/CurrencySymbol instead.

string

yes

DecimalSymbol
Deprecated. Use General/DecimalSymbol insread.

string

yes

ShowGrid
Deprecated. Use General/IsShowGrid instead.

boolean

yes

ShowCrossTabReports
Deperecared. Use General/IsShowCrossTabReports
instead.

boolean

yes

ShowExpressReports
Deprecated. Use General/IsShowExpressReports
instead.

boolean

yes

ShowExpressReportsGrouping
Deprested. Use
General/IsShowExpressReportsGrouping instead.

boolean

yes

ShowExpressReportsFormulas
Deprecated. Use
General/IsShowExpressReportsFormulaButton
instead.

boolean

yes

Name

Writable

171 of 215

REST — Config Settings

Technical Guide

ShowExpressReportsStyling
Deperecated. Use
General/IsShowExpressReportsStylingToolbar
instead.
ShowExpressReportsThemes
Deprecated. Use
General/IsShowExpressReportsThemes instead.

boolean

yes

boolean

yes

ShowAdvancedReports
Deprecated. Use General/IsShowAdvancedReports
instead.

boolean

yes

ShowScheduleReports
Deperecated. Use General/IsShowScheduleReports
instead.

boolean

yes

ShowScheduleReportsManager
Deperecated. Use
General/IsShowScheduleReportsManager instead.

boolean

yes

ShowScheduleReportsEmail
Deperecated. Use
General/IsShowScheduleReportsEmail instead.

boolean

yes

ReadFilterValues
boolean
Deprecated. Use General/IsReadFilterValues instead.

yes

ShowTabs

boolean

yes

WebReportsBaseUrl

string

yes

DefaultFolderName

string

yes

DefaultReportName

string

yes

General Settings JSON
Some settings appear both in the Settings JSON (Table A) and in General Settings JSON (Table B). When this happens, the setting
contained in Table B should be used in lieu of the one in Table A.
Name
ReportPath

Table B — General Settings JSON
Type
string

Writable
yes

AllowHomeDirect

boolean

yes

AllowHtmlOutput

boolean

yes

AllowExcelOutput

boolean

yes

AllowPdfOutput

boolean

yes

AllowRtfOutput

boolean

yes

AllowCsvOutput

boolean

yes

DefaultOutputType

wrExportType

yes

IsWriteLog

boolean

yes

CustomCode

string

yes

LicenseKey

string

yes

DateFormat

string

yes

TimeFormat

string

yes

DateTimeFormat

string

yes

integer
DateTimeTreatedAs

0. Date
1. Time
2. DateTime

yes

IsReadFilterValues

boolean

yes

DbTimeout

integer

yes

DbRowLimit

integer

yes

DbRowLimitStepSize

integer

yes

VisualizationDbRowLimit

integer

yes

CallTypeParamName

string

yes

ColumnParamName

string

yes

FilterParamName

string

yes

FullFilterParamName

string

yes

SortParamName

string

yes

DataCategoryParamName

string

yes

ObjectIdParamName

string

yes

IsShowGrid

boolean

yes

ActiveRoleId

string

yes

IsDebugging

boolean

yes

IsShowPdfTemplate

boolean

yes

IsDashboardPromptAtExecution

boolean

yes

IsDashboardShowUrlItemButton

boolean

yes

IsVisualizationShowKeyword

boolean

yes

IsShowChartWizard

boolean

yes

IsShowMapWizard

boolean

yes

IsShowGoogleMapWizard

boolean

yes

IsShowGaugeWizard

boolean

yes

IsSaveOnExecute

boolean

yes

IsSaveOnFinish

boolean

yes

IsEnableRightClickMenus

boolean

yes

IsEnableReportsTreeDragAndDrop

boolean

yes

IsShowLinkReportFields

boolean

yes
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IsShowLinkReportFormula
IsShowLinkAction

boolean
boolean

yes
yes

IsShowInsertImage

boolean

yes

ExpirationDateStr

string

yes

IsHtmlPaging

boolean

yes

WindowHeight

integer

yes

WindowWidth

integer

yes

SeparatorSymbol

string

yes

CurrencySymbol

string

yes

DecimalSymbol

string

yes

IsDataMapping

boolean

yes

IsShowJoinFields

boolean

yes

IsDetectJoinedObjects

boolean

yes

IsEnableSpecialCartesianProcessing

boolean

yes

IsIncludeNotFilterNullValues

boolean

yes

TempPath

string

no

TempCloudService

string

yes

DataCloudService

string

yes

IsShowScheduleReports

boolean

yes

IsShowScheduleReportsManager

boolean

yes

ScheduleManagerViewLevel

Schedule Manager View Level

yes

IsShowScheduleReportsEmail

boolean

yes

ScheduleRemotingHost

string

yes

SynchronousRemotingHost

string

yes

SchedulerQueueService

string

yes

ReportScheduleEmailSubject

string

yes

ReportScheduleEmailBody

string

yes

IsRenewSession

boolean

yes

PasswordRequirement

string

yes

IsExecuteRemotely

boolean

yes

IsAccessDataSourcesRemotely

boolean

yes

MaxTempFileAge

integer

yes

AllowExecuteNewFilters

boolean

yes

ExternalInterface

string

yes

DecimalPlaces

integer

yes

CurrencyDecimalPlaces

integer

yes

ApplyGeneralFormatDecimalPlaces

boolean

yes

ApplyGeneralCurrencyRightAlignment

boolean

yes

ChartColors

string

yes

GeochartMapKey

string

yes

MapColors

string

yes

GoogleMapJSAPIKey v2018.1+

string

yes

GoogleMapGeocodeAPIKey v2018.1+

string

yes

GoogleMapColors

string

yes

GaugeColors

string

yes

IsShowGroupFilters

boolean

yes

IsShowJoinsWindow

boolean

yes

IsShowAdvancedJoins

boolean

yes

IsShowEventsWindow

boolean

yes

IsShowReportParametersWindow

boolean

yes

IsShowCrosstabReports

boolean

yes

IsShowDashboardReports

boolean

yes

IsShowChainedReports

boolean

yes

IsAllowExpressViewLiveEdit

boolean

yes

IsShowExpressViews

boolean

yes

IsShowDashboardNewVisualizationButton

boolean

yes

IsShowDashboardDataFieldsSearch

boolean

yes

IsShowExpressViewDataFieldsSearch

boolean

yes

IsUseSampleDataForDashboardVisualizationDesign boolean

yes

IsShowDashboardExistingVisualizationReportButton boolean

yes

IsDashboardPromptKeywordByDefault

boolean

yes

IsShowExpressReports

boolean

yes

IsShowExpressReportsGrouping

boolean

yes

IsShowExpressReportsFormulaButton

boolean

yes

IsShowExpressReportsStylingToolbar

boolean

yes

IsShowExpressReportsThemes

boolean

yes

IsShowAdvancedReports

boolean

yes

IsShowGroupHeadersFormulaButton

boolean

yes

IsOneCategoryLimit

boolean

yes

IsCacheServices

boolean

yes

SchedulerRecipientWindow

string

yes
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FilterExecutionWindow

string

yes

IsShowIeDownloadButton

boolean

yes

IsDeleteSchedulesUponReportDeletion

boolean

yes

AllowMultipleSessions

boolean

yes

AllowMD5OnFIPS

boolean

yes

WriteBOMToCSV v2019.1.1+

boolean

yes

IsShowScheduleNoEndDate

boolean

yes

IsShowScheduleIntradayRecurrence

boolean

yes

TempUrl

string

yes

UserPreferenceStorage

integer

yes

UserStartupReportOverwriteGettingStarted

boolean

yes

UserStartupReportMaxNum

integer

yes

integer
ExcelExportTarget

0.
1.
2.
3.
4.

2003
2007
2010
2013
2016

yes

AllowDependantFilters

boolean

yes

LinkedReportsInNewTab

boolean

yes

LoadImageFuncParamPrefix

string

yes

LanguageFile

string

yes

IsShowHelp

boolean

yes

CustomHelpSource

string

yes

IsEmailScheduledReports

boolean

yes

IsEnableBatchReports

boolean

yes

IsShowScheduleDeliveryTypeOptions

boolean

yes

IsUseSecureRemotingChannel

boolean

yes

IsShowTemplateUploadButton

boolean

yes

UseSVGForAppIcons

boolean

yes

CrossTabMaximumFields

boolean

yes

IsShowExportsInTab

boolean

yes

integer
IsShowHtmlToolbar

1. auto
2. show always
3. hide always

yes

IsEnableScheduling

boolean

yes

IsShowFilterDescription

boolean

yes

integer
DefaultFilterExecutionWindow

0.
1.
2.
3.

standard
operator
simple
custom

yes

IsChangeableFilterExecutionWindow

boolean

yes

IgnoreInaccessibleReportFolders

boolean

yes

integer
SchemaAccessType

1. datasource
2. metadata

yes

ServerTimeZoneOffset

decimal

yes

ClientTimeZoneName

string

yes

IsShowEnhancedTooltips

boolean

yes

IsShowReportUploadDownloadOptions

boolean

yes

AllowInteractiveHtml

boolean

yes

AllowHtmlInScheduledEmails

boolean

yes

DefaultIsDockOpen

boolean

yes

integer
DockPlacement

0. left
1. right

yes

CssTheme

string

yes

AllowExecuteSaveToDesign

boolean

yes

UserAllowUserReports

boolean

yes

MaxNumberOfChartPoints

integer

yes

DefaultFont

string

yes

DefaultFontSize

integer

yes

DefaultChartFont

string

yes

IsWebFarmSupport

boolean

yes

IsSilentDashboardRefresh

boolean

yes

MaxJobExecutionMinutes

integer

yes

IsAggregateAndGroupInDatabase

boolean

yes

IsEvaluateFormulasInDatabase

boolean

yes

IsShowBrowserOutOfDateWarning

boolean

yes
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AreDateFunctionsLoaded
VersionNumber

boolean
string

yes
no

DbRowLimitParamName v2018.1

string

yes

DbRowRangeStartParamNamev2018.1+

string

yes

DbRowRangeEndParamName v2018.1+

string

yes

string
ExpressviewJoinAlgorithm v2018.1+

yes
"Standard" or "Legacy"

ExcludeDataSourcesReportCustomSQL v2018.1+

boolean

yes

LoadAssemblyInExternalDomain v2018.1+

boolean

yes

ShowTipsExpressView v2018.2+)

boolean

yes

ShowTutorialExpressView v2018.2+

boolean

yes

IsShowSQLWindow v2019.1+

boolean

yes

Example:
{
"General": {
"ReportPath": "C:\\Exago\\Reports",
"AllowHomeDirect": true,
"AllowHtmlOutput": true,
"AllowExcelOutput": true,
"AllowPdfOutput": true,
"AllowRtfOutput": true,
"AllowCsvOutput": true,
"DefaultOutputType": 2,
"IsWriteLog": true,
"CustomCode": "",
"LicenseKey": "",
"DateFormat": "",
"TimeFormat": "",
"DateTimeFormat": "",
"DateTimeTreatedAs": 0,
"IsReadFilterValues": true,
"DbTimeout": 600,
"DbRowLimit": 0,
"DbRowLimitStepSize": 1000,
"VisualizationDbRowLimit": 0,
"CallTypeParamName": "",
"ColumnParamName": "",
"FilterParamName": "",
"FullFilterParamName": "",
"SortParamName": "",
"DataCategoryParamName": "",
"ObjectIdParamName": "",
"IsShowGrid": true,
"ActiveRoleId": "",
"IsDebugging": false,
"IsShowPdfTemplate": true,
"IsDashboardPromptAtExecution": false,
"IsDashboardShowUrlItemButton": false,
"IsVisualizationShowKeyword": false,
"IsShowChartWizard": true,
"IsShowMapWizard": false,
"IsShowGoogleMapWizard": false,
"IsShowGaugeWizard": true,
"IsSaveOnExecute": true,
"IsSaveOnFinish": true,
"IsEnableRightClickMenus": true,
"IsEnableReportsTreeDragAndDrop": true,
"IsShowLinkReport": true,
"IsShowLinkReportFields": true,
"IsShowLinkReportFormula": false,
"IsShowLinkAction": false,
"IsShowInsertImage": true,
"ExpirationDateStr": "",
"IsHtmlPaging": true,
"WindowHeight": 0,
"WindowWidth": 0,
"SeparatorSymbol": ",",
"CurrencySymbol": "$",
"DecimalSymbol": ".",
"IsDataMapping": false,
"IsShowJoinFields": true,
"IsDetectJoinedObjects": true,
"IsEnableSpecialCartesianProcessing": true,
"IsIncludeNotFilterNullValues": false,
"TempPath": "",
"TempCloudService": "",
"DataCloudService": "",
"IsShowScheduleReports": false,
"IsShowScheduleReportsManager": false,
"ScheduleManagerViewLevel": 0,
"IsShowScheduleReportsEmail": false,
"ScheduleRemotingHost": "",
"SynchronousRemotingHost": "",
"SchedulerQueueService": "",
"ReportScheduleEmailSubject": "",
"ReportScheduleEmailBody": "",
"IsRenewSession": true,
"PasswordRequirement": "",
"IsExecuteRemotely": false,
"IsAccessDataSourcesRemotely": false,
"MaxTempFileAge": 1440,
"AllowExecuteNewFilters": true,
"ExternalInterface": "",
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"ExternalInterface": "",
"DecimalPlaces": -1,
"CurrencyDecimalPlaces": -1,
"ApplyGeneralFormatDecimalPlaces": false,
"ApplyGeneralCurrencyRightAlignment": true,
"ChartColors": "#e85d61, #e5d08f, #00d995",
"GeochartMapKey": "",
"MapColors": "Lightblue,Navy",
"GoogleMapKey": "",
"GoogleMapColors": "Lightblue,Navy",
"GaugeColors": "#e85d61, #e5d08f, #00d995",
"IsShowGroupFilters": true,
"IsShowJoinsWindow": true,
"IsShowAdvancedJoins": true,
"IsShowEventsWindow": false,
"IsShowReportParametersWindow": true,
"IsShowCrosstabReports": true,
"IsShowDashboardReports": true,
"IsShowChainedReports": true,
"IsAllowExpressViewLiveEdit": false,
"IsShowExpressViews": true,
"IsShowDashboardNewVisualizationButton": true,
"IsShowDashboardDataFieldsSearch": false,
"IsShowExpressViewDataFieldsSearch": true,
"IsUseSampleDataForDashboardVisualizationDesign": true,
"IsShowDashboardExistingVisualizationReportButton": false,
"IsDashboardPromptKeywordByDefault": false,
"IsShowExpressReports": true,
"IsShowExpressReportsGrouping": true,
"IsShowExpressReportsFormulaButton": true,
"IsShowExpressReportsStylingToolbar": true,
"IsShowExpressReportsThemes": true,
"IsShowAdvancedReports": true,
"IsShowGroupHeadersFormulaButton": false,
"IsOneCategoryLimit": false,
"IsCacheServices": true,
"SchedulerRecipientWindow": "",
"FilterExecutionWindow": "",
"IsShowIeDownloadButton": false,
"IsDeleteSchedulesUponReportDeletion": false,
"AllowMultipleSessions": true,
"AllowMD5OnFIPS": false,
"WriteBOMToCSV": false,
"IsShowScheduleNoEndDate": true,
"IsShowScheduleIntradayRecurrence": true,
"TempUrl": "",
"UserPreferenceStorage": 0,
"UserStartupReportOverwriteGettingStarted": false,
"UserStartupReportMaxNum": 1,
"ExcelExportTarget": 1,
"AllowDependantFilters": false,
"LinkedReportsInNewTab": false,
"LoadImageFuncParamPrefix": "",
"LanguageFile": "en-us,en-us-getting-started,en-us-tooltips",
"IsShowHelp": true,
"CustomHelpSource": "",
"IsEmailScheduledReports": true,
"IsEnableBatchReports": false,
"IsShowScheduleDeliveryTypeOptions": false,
"IsUseSecureRemotingChannel": false,
"IsShowTemplateUploadButton": false,
"UseSVGForAppIcons": true,
"CrossTabMaximumFields": 5,
"IsShowExportsInTab": true,
"IsShowHtmlToolbar": 0,
"IsEnableScheduling": true,
"IsShowFilterDescription": false,
"DefaultFilterExecutionWindow": 0,
"IsChangeableFilterExecutionWindow": true,
"IgnoreInaccessibleReportFolders": false,
"SchemaAccessType": 1,
"ServerTimeZoneOffset": null,
"ClientTimeZoneName": "America/New_York",
"IsShowEnhancedTooltips": true,
"IsShowReportUploadDownloadOptions": false,
"AllowInteractiveHtml": true,
"AllowHtmlInScheduledEmails": false,
"DefaultIsDockOpen": false,
"DockPlacement": 0,
"CssTheme": "Basic",
"AllowExecuteSaveToDesign": true,
"UserAllowUserReports": true,
"MaxNumberOfChartPoints": 300,
"DefaultFont": "Arial",
"DefaultFontSize": 8,
"DefaultChartFont": "Arial",
"IsWebFarmSupport": false,
"IsSilentDashboardRefresh": false,
"MaxJobExecutionMinutes": 240,
"IsAggregateAndGroupInDatabase": false,
"IsEvaluateFormulasInDatabase": true,
"IsShowBrowserOutOfDateWarning": true,
"AreDateFunctionsLoaded": true,
"VersionNumber": "2016.3.4.100"
},
"DateFormat": "",
"TimeFormat": "",
"DateTimeFormat": "",
"SeparatorSymbol": ",",
"CurrencySymbol": "$",
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"CurrencySymbol": "$",
"DecimalSymbol": ".",
"ShowGrid": true,
"ShowCrossTabReports": true,
"ShowExpressReports": true,
"ShowExpressReportsGrouping": true,
"ShowExpressReportsFormulas": true,
"ShowExpressReportsStyling": true,
"ShowExpressReportsThemes": true,
"ShowAdvancedReports": true,
"ShowScheduleReports": false,
"ShowScheduleReportsManager": false,
"ShowScheduleReportsEmail": false,
"ReadFilterValues": true,
"ShowTabs": true,
"WebReportsBaseUrl": null,
"DefaultFolderName": "",
"DefaultReportName": ""
}

Note
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted in the
interest of brevity.

Show Settings
GET /rest/settings

Show the available settings for the current configuration.

Using curl
curl http://{webservice}/rest/settings?sid={sid} -X GET

Example response
Status: 200 OK
{
"General": {
"ReportPath": "C:\\Exago\\Reports",
...
}
"DateFormat":
"MM/dd/yyyy",
"TimeFormat":
"hh:mm:ss a",
"DateTimeFormat":
"MM/dd/yyyy hh:mm:ss a",
"SeparatorSymbol":
",",
"CurrencySymbol":
"$",
"ShowGrid":
true,
"ShowCrossTabReports":
true,
"ShowExpressReports":
true,
...
}

Edit Settings
PATCH /rest/settings

Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/settings?sid={sid} -X PATCH ^
-d "{
'General':
{
'ReportPath':'C:\\Exago\\Reports',
'IsShowLinkReportFormula':false,
...
}
'ShowScheduleReports':false,
'ShowExpressReports':false,
...
}"

Example response
Status: 204 No Content

REST — Data Sources
A Data Source is a resource which contains or accesses the information which is reported on. Often this is a database, but a variety of
types are supported. Data Sources are accessed using a connection string, which passes the location of the resource and authentication
params. This endpoint allows for session-based read/write access to all data sources for the current config.
Important
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted for clarity.

Data Source JSON
Data Sources are represented as JSON objects with the following properties:
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Id

string

Writable
no

Description
The unique Id of this data source

Name

string

yes

The name of this data source

DbType

enum

yes
("MsSql")

Data Source Type

Connection

string

yes

The connection string of this data source

Schema

string

yes

The data source schema name (blank for default)

Example
{
"Id":
"Name":
"DbType":
"Connection":
"Schema":

"1",
"My Data Server",
"MsSql",
"Server=DataServer;Database=Northwind;uid=username;pwd=password;",
"dbo"

}

List Data Sources
GET /rest/datasources

List all the data sources in the current configuration. Output is an array of JSON objects, each representing an individual data source.
GET /rest/datasources?config=myconfig.xml

List all of the data objects only in the user's session specific configuration. Replace myconfig.xml with the file name of the corresponding
config file name. Output is an array of JSON objects, each representing an individual data source.
Name

Type

Id

string

Name

string

Description
The unique Id of this data
source
The name of this data source

Using curl
curl http://{webservice}/rest/datasources?sid={sid} -X GET

Example response
Status: 200
[
{
"Id":
"Name":
},
{
"Id":
"Name":
}
]

OK

"0",
"Northwind"

"1",
"AdventureWorks"

Show Data Source
GET /rest/datasources/{Id}

Show the properties of the data source specified by its Id.

Using curl
curl http://{webservice}/rest/datasources/{Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":
"Name":
"DbType":
"Connection":
"Schema":

"0",
"Northwind",
"MsSql",
"Server=DataServer;Database=Northwind;uid=username;pwd=password;",
"dbo"

}

Create Data Source
POST /rest/datasources

May be useful if you don't want your connection strings in the config file.

Using curl
curl http://{webservice}/rest/datasources?sid={sid} -X POST ^
-d "{'Name':'NW','DbType':'MsSql','Connection':'Server=SRV;Database=NW;uid=ID;pwd=PW;'}"

Example response
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Status: 201 Created
Location: /{webservice}/rest/DataSources/2
{
"Id":
"Name":
"DbType":
"Connection":
"Schema":

"2",
"NW",
"MsSql",
"Server=SRV;Database=NW;uid=ID;pwd=PW;",
""

}

Edit Data Source
PATCH /rest/datasources/{Id}

Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/datasources/{Id}?sid={sid} -X PATCH ^
-d "{'Connection':'Server=SRV;Database=NW;uid=Admin;pwd=Password;'}"

Example response
Status: 204 No Content

Delete Data Source
DELETE /rest/datasources/{Id}

Using curl
curl http://{webservice}/rest/datasources/{Id}?sid={sid} -X DELETE

Example response
Status: 204 No Content

REST — Data Objects
Data Objects (also known as "Entities") are the manner by which Exago views and accesses the tables, views, procedures, etc... from
the Data Sources. Data objects represent the structure of the data, but the actual data is only accessed at report run-time.
Note
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted in the
interest of brevity.

Data Object JSON
Data Objects are represented as JSON objects with the following properties:
Name

Type

Writable
requiredcreate

Description

Id

string

The unique Id of this data object

Name

string

required

The display name ("alias") of this data object

Schema

string

yes

The schema of this data object
How Exago should retrieve the schema for the data object. There
are three possibilities:
Default — Follow the global Schema Access Type setting
in Other Settings.
Datasource — Queries the data source for the schema.
Metadata — Reads the schema from the stored metadata.

SchemaAccessType

string

yes

CategoryName

string

yes

The Category/Folder group this object will appear in

DataName

string

required

The name of this data object in its data source

DataSourceId

integer

required

The Id of the data source of this data object (see Data Sources)

DataType

enum

yes
("Table")

Data Object Type

SqlStatement

string

yes

The custom SQL of this data object if it's DataType is SqlStmt

Parameters

array of strings

yes

Any parameters for stored procedure, .NET Assembly or Web
Service API calls

KeyColumns

array of strings

yes

The unique key fields of this data object

TenantColumns

array of Tenant Column yes

The tenant fields of this data object

FilterDropdownObject

Filter Dropdown

The filter dropdown object of this data object

yes

Example
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{
"Id":
"Employees_0",
"Name":
"Employees",
"Schema":
"dbo",
"CategoryName": "",
"DataName":
"Employees",
"DataSourceId": "0",
"DataType":
"Table",
"SqlStatement": "",
"Parameters":
[],
"KeyColumns":
["EmployeeID"],
"TenantColumns": [
{
"Column":
"EmployeeID",
"Parameter": "UserId"
}
],
"FilterDropdownObject": {
"FilterDbName":
"Employee_List",
"FilterDataSourceId": -1,
"FilterObjectType": "view",
"FilterSchema":
"",
"FilterSqlStmt":
""
}
}

Tenant Column JSON
Tenant Columns are represented as JSON objects with the following properties:
Name
Column

string

Type

Writable
Description
required The tenant data field

Parameter

string

required The tenant parameter

Example
"TenantColumns": [
{
"Column":
"EmployeeID",
"Parameter": "UserId"
}
]

Filter Dropdown JSON
A Data Object's Filter Dropdown is represented as a JSON object with the following properties:
Name
FilterDbName

string

Type

Writable
Description
required The name of this data object in its data source

FilterObjectType

enum

yes

Data Object Type

FilterSchema

string

yes

The schema for this data object

FilterSqlStmt

string

yes

The custom SQL for this data object if it is of type SqlStmt

Example
"FilterDropdownObject":
"FilterDbName":
"FilterObjectType":
"FilterSchema":
"FilterSqlStmt":
}

{
"Employee_List",
"view",
"",
""

List Data Objects
GET /rest/entities

List all the data objects in the current configuration. Output is an array of objects, each representing an individual data object.
Id

Name
string

Type

Description
The unique Id of this data object

Name

string

The display name ("alias") of this data object

Using curl
curl http://{webservice}/rest/entities?sid={sid} -X GET

Example response
Status: 200 OK
[
{
"Id":
"Name":
},
{
"Id":
"Name":
},
...

"Customers_0",
"Customers"

"Employees_0",
"Employees"

]

Show Data Object
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GET /rest/entities/{Id}

Show the properties of the data object specified by its Id.

Using curl
curl http://{webservice}/rest/entities/{Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":"system_departments_0",
"Name":"Departments",
"Schema":"",
"CategoryName":"Roster",
"DataName":"system_departments",
"DataSourceId":"4",
"DataType":"Table",
"SqlStatement":"",
"Parameters":[],
"KeyColumns":["id"],
"TenantColumns":[],
"FilterDropdownObject":null
}

Create Data Object
POST /rest/entities

Requires a DataName or a custom SqlStatement. One or more KeyColumns are required for most data types.

Using curl
curl http://{webservice}/rest/entities?sid={sid} -X POST ^
-d @newDataObject.txt

newDataObject.txt
"{'Id':'Employees_1','Name':'Employees','Schema':'dbo','DataName':'Employees','DataSourceId':0,'KeyColumns':['EmployeeID']}"

Example response
Status: 201 Created
Location: /{webservice}/rest/Entities/Employees_1
{
"Id":
"Employees_1",
"Name":
"Employees",
"Schema":
"dbo",
"CategoryName": "",
"DataName":
"Employees",
"DataSourceId": "0",
"DataType":
"Table",
"SqlStatement": "",
"Parameters":
[],
"KeyColumns":
["EmployeeID"],
"TenantColumns": [],
"FilterDropdownObject": null
}

Edit Data Object
PATCH /rest/entities/{Id}

Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/entities/{Id}?sid={sid} -X PATCH ^
-d "{'Name':'Staff List'}"

Example response
Status: 204 No Content

Delete Data Object
DELETE /rest/entities/{Id}

Using curl
curl http://{webservice}/rest/entities/{Id}?sid={sid} -X DELETE

Example response
Status: 204 No Content

Data Field JSON
Data fields for each object are represented as JSON objects with the following properties. The actual data in the fields is not accessible via
REST. Data fields cannot be created or deleted. However, some metadata for existing fields can be edited.
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Important
The IsFilterable property name changed to Filterable in v2019.1.13.

Id

Name
string

Type

Writable
no

Description
The unique name for this data field

Name

string

yes

The display name for this data field

Type

enum

yes

Data Field Type

IsFilterable (pre2019.1.13)
Filterable (v2019.1.13+)
IsVisible

bool
(pre-v2017.2)
const
(v2017.2+)
boolean

Whether this field is filterable
yes
Filterable Type
yes

Whether this field is visible to end users. Set to false to hide it or
true to show it.
The content of the data field. Enclose other Exago data fields in
curly braces { }. There are three possibilities:

Value

string

yes

Description

string

yes

An Exago formula — A custom function used to define the
field value. Can use other fields from the same data object.
(e.g. “Concatenate({Orders.ShipCountry},'+ ',
{Orders.ShipCity})”)
A SQL formula — SQL statement used to define the the field
value. (e.g. “Concat(ShipCountry, ' + ',
ShipCity)”)
A static value — Static content (e.g. "12345")
A text description of the data field what will be shown to the end
user
Describes the content of the Value property. Either:

ColumnSource

string

yes

Data — use for either a static value, or when Value contains
a single column name
ExagoFormula — use when the Value is an Exago formula
SqlFormula — use when the Value is a SQL formula

SortAndGroupBy

string

yes

Either an Exago formula or another data field name that will be used
to sort/group the values in this column. Enclose column names in
curly braces { }. If null, sorting/grouping on a field is not enabled.

List Data Fields of a Data Object
GET /rest/entities/{Id}/fields

List all the data fields in the data object specified by its Id. Output is an array of objects, each representing an individual data field.
Id

Name

Type
string

Description
The unique Id of this data field

Name

string

The display name of this data field

Using curl
curl http://{webservice}/rest/entities/{Id}/fields?sid={sid} -X GET

Example response
Status: 200 OK
[
{
"Id":
"Name":
},
{
"Id":
"Name":
},
{
"Id":
"Name":
},
{
"Id":
"Name":
},
{
"Id":
"Name":
},
...

"Address",
"Address"

"BirthDate",
"Date of Birth"

"EmployeeID",
"ID Number"

"FirstName",
"First Name"

"LastName",
"Last Name"

]

Show Data Field
Important
Performing a GET for the data fields will result in fixing the current column metadata list as the only defined columns. The column
metadata can be further altered, but will not be reflected in the Entity Columns collection until the session is launched in a browser.

GET /rest/entities/{Id}/fields/{Field Id}

Show the properties of the data field specified by its Id, of the data object specified by its Id.

Using curl

182 of 215

REST — Data Joins

Technical Guide

curl http://{webservice}/rest/entities/{Id}/fields/{Field Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":
"Name":
"Type":
"IsFilterable":
"IsVisible":

"LastName",
"Last Name",
"String",
true,
true

}

Edit Metadata for Data Field
PATCH /rest/entities/{Id}/fields/{Field Id}

Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/entities/{Id}/fields/{Field Id}?sid={sid} -X PATCH ^
-d "{'Name':'Surname'}"

Example response
Status: 204 No Content

Add New Metadata to Data Field
Add new metadata that doesn't already exist to a data field.
POST /rest/entitites/{Id}/Fields/{Field Id}

Caution
Setting the Type property to a data type that does not match the actual type in the data source will cause errors when reports are run or
designed.
Important
Adding additional column metadata will result in fixing the current column metadata list as the only defined columns. The column
metadata can be further altered, but will not be reflected in the Entity Columns collection until the session is launched in a browser.

REST — Data Joins
Joins are the relationship data objects have to each other. Join information is accessible and editable via REST.
Important
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted for clarity.

Join JSON
Joins are represented as JSON objects with the following properties:
Name

Type

Writeable

Description

Id

string

no

The unique Id of this join

EntityFrom

string

required-create

The "from" (or "left") data object of this
join

EntityTo

string

required-create

The "to" (or "right") data object of this
join

JoinType

const

yes ("Inner")

Join Type

RelationshipType

const

yes ("OneToOne")

Join Relation Type

Weight

integer

yes (0)

The weight of this join

JoinColumns

array of
JoinColumn

required

The data fields which are joined

Example
{
"Id":
"Shippers.Orders",
"EntityFrom":
"Shippers",
"EntityTo":
"Orders",
"JoinType":
"Inner",
"RelationshipType": "OneToMany",
"Weight":
0,
"JoinColumns": [
{
"ColumnFrom": "ShipperID",
"ColumnTo": "ShipVia"
}
]
}

JoinColumn JSON
The JoinColumn objects of a join indicate which columns are used to join the data objects. Objects can be joined on multiple join columns
(which are AND-ed). Each join requires one or more sets of join columns. JoinColumn objects have the following properties:
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Name

Type

Writeable

Description

ColumnFrom

string

required

The join data field for the "from" (or "left")
data object

ColumnTo

string

required

The join data field for the "to" (or "right")
data object

Example
"JoinColumns": [
{
"ColumnFrom": "ShipperID",
"ColumnTo": "ShipVia"
}
]

List Joins
GET /rest/joins

List all the joins in the current configuration. Output is an array of objects, each representing an individual join.
Name

Type

Description

Id

string

The unique Id of this join

Available parameters
Name

Type

Description

entity

string

Show only joins that join this data object

Using curl
curl http://{webservice}/rest/joins?sid={sid} -X GET

Example response
Status: 200 OK
[
{
"Id": "Employees.Orders"
},
{
"Id": "Employees.EmployeeTerritories"
},
...
]

Show Join
GET /rest/joins/{Id}

Show the properties of the join specified by its Id.

Using curl
curl http://{webservice}/rest/joins/{Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":
"Orders.OrderDetails",
"EntityFrom":
"Orders",
"EntityTo":
"OrderDetails",
"JoinType":
"Inner",
"RelationshipType": "OneToOne",
"Weight":
0,
"JoinColumns": [
{
"ColumnFrom": "OrderID",
"ColumnTo": "OrderID"
}
]
}

Create Join
POST /rest/joins

Using curl
curl http://{webservice}/rest/joins?sid={sid} -X POST ^
-d @newJoin.txt

newJoin.txt
"{'EntityFrom':'Shippers','EntityTo':'Orders','RelationshipType':'OneToMany','JoinColumns':[{'ColumnFrom':'ShipperID','ColumnTo':'ShipVia'}]}"

Example response
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Status: 201 Created
Location: /{webservice}/rest/Joins/Shippers.Orders
{
"Id":
"Shippers.Orders",
"EntityFrom":
"Shippers",
"EntityTo":
"Orders",
"JoinType":
"Inner",
"RelationshipType": "OneToMany",
"Weight":
0,
"JoinColumns": [
{
"ColumnFrom": "ShipperID",
"ColumnTo": "ShipVia"
}
]
}

Edit Join
PATCH /rest/joins/{Id}

Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/joins/{Id}?sid={sid} -X PATCH ^
-d "{'JoinType':'LeftOuter'}"

Example response
Status: 204 No Content

Delete Join
DELETE /rest/joins/{Id}

Using curl
curl http://{webservice}/rest/joins/{Id}?sid={sid} -X DELETE

Example response
Status: 204 No Content

REST — Folder Management
Management of the folder and report tree is available with the REST Web Service API. Unlike other resources, managing the tree affects
the base configuration, and is not temporary to a session. Therefore it also affects concurrent users.
Note
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted in the
interest of brevity.

Node JSON
The folders tree is represented as an output-only (ie. non-writeable) resource. Each object in the tree is a Node. Nodes are represented as
JSON objects with the following properties:
Name

Type

Description

name

string

The name of this folder or report

leaf_flag

boolean

Whether this node is a report

readonly_flag

boolean

Whether this node is read-only for the active role

type

enum

Report Type (null if this is a folder)

user

string

The active role

entity

array of
Node

If this is a folder, an array of the nodes contained within

Note
The top-level node has only an entity property.

Example
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{
"entity": [
{
"name":
"Asset Reports",
"leaf_flag":
false,
"readonly_flag": false,
"type":
null,
"user":
"Admin",
"entity": [
{
"name":
"Sales Report",
"leaf_flag":
true,
"readonly_flag": false,
"type":
"advanced",
"user":
"Admin",
"entity":
null
},
{
"name":
"Financial Holdings",
"leaf_flag":
false,
"readonly_flag": false,
"type":
null,
"user":
"Admin",
"entity": [
{
"name":
"Liquidity Report",
"leaf_flag":
true,
"readonly_flag": false,
"type":
"expressview",
"user":
"Admin",
"entity":
null
},
{
"name":
"Regional Holdings",
"leaf_flag":
true,
"readonly_flag": false,
"type":
"dashboard",
"user":
"Admin",
"entity":
null
}
]
}
]
}
]
}

Show Folders Tree
GET /rest/reports/list

Show the full folder tree for the current configuration.

Using curl
curl http://{webservice}/rest/reports/list?sid={sid} -X GET

Example response
Status: 200 OK
{
"entity": [
{
"name": "Asset Reports",
...
"entity": [
{
"name": "Sales Report",
...
"entity": null
},
{
"name": "Financial Holdings",
...
"entity": [
{
"name": "Liquidity Report",
...
"entity": null
}
]
}
]
}
]
}

Folder JSON
The /rest/folders endpoint represents each folder as an output-only (ie. non-writeable) resource. Folders are represented as JSON objects
with the following properties:
Name

Type

Description

Name

string

Full path from root folder to this folder

Status

const

Folder Status

186 of 215

REST — Functions

Technical Guide

Create a Folder
POST /rest/folders/{Name}

Name is the full path from the root folder to the name of the folder to be created. Spaces and unusual characters must be URL-encoded.
Folder names are case sensitive.

Using curl
curl http://{webservice}/rest/folders/Asset%20Reports/Overseas%Holdings?sid={sid} -X POST

Example response
Status: 200 OK
{
"Id":
null,
"Name": "Asset Reports/Overseas Holdings",
"Status": "Created"
}

Note. The "Id" property is not used.

Move or Rename a Folder
POST /rest/folders/rename

Folders are moved or renamed by supplying the following JSON resource:
Name

Type

Writeable

Description

OldName

string

required

Full path from the root folder to the name of the
folder to be moved or renamed

NewName

string

required

Full path from the root folder to the new folder
location and name

Using curl
curl http://{webservice}/rest/folders/rename?sid={sid} -X POST ^
-d "{'OldName':'Asset Reports\\Overseas Holdings', ^
'NewName':'Asset Reports\\Regional Holdings'}"

Note. Windows file paths are delineated by double-backslashes: \\

Example response
Status: 200 OK
{
"Id":
null,
"Name": "Asset Reports/Regional Holdings",
"Status": "Renamed"
}

Delete a Folder
DELETE /rest/folders/{Name}

Name is the full path from the root folder to the name of the folder to be created. Spaces and unusual characters must be URL-encoded.
Folder names are case sensitive. The folder must be empty to be deleted.

Using curl
curl http://{webservice}/rest/folders/Asset%20Reports/Overseas%Holdings?sid={sid} -X DELETE

Example response
Status: 200 OK
{
"Id":
null,
"Name": "Asset Reports/Overseas Holdings",
"Status": "Deleted"
}

REST — Functions
Functions are custom formulas that can be used in reports to manipulate data. Only custom functions can be edited, not the built-in
functions.
Note
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted in the
interest of brevity.

Function JSON
Functions are represented as JSON objects with the following properties:
Name

Type

Writeable

Description

Id

string

required-create

The unique Id of this function

Description

string

yes

The description of this function
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yes

Code Language

yes

Namespaces for this function

References

array of
strings

yes

References for this function

ProgramCode

string

yes

Function code

IsCustom

boolean

no

Whether this is a custom function

Example
{
"Id":
"Description":
"MinArgs":
"MaxArgs":
"Language":
"Namespaces":
"References":
"ProgramCode":
"IsCustom":

"DayOfWeek",
"Returns the day of the week as a string given a date value",
null,
null,
"cs",
[],
["System.dll"],
"return System.Convert.ToDateTime(args[0].ToString());",
true

}

List Functions
GET /rest/functions

List all the functions in the current configuration. Output is an array of objects, each representing an individual function.
Name

Type

Description

Id

string

The unique Id of this function

Available parameters
Name

Type

Description

filter

string

Possible values: custom - Return only custom
functions.

Using curl
curl http://{webservice}/rest/functions?sid={sid} -X GET

Example response
Status: 200 OK
[
{
"Id": "Today"
},
{
"Id": "Tomorrow"
},
...
]

Show Function
GET /rest/functions/{Id}

Show the properties of the function specified by its Id.

Using curl
curl http://{webservice}/rest/functions/{Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":
"Description":
"MinArgs":
"MaxArgs":
"Language":
"Namespaces":
"References":
"ProgramCode":
"IsCustom":

"Today",
"",
null,
null,
"cs",
[],
[],
"return sessionInfo.Today;",
true

}

Create Function
POST /rest/functions

Using curl
curl http://{webservice}/rest/functions?sid={sid} -X POST ^
-d @customFunction.txt

customFunction.txt
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"{'Id':'DayOfWeek','Description':'Returns the day of the week as a string given a date value','References':['System.dll'],'ProgramCode':'return System.Convert.ToDateTime(args[0].ToSt

Example response
Status: 201 Created
Location: /{webservice}/rest/Functions/DayOfWeek
{
"Id":
"Description":
"MinArgs":
"MaxArgs":
"Language":
"Namespaces":
"References":
"ProgramCode":
"IsCustom":

"DayOfWeek",
"Returns the day of the week as a string given a date value",
null,
null,
"cs",
[],
["System.dll"],
"return System.Convert.ToDateTime(args[0].ToString());",
true

}

Edit Function
PATCH /rest/functions/{Id}

Only supply the properties to be edited. Only custom functions can be edited.

Using curl
curl http://{webservice}/rest/functions/{Id}?sid={sid} -X PATCH ^
-d "{'Namespaces':['WebReports.Api']}"

Example response
Status: 204 No Content

Delete Function
DELETE /rest/functions/{Id}

Only custom functions can be deleted.

Using curl
curl http://{webservice}/rest/functions/{Id}?sid={sid} -X DELETE

Example response
Status: 204 No Content

REST — Parameters
Parameters are used throughout the application to store values. The userId and companyId parameters are used for identifying the
current user. Non-hidden parameters can be accessed in reports.
Important
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted for clarity.

Parameter JSON
Parameters are represented as JSON objects with the following properties:
Name

Type

Writeable

Description

Id

string

required-create

The unique Id of this parameter

DataType

enum

yes ("String")

Parameter Type

Value

string

yes

The value of this parameter

PromptText

string

yes

If set, text to prompt the user for a value

IsHidden

boolean

yes (true)

Whether the parameter is accessible in reports

Example
{
"Id":
"DataType":
"Value":
"PromptText":
"IsHidden":

"MyParameter",
"String",
"",
"Input a value",
true

}

List Parameters
GET /rest/parameters

List all the parameters in the current configuration. Output is an array of objects, each representing an individual parameter.
Name

Type

Description

Id

string

The unique Id of this parameter

Using curl

189 of 215

REST — Role Security

Technical Guide

curl http://{webservice}/rest/parameters?sid={sid} -X GET

Example response
Status: 200 OK
[
{
"Id": "MyParameter"
},
{
"Id": "HelloWorld"
}
]

Show Parameter
GET /rest/parameters/{Id}

Show the properties of the parameter specified by its Id.

Using curl
curl http://{webservice}/rest/parameters/{Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":
"DataType":
"Value":
"PromptText":
"IsHidden":

"MyParameter",
"String",
"",
"Input a value",
true

}

Create Parameter
POST /rest/parameters

Parameters are designed to be set in the API. If they do not already exist in config, create them programmatically.

Using curl
curl http://{webservice}/rest/parameters?sid={sid} -X POST ^
-d "{'Id':'Hello','DataType':'String','Value':'World','IsHidden':false}"

Example response
Status: 201 Created
Location: /{webservice}/rest/Parameters/Hello
{
"Id":
"DataType":
"Value":
"PromptText":
"IsHidden":

"Hello",
"String",
"World",
"",
false

}

Edit Parameter
PATCH /rest/parameters/{Id}

Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/parameters/{Id}?sid={sid} -X PATCH ^
-d "{'IsHidden':true}"

Example response
Status: 204 No Content

Delete Parameter
DELETE /rest/parameters/{Id}

Using curl
curl http://{webservice}/rest/parameters/{Id}?sid={sid} -X DELETE

Example response
Status: 204 No Content

REST — Role Security
Roles are collections of security settings for users of the application. They are used to distinguish classes of users by access rights.
Setting an active role will cause it to take effect for the application session, once the AppUrl is launched in the browser. Once in an
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application session, the active role cannot be changed. Only one role can be active at a time.
Roles do not affect your access to the API.
Note
All requests require a Session ID URL parameter and basic request headers. In the following document, headers are omitted in the
interest of brevity.

Role JSON
A role's base status is represented as a JSON object with the following properties:
Name

Type

Id

string

IsActive

boolean

Writable
requiredcreate
yes (true)

Description
The unique Id of this role
Whether this role is active

Example
{
"Id":
"Client",
"IsActive": false
}

List Roles
GET /rest/roles

List all the roles in the current configuration. Output is an array of objects, each representing an individual role.
Name
Id

Type
string

Description
The unique Id of this role

Using curl
curl http://{webservice}/rest/roles?sid={sid} -X GET

Example response
Status: 200 OK
[
{
"Id":
},
{
"Id":
},
...

"Admin"

"Client"

]

Create a Role
POST /rest/roles

Creating a new role activates it by default.

Using curl
curl http://{webservice}/rest/roles?sid={sid} -X POST ^
-d "{'Id':'User'}"

Example response
Status: 201 Created
Location: /{webservice}/rest/Roles/User
{
"Id":
"User",
"IsActive": true
}

Show Role Status
GET /rest/roles/{Id}

Using curl
curl http://{webservice}/rest/roles/{Id}?sid={sid} -X GET

Example response
Status: 200 OK
{
"Id":
"User",
"IsActive": true
}

Activate or Deactivate a Role
PATCH /rest/roles/{Id}
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Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/roles/{Id}?sid={sid} -X PATCH ^
-d "{'IsActive':false}"

Example response
Status: 204 No Content

Delete a Role
DELETE /rest/roles/{Id}

Using curl
curl http://{webservice}/rest/roles/{Id}?sid={sid} -X DELETE

Example response
Status: 204 No Content

Role Settings JSON
Each role has a group of settings that may be used to override the base config. Each key corresponds with a setting in the Admin
Console, which is noted in the Description field. If a setting is blank or null, then the value from the base config is not overridden for this
role. The settings are represented as a JSON object with the following properties:
Note
All properties are read/write. No properties are required. Default values are inherited from the base config.
Name

Type

Description

ReportPath

string

Report Path

LanguageFile

string

Language File

ServerTimeZoneOffset

integer

Server Time Zone Offset

ReadFilterValues

boolean

Read Database for Filter Values

DbTimeout

integer

Database Timeout

ScheduleManagerViewLevel

enum

Scheduler Manager User View Level

DateFormat

string

Date Format

TimeFormat

string

Time Format

DateTimeFormat

string

DateTime Format

SeparatorSymbol

string

Numeric Separator Symbol

CurrencySymbol

string

Numeric Currency Symbol

ShowGrid

boolean

Show Grid Lines in Report Viewer

ShowCrossTabReports

boolean

Allow Creation/Editing of CrossTab Reports

ShowExpressReports

boolean

Allow Creation/Editing of Express Reports

ShowExpressReportsGrouping

boolean

Show Grouping in the Express Report Designer

ShowExpressReportsFormulas

boolean

Show Formula Button in the Express Report Designer

AllowReportCustomSQLObjects
v2018.1+

boolean

Allow Creation of Custom SQL Objects in Advanced Reports

ShowExpressReportsStyling

boolean

Show Styling Toolbar in the Express Report Designer

ShowExpressReportsThemes

boolean

Show Themes in the Express Report Designer

ShowScheduleReports

boolean

Show report scheduling options

ShowScheduleReportsManager

boolean

Show Schedule Manager in the main menu

ShowScheduleReportsEmail

boolean

Show Email Report Options

DecimalSymbol

string

Numeric Decimal Symbol

The following settings have been added to versions v2018.1.27+, v2018.2.16+, 2019.1.2+ of Exago:
Name
ShowAdvancedReports

boolean

Type

Description
Allow Creation/Editing of Advanced Reports

ShowDashboardReports

boolean

Allow Creation/Editing of Dashboard Reports

ShowDashboardNewVisualizationButton boolean

Allow Creation/Editing of Dashboard Visualizations

ShowExpressViews

boolean

Allow Creation/Editing of ExpressViews

AllowExpressViewLiveEdit

boolean

Allow Editing ExpressView with Live Data

ShowChainedReports

boolean

Allow Creation/Editing of Chained Reports

CacheVisibilityLevel

wrCacheVisibility

Cache Visibility Level

Example
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{
"ReportPath":
"C:\\Exago\\Reports",
"LanguageFile":
null,
"ServerTimeZoneOffset":
0,
"ReadFilterValues":
true,
"DbTimeout":
0,
"ScheduleManagerViewLevel": "All",
"DateFormat":
"MM/dd/yyyy",
"TimeFormat":
"hh:mm:ss a",
"DateTimeFormat":
"MM/dd/yyyy hh:mm:ss a",
"SeparatorSymbol":
",",
"CurrencySymbol":
"$",
"ShowGrid":
true,
"ShowCrossTabReports":
true,
"ShowExpressReports":
true,
"ShowExpressReportsGrouping": true,
"ShowExpressReportsFormulas": true,
"ShowExpressReportsStyling": true,
"ShowExpressReportsThemes": true,
"ShowAdvancedReports":
true,
"ShowDashboardReports":
true,
"ShowDashboardNewVisualizationButton": true,
"ShowExpressViews":
true,
"AllowExpressViewLiveEdit": true,
"ShowChainedReports":
true,
"CacheVisibilityLevel":
"Global",
"ShowScheduleReports":
true,
"ShowScheduleReportsManager": true,
"ShowScheduleReportsEmail": true,
"DecimalSymbol":
"."
}

Show Role Settings
GET /rest/roles/{Id}/settings

Show the settings for the role specified by its Id.

Using curl
curl http://{webservice}/rest/roles/{Id}/settings?sid={sid} -X GET

Example response
Status: 200 OK
{
"ReportPath":
"LanguageFile":
"ServerTimeZoneOffset":
"ReadFilterValues":
"DbTimeout":
"ScheduleManagerViewLevel":
"DateFormat":
"TimeFormat":
...

"C:\\Exago\\Reports",
null,
0,
true,
0,
"All",
"MM/dd/yyyy",
"hh:mm:ss a",

}

Edit Role Settings
PATCH /rest/roles/{Id}/settings

Only supply the properties to be edited.

Using curl
curl http://{webservice}/rest/roles/{Id}/settings?sid={sid} -X PATCH ^
-d "{'ShowAdvancedReports':false}"

Example response
Status: 204 No Content

Folder Permissions JSON
Each role has a set of folder permissions which allow or disallow access to folders for the current session. The permissions are
represented as a JSON object with the following properties:
Note
All properties are read/write. No properties are required.
Name

Type

Description
If True, all folders are visible to this role except the ones specified in
Folders. If False, only the folders specified in Folders are visible to
this role.

IncludeAll

boolean

ReadOnly

boolean

If True, all folders are read-only except the folders marked
ReadOnly = 'true'. If false, only the folders marked ReadOnly = 'true'
are read-only.

AllowManagement

boolean

If True, users will be able create, rename and delete folders via the
user interface. If False, users cannot take action on folders and the
Add Folder buttons are hidden from the user interface.

CreateFolders

boolean

If True, when adding Folders to the Role via the API, Exago will
check if the folder exists and add it if not. If False no check will be
performed. Once the session is launched, this property no longer
applies.
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array of Folder

The folders with properties specific to this role

Folder JSON
Each folder in the Folders property is represented as a JSON object with the following properties:
Name

Name
string

Type

Description
Full path from the root folder to this folder

ReadOnly

boolean

Whether this folder is ReadOnly

Propagate

boolean

Whether this folder's subfolders share its ReadOnly property

Example
{
"IncludeAll":
false,
"ReadOnly":
false,
"AllowManagement": true,
"CreateFolders": false,
"Folders": [
{
"Name":
"Examples\Client",
"ReadOnly": true,
"Propagate": true
}
]
}

List Folder Permissions
GET /rest/roles/{Id}/folders

Show the folder permissions for the role specified by its Id.

Using curl
curl http://{webservice}/rest/roles/{Id}/folders?sid={sid} -X GET

Example response
Status: 200 OK
{
"IncludeAll":
false,
"ReadOnly":
false,
"AllowManagement": true,
"CreateFolders": false,
"Folders": [
{
"Name":
"Examples",
"ReadOnly": true,
"Propagate": true
}
]
}

Edit Folder Permissions
PATCH /rest/roles/{Id}/folders

Only supply the properties to be edited. Supplying a Folders property will overwrite the entire collection.

Using curl
curl http://{webservice}/rest/roles/{Id}/folders?sid={sid} -X PATCH ^
-d "{'ReadOnly':true}"

Example response
Status: 204 No Content

Data Object Permissions JSON
Each role has a set of data object permissions which allow or disallow access to data objects for the current session. The permissions are
represented as a JSON object with the following properties:
Note
All properties are read/write. No properties are required.
Name

Type

IncludeAll

boolean

Entities

array of Data Object

Description
If true, all data objects are available to this role except the ones
specified in Entities. If false, only the data objects specified in
Entities are visible to this role.
The data objects with properties specific to this role

Data Object JSON
Each Data Object in the Entities property is represented as a JSON object with the following properties:
Name
Id

Type
string

Description
The unique Id of this data object

Example
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{
"IncludeAll": true,
"Entities": [
{
"Id": "EMP"
},
{
"Id": "ETE"
}
]
}

List Data Object Permissions
GET /rest/roles/{Id}/entities

Show the data object permissions for the role specified by its Id.

Using curl
curl http://{webservice}/rest/roles/{Id}/entities?sid={sid} -X GET

Example response
Status: 200 OK
{
"IncludeAll": false,
"Entities": [
{
"Id": "EMP"
}
]
}

Edit Data Object Permissions
PATCH /rest/roles/{Id}/entities

Only supply the properties to be edited. Supplying an Entities property will overwrite the entire collection.

Using curl
curl http://{webservice}/rest/roles/{Id}/entities?sid={sid} -X PATCH ^
-d "{'IncludeAll':false}"

Example response
Status: 204 No Content

Row Filters JSON
You can add security filters to data objects so that users can only view specific rows in the data object. The collection of row filters for this
role is represented as a JSON object with the following properties:
Name
DataObjectRows

Type
Description
array of Row Filter The row filters for this role

Row Filter JSON
Each row filter in the DataObjectRows property is represented as a JSON object with the following properties:
Name
Id

Type
string

Description
The Id of the data object to filter
The filter string.

Filter

string

The filter string should be valid, standard SQL to be added to the
'WHERE' clause sent to the Data Source. This filter string can
include Exago system parameters (e.g. @userId@) or custom SQL
including subqueries (e.g. IN (SELECT EmployeeID FROM
Employees WHERE EmployeeID <4)). The Filter String must
contain the actual name of objects in the Data Source (e.g. tables,
views, columns, etc...) rather than their Exago aliases.

Example
{
"DataObjectRows": [
{
"Id":
"EMP",
"Filter": "EmployeeID = 1"
},
{
"Id":
"ETE",
"Filter": "EmployeeID = 2"
}
]
}

List Row Filters
GET /rest/roles/{Id}/dataobjectrows

Show the row filters for the role specified by its Id.
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Using curl
curl http://{webservice}/rest/roles/{Id}/dataobjectrows?sid={sid} -X GET

Example response
Status: 200 OK
{
"DataObjectRows": [
{
"Id":
"EMP",
"Filter": "EmployeeID = 3"
},
...
]
}

Edit Row Filters
PATCH /rest/roles/{Id}/dataobjectrows

This will overwrite the entire filter collection.

Using curl
curl http://{webservice}/rest/roles/{Id}/dataobjectrows?sid={sid} -X PATCH ^
-d "{'DataObjectRows':[{'Id':'EMP','Filter':'Client'}]}"

Example response
Status: 204 No Content

Executing Reports with the API
There are two different ways to use the Exago APIs to perform report execution. This guide discusses the main differences and provides
examples for both types in each API.
API Action is the most comprehensive way to run executions, and supports all types of reports. This is the only way to run
composite reports such as Dashboards and Chained Reports. This method launches an Exago session into the browser via URL,
and thus usually requires the use of an Iframe. This also means that all interactive Report Viewer or ExpressView (v2016.3+)
features are supported.
GetExecute (formerly Direct Execution) executes reports on the back-end and returns bare HTML, JSON, CSV, or binary data.
GetExecute only supports non-composite (Advanced, Express and CrossTab) reports. Using this method you do not have to launch
any visible instance of Exago for the user, and can simply use it as a calculation engine.
Note
GetExecute methods are not supported by Remote Execution in versions pre-v2019.1.15. In v2019.1.15+, all calls of the
GetExecute() functions will use the Remote Execution servers if configured.
To disable this behavior, disable remote executions for the session with the API.

Overview
browser frame to
API Action Redirect
Exago session URL

Supported Report .NET Supported Output SOAP Supported
REST Supported
Types
Types
Output Types
Output Types
Interactive Report Viewer, Dashboard Viewer, ExpressView designer, or
All types
PDF, RTF, Excel, CSV

GetExecute Data returned directly to
calling method

Advanced,
HTML, CSV, PDF, RTF, HTML, CSV, PDF,
Express, CrossTab Excel, JSON
RTF, Excel

Launch Method

HTML, CSV, PDF, RTF,
Excel, JSON

API Action
API sessions in Exago have a property called action type, which determines what part of Exago should be launched when the session is
opened. Action types include executing a report, loading a report into the editor, loading a report into the scheduler, opening a section of
the UI, etc.
Note
API Action is also referred to as GetUrlParamString, because this is the general term for the methods which return the session redirect
URL.
To tell the session to execute a report, set the action type to ExecuteReport.
Actions which load reports, such as Execute or Edit, work on the active report object. This is another property that must be set. This is
done differently for each API: details are in the included examples.
Important
For security reasons, always set the action type and the active report explicitly. Although setting an active report defaults to execute,
if a report fails to load and an action has not been specified, Exago will launch into the full Web Application user interface. This could
cause users to have unintended levels of access.
Once you've finished setting the session variables, call GetUrlParamString(). This finalizes the session and creates a single-use URL
string. This is done differently for each API; details are in the included examples. The URL is used to direct a browser window or iFrame to
an Exago instance where the specified action takes place. The user can then interact with the report like normal.
See the following sections for examples. Variable names and arguments are placeholders.

.NET
1. First create an API session and load a report object.

196 of 215

Executing Reports with the API

Technical Guide

// a .net api object is a specific session; methods act on that session
WebReports.Api.Api netApi = new WebReports.Api.Api(appPath);
Report myReport = (Report)netApi.ReportObjectFactory.LoadFromRepository(reportPath);

2. Set the desired output type.
myReport.ExportType = wrExportType.Html;

3. Then save the report object back to the API.
netApi.ReportObjectFactory.SaveToApi(myReport);

4. Set the API action to execute.
netApi.Action = wrApiAction.ExecuteReport;

5. Finally, call GetUrlParamString to get the session URL.
// note: this terminates the session
string url = netApi.GetUrlParamString(homePage);

REST
When using the REST Web Service API, the initialization call creates a session ID string, a required URL parameter in all subsequent
method calls. Note that the session URL is generated immediately, and altered dynamically as modifications are made to the session.
To use REST, create the session and pass the session variables. Take note of the sessionId and UrlParamString.
POST /sessions
Payload:
{
"Page": homePage,
"ApiAction": "ExecuteReport",
"ExportType": "Html",
"ReportSettings":
{
"ReportPath": reportPath
}
}

Response (some params omitted):
{
"sid": sessionId,
"AppUrl": urlParamString
}

SOAP
When using the SOAP Web Service API, the initialization call creates a session ID string, which is a required parameter in all subsequent
method calls.
1. First create an API object and initialize an API session.
// a soap api object is not a specific session; it's an accessor for the methods
WebServiceApi.Api soapApi = new WebServiceApi.Api();
// initialize a session and save the id to memory
string sessionId = soapApi.InitializeApi();

2. Set the active report.
// all methods require the session id parameter
soapApi.ReportObject_Activate(sessionId, reportPath);

3. Set the API action to execute.
soapApi.SetAction(sessionId, (int)wrApiAction.ExecuteReport, null);

4. Finally, call GetUrlParamString to get the session URL.
string url = soapApi.GetUrlParamString(sessionId);

GetExecute
There are four provided GetExecute methods. Each return a different data representation of the report. Not every API supports every data
type; see the Overview for details.
GetExecuteHtml: Typically used for web viewing
GetExecuteCsv: Plain-text format readable by spreadsheet applications
GetExecuteData: Byte array of binary data
GetExecuteJson (v2016.3+): Typically used for asynchronous client-server communication
Since GetExecute does not require loading the Exago UI, calling GetUrlParamString is not required. Report interactivity is also not
supported when executing reports via the GetExecute functions. However, the following Server Events are triggered by GetExecute in order
to ensure that the data returned accurately reflects the report design:
OnReportExecuteStart
OnReportExecuteEnd
OnAfterReportExportSuccess
See the following sections for examples. Variable names and arguments are placeholders.

.NET
1. First create an API session and load a report object.
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// a .net api object is a specific session; methods act on that session
WebReports.Api.Api netApi = new WebReports.Api.Api(appPath);
Report myReport = (Report)netApi.ReportObjectFactory.LoadFromRepository(reportPath);

2. Then call the appropriate GetExecute method for the desired data type.
string reportHtml = myReport.GetExecuteHtml();

REST
When using the REST API, the initialization call creates a session ID string, which is a required URL parameter in all subsequent method
calls. Note that the session URL is generated immediately, and altered dynamically as modifications are made to the session.
1. First create an API session. Take note of the session ID.
POST /sessions
Response (some params omitted):
{
"Id": sessionId
}

2. Then execute the selected report. Supported types are HTML, CSV, PDF, RTF, Excel, JSON.
POST /reports/execute/{type}?sid="sid"
Payload:
{
"ReportPath": reportPath
}

Response (some params omitted):
{
"ExecuteData": rawReportData
}

SOAP
When using the SOAP API, the initialization call creates a session ID string, which is a required parameter in all subsequent method calls.
1. First create an API object and initialize an API session.
// a soap api object is not a specific session; it's an accessor for the methods
WebServiceApi.Api soapApi = new WebServiceApi.Api();
// initialize a session and save the id to memory
string sessionId = soapApi.InitializeApi();

2. Set the active report.
// all methods require the session id parameter
soapApi.ReportObject_Activate(sessionId, reportPath);

3. Then call the appropriate Report_GetExecute method for the desired data type. Supported methods are Report_GetExecuteHtml
and Report_GetExecuteData.
string reportHtml = soapApi.Report_GetExecuteHtml(sessionId);

REST — GetExecute
GetExecute allows you to execute reports in the API, without opening an instance of Exago. If executing as text, i.e. HTML, CSV, or
JSON, then the output data is returned directly in the ExecuteData property. If executing as binary, i.e. PDF, RTF, or EXCEL, then
ExecuteData returns a URL string in the following format:
ExecuteExport.aspx?{parameters}

To download the output data, append the URL to the end of your Exago base URL and launch the full URL string in a browser:
http://{yoursite}/{exago}/{ExecuteExportUrl}

The string is one-use only. To re-download the file, you must create a new Export Url.
Note
All requests require Session Id URL parameter and basic request headers. In the following examples, headers are omitted for clarity.
Since GetExecute does not load the Exago UI, report interactivity is not supported for these functions. However, the following Server
Events are triggered by GetExecute in order to ensure that the data returned accurately reflects the report design:
OnReportExecuteStart
OnReportExecuteEnd
OnAfterReportExportSuccess

Report JSON
The path to the report is passed as part of a JSON object, with optional sorts and filters. Any sorts and filters are added only for this
execution, and do not persist throughout the session.
Name

Type

Writeable

Description

ReportPath

string

required

Full path from the root folder to the report

Sorts

array of Sort

yes

Any sorts to apply to the report during execution

Filters

array of Filter

yes

Any filters to apply to the report during execution
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Execute a Report
POST /reports/execute/{Type}

Type indicates which format you want to receive the output data: html, csv, pdf, rtf, excel, json.

Using curl
curl http://{webservice}/rest/reports/execute/csv?sid={sid} -X POST ^
-d "{'ReportPath':'Inventory\\Products'}"

Note
Windows file paths are delimited with double-backslashes: \\.

Output JSON
GetExecute returns the following JSON object:
Name

Type

Description

ReportPath

string

Full path from the root folder to this report

ExportType

string

Format of export data

DataType

string

"Data" for text-based formats; "Url" for binary formats

ExecuteData

string

For text-based formats, the report output data; For binary formats, the
Execute URL to download the data

IsError

boolean

Whether there were any errors when executing this report

ErrorList

array of string If IsError = true, a list of errors encountered when executing this report

Example response
Status: 200 OK
{
"ReportPath":
"ExportType":
"DataType":
"ExecuteData":
"IsError":
"ErrorList":

"Inventory\\Categories",
"csv",
"Data",
"\"Categories\"\r\n\"Beverages\"\r\n\"Condiments\"\r\n\"Confections\"\r\n\"Dairy Products\"\r\n\"Grains/Cereals\"\r\n\"Meat/Poultry\"\r\n\"Produce\"\r\n\"Seafood\"\r
false,
null

}

Sort JSON
Each run-time sort is supplied using the following JSON object:
Name

Type

Writeable

Description

EntityName

string

required

Data object to sort on

ColumnName

string

required

Column to sort on

AscendingFlag

boolean

yes (false)

Whether to sort in ascending (versus
descending) order

Filter JSON
Each run-time filter is supplied using the following JSON object:
Name

Type

Writeable

Description
The value of the filter, either a Category name or a
formula. For example:

FilterText

string

required

DataType

enum

yes ("string")

Operator

enum as
yes (0)
integer

Filter Operator Type (only accepts integer
value)

Values

array of
string

yes

Values to filter with

EntityName

string

deprecated (as
of v2018.1)

Data object to filter on

string

deprecated (as
of v2018.1)

Column to filter on

ColumnName

Employees.EmployeeName
=Month(Employees.BirthDate)
Data Field Type

Note
DateTime strings passed as filter values must be able to be parsed by the .NET method DateTime.Parse using the current thread
culture.

Execute with Sorts and Filters
POST /rest/reports/execute/{Type}

Type indicates the format you want to receive the output data, html, csv, pdf, rtf, excel, json.

199 of 215

JavaScript API

Technical Guide

Using curl
curl http://{webservice}/rest/reports/execute/csv?sid={sid} -X POST ^
-d @reportExecuteResource.txt

reportExecuteResource.txt
"{
'ReportPath': 'Inventory\\Categories',
'Sorts': [
{
'EntityName': 'Categories',
'ColumnName': 'CategoryName',
'AscendingFlag': false
}
],
'Filters': [
{
'FilterText': 'Category.CategoryName'
'DataType': 'string',
'Operator': 14,
'Values': [
'Beverages',
'Produce',
'Seafood'
],
}
]
}"

Example response
Status: 200 OK
{
"ReportPath":
"ExportType":
"DataType":
"ExecuteData":
"IsError":
"ErrorList":

"Inventory\Categories",
"csv",
"Data",
"\"Categories\"\r\n\"Seafood\"\r\n\"Produce\"\r\n\"Beverages\"\r\n",
false,
null

}

JavaScript API
The Exago JavaScript (JS) API allows Exago functionality to be embedded directly into HTML <div> containers.
<div>s can inherit code and styles from the host application. Since CSS cascades down to Exago as well as up to the parent app, a
single base of styles can be used, rather than separate ones for the host app and for Exago. The Exago DOM is accessible from the host
application, so custom scripting is possible without being limited to Action Events.

Background
The JS API implements asynchronous calls to Exago functionality in the client browser. Besides the advantages of being able to embed in
<div>s and interact programmatically, the API also allows for multiple calls without needing to generate a new session for each one. As
sessions are created only once per page load, this can increase the feeling of responsiveness in the host application.
As the JS API runs on the client-side, it is not standalone. Session objects are still required to be generated, either with the .NET or REST
Web Service APIs. Session objects must include any relevant user permissions and configuration settings.
A parameter called the ApiKey encodes the session object in a string, which is passed from the server-side API to the JS API. The JS
API then initializes a JS API object, which is analogous to an Exago user session.
Note
JS API objects are static and single-use. They cannot persist between page loads, and multiple JS API objects cannot be active on the
same page.
The JS API object provides a set of functions that are used to implement elements of Exago functionality.
Note
API Actions and active reports should not be set when using the JS API as doing so may produce errors within the API session. Any
desired actions, such as executing a report or editing a report on the page, should be done using the appropriate JavaScript API
functions instead.

Setup and Configuration
These steps describe how to configure the environment to use the JS API, as well as how to implement it in an application.
1. Create the Session
2. Instantiate the JS API object

1. Create the Session
1. First, use the .NET API or REST Web Service API to set up security and permissions for the session. Make all configuration
changes there, as these settings cannot be changed once the JS API object is loaded.
Set the WebAppBaseUrl property to the virtual directory where Exago BI is installed:

.NET
api.SetupData.WebAppBaseUrl = "http://server/Exago/";

REST
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Do one of the following:
PATCH /Rest/Settings?sid={sid}, Payload:
{ "WebReportsBaseUrl" : "http://server/Exago" }

Add to the web service config file ({WebService}/Config/WebReportsApi.xml):
<webreportsbaseurl>http://server/Exago/</webreportsbaseurl>

In contrast to the .NET and REST Web Service APIs, the JavaScript API has no concept of an Active Report or an API Action.
Instead, the action and report are specified by calling the individual JS function calls.
Note
A side-effect of this is that per-session report changes cannot be made in memory, since the JS API function can only act on
saved reports. Changes will need to be saved to storage before execution.
2. Once the session is ready, get the ApiKey. This encodes the session settings to pass to the JS API. This API key will need to be
passed to the page as it will be used in client side JavaScript calls.

.NET
return api.GetApiKey();

REST
GET Rest/Sessions/{sid}, then get the ApiKey property from the response object:
{
...
"ApiKey": "encodedAlphanumericApiKey"
}

Note
This is not the UrlParamString / AppUrl.

2. JS API Object
1. Load the JS API library into the host web application via a <script> tag:
<script src="http://server/Exago/WrScriptResource.axd?s=ExagoApi"></script>

Note
WrScriptResource.axd is not a file on the file system, it is a virtual file that contains the necessary scripts to load the API.
"http://server/Exago" is the URL to the virtual path of your Exago web application.
2. Using the ApiKey, instantiate an ExagoApi JavaScript API object. There are two constructors available:

Constructor 1
var api = new ExagoApi(ExagoBaseURL, ApiKey, onLoadCallback, [showErrorDetail]);

ExagoBaseURL — URL to the installation of Exago BI
ApiKey — key generated when the session was created
onLoadCallback — function to execute once the JS API has been fully loaded and is ready for use
Optional: showErrorDetail — set to true to see more detailed application error messages. (Default: False).
Example
new ExagoApi("https://exago.example.com", "tCq0n6dMl6kQEbgofptKsdinMINJpqsClF5kVnzz2wcgcEfGjYE8eEeKjR3NBkjayZY%2fbs7RLTcpH9EtDyhRBA%3d%3d", () => {
console.log("Exago is ready for further API calls!");
}, true);

Constructor 2 v2019.1.22+ v2019.2.8+
This constructor contains an additional OnError() callback function. The definitions below are written using TypeScript syntax.
var api = new ExagoApi(options: wrExagoApiOptions);

This constructor takes one argument, an object of type wrExagoApiOptions. wrExagoApiOptions objects are defined by the
following interface:
interface wrExagoApiOptions {
WebEndpoint: string;
ApiKey: string;
OnLoad: () => void;
OnError?: (err: wrJsApiError) => void;
OnDisposeContainer?: (container: HTMLElement) => void;
ShowErrorDetail?: boolean;
}

WebEndPoint — URL to the installation of Exago BI
ApiKey — key generated when the session was created
OnLoad() — function to execute once the JS API has been fully loaded and is ready for use
OnError() — optional: function to execute if the loading of the JS API fails. Takes one argument, an object of type
wrJsApiError which simply represents an error message if loading of the API fails. A wrJsApiError object is defined by the
following interface:
interface wrJsApiError {
Message: string;
}
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OnDisposeContainer — optional: function to execute when the <div> containing Exago is no longer needed and can be
disposed. Takes one argument of type HTMLElement object, the ID of the containing <div>. This is the recommended way
of passing this function to the ExagoApi object. For more information, see Disposing Containers below.
ShowErrorDetail — optional: true if full error messages should be displayed to the end user in the browser, false if they
should be saved to the log only
OnError()
The OnError() callback function will be called under the following conditions:
Any HTTP 4xx or 5xx status code is returned from any XHR or fetch request involved with initialization
There are several use cases for the OnError() callback function, such as (but not limited to):
An expired ApiKey is passed
An incorrect WebEndPoint is passed
In a cross-origin environment, cookieless sessions are not enabled
The Exago application server is down
Example
new ExagoApi({
WebEndpoint: "https://exago.example.com",
ApiKey: "tCq0n6dMl6kQEbgofptKsdinMINJpqsClF5kVnzz2wcgcEfGjYE8eEeKjR3NBkjayZY%2fbs7RLTcpH9EtDyhRBA%3d%3d",
ShowErrorDetail: true,
OnLoad: () => {
console.log("Exago is ready for further API calls!");
},
OnError: () => {
console.log("There was an error loading Exago");
},
});

Note
ApiKeys are single-use. Multiple instances are not supported nor necessary. Functions can be called against the object for the duration
of the session.

Functions
The following functions are available for loading and managing Exago functionality.
Note
Functions can only be used once the JS API is fully loaded. Wait for onLoadCallback() or OnLoad() to indicate that the API is
ready.
Caution
Due to a known issue, the callbacks mentioned in the following JavaScript API functions only work as described as of v2018.1.12+ or
v2018.2+.

LoadFullUI(container)
Load the full web application user interface in to a <div> container.
Argument
container

Description
<div> container to place the user interface
into

Note
The Full UI being loaded will block almost all other actions, so while the Full UI is displayed on screen, the host application cannot
perform any other Exago functions such as executing reports or creating new reports.

ExecuteReport(container, exportType, reportPath, [udfOrOptions],
[updateCallback], [errorCallback])
Execute a report or dashboard to a specific output type in a defined container.
container

Argument

Description
Div container to place the executed report into

exportType

html|pdf|csv|excel|rtf

reportPath

Relative path to report to execute
Example: "MyFolder\\MyReport"
Optional: Report UDF information for use within folder management or a Report Options object for
modifying reports before execution
Note

udfOrOptions v2019.1+

If the wrJsApiExecuteReportOptions object is passed to this parameter, the updateCallback and
errorCallback parameters will be ignored and ExecuteReport will change its behavior based upon
the contents of the object being passed. For more information, please see the Interfaces section
below and the JavaScript API: Filters and Parameters article.
Optional: Callback to execute when the execution status changes, called when the report execution is
starting and again when it is ready to be viewed
Parameter ‘container’: The same container HTMLElement that was passed in to the call
Parameter ‘updateType’: The type of update as a string, either

updateCallback (container,
updateType)

The parameter 'updateType' will assume one of these string values:
“executionstart”: The report has been loaded and is starting execution, or
“initialcontentload”: The execution viewer has been loaded and populated with at least the first
page of the report, if executing an Advanced Report or ExpressView to HTML)
Note: This callback will occur once for each status change unless errors occur.
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Optional: Callback to execute in the event an execution blocking error occurs

errorCallback (container,
errorMessage) => string

Parameter ‘container’: The same container HTMLElement that was passed in to the call
Parameter ‘errorMessage’: The error text
Return value: See errorCallback return values below.

ExecuteStaticReport(exportType, reportPath, udfOrOptions , successCallback,
[errorCallback])
Execute a report, and return its output to the successCallback function. Report is not interactive.
Note
This function is only compatible with Advanced Reports.
Argument

Description

exportType

html|pdf|csv|excel|rtf|json

reportPath

Relative path to report to execute
Example: "MyFolder\\MyReport"
Report UDF information for use within folder management or a Report Options object for modifying
reports before execution
Note

udfOrOptions v2019.1+

If the wrJsApiExecuteStaticReportOptions object is passed to this parameter, the
sucessCallback and errorCallback parameters will be ignored and ExecuteReport will change its
behavior based upon the contents of the object being passed. For more information, please see the
Interfaces section below and the JavaScript API: Filters and Parameters article.
Callback to execute when execution request returns
Parameter 'executionData': a string containing the executed report’s data is passed as a
parameter, whose formatting depends on the specified exportType. If the export type is “html”,
“csv”, or “json”, the returned string will contain all of the data in the corresponding format. If the
export type is “pdf”, “excel”, or “rtf”, the returned string will be partial URL to the file, e.g.
“ExecuteExport.aspx?eid=…”. See the below example for prefixing the returned partial URL with
the base address.

successCallback
(executionData)

Optional: Callback to execute in the event an error occurs.
errorCallback (errorMessage)

Parameter 'errorMessage': The error text.
Return value: See errorCallback return values below.

const container = ...
const exportType = ...
const reportPath = ...
api.ExecuteStaticReport(exportType, reportPath, null,
(executionData) =>
{
if (exportType == "excel" || exportType == "rtf" || exportType == "pdf")
container.innerHTML = "<iframe src="' + api.GetBaseAddress() + executionData + '"></ iframe>";
else
container.innerHTML = executionData;
},
(errorMessage) =>
{
container.innerHTML = errorMessage;
});

ScheduleReportWizard(container, reportPath, [udf], [errorCallback])
Open the schedule report wizard for a report.
Argument
container

Description
Div container to place the scheduled report wizard into

reportPath

Relative path to report to schedule
Example: "MyFolder\\MyReport"

udf

Optional: Report UDF information for use with folder management
Optional: Callback to execute in the event an error occurs, such as the
scheduler being disabled

errorCallback
(container,
errorMessage) => string

Parameter ‘container’: The same container HTMLElement that was
passed in to the call
Parameter ‘errorMessage’: The error text
Return value: see errorCallback return values below.

ScheduleReportManager(container, [errorCallback])
Open the schedule report manager.
Argument
container

Description
Div container to place the scheduled report manager into
Optional: Callback to execute in the event an error occurs, such as the scheduler being disabled

errorCallback (container,
errorMessage) => string

Parameter ‘container’: The same container HTMLElement that was passed in to the call
Parameter ‘errorMessage’: The error text
Return value: see errorCallback return values below.

LoadReportTree(successCallback, [errorCallback])
Load the report tree as JSON, returned to the successCallback method.
Argument
successCallback (reportTree)

Description
Callback to execute once the report tree has been loaded.
Parameter 'reportTree': A JSON object representing the report tree.
Optional: Callback to execute in the event an error occurs
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Optional: Callback to execute in the event an error occurs

errorCallback (errorMessage)

Parameter ‘errorMessage’: The error text

EditReport(container, reportPath, [udf], [errorCallback])
Load the report designer for a report.
container

Argument

Description
Div container to place the report designer into

reportPath

Relative path to report to edit
Example: "MyFolder\\MyReport"

udf

Optional: Report UDF information for use with folder management
Optional: Callback to execute if the report fails to load
Parameter ‘container’: The same container HTMLElement that was passed in to the
call
Parameter ‘errorMessage’: The error text

errorCallback (container,
errorMessage) => string

Return value: see errorCallback return values below.

NewReport(container, reportType)
Load the report designer for a new report.
Argument
container

Description
Div container to place the report designer into

reportType

advanced|express|dashboard|chained|expressview

DisposeContainerContent(container)
Disposes the contents of a container and resets the system state to be aware of what containers are open.
Argument
Description
container Div container to dispose

DisposePage()
Disposes the contents of a page, removing any event listeners added to the page and performing other cleanup necessary for complete
removal of the ExagoAPI instance. After calling DisposePage(), the ExagoAPI instance should be considered "closed." Any new Exago
JavaScript API calls must be performed on a new ExagoAPI instance.

IsAllowedReportType(reportType)
Returns whether or not a specified report type is allowed for the session.
Tip
CrossTab Reports are a type of Advanced Reports.
Argument
reportType

Description
advanced|express|dashboard|chained|expressview

GetAllowedReportTypes()
Returns an array of the report types allowed for this session.

Example:
function RunReportJS() {
var container = document.getElementById("ExagoDiv");
api.ExecuteReport(container, "html", "Examples\\ClientReport");
}

Note
Container divs must be empty or disposed before loading. Additionally, you should specify size and position constraints for each div.

div#ExagoDiv {
width: 1200px;
height: 600px;
position: relative;
}

Disposing Containers
It is important to properly dispose of containers when they are finished being used by explicitly calling the
DisposeContainerContent(container) method.
Optionally, an OnDisposeContainer callback can be defined that will execute when a container has been disposed either implicitly or
explicitly. This allows the host application to safely reset the container to whatever state necessary, or remove the container from the page
entirely. When a user encounters an error that prevents the requested action, e.g., ExecuteReport(...), the container will auto-dispose and
execute the OnDisposeContainer callback if one is defined.
Example:
api.OnDisposeContainer = function(container) {
container.parentElement.removeChild(container);
};

Disposing Pages v2018.2+
Once an ExagoAPI instance has been instantiated, DisposePage() must be called before instantiating subsequent ExagoAPI instances.
DisposePage() will dispose the contents of an entire page, thereby disposing each instantiated container. Furthermore, it will remove any
event listeners added to the page by the ExagoApi instance and perform other cleanup necessary for complete removal of the ExagoAPI
instance.
After calling DisposePage(), the ExagoAPI instance should be considered "closed." Any new Exago JavaScript API calls must be
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performed on a new ExagoAPI instance.

errorCallback return value
Whenever an error occurs that prevents the JS API action from updating a container (such as an undefined report name in a call of
ExecuteReport), the following will happen:
If errorCallback is not defined, an alert dialog will appear with the error message (or a placeholder error message, if the URL
parameter 'showerrordetail' is set to false).
If errorCallback is defined, it will first be called. If errorCallback returns a string (either the original error message or a custom
message), an alert dialog will appear with the given string, or a placeholder error message if the URL parameter 'showerrordetail' is
set to false.
If errorCallback does not return a string, or the string is empty, no alert dialog will be shown and the DisposeContainerContent()
method will run immediately.
Clicking on the error dialog’s dismiss button will close the dialog and call DisposeContainerContent(). The container’s content will be
closed, the inner HTML will be cleared, and the OnDisposeContainer callback will be called.

Interfaces
As of v2019.1+, the following interfaces are available for managing and modifying report settings at runtime.

wrJsApiExecuteReportOptions
Allows information for the modification of filters and parameters of a report to be passed to the udfOrOptions parameter of the
ExecuteReport function. If this interface is passed to ExecuteReport the updateCallback and errorCallback parameters of this function
will be ignored; however, they may be specified within this interface if necessary.
Note
All properties in the wrJsApiExecuteReportOptions object are optional.
Property

Description

Udf

The UDF information used to load the report if required

UpdateCallback
(container, updateType)
=> void

Callback to execute when there has been an update in the status of the
report execution

ErrorCallback (container, Callback to execute in the event an error occurs
errorMessage) => string
NewFilters

An array of wrJsApiExecuteReportFilter objects defining the new filters
to add to the report before execution begins
An array of prompting filter values to modify before execution begins

PromptingFilterValues

When executing an Advanced Report, an array of
wrJsApiPromptingFilterValue objects should be passed
When executing a Dashboard or Chained Report, an array of
wrJsApiCompositePromptingFilterValue objects should be
passed
Note: It is assumed that the value provided by the given item will be the
final value for the filter before the report executes. As such, any filter with a
value modified by an item in this array will not prompt the user upon
execution.

Parameters

A list of wrJsApiExecuteReportParameter objects defining the nonhidden parameters to add or modify before execution begins

wrJsApiExecuteStaticReportOptions
Allows information for the modification of filters and parameters of a non-interactive report to be passed to the udfOrOptions parameter of
the ExecuteStaticReport function. If this interface is passed to ExecuteStaticReport the successCallback and errorCallback
parameters of this function will be ignored; however, they may be specified within this interface if necessary.
Note
All parameters in the wrJsApiExecuteStaticReportOptions object are optional.
Parameter

Description

Udf

The UDF information used to load the report if required

SuccessCallback
(execution) => void

Callback to execute when the report execution succeeds

ErrorCallback
Callback to execute in the event an error occurs
(errorMessage) => string
NewFilters

An array of wrJsApiExecuteReportFilter objects defining the new filters
to add to the report before execution begins
An array of prompting filter values to modify before execution begins

PromptingFilterValues

When executing an Advanced Report, an array of
wrJsApiPromptingFilterValue objects should be passed
When executing a Dashboard or Chained Report, an array of
wrJsApiCompositePromptingFilterValue objects should be
passed
Note: It is assumed that the value provided by the given item will be the
final value for the filter before the report executes. As such, any filter with a
value modified by an item in this array will not prompt the user upon
execution.

Parameters

A list of wrJsApiExecuteReportParameter objects defining the nonhidden parameters to modify before execution begins

wrJsApiExecuteReportFilter
Defines the necessary information for a new filter. To be passed to wrJsApiExecuteReportOptions in order to add new filters to a report
prior to execution.
Property

Description
The filter string (e.g., "Employees.FirstName" or
"=MonthName({Employees.BirthDate})")
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Note: This must take the form of a data field, formula, or parameter.
The condition used to match the data values to the specified filter value or
values
type wrJsApiFilterOperator =

Operator

"EqualTo" (Default)
"NotEqualTo"
"LessThan"
"LessThanOrEqualTo"
"GreaterThan"
"GreaterThanOrEqualTo"
"StartsWith"
"NotStartsWith"
"EndsWith"
"NotEndsWith"
"Contains"
"NotContains"
"Between"
"NotBetwen"
"OneOf"
"NotOneOf"
Select whether or not to prompt the user for a value upon report execution

PromptFlag

AndFlag

Defaults to False
Set to True to insert an AND condition after this filter, set to False to insert
an OR condition after this filter
Defaults to True
Select whether or not to group this filter with the filter following it

GroupWithNextFlag

Defaults to False
The values to add to the filter

Values

Note: Can be a string, number, or date, or an array of any of these types if
multiple values are required (e.g., for "Between" and "OneOf" filters).
Note: All date values must be passed as JavaScript Date objects (e.g., var
date = new Date('December 17, 1995 03:24:00');.
The name of the filter

Title

Defaults to an empty string ("")

wrJsApiPromptingFilterValue
Defines the necessary information to pass a value to a prompting filter for Advanced Reports. To be passed to
wrJsApiExecuteReportOptions in order to set prompting filter values of a report prior to execution.
Property

Description

FilterText

The filter text used to identify which filter to modify

Index

Optional: In the case of multiple filters having the same FilterText, the
index into the matching group of filters
Defaults to 0 (zero)
Optional: Reassign the condition used to match the data values to the
specified filter value or values
type wrJsApiFilterOperator =

Operator

"EqualTo"
"NotEqualTo"
"LessThan"
"LessThanOrEqualTo"
"GreaterThan"
"GreaterThanOrEqualTo"
"StartsWith"
"NotStartsWith"
"EndsWith"
"NotEndsWith"
"Contains"
"NotContains"
"Between"
"NotBetwen"
"OneOf"
"NotOneOf"
The values to add to the filter

Values

Note: Can be a string, number, or date, or an array of any of these types if
multiple values are required (e.g., for "Between" and "OneOf" filters).
Note: All date values must be passed as JavaScript Date objects (e.g., var
date = new Date('December 17, 1995 03:24:00');.

wrJsApiCompositePromptingFilterValue
Defines the necessary information to pass a value to a prompting filter for Dashboards and Chained Reports, also known as "composite
reports". To be passed to wrJsApiExecuteReportOptions in order to set prompting filter values of a report prior to execution.
Property

Description

Index

The index of the filter as it appears in the prompting UI, beginning at 0
(zero) and increasing by 1 for each following filter
Optional: Reassign the condition used to match the data values to the
specified filter value or values
type wrJsApiFilterOperator =
"EqualTo"
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"NotEqualTo"
"LessThan"
"LessThanOrEqualTo"
"GreaterThan"
"GreaterThanOrEqualTo"
"StartsWith"
"NotStartsWith"
"EndsWith"
"NotEndsWith"
"Contains"
"NotContains"
"Between"
"NotBetwen"
"OneOf"
"NotOneOf"
The values to add to the filter
Note: Can be a string, number, or date, or an array of any of these types if
multiple values are required (e.g., for "Between" and "OneOf" filters).
Note: All date values must be passed as JavaScript Date objects (e.g., var
date = new Date('December 17, 1995 03:24:00');.

wrJsApiExecuteReportParameter
Defines the necessary information to add or modify non-hidden parameters. To be passed to wrJsApiExecuteReportOptions in order to
add or set parameter values of a report prior to execution.
Property

Description
The name of the non-hidden parameter to modify

Name
Note: This value must not contain the '@' symbol.
The value to give to the parameter
Value

Note: Can be a string, number, or date depending on the parameter's
datatype.
The text that will display when prompting the user for a value

PromptText

Note: If this field is set to a null value, the parameter will be considered
non-prompting.

JavaScript API: Filters and Parameters
As of v2019.1, runtime filters and parameters can now be modified via the JavaScript API prior to a report's execution. New behaviors have
been defined for the for ExecuteReport function in order to allow the addition of new filters, the modification of existing filters, and the
addition or modification of parameters. These modifications only apply at runtime and do not alter report definitions.
Important
Review the JavaScript API article for in depth descriptions of the Functions and Interfaces utilized by these features.
For the code snippets in the following sections, please assume the following framework:
function executeReport() {
var reportPath = document.getElementById('exagoReport').value;
var exportSelector = document.getElementById('execSelection');
var exportType = exportSelector.value;
var containerId = document.getElementById('containerSelection').value;
var container = document.getElementById('container' + containerId);
/**

Adding a New Filter
Modifying an Existing Prompting Filter
Adding Parameters and Modifying Parameter Values
**/
var reportOptions =
{
Udf: null,
UpdateCallback: updateCallback,
ErrorCallback: errorCallback,
//For adding new filters to a report
NewFilters: filters,
//For modifying prompting filters in Advanced Reports
PromptingFilterValues: promptingFilters,
//For modifying prompting filters Dashboards and Chained Reports
//PromptingFilterValues: promptingCompositeFilters,
//For adding or modifying the non-hidden parameters of a report
Parameters: parameters
};
api.ExecuteReport(container, exportType, reportPath, reportOptions);
}

Adding a New Filter
To add runtime filters to a report via the JavaScript API:
1.
2.
3.
4.

Define the report filter objects by specifying their FilterText, Operator, Values, and other necessary information.
Add these definitions to an array of report filters.
Reference this array in the NewFilters property of the report options interface.
Call ExecuteReport referencing the report options parameter.

For a full list of properties and a description of this feature, please see the wrJsApiExecuteReportFilter section of the JavaScript API
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article.
Please consider the following when adding a new filter via the JavaScript API:
FilterText may not be null
FilterText must take one of the following forms:
a data field (Employees.LastName)
a function (=Month({Employee.BirthDate}))
a parameter (@parameterName@)
If the Operator type is OneOf or NotOneOf, then Values must be an array. If the type is Between or NotBetween, then the
array may only be a length of two.
Filter functions, like DayAfterTomorrow(), may not be used as a value.
Note
Currently, runtime filters may not be added to Dashboards or Chained Reports via the JavaScript API.

Example
The following code sample creates two runtime filters on the Employees data category.
var filters = [];
var filter =
{
FilterText: "Employees.EmployeeID",
Operator: "Between",
PromptFlag: true,
AndFlag: true,
GroupWithNextFlag: false,
Values: [2, 5],
Title: "Employee Id"
};
filters.push(filter);
filter =
{
FilterText: "=Year({Employee.HireDate})",
Operator: "GreaterThanEqualTo",
PromptFlag: false,
AndFlag: true,
GroupWithNextFlag: false,
Values: 2010,
Title: "Employee Hire Date"
};
filters.push(filter);

Modifying an Existing Prompting Filter
To modify and set the values for existing prompting filters on a report via the JavaScript API:
1.
2.
3.
4.

Define the prompting filter objects by specifying their FilterText, Index, and Values.
Add these definitions to a designated array of prompting filters.
Reference this array in the PromptingFilterValues property of the report options interface.
Call ExecuteReport referencing the report options parameter.

Note
Only prompting filters may be modified prior to report execution. Non-prompting filters cannot currently be modified via the JavaScript API.
For a full list of properties and a description of this feature, please see the wrJsApiPromptingFilterValue and
wrJsApiCompositePromptingFilterValue sections of the JavaScript API article.
Note
Any prompting filter with a value set via the JavaScript API will be treated as non-prompting and will not appear in the prompting Filters
menu upon report execution.

Examples
The following sections detail how to modify prompting filters on Advanced Reports and non-interactive filters on Dashboards and
Chained Reports:

Modifying Prompting Filters on an Advanced Report
For the following example, assume that the following existing prompting filters on an Advanced Report:
Employees.LastName Starts With 'D' AND
Employees.ID Is Between '2' And '5' AND
Employees.LastName Is Not Equal To 'Dodsworth'

These filters are ordered as they appear in the Filters menu in the Advanced Report designer. FilterText values are treated as the
primary identifier of each filter. The Index value serves as a secondary identifier, increasing its value at each instance of identical
FilterText. The following list details filter indexing for Advanced Reports:
Employees.LastName [Index: 0]
Employees.ID
[Index: 0]
Employees.LastName [Index: 1]
/** Continuing the example: ************************/
=MonthName({Employees.BirthDate}) [Index: 0]
Employees.ID
[Index: 1]
Employees.BirthDate [Index: 0]
Employees.LastName [Index: 2]
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Note
If the Index value is left null, the value of 0 (zero) will be passed by default.
The following code modifies and sets the values for two existing prompting parameters on a report prior to its execution. It sets the value of
"Davolio" to the second instance of the Employees.LastName filter and modifies the Operator of the first instance of the
Employees.EmployeeID filter.
var promptingFilters = [];
var promptingFilter =
{
FilterText: "Employees.LastName",
Index: 1,
Values: "Davolio"
};
promptingFilters.push(promptingFilter);
promptingFilter =
{
FilterText: "Employees.EmployeeID",
Index: 0,
Values: [2, 5],
Operator: "NotBetween"
};
promptingFilters.push(promptingFilter);

Modifying Prompting Filters on a Dashboard or Chained Report
For the following example, assume the following existing prompting filters on the Dashboard or Chained Report:
=Year({Employees.HireDate}) = '1996' AND
Employees.FirstName Is Not Equal To 'Janet' AND
Employees.Title = 'Sales Representative'

These filters are ordered as they appear in the Filters menu on the composite report. However, within composite reports, Index values are
the primary identifiers of each filter and are set on a global scale. The Index value increases for each new filter on a composite report. The
following list details filter indexing for composite reports:
=Year({Employees.HireDate}) [Index: 0]
Employees.FirstName
[Index: 1]
Employees.Title
[Index: 2]
/** Continuing the example
Employees.ID
Employees.BirthDate
Employees.FirstName

************************/
[Index: 3]
[Index: 4]
[Index: 5]

Note
Index values for composite reports do not default to 0 (zero) and are a required field for each prompting filter.
The following code modifies and sets the values for three existing prompting parameters on a composite report prior to its execution.
var promptingCompositeFilters = [];
var promptingCompositeFilter =
{
Index: 0,
Values: [1996, 2005],
Operator: "Between"
};
promptingCompositeFilters.push(promptingCompositeFilter);
promptingCompositeFilter =
{
Index: 1,
Values: ["Nancy"],
};
promptingCompositeFilters.push(promptingCompositeFilter);
promptingCompositeFilter =
{
Index: 2,
Values: "Sales Manager"
};
promptingCompositeFilters.push(promptingCompositeFilter);

Adding Parameters and Modifying Parameter Values
New parameters may be added to a report and existing non-hidden parameter values may be modified prior to report execution via the
JavaScript API. For a full list of properties and a description of this feature, please see the wrJsApiExecuteReportParameter section of
the JavaScript API article.
To add a new parameter to a report:
The Name value must be unique and cannot be identical to the names assigned to existing non-hidden parameters or to reserved
parameters. If the Name value is identical to an already existing non-hidden parameter, then this parameter's value will be
overwritten.
The Value being assigned to the new parameter must be a number, string, or date. It may not be an array of multiple values.
The PromptText value set represents the text that will display when prompting the user for a value. If PromptText is set to a null
or empty string value, the parameter will be set to non-prompting. Otherwise, the parameter will prompt the user for input upon
report execution.
Note
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For more information on parameters and a list of reserved parameters please see the Parameters article.
To modify the value of an existing non-hidden parameter:
The Name value must be identical to an existing non-hidden parameter on the report.
The Value being assigned to the parameter must be a number, string, or date, and must match the existing parameter's datatype.
It may not be an array of multiple values.
The PrompText value set represents the text that will display when prompting the user for a value. If PromptText is set to a null
or empty string value, the parameter will be set to non-prompting. Otherwise, the parameter will prompt the user for input upon
report execution.
Note
Modifying parameters via the JavaScript API will overwrite existing parameters at the application/system level for that specific report
execution. For example, if an existing prompting parameter is modified to be non-prompting, it is equivalent to setting this parameter to
be non-prompting within the Admin Console.

Example
The following code will add two parameters. In this example, the first parameter, @FirstName@, will prompt the user with the specified
prompting text, while the second parameter, @Id@, will be non-prompting.
var parameters = [];
var parameter =
{
Name: "FirstName",
Value: "Anne",
PromptText: "Enter your first name"
};
parameters.push(parameter);
parameter =
{
Name: "Id",
Value: 9,
PromptText: ""
};
parameters.push(parameter);

JavaScript API: Proxy Incoming Requests
Note
As of v2018.1, this is no longer necessary. Use Cookieless Sessions instead.
It can be tricky to serve content from different domains as part of the same web page. To protect against malicious scripts, web browsers
enforce a same-origin policy whereby scripts have permission to access only data from the same origin (domain and port number).
Websites that violate the same-origin policy are said to be engaging in cross-site scripting (XSS). Such websites will not function properly
in modern web browsers.
A common integration of Exago BI into a host application is to separate the installation of Exago onto its own web server. API calls
between the host app and Exago are communicated via a web service.
When embedding Exago content into a host web page, iFrames work around the same-origin policy because the iFrame barrier effectively
isolates the embedded page from the surrounding content. No scripts can cross the barrier in either direction.
However, when using the Exago JavaScript API to embed content directly in the host DOM, browsers will complain if the embedded
content is thought to be coming from a different domain than the host. One way to work around this restriction is to use the host web
server as a proxy server. The host can be configured as the entry point for requests to Exago, which it then redirects to the Exago server.
This is known as a reverse proxy.
This setup can have some security advantages—all external calls are routed through the host server, thus preventing potential attackers
from being able to access the Exago server directly. Exago can be hidden behind a firewall and requests filtered based on their content.
The following sections explain how you might set up this configuration.

Configure the Host Server
The host server application should be configured as follows:

IIS
First ensure that the Application Request Routing extension is installed.

Enable Proxy
1. In IIS select the web server then open Application Request Routing Cache.
2. Click Server Proxy Settings
3. Select Enable proxy then click Apply.

Set up URL Rewrite
1. In IIS select the Default Web Site then open URL Rewrite.
2. For both the web application and web service do the following:
a. Click Add Rule(s)
b. Select Reverse Proxy then click OK.
c. Enter the Exago BI server / web service address in the Inbound Rule field.
d. Enter the Exago BI server / web service address in the Outbound Rule - From: field.
e. Enter the host application address in the Outbound Rule - To: field.
f. Click OK.
See Setup IIS with URL Rewrite as a reverse proxy for real world apps (MSDN) for more information.

Apache
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Add the following lines to httpd.conf
LoadModule proxy_module
LoadModule proxy_ajp_module
LoadModule proxy_http_module
ProxyPass /{EXAGO}
ProxyPass /{EXAGO_WEBSERVICE}

modules/mod_proxy.so
modules/mod_proxy_ajp.so
modules/mod_proxy_http.so
http://localhost/{EXAGO}
http://localhost/{EXAGO_WEBSERVICE}

See Running a Reverse Proxy with Apache for more information.

Configure Exago BI
Exago BI should be configured as follows:
Add the following to the web service configuration file - Config\WebReportsApi.xml:
<webreportsbaseurl>http:\\{HOST_APP_ADDRESS}\{EXAGO_PATH}\</webreportsbaseurl>

Finally, make sure that any references in the host application to Exago BI (web application or web service) use the proxy URL.

JavaScript API: Report and Dashboard Execution Timing
As of v2019.1.3+, Exago BI exposes a JavaScript API that may be invoked in the browser to execute reports and dashboards and retrieve
information about how long they take to run. This makes it easier to do benchmarking, especially for dashboard executions where a test
would need to wait until the last tile is finished loading.
Note
All report types and execution formats are supported in this API.
wrWebReportsCtrl.ExecuteReport now returns a Promise that resolves with the class that controls the given execution (one of
wrChainedExecuteClass, wrDashboardDesignCtrl, wrExecuteClass, wrExpressViewDesignCtrl). Each of these classes
exposes the Timing property, which is a Promise that resolves when execution timing information has finished being collected for the
given execution.
const executor = await wrWebReportsCtrl.ExecuteReport("Reports\\Report", "html");
await executor.Timing; // Evaluates to { load: 5243 }

The Timing property resolves with an object describing timing information about the report or dashboard execution:
{
load: 5243
}

Returns the time (in milliseconds) it took for the report or last dashboard tile to finish loading.

Cross-Origin Embedding of Exago
Cross-Origin Resource Sharing (CORS)
Important
When using cookies, Exago must be accessed via HTTPS in a CORS environment for versions prior to v2019.1.23, v2019.2.9 .
If the Exago BI application is being accessed over a network, the Exago web server must be configured to allow cross-origin requests to
the client host application.
By default, a web application making a request for content that originates from a remote server sends a cross-origin HTTP request. For
security reasons, browsers restrict these types of requests when they originate from scripts.
See Cross-Origin Resource Sharing (CORS) - HTTP | MDN (Mozilla) for additional information on this topic.
Important
When using the JavaScript API with versions prior to v2019.1.23, v2019.2.9 in a CORS environment, cookieless sessions must be
enabled.
To permit content to be accessed by whitelisted resources, you can configure the Exago web server to send a Access-Control-AllowOrigin, Access-Control-Allow-Headers and Access-Control-Allow-Credentials headers.
Access-Control-Allow-Origin should be set to a single domain that matches the domain of the page in which Exago is embedded. For
example:
Access-Control-Allow-Origin: "hostapp.server.com"
Access-Control-Allow-Headers: "*"
Access-Control-Allow-Credentials: "True"

In IIS, this is either set in the HTTP Response Headers or added manually to the web.config file.
In Apache, the following lines should be added to all relevant .conf files:
Header set Access-Control-Allow-Origin "hostapp.server.com"
Header set Access-Control-Allow-Headers "*"
Header set Access-Control-Allow-Credentials: "True"

In NGINX, the following line should be added inside the location /Exago/ {...} section of the "exago" NGINX site configuration file:
add_header "Access-Control-Allow-Origin' 'hostapp.server.com';
add_header 'Access-Control-Allow-Headers' '*';
add_header Access-Control-Allow-Credentials: "True"

Cookieless Sessions
When a user enters Exago BI, the application creates a session in order to preserve the user's working state and environment while they
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engage in application tasks. The session information is stored on the web application server or state server (depending on the network
configuration). Whenever requests are made, the user's browser sends a unique, randomly generated ID to the web server in order to
authenticate the user and preserve the connection between user and session.
By default, and in versions of Exago BI prior to v2018.1, the session ID is stored as a browser cookie. However, when embedding using the
JavaScript API in a cross-origin environment (where the Exago BI application and host application are on separate servers with different
domains), cookies are considered a potential attack vector for cross-site scripting (see IBM: Prevent a cross-site scripting attack for
more information). Therefore, most modern web browsers prevent embedded content from separate origins from using cookies.
Important
As of Exago v2019.1.23+, v2019.2.9+ the use of cookieless sessions is not recommended when Exago is hosted over a secure
connection (HTTPS).

Enable Cookieless Sessions
Note
This article references <WebApp>\as a placeholder for the application's install location. The default install locations are /opt/Exago/
on Linux and C:\Program Files\Exago\ExagoWeb\ on Windows; however, these directories may be changed during installation.
To enable cookieless sessions, locate the following line in the <WebApp>\web.config file and set the cookieless attribute to true:
<sessionState mode="InProc" cookieless="true" timeout="20" />

Cookieless sessions work to preserve state by appending the session ID to the URL string itself, which is used to connect to the web
server. For example, a standard application URL generated by the server API after creating a session looks similar to the following:
//ExagoBI/ExagoHome.aspx?sn=0

With cookieless sessions enabled, the session ID is added to the URL, for example:
//ExagoBI/(S(rim43x0e3cz2hf4sjw24ezdk))/ExagoHome.aspx?sn=0

This has no direct implications for the embedding process into the host application.
Important
In Linux environments, a patched System.Web.dll Mono library is necessary when using cookieless sessions. This patched DLL is
installed when the Exago Linux Installer is executed, or it can be installed using our patch script. Exago only supports specific versions
of Mono, review Installing Exago on Linux for details.

Secured Authentication
When the web application server is exposed to the internet or any insecure public network or intranet, you need to enable secured
authentication to prevent unauthorized access.
Because the session ID is passed as a part of the URL, it can be used by malicious third parties to send unauthorized requests to the web
server. Secured authentication causes the web server to require a secondary security token in order to authenticate the session. This does
not require any additional effort on the part of the end-user.
To enable secured authentication, edit the <WebApp>\appSettings.config file and add the following line:
<add key="useSecurityToken" value="True" />

The server API generates a security token with the session and embeds it into the page markup. It is sent with every client request as a
part of the payload. When using a secured connection, the payload is encrypted, thus making it nearly impossible for a malicious party to
derive the token.
Caution
Unsecured connections will compromise any security intended by the use of secured authentication. If the payload is unencrypted, the
token can be easily intercepted by a third party. The web server must enforce HTTPS in order for secured authentication to function
properly.

Application and Performance Logging
An administrator can configure how Exago handles logging in order to change or extend functionality.

Logging Defaults
By default Exago saves a log file WebReportsLog.txt to the application’s Temp path. The logger maintains a lock on the file for the
lifespan of the application. The log file cannot be edited or deleted without restarting the application or releasing the lock.
Note
As of version 2018.1, the .NET API logs to the file <Temp>\WebReportsApiLog.txt
There are five configurable verbosity levels for the logger. By default, Exago logs at the Info level. Set the level by changing the Admin
Console > General > Other Settings > Write Log File setting.
None — Turns logging off.
Error — Logs application errors.
Warn — Logs application warnings, which may be indicative of problems in the configuration, as well as all Error messages.
Info — Logs SQL statements, number of rows returned from each statement, and report execution information, as well as all Warn
and Error messages. Report execution information includes the following:

Execution start
Start time, userId, companyId, full report name, filter summary.

Execution end
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End time, runtime, userId, companyId, full report name.
Debug — Logs a variety of debugging information that can be used to time specific parts of the application as well as all Info,
Warn, and Error messages.

log4net
The logger can load its configuration from a file and continually watch the file for changes. A config file can be used to lock or unlock the
log file, change the log file name and path, as well as customize and extend logging capability.
A custom log configuration file will override the application's configuration settings.
Notice
Enabling or disabling logging with log4net will require restarting the web server.
To use a custom log configuration:
1. Create a file named log4net.config in the <WebApp>\Config directory of the Exago Web Application. The following shows a
sample config file or download our sample.
<log4net>
<appender name="RollingFile" type="log4net.Appender.RollingFileAppender" >
<file value="WebReportsLog.txt" />
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%date #%-3thread %-5level [%-8.8property{ReportId}][%-8.8property{SessionId}] - %message%newline" />
</layout>
<maxSizeRollBackups value="10" />
<maximumFileSize value="1MB" />
<rollingStyle value="Size" />
</appender>
<appender name="PerfRollingFile" type="log4net.Appender.RollingFileAppender" >
<file value="WebReportsPerfLog.txt" />
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%date #%-3thread %-5level %logger [%-8.8property{ReportId}][%-8.8property{SessionId}] - %message%newline" />
</layout>
<maxSizeRollBackups value="10" />
<maximumFileSize value="1MB" />
<rollingStyle value="Size" />
</appender>
<root>
<level value="DEBUG" />
<appender-ref ref="RollingFile" />
</root>
<!-- Set logging level to DEBUG and use logger define at the ROOT level -->
<logger name="Exago Logger">
<level value="DEBUG" />
</logger>

<!-- Disable Performance Logging
<logger name="Perf Logger">
<level value="OFF" />
</logger>
-->
<!-- Enable Perf Logging in general log file -->
<logger name="Perf Logger">
<level value="INFO" />
</logger>
<!-- Perf logging in its own file
<logger name="Perf Logger" additivity="False">
<level value="INFO" />
<appender-ref ref="PerfRollingFile" />
</logger>
-->
</log4net>

2. Determine the type of logging needed: either Application, Performance or both.
3. Edit the log4net.config file as follows:

Anatomy of the log4net.config file
For full details about the log4net.config file, refer to Apache's official log4net documentation. Below are some common changes
that can be made that apply to Exago.

Appenders
The appender sections control the log output. There can be seperate log files output for both the standard Exago application log and for
performance logging. In the example two appenders are defined, one named RollingFile and the other PerfRollingFile which can be used for
application and performance logging, respectively.
Change Log File Location
This node determines the location of the log file. If not an absolute path, the file is stored
<file value="Path\To\Log.txt" />

Changing the Logging Pattern
<conversionPattern value="%date %-5level [%property{SessionId}] %message%newline" />
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Configures which information is logged and the format of how it is written.
See Apache log4Net SDK Documentation - PatternLayout Class for details on how to format the conversionPattern.
Unlock the Log File
<lockingModel type="log4net.Appender.FileAppender+ExclusiveLock" />

Configures the locking model in use for the log file. To temporarily disable the write lock, you can use:
log4net.Appender.FileAppender+MinimalLock
Note
This will result in a performance reduction until it is reset.

Loggers
The root and logger nodes establish loggers that receive information from Exago and then send it to the appenders that actually write
the files.
The Exago Logger is used by the main application. The Perf Logger records application performance. By default, logs will then be passed
to the the root logger unless their corresponding additivity attribute is False.
In the example file, both Application logging (via the <logger name="Exago Logger"> node) and Performance logging (via the
<logger name="Perf Logger"> node) are enabled. They will capture the data then will use the <root> logger since the additivity
attribute is not specified. The <root> logger uses the RollingFile appender, so both the Application and Performance log data will be
written to the same file.
To write the application and performance logs to different files, comment out the <logger name="Perf Logger"> node and
uncomment the <logger name="Perf Logger" additivity="False"> node. The log level and destinaiton appender are then
further defined:
Change Logging Level of a Logger
Specifies the Exago logging level: OFF, ERROR, INFO, or DEBUG.
<level value="INFO" />

Change Appender a Logger Uses
Specify the name of an appender in the ref attribute of this node.
<appender-ref ref="PerfRollingFile"

Resolving log4net.dll version conflicts
Exago uses a specific version of the log4net.dll file that is shipped with the application. When a .NET embedding application implements a
different version of log4net, there can be conflicts. The solution is to add a runtime assembly binding redirect to the Exago web.config.
Example
<dependentAssembly>
<assemblyIdentity name="log4net" publicKeyToken="669e0ddf0bb1aa2a" culture="neutral"/>
<bindingRedirect oldVersion="1.2.11.0" newVersion="1.2.15.0" />
</dependentAssembly>

See Redirecting Assembly Versions (MSDN) for more information.

Logging to a SQL Database
The following will describe the necessary steps to store Exago logging information in a database. The sample referenced here is configured
for MS SQL Server, but log4net provides examples for other database types.
First create a new database table to store the log transactions:
CREATE TABLE [dbo].[exagoweb] (
[id] [int] IDENTITY (1, 1) NOT NULL,
[timestamp] [datetime] NOT NULL,
[logger] [varchar] (255) NOT NULL,
[thread] [varchar] (255) NOT NULL,
[level] [varchar] (50) NOT NULL,
[reportId] [varchar] (255) NOT NULL,
[sessionId] [varchar] (255) NOT NULL,
[message] [varchar] (4000) NOT NULL
)

Use the following example log4net configuration file as a reference to configure log4net logging to a database:
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<?xml version="1.0" encoding="UTF-8"?>
<log4net>
<appender name="AdoNetAppender" type="log4net.Appender.AdoNetAppender">
<bufferSize value="100"/>
<connectionType value="System.Data.SqlClient.SqlConnection, System.Data, Version=4.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089"/>
<connectionString value="database connection string"/>
<commandText value="INSERT INTO exagoweblog ([timestamp],[logger],[thread],[level],[reportId],[sessionId],[message]) VALUES (@timestamp, @logger, @thread, @level, @reportId, @ses
<parameter>
<parameterName value="@timestamp"/>
<dbType value="DateTime"/>
<layout type="log4net.Layout.RawTimeStampLayout"/>
</parameter>
<parameter>
<parameterName value="@logger"/>
<dbType value="String"/>
<size value="255"/>
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%logger"/>
</layout>
</parameter>
<parameter>
<parameterName value="@thread"/>
<dbType value="String"/>
<size value="255"/>
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%-3thread"/>
</layout>
</parameter>
<parameter>
<parameterName value="@level"/>
<dbType value="String"/>
<size value="50"/>
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%-5level"/>
</layout>
</parameter>
<parameter>
<parameterName value="@reportId"/>
<dbType value="String"/>
<size value="255"/>
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%-8.8property{ReportId}"/>
</layout>
</parameter>
<parameter>
<parameterName value="@sessionId"/>
<dbType value="String"/>
<size value="255"/>
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%-8.8property{SessionId}"/>
</layout>
</parameter>
<parameter>
<parameterName value="@message"/>
<dbType value="String"/>
<size value="4000"/>
<layout type="log4net.Layout.PatternLayout">
<conversionPattern value="%message"/>
</layout>
</parameter>
</appender>
<root>
<level value="INFO"/>
<appender-ref ref="AdoNetAppender"/>
</root>
</log4net>

Once complete, perform an IIS reset, and relaunch Exago. You should no longer see information being saved to disk, and should instead
see entries being populated in your new database table instead.

Troubleshooting log4net
log4net does provide the ability to troubleshoot logging. Should you need to troubleshoot, add the following to Exago’s web.config file below
“appSettings”:
<system.diagnostics>
<trace autoflush="true">
<listeners>
<add
name="textWriterTraceListener"
type="System.Diagnostics.TextWriterTraceListener"
initializeData="C:\tmp\log4net.txt" />
</listeners>
</trace>
</system.diagnostics>

In addition to the above, add the following entry to the appSettings collection:
<add key="log4net.Internal.Debug" value="true"/>
Save the file, refresh IIS and give IIS_IUSRS full permission to the folder where logging logs are set to be stored. In the example above, that
would be “C:\tmp”. Then, attempt to execute Exago reports and check the logging log file to see why Exago logging is failing.
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